1. Instalace a aktivace

1.1 Instalace 4MCAD

. Stahnéte si instalaci programu 4M CAD ze stranky Ke stazeni a spustte jej.
. Pokud se zobrazi okno Rizeni uzivatelskych u&td: ".chcete povolit provedeni
zmén v tomto pocitaci?", zvolte "Ano".
. V uvodnim dialogu zvolte "DalSi".

B4 Privodce instalaci - 4MCAD 19 PRO — X

Vita Vas privodce instalad
produktu 4MCAD 19 PRO.
Produkt 4MCAD 15 PRO bude nainstalovan na Vas pocitac.

Drive neZ budete pokraCovat, doporuéuje se ukon&it veskeré
spusténé aplikace.

Pokracujte klepnutim na tlacitko Dal§i nebo ukoncete
pruvodce instalaci tla¢itkem Stomo.

4AM CAD SERIES

winw, dmsa.com Stomo

. Seznamte se s licenénim podminkami, potvrdte souhlas volbou
"Souhlasim..." a pokracujte tlaCitkem "DalSi".


https://www.4mcad.cz/ke-stazeni

g Pravodce instalaci - 4MCAD 19 PRO — X i

Licenéni smlouva £ A\
Drive neZ budete pokracovat, prectéte si prosim pozomeé nasledujici dulezité A
informace.

Prectéte si prosim tuto licenéni smlouvu. Musite souhlasit s podminkami této smlouvy,
aby instalace mohla pokracovat.

SOUHLAS S UZIVATELSKU LICENCI 4M  »
SOFTWARE

INSTALACI, KOPIROVANIM NEBO JINYM UZIVANIM SOUCASTI
PROGRAMU SOUHLASITE S DODRZOVANIM PRAVIDEL A PODMINEK
4M SOFTWARE. POKUD S TEMITO PODMINKAMI A PRAVIDLY

NESOUHLASITE, NEINSTALUJTE, NEKOPIRUJTE ANI JINAK
NENZIVE ITE QNI IAAQTI PRACD AMI |

(® Souhlasim s podminkami licenéni smlouvy
(O Nesouhlasim s podminkami licenéni smlouvy

www. 4msa.com | <2t || Dai> | | Stomo

Vyplrite vaSe informace a zvolte "DalSi".

B2 Privodce instalaci - 4MCAD 19 PRO — x ‘
Informace o uZivateli £\
Zadejte prosim poZadované Udaje. Y

Uzivatelské jméno:

[Marek |

Spoleénost:

[ﬁmh lab, sro. I
wovw, dmsa, com . <Zpit | Stomo

Ponechte vychozi slozku nabidky Start, nebo vyberte jinou, a pokracujte

tlaCitkem "DalSi".



E Privodce instalaci - 4MCAD 19 PRO

Vyberte slozku v nabidce Start
Kam ma privedce instalaci umistit zastupce aplikace?

Start.

tla¢itko Prochazet.

\ MCAD 19 PRO

4N
A

Privodce instalaci vytvori zastupce aplikace v nasledujici sloZce nabidky
Pokracujte klepnutim na tlacitko Dalsi. Cheetedi zvolit jinou sloZku, klepnéte na

| | Prochazet...

wwww, dmsa. com

<Zpdt

Zatrhnéte vyhovujici moznosti nabidky a zvolte "DalSi"

Stoma

@ Privodce instalaci - 4MCAD 19 PRO

Zvolte dalsi dlohy
Ktere dalsi ulohy maji byt provedeny?

x|

4L/
fa

Zvolte dali dlohy, které maji byt provedeny v pribéhu instalace produktu 4MCAD 19

PRO a pokraéujte klepnutim na tladitko Dalsi.

Dal$i zéstupci:

1 Wytvortt zastupce na ploge

[] Vytvorit zdstupce na panelu Snadné spudténi
Nastavit otevirani dwg a dxf soubori vidy s AMCAD

(@) Yes
O No

wwww, dmsa. com

<Zpdt

Zvolte "Instalovat"

Dalgi >

Stoma



B2 Privodce instalaci - 4MCAD 19 PRO — x ‘

Privodce instalaci je nyni pfipraven nainstalovat produkt 4MCAD 13 PRO na Vas Y
pocitac.

Pokraéuite v instalaci klepnutim na tlaéitko Instalovat. Prejetedi si zménit nékiera
nastaveni instalace, klepnéte na tladitko Zpét.

Informace o ufivateli:
Marek
Archlab.sro.

Slotka v nabidee Start:
4MCAD 19 PRO

Dalsi Glohy:
Vytvorfit zastupce na plose

Yes

v dmsa com | < Zpdt . Stomo

...a vyCkejte na dokonceni instalace .

P Privodce instalaci - 4MCAD 19 PRO — >
Instalovani £\
Cekete prosim dokud privodce instalaci nedokonéi instalaci produktu 4MCAD Y
15 PRO na Va3 pocitac.
Bxtrahuji se soubory...
C:\4MCAD13PROMcDb.dl

e

Muzete ponechat vybranou volbu "Spustit aplikaci" a zvolte "Dokon¢it"



B2 Privodce instalaci - 4MCAD 19 PRO — x

Dokoncuje se instalace produktu
4MCAD 19 PRO

Privodce instalaci dokonci instalaci produktu 4MCAD 15 PRO
na Vas pocitac. Produkt lze spustt pomoci nainstalovanych
zastupct.

Ukonéete pravodce instalaci klepnutim na tladitko Dokondit

b1 Spustit aplikaci 4MCAD 13 PRO

a4k CAD SERIES

wwew dmsa com

. PFi prvnim spusténi mizete nastavit asociativitu DWG
souboru s programem 4MCAD.

r- -
Varovani asociace souboru m

AMCAD jiZ neni vychozim programem pro soubory .dwg.
Chtéli byste obnovit asociace .dwg soubori se 4MCAD?

Pamatovat si volbu a tuto zpravu jiz nezobrazovat.

. Po ukonceni instalace se program nachazi v seznamu programu na disku.

1.2 Online aktivace licence

Jde o nejCastéji pouzivany zplsob aktivace zakoupené licence CAD program( 4M.
Doporucujeme do€asné vypnout firewall a antivirus.

Pred aktivaci spustte 4M CAD pres ikonu na plose pomoci pravéh tlaCitka mysSi
volbou Spustit jako spravce.



V uvodnim dialogu vlozte jméno, pfijmeni, firmu a licenéni Cislo. VeSkeré
udaje je nutné zadavat bez diakritiky. Program vyZaduje alespor jedno pismeno jako
nazev firmy. U fyzické osoby mlzete napfiklad zopakovat jméno.

Altivace

Vyberte, jak cheete aktivovat tento produkt:

" Orline {vyZadovano piipojeni k internetu) | Zyolte tento zpfisob, pokud mate aktivni
(" Internebova strank internetové pripojeni. Je nejrychlejsi.,

" E-mail
" Fax

Dalsi Storno

. U zplsobu aktivace ponechte nastavenou prvni moznost (Online).

Yiogte, prozim, Wase sérioveé dizlo a
zvolte “Aktivoval” pro akbivac legalni
licence nebo zvolte "Zadit zkufebni

c E D dobu' pro wyzkougeni AMCAD UL

4/ N\

Jméno IJ meno Primeni

Spoleénost; IFlrma, zL.O.

Sériové &sl:  |Licence

Zhired 30 dni pro odzkouzeni.

At at | Zacit zkugebni dobu Drema

Vyplite formular tak, aby souhlasil s Udaji registrovanymi u vyrobce.
Pozornost vénujte pfedevdim jménu a pfijmeni kontaktni osoby a emailové adrese.
Na tuto adresu Vam bude doru€eno také informacni potvrzeni o aktivaci.



Altivace
Seriove dslo:
emé: |CZEd" Fepublic ﬂ
: | Jmeno
Jmeno:
Prijmeni: | Frignc
Spolefnost: | Firma s.r.o.
adresa: | lice 10
L | 000 00
Mésto: | Mesto
Telefon; | +420 D0D 000 000
Fax: |
E-mail: | info@email.cz
Aktivovat ﬂ

Po odeslani dialogu tlaCitkem Aktivovat se program spoji s licenénim serverem
a ovéfi spravnost Cisla licence. Pokud je v8e v poradku, spusti se program po kratké
chvili v pIné aktivovaném rezimu.

V pFipadé potizi nas kontaktujte na info@4mcad.cz.

1.3 Aktivace emailem

Pokud nemate k dispozici stalé pfipojeni pocitaCe k internetu nebo z néjakého
ddvodu selze online aktivace programu, je k dispozici aktivace emailem.

Aktivace emailem mulze byt vyuZita také pfi FeSeni potizi s aktivaci. V takovém
pfipadé zasilejte vygenerovany textovy soubor na adresu ¢eské podpory.

PFi aktivaci programu doporucujeme do¢asné vypnout firewall a antivirus. Mohou (ale
nemusi) aktivaci v jejim prabéhu zabranit.

. VloZte jméno, pfijmeni, firmu a licenéni €islo. VeSkeré udaje je nutné zadavat
bez diakritiky. Program vyZaduje alespori jedno pismeno jako nazev firmy. U fyzické
osoby mulzete napfiklad zopakovat jméno.



Ylozte, prozim, Yage sénove Cizlo a
zvolke “Aktvovat’! pro aktivaci legalni
licence nebo zvolte "Zadit zkugebni

c a D dabu! pro wyzkougeni AMCAD L

Jméno IJ meno Prijmeni

Spoleénost: |Firma, IO,

Séiiové &islo;  |Licence

Zbiwd 30 dni pro odzkougeni.

Akt at | £acit zkugebni dobu | Demo |

U zplsobu aktivace zvolte tfeti moznost (Aktivace emailem).

Altivace

Vyberte, jak cheete aktivovat tento produkt:

" Online (vyZadovano pfipajeni kinternetu) | Zyolte tento zplsob, pokud cheete zaslat

{" Internetovd strénka pug.?d.?vgk i a}:ﬁuad na_majlern. Budete
______________ : poZadani o zaslani spedfického souboru,

{« E-mail ktery bude obsahovat data o Vasii
e Pl

" Fax

Dalsi Storno

Vyplnte formular tak, aby souhlasil s udaji registrovanymi u vyrobce.

Pozornost vénujte pfedevdim jménu a pfijmeni kontaktni osoby a emailové adrese.
Na tuto adresu také obdrzite aktivacni kod.



Alktivace

Sérigvé dslo:
Zeme:
Jméno:
Priimeni:
Spolednost:
Adresa:
pPsC:
MEstao:
Telefon:

Fax:

E-mail:

Aktivovat

1Czen:h Republic

I Jmeno

| Prijrieni

]Firma 5.r.0.

]ulice 10

] 000 00

l Mesto

] +420 000 000 000

|

| info@email.cz

Storno |

. Ulozte textovy soubor s Vasimi udaji do pocitace pod vhodnym nazvem (napf.
aktivace.txt) v dobfe zapamatovatelné cesté.

B2 Ulozit jako

= v « dm 3 test » w Prohledat: test

Uspofadat - Mowva slozka S ow
|5 Dokumenty " Nizev Datum zmény
d Hudba dmcad_16.1 26.05.2016 14:50
=] Obrizky Amecad 26.04.2016 12:29
B Plocha dmcad1d 2.05.2016 11:53
4 Stazené soubory Amcadifsk 25.05.2016 10:53
B Videa dgn 16.01.2016 20:2

fineelecld 01.02.2016 16:13

i, Windows8 OS(C) o, o1
Mazev souboru: | aktivace.bd

UleZit jako typ: | Register Files (*.tet)

A Skrjt slozky

Frugit




. Soubor odeslete jej v pfiloze emailu na zobrazenou adresu.
Pfi FeSeni potizi s aktivaci zasilejte soubor na email Ceské podpory
info(zavinac)4mcad.cz .

Data uloZena do souboru C:\dm\test\aktivace. tt,
Zaslete soubor na adresu registrations @4m.ar

. Zobrazi se okno pro vlozeni aktivaéniho kédu. Pokud mate tuto moznost,
ponechte toto okno oteviené dokud neobdrzite odpovéd s aktivaénim kédem na Vas
email. V opacném pfipadé budete muset zopakovat po obdrZzeni kddu kroky k tomuto
bodu, neodesilat znova pozadavek, ale obdrzeny kéd znova vloZit.

Vlozte kod odpovédi

Kod 0607-3456-0905-0304
0557-3530-0277-0072
1703-0774-064A-500D
o073 AC1E-6972-073C

Kod odpovédi; |

0K Storno |

1.4 Uplna odinstalace programu

PFi feSeni nékterych problému je vhodné jako prvni vyzkousSet preinstalaci
s pfedchozim uplnym odstranénim programu:

. Odinstalujte program pomoci Ovladacich paneltd ve Windows. Zvolte Start >
Ovladaci panely > Pfidat nebo odebrat programy a odinstalujte pfisludny program ze
seznamu.

. Smazte adresar programu na disku C. Napfiklad C:/4MCAD19 pro verzi
4AMCAD 19 Standard nebo C:/4AMCAD19PRO pro verzi 4AMCAD 19 Professional.
. Program 4MCAD by mél své zaznamy v registrech odstranit pfi odinstalaci,

ale mlzete zkontrolovat, zda zaznamy nezUstaly a pfipadné je smazat: Ve Windows
zvolte Start > Spustit, do fadku napiste Regedit a potvrdte klavesou Enter. Zvolte
HKEY_CURRENT_USER > Software > 4M a smazte zaznam v registrech dle verze
Vaseho programu.



ﬁ Editor registru - [m]
Soubor Upravy Zobrazit Oblibené poloZky Napovéda

Pocitad\HKEY_CURRENT_USER\Software\4M\4MCAD 19 Professional

v Software A || Nazev e —
bl 2b|(vychoziy REG_SZ
4MCAD 10 P-nenm |
XCrashRe Rozbalit
Adobe Novy >
AppDataloy Najit...
A3 Odstranit

Classes
Clients
csastats Exportovat

Goagle Opravnént...

Pfejmenavat

Chromium
Intel
Macromedia
McAfee
Microsoft
Mozilla
Netscape
Notepad2
NVIDIA Corporation

Zkopirovat nazev klice

OpenOffice

Opera Software
PDFsam Basic

Policies

Realtek
RegisteredApplicatic

< >

1.5 Vymazani zaznamu v registrech

Promazani zaznamu CAD programu v registrech systému maze pomoci vyresit
problémy s funkénosti, které mohou vzniknout pfi instalaci nové verze progamu pfes
verzi starsi.

Program si pfi dalSim spusténi vytvofi v registrech nové zaznamy. Po promazani
zaznamu v registrech bude ale nutné nastavit jazyk zpét na ¢estinu a program znova
aktivovat. Budete tedy potifebovat Vase licencni (sériové Cislo).

Pro vymazani zaznamu v registrech

. Zvolte Start > Spustit, napiSte "regedit" a potvrdte klavesou Enter.
Ve Windows 8 a novéjSich zadejte "regedit" pfimo do pole pro vyhledavani aplikace.
. Zvolte HKEY_CURRENT_USER > Software > 4M a smaZte zaznam

Vv registrech s nazvem vaseho programu.

. Zmeénte jazyk programu zpét na ¢estinu: Zvolte Tools > Menu
Select... a polozku Language zménte na "Czech".

. Aktivujte pfi dalSim spusténi program s Vasimi platnymi licenCnimi udaji.
Doporuceny zpusob aktivace je "online". Pokud jste na stejném systému, kde byl
program jiz aktivovan, zaznam na licenénim serveru vyrobce zUstava v platnosti. PFi
aktivaci by nemél nastat problém.

Pokud probéhl upgrade systému na Windows 10 bez deaktivace licence 4MCAD,
mohou zmény v novém systému zpusobit problém. V takovém pFipadé zvolte zplsob
aktivace "emailem". Program Vas vyzve k ulozeni textového souboru. Zadejte nazev
souboru a umisténi pro ulozeni v pocitaci. Soubor pak zaslete emailem na adresu
Ceského zastoupeni s informaci, Ze se jedna o problém s aktivaci po upgrade na
Windows 10. Pro praci do¢asné vyuZijte jinou verzi 4MCAD ve zkuSebnim rezimu.

. Provedte dalSi upravy uzivatelského rozhrani dle vasich zvyklosti
a zkontrolujte funkénost po op&tovném spusténi programu.



ﬁ Editor registru - [m] X
Soubor Upravy Zobrazit Oblibené poloZky Napovéda

Pocitad\HKEY_CURRENT_USER\Software\4M\4MCAD 19 Professional

v Software A || Nazev e —
bl 2b|(vychoziy REG_SZ
4MCAD 10 P-nenm |
XCrashRe Rozbalit
Adobe Novy >
AppDataloy Najit...
A3 Odstranit

Classes
Clients
csastats Exportovat

Goagle Opravnént...

Pfejmenavat

Chromium Zkopirovat nazev klice
Intel T

Macromedia
McAfee

Microsoft

Mozilla

Netscape
Notepad2

NVIDIA Corporation

OpenOffice

Opera Software
PDFsam Basic

Policies

Realtek
RegisteredApplicatic

< >

1.6 Instalace aktualizované verze CAD
programu

Novou verzi programu by mélo byt mozné instalovat pfimo pfes verzi pfedchozi bez
jejiho odebrani.

Pokud se po aktualizaci objevi potiZe s tiskem z rozvrzeni Ci jiné problémy, |ze
vyzkouset promazani zaznamu v registrech.

Promazani zaznamu v registrech by mélo postacovat pro vytvoreni novych nastaveni
programu a odstranéni potizi. Pokud by se tak pfes to nestalo, je jes$té mozné
vyzkouSet pfeinstalaci v€etné uplného odebrani:

PFed uplnou odinstalaci programu mize byt uzitecné zalohovat néktera z nastaveni
Ci stylu tisku. Muze se jednat o tyto soubory &i adresare v adresafi programu (napf.
C:/4AMCAD19PRO):

./ColorBook - pokud vyuzivate vlastni knihovny barev
./DWG - pokud obsahuje vlastni bloky, které vyuzivate
.IPlotStyle - pro zalohovani stylu tisku (ctb & pcp souboru)
LSP a DCL soubory, pokud vyuzivate vlastni LISP aplikace

Je také mozné exportovat menu &i nastaveni rychlych klaves pod polozkou Nastroje
> Vlastni nastaveni menu...

Po té postupujte dle navodu pro uplnou odinstalaci a nasledné provedte novou
instalaci s aktivaci licence.

Pokud potize pfetrvaji nebo si nékterymi kroky nejste jisti, kontaktujte nas.
1.7 Deaktivace licence

P¥i planovaném piesunu licence 4MCAD ¢i planované zméné systému je nutné
v puivodnim pocitaci nejprve stavajici licenci deaktivovat:

. Spustte program pomoci pravého tlacitka mysi volbou "Spustit jako spravce".


https://www.4mcad.cz/vymazani-zaznamu-v-registrech
https://www.4mcad.cz/uplna-odinstalace

. V dialogu Pravodce po spusténi stisknéte tlacitko Deaktivovat.

Pokud se dialog pfi spusténi programu nezobrazuje, Ize jej vyvolat v menu Napovéda
> Privodce po spusténi.

4MCAD 14 _

4MCAD

Vase vykresy: = Zaciname:
Zobrazit vzor vykresu:

) Vytvofit vykres E] Oteviete 2D vykres

Vyberte vyk
e ¥ Oteviete 3D vykres

...s\lisp\midas\struct076b.dwg Prohlédnéte si videa:
...als\lisp\midas\test076b.dwg

...sYlisp\midas‘\struct075b.dwg ’(H\ Koncept na videu

=EE

o

Najdete nas na Facebooku

[ Zobrazit toto okno pfi spug B8l Ffipojte se na Google+ Kontalkt | Koupit || Deaktivovat || Zawrit

Deaktivace licence je také provedena pfi odinstalaci programu, pokud je pocitac
pfipojen k internetu. U verze 4MCAD 11 ¢i starSich je deaktivace mozna pouze pfi
odinstalaci.

Uspé&sna deaktivace je potvrzena zaslanim automatického emailu z licenéniho
serveru na registrovany email.

U upgradovanych licenci je nutné pro pfenos licence na novy pocitaC deaktivovat na
puvodnim pocitaci i vSechny starSi verze. U 4MCAD se v takovém pfipadé jedna
0 jednu licenci, ktera ma vice licen€nich Cisel.

2. Prostredi

2.1 Roletové menu

Skupiny pfikazi 4MCAD sestavaji z moznosti
menu Soubor, Upravit, Zobrazit, Vlozit, Format, Nastroje, Render, Plus, Kreslit,
Koéty, Modifikace, Okno a Napovéda.

Pod jednotlivymi volbami se skryvaji souvisejici skupiny pfikaz(. Pokud je volba
oznacena Sipkou na pravé strané, znamena to, Ze skryva dalSi podmenu s pfikazy.
Volby zakon&ené teCkami (...) zobrazuji dialogova okna s dalSimi moznostmi
nastaveni. Ostatni volby provedou konkrétni pfikaz.



Pfi najeti mysi na pfikaz v menu je v levé spodni ¢asti okna 4MCADu (stavovém
fadku) zobrazen jeho popis nebo stru¢na napovéda.

@ AMCAD 19x64 Professional

Soubor Upravit io| Viozit Format Nastroje Render Plus Kreslit Koty Modifikace Okno Néapovéda

: 3 Wy P i |= =
ﬁmal@) Prekreslit Pﬂm]";k.n'_,‘ﬂlh’lglk'ﬁ}QQ'Qlf
) (} Regenerovat — S
HK > Vykresiy Zoom 14 q V redlném case

"Sr Fosun . Q Pfedchozi

ﬁ' [ 3D Orbit > @ Okno

6’ Pracovni prostory Q Dynamicky

@}V ’ Vyfezy vedle sebe > Q Meéfitko

dl' . Plovoucf vyfezy > @ stred

_s @ Pojmenované pohledy Q Zveétsit

H 3D bod pohledu p | @ Zmensit

il & 3D dynamicky pohled Vie

ﬁ‘a Styly zobrazenf( > NiEze

ol @ Skryt (2} Max pohled

@'; P Stnovat Q Vievo

=3 Q Objekt

A.; Zaobrazit | 4

74’ B Panely nastroj...

-

Pfikaz je proveden po kliknuti levym tlaCitkem mysi. Po kliknuti nasleduje bud pfima
prace ve vykresovém okné nebo specifikace voleb nabizenych v pfikazovém fadku.

2.2 Vybér menu

Program 4M CAD CZ nabizi mozZnost nastaveni menu v €estiné a anglictiné.
Dialog pro nastaveni menu naleznete pod Nastroje > Vybér menu
Alternativné muzete v pfikazovém fadku zadat _ MENUPARAMS.



r N
Mastavit jazyk w

MNastaveni Windows
Mistni jazyk: [C=stina (Ceska republika)|

Systémovy jazyk: | Cedtina (Ceskd republika)

[ Mistni & jazykove moZnosti. ..

Mastaveni 4MCAD
Metoda vibéru jazyka
@) Ruéni wybér
() Automaticky pfizplsobit nastaveni regionu
() Automaticky prizpisobit lokalizad systému

Jazyky
* Jamyk MNativni ndzev Femé Alktudini profil
@ Anglicky English United States Default
@ Cesky cedting Czech Republic Default

(2] —— R —
e ———————————————————————————

PFepnuti menu maze zrusit jina vlastni nastaveni pfikazt nebo ikon v panelech
nastroju. Jsou nactena vychozi nastaveni. Pokud jste vytvareli vlastni nastaveni
roletového menu nebo panell nastroju, doporucujeme toto nastaveni pfed zménou
menu exportovat (napf. export do souboru .mnu) a zalohovat.

2.3 Uzivatelské rozhrani

S oknem 4MCAD a jeho prvky je mozné pracovat mnoha zpusoby.

Muzete napfiklad zobrazovat a pfemistovat panely nastroju, zobrazovat nebo
vypinat okno pfikazového fadku a stavovy fadek.
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A. Mlizete upravovat menu v horni ¢asti okna.

B. MUzete upravovat panely nastroj, ménit jejich vzhled, umisténi nastroji a
pridavat vlastni pfikazy i makra. Panely nastroju Ize umistit nebo zakotvit na
jakémkoli misté obrazovky.

C. Vykresy se zobrazuji v kreslicim okné.

D. Kliknéte na zaloZky pro pfepnuti mezi modelovym a vykresovym prostorem.
E. Pfikazy jsou zadavany v okné prikazového fadku.

F. Stavovy fadek zobrazuje informace jako nazev nebo ucel nastroje, aktualni
souradnice kurzoru, nazev hladiny a nastaveni rezimu.

G. Ikona uzivatelského soufadného systéemu (USS) zobrazuje orientaci vykresu v
trojrozmérném prostoru.

H. Panel Vlastnosti zobrazuje riizné viastnosti vybranych entit a umoznuje jejich
editaci.

2.4 Kontextové menu
Kontextova menu zajidtuji rychly pFistup k nékterym pfikazam.

Kontextové menu je zobrazeno, pokud pravym tlacitkem mysi kliknete na entitu,
panel nastroju, stavovy fadek nebo zalozky modelovych a vykresovych prostor(.

Nabidka zobrazeni v kontextovém menu se liSi dle prvku, na ktery bylo kliknuto.

PFi pravém kliku na panel nastrojl, zobrazi program kontextové menu, které umozni
zobrazeni riznnych panell nastroji zapnout nebo vypnout.
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Pokud vyberete jednu nebo vice entit a kliknete pravym tlacitkem, zobrazi program
kontextové menu, ze kterého muzete zvolit pfikaz pro editaci vybranych entit.

\ Opakovat CYLINDER
Posledni pfikazy 4

Editace téles 4
Schranka »

Odstranit
Posun
Kopie
Méfitko

QEl&# 4 X

Otocit

Pofadi zobrazeni 4
Y Rychiy wbér

Najit a nahradit

iy
Vlastnosti...

Pro zobrazeni menu, ze kterého Ize vybrat uchopy entit, stisknéte a podrzte klavesu
Shift a pak pravym tlacitkem kliknéte kdekoli uvnitf kresliciho okna.
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2.5 Panely nastroju

Program nabizi mnoho riznych panell nastroju, které Ize upravovat pfidavanim a
odebiranim jednotlivych ikon nastroju. Panely nastroju mlzete také pfemistovat a
vytvaret nové vlastni. Pro zobrazeni a skryvani panell nastrojl Ize pouzit kontextové
menu. Je také mozné zvolit, zda jsou panely zobrazeny s velkymi nebo malymi
ikonami. DalSi vlastnosti je volba zobrazeni kontextové napovédy, které zobrazuje
popis nastroje pfi pozastaveni kurzoru nad nim.

Pro tato nastaveni zvolte Zobrazit > Panely nastroju.
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Panely nastrojii mohou byt bud zakotvené nebo plovouci. Plovouci panel nastroju
ma titulni listu s nazvem a kfizkem pro uzavieni, maze byt umistén kdekoli na
obrazovce a lze ménit jeho rozméry. Zakotveny panel nastroju nezabrazuje titulni

liStu ani kfizek pro uzavreni a je pfipojen k jedné z hran kresliciho okna.

[ISIE]

<]

Pro zakotveni panelu nastroju jej pretahnéte na jeden z okraji okna programu, pro
uvonéni jej pfetdhnéte z okraje pry€. Pro umisténi plovouciho panelu v oblasti na
okraji okna bez jeho ukotveni stisknéte nejprve klavesu Ctrl a pak jej pfetanéte. Pro
pfesun panelu jej pfetahnéte na novou pozici.

Pro zménu velikosti pfesurite kurzor na hranu panelu, vyckejte, dokud se nezméni
tvar Sipky, a pak tahnéte.

Pro vybér, které panely nastroji zobrazovat
1. Provedte jedno z nasledujicich:

Zvolte Zobrazit > Panely nastroju

nebo

Kliknéte pravym tlaCitkem kdekoli na zakotveném panelu pro zobrazeni kontextového
menu a pak zvolte Panely nastroja.

Panely, které chcete zobrazit mizete také zvolit pfimo z kontextového menu.

2.V dialogu Vybér panell nastrojii zvolte panely nastroju, které chcete zobrazovat a
pak kliknéte OK.



2.6 Okno prikazového radku

Okno pfikazového Fadku je okno s moznosti zakotveni, kam jsou zadavany pfikazy
4MCAD, jsou zde zobrazovany vyzvy a dal$i zpravy programu.

Ve vychozim nastaveni zobrazuje Okno pfikazového Fadku posledni fadky pfikaza.
Horni a pfipadné i dolni okraj okna pfikazového Ffadku Ize tazenim pfesunout tak, aby
se zvétSil po€et zobrazovanych fadkl textu. Ve vychozim zobrazeni najedte mysi na
horni okraj okna tak, aby se kurzor zménil na Sipku a tazenim vzhuru uréete novou
velikost okna.

D i
M 4| » | M\ Model 4 33_100 4 a4_100 } a3_50 j a4_50 /

vrchol (A)/<vyska kuZelu>:

|Pfikaz:

Pfipraven -17622.6342,-1040]

Okno pfikazového fadku je mozné umistit v horni nebo dolni ¢asti okna programu.
Pro zobrazeni okna pfikazového rfadku zvolte ve Standard menu Zobrazit > Okno
pfikazového Fadku. Pokud pouzivate vychozi menu Advanced, zadejte pro
nastaveni zobrazovani do pfikazového fadku pfikaz _ CMDBAR. Pak zadejte Enter
pro skryti pfikazového fadku nebo U pro jeho pfemisténi do horni ¢asti okna
programu.

: _CMDBAR

|Pohybliv? (F}) /Dolni (L) fHorni (U)/<Skr7t prikazovy Fadek>: u

259'-317/32"10°-0 1y

Pokud je okno pfikazoveého fadku skryto, jsou vyzvy a volby pfikazli zobrazovany ve
stavovém radku.

2.7 Stavovy radek

Pokud neni zobrazeno Okno pfikazového fadku, zobrazuje Stavovy fadek informace
o vybraném pfikazu nebo nastroji. MUze také zobrazovat aktualni soufadnice
kurzoru, nazev aktualni vrstvy, nastaveni rezim( a dal$i informace o aktualnim
nastaveni.

Kromé zobrazovani informaci je stavovy rfadek rychlou cestou pro pfistup k mnoha
funkcim. Je mozZné kliknout na prvky stavového radku pro provedeni zmén a pravym
tlacitkem vyvolat kontextova menu pro zobrazeni dalSich moznosti.

= o




Ve vychozim nastaveni stavovy fadek zobrazuje:

Na levé strané Informace o aktualnim pfikazu nebo napovédu o pfikazu, nad kterym
je umisténa mys.

Souradnice kurzoru (x,y,z)

SNAP Nastaveni krokovani

GRID Nastaveni mfizky

ORTHO Ortogonalni kresleni

POLAR Nastaveni polarniho trasovani

ESNAP Nastaveni uchopt entit

LWT Zobrazeni tloustky Car

MODEL Pfepinani modelovy nebo vykresovy prostor
TABLET ReZim tabletu

DYN Dynamické zadani

Pro zménu prvki, které jsou zobrazeny ve stavovém fadku

1. Kliknéte pravym tlaCitkem na prazdnou oblast ve stavovém radku.
2. Vyberte prvky pro pfidani nebo odstranéni.

Pro zménu nastaveni prvki (tlagitek) ve stavovém fadku, provedte jedno z
nasledujiciho:

Klinéte dvojité na prvek stavového fadku nebo
kliknéte pravym tlaCitkem na prvek stavového fadku, ktery si prejete zménit a pak
zvolte pozadované nastaveni.

2.8 Nabidky prikaz

Pfikazy zadavané v programu 4MCAD maji pfi jednotlivych krocich rizné moznosti €i
volby. Ty se zpravidla zobrazuji v okné pfikazového fadku. Pro volbu urcité mozZnosti
je pak nutné do pfikazového Ffadku zadat pismeno nebo skupinu pismen, které jsou
umistény v zavorce za volbou. Tyto zkratky vychazeji z anglickych nazvu pfikazd.
Pokud zavorka za volbou neni, je tfeba pouzit prvni znak volby. Vychozi volba je
umisténa na konci ve Spicatych zavorkach.

Napfiklad pfi volbé pfikazu Oblouk (Kreslit > Oblouk > 3 body) a kliknutim na pozici
prvniho bodu nabidne stavovy fadek tyto moznosti:

uhel (A)/stfed (C)/smér (D)/konEc /poloméR/:

Muzete pokraCovat v zadani dalSiho bodu kliknutim mysi nebo pouzit nékterou z
voleb a urcit, Ze dalSim bodem je stfed oblouku (C + Enter).

Misto oznaCovani voleb pismeny je také mozné zobrazit dialog s nabidkami pfikazl
pomoci Nastroje > Moznosti... > Zobrazeni > Zobrazovat nabidky pfikazu.

Nabidky jsou pak zobrazovany v pfehledném panelu, ktery je mozné umistit kdekoli
na obrazovce.
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2.9 Zadavani prikazu

Pfikazy vyberte jednou z nasledujicich metod:

- Zvolte pfikaz z roletového menu

- Kliknéte na ikonu pfikazu v panelu nastroju

- Napiste pfikaz do pfikazového fadku

- Zadejte pfeddefinovany alias nebo rychlé klavesy pfikazu

Nékteré prikazy zUstavaji aktivni, i kdyz je ukoncite, takze mlzete opakovat akci bez
volani pfikazu znova (napf. kopie). Pfikaz muzete ukongit kliknutim na hotovo v
dialogu vyzev, stisknutim Esc nebo Enter.

Vétsinu pfikazl je mozné pouzivat, i kdyz je aktivni pfikaz jiny. Napfiklad pokud
kreslite useCku, mlzete pouzit posun pro posunuti vykresu pies obrazovku kvli
vybéru koncového bodu Usecky. Lze také zménit nastaveni kreslicich pomucek jako
jsou uchop nebo rastr, zatimco jsou jiné pfikazy aktivni.

Pro spusténi pfikazu z panelu nastroji kliknéte na nastroj a reagujte na vyzvy
programu. Nékteré nastroje jako usecCka nebo oblouk obsahuji dalsi mozZnosti, jak
pouzit zakladni nastroj s jinymi metodami nebo metodami, které obsahuji jiné,
pfibuzné nastroje. Tyto moznosti se zobrazuji jako maly trojuhelnik v pravém dolnim
rohu nastroje. Pro zobrazeni moznosti kliknéte na nastroj a podrzte tlacitko mysi. Pro
vybér jedné ze zobrazenych moznosti nad ni pfesurte kurzor mySi a uvolnéte
stisknuté tlacitko. Vybrany nastroj se pak zobrazi jako vychozi nastroj v panelu
nastroja.

Pro spusténi pfikaz( z roletového menu jej zvolte ze seznamu moznosti
nabizenych v menu.

Pro spusténi pfikazu z prikazového Fadku napiste pfikaz a pak stisknéte Enter.
Pokud je na obrazovce zobrazeno okno pfikazového fadku, objevi se zde napsany
pfikaz. V opa¢ném pripadé se pfikaz zobrazi ve stavovém fadku.

Pokud pfikaz zobrazuje dialogové okno, je zpravidla mozné vynutit také jeho
textovou verzi pomoci pomlcky pfed pfikazem (napf. -layer).

Opakovani prikazu
Posledni pfikaz Ize opakovat bez nutnosti zadavat jej znova témito zpUsoby:

- Stisknutim Enter
- Klikem pravého tla¢itka mysi.

Zanoreni prikazu



Pokud pracujete v okné pfikazového fadku, mazete pouzit pfikaz uvnitf jiného
pfikazu. Pro zavolani pfikazu uvnitf jiného pfikazu, napiste pred pfikaz apostrof:
napf. ‘circle, ‘line nebo ‘pyramid. Ve 4MCAD muzete vnofit pfikazy donekonec¢na.
Mnoho menu a maker z panell nastroj pracuji timto zplisobem automaticky:
napfiklad nastaveni barvy, referenéni mfizka a uchop. Pfi ukonéeni vnofeného
prikazu pokracuje plvodni pFikaz.

2.10 Okno historie prikazu

Okno historie pfikaz(l zobrazuje historii pfikazt a vyzev od spusténi 4AMCAD. Ve
vychozim nastaveni uchovava az 256 pfikazovych radku. V poctu uchovavanych
fadka neexistuje zadny limit, ale pfi velkém poctu uchovavanych fadkl maze byt
rychlost programu zpomalena.

Pro zobrazeni Okna historie pfikazl stisknéte klavesu F2.
B AMCAD Historie vjzev [E=REER

adejte moznost [Zddratény (2DW) /Drateny(3DW) /Skryty e
(3D) /Realisticky/Koncepcni /Dalsi(0)] <2dwireframe=: _R

ommand :

pacny roh:

ommand: _vscurrent

adejte moZnost [Zddratény (2DW)/Dratény(3DW) /Skryty
(3D) /Realisticky/Koncepéni /Dalsi(0)] <Realistics: _3dw
ommand: _wvscurrent

adejte moZnost [Zddratény (2DW)/Dratény(3DW) /Skryty
(3D) /Realisticky/Koncepcni /Dalsi(0)] <wireframe>: _2dw
ommand :

pacny roh:

ommand: '_HELP

ommand: pmhist

ommand: _ABOUT

ommand: '_HELP

ommand: pmthist

4 [

|Command:|

Pro zménu poctu uchovavanych fadkl napiste do pfikazového fadku pfikaz options
a stisknéte Enter. Pak zvolte zalozku Zobrazeni. V poli Po€et radek v okné historie
prikazl zadejte pocet fadek, které chcete uchovavat a stisknéte OK.
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2.11 Pfikaz Zpét

4MCAD uchovava provadéné piikazy a zmény. Pokud zménite nazor nebo jen
udélate chybu, mlzete vratit posledni krok nebo nékolik pfedchozich krokd. VSechny
kroky muazete také znova provést:

A. Kliknéte na nastroj Zpét pro vraceni posledniho kroku.

Soubor Upravit Zobrazit VloZit Format MNastroje Render Plus Kreslit Kéty Modifikace Okno Napovéda

B. Kliknéte na nastroj Znova pro nové provedeni vracenych krokd.

Muzete také vratit nékolik krok najednou, pokud napiSete pfikaz Undo a pocet krokd
pro vraceni.

3. Bloky, atributy a externi
reference



3.1 Prace s bloky

Bloky jsou obvykle tvofeny nékolika entitami, které jsou vloZeny do vykresu a je
mozné s nimi manipulovat jako s jedinou entitou. Blok se muze skladat z viditelnych
entit jako jsou €ary, oblouky, kruznice, stejné jako z viditelnych nebo neviditelnych
dat, které nazyvame atributy. Bloky se ukladaji jako ¢ast souboru s vykresem.

Bloky Vam muzou pomoci si lépe zorganizovat praci, rychle vytvaret a opravovat
vykresy a zmenSit velikost souboru. S vyuzitim bloku muzete vytvaret knihovnu Casto
vyuzivanych symboll. Pak je mozné vkladat symboly jako bloky a neni nutné
prekreslovat symboly z nacrta.

Po vytvoreni bloku z nasobnych entit je ulozite jako jednu entitu, ¢imz se rovnéz Setfi
misto na disku. Pak vlozite pouze vicenasobné reference k definici bloku. Mizete
ménit definici bloku pro rychlou upravu vykresu, a pak aktualizovat instance bloku.
Pokud vlozite blok, ktery obsahuje entity nakreslené pivodné na vrstvé 0 a pfifadite
prostfednictvim BYBLOCK barvu a typ ¢ary, a blok samotny ma barvu a typ ¢ary
BYLAYER, tyto entity pfijmou barvu a typ €ary vrstvy, na kterou jsou vioZzeny. Pokud
je blok pfifazeny k explicitni barvé a typu €ary, napfiklad ¢ervena pferusovana, tyto
entity pfijmou tyto vlastnosti.

Procedura nazvana hnizdéni se objevi, kdyZ zahrnete jiné bloky do nového bloku,
ktery jste vytvofili. Hnizdéni je uziteCné, kdyZ chcete zkombinovat a zahrnout malé
komponenty jako jsou Srouby a matice do vétSiho seskupeni a potiebujete vloZzit
nasobné instance tohoto seskupeni do jesté vétSiho vykresu.

3.2 Tvorba bloku

Bloky muzete tvofit dvéma zplsoby:

- pro ulozeni bloku pouze v aktualnim vykrese

- pro ulozeni bloku jako samostatného souboru s vykresem, ktery mizete vkladat do
jinych vykrest

Kdyz tvofite blok, mlzete zadat jeho jméno, bod vlozeni, a entity, které chcete v
bloku seskupit. Bod vloZeni je zakladnim bodem pro blok a slouZzi jako referenéni
bod, kdyz pozdéji vkladate blok do vykresu.

Pro vytvoreni bloku pro vyuziti v aktualnim vykrese

1. provedte jedno z nasledujiciho:

- Zvolte Kreslit > Blok > Vytvorit

- Na panelu nastroju Kresli zvolte nastroj Vytvorit blok.

- Napiste block a stisknéte Enter.

2. Zvolte entity, které chcete zahrnout do bloku a stisknéte Enter.

3. Upfesnéte bod vioZeni bloku.

4. Napiste nazev bloku a stisknéte Enter.

Blok je vytvofeny a existuje pouze v aktualnim vykrese.



Definice bloku e

Nazev

| ~ |

Zakladni bod Entit
T: | Zadejte bod Ty | Vyberte entity &
x ® zachovat
¥ | 0.0000 () Konvertovat na blok
: il

Nejsou vybrany Zadné entity.
Nastaveni

[] 3kélovat rovnomé&rné
UmoZnit rozloZeni

Popis

Hypertextovy odkaz...

OK Storno Népovéda

Muzete vSak vytvorit i blok, ktery je samostatnym souborem s vykresem a mizete jej
vkladat do jinych vykresa.

Pro ulozeni bloku jako samostatného souboru s vykresem
1. Provedte jedno z nasledujiciho:

- Zvolte Kreslit > Blok > Ulozit blok na disk
- Napiste wblock a stisknéte Enter.

2.V okné Ulozte blok na disk zvolte jednu z moznosti:

- Blok - tato moznost uklada nastaveni existujici entity bloku do samostatného
souboru s vykresem. Kdyz ji zvolite, vloZte nazev bloku.

- Cely vykres - tato moznost okamzité uklada cely vykres do samostatného souboru
s vykresem.

- Entity - tato moznost uklada Ty entity, které jste si zvolili do samostatného souboru
s vykresem. Kdyz ji zvolite, specifikujte bod vlozeni bloku a zvolte entity, které chcete
vlozit do bloku.

3. Do okénka Nazev a cesta souboru napiste nazev souboru s vykresem, ktery
chcete vytvofit a stisknéte tlacitko [...] pro zvoleni mista, kam chcete soubor uloZit.

4. Kliknéte na OK.
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Poznamka:

Kdyz ukladate nasobné bloky, nebo cely vykres jako samostatny soubor s vykresem,
program pripiSe souradnice 0, 0, 0 jako jeho bod viozeni. Mizete zménit bod vioZeni
otevienim vykresu a zménou definice bloku.

3.3 Zmeéna definice bloku

Muzete zménit definici vSech instanci bloku z aktualniho vykresu. Pro zménu definice
bloku, ktery jste vytvofili v aktualnim vykrese, vytvofite novy blok se stejnym nazvem.
Muzete aktualizovat vSechny bloky z aktualniho vykresu pomoci zmény definice
bloku. Pokud byl blok vlozen ze samostatného souboru s vykresem, ktery byl
nasledné aktualizovan, vloZte opét stejny blok pro aktualizaci vSech jeho instanci v
aktualnim vykrese.

Pro zménu definice bloku v aktualnim vykrese

1. provedte jedno z nasledujiciho:

- Zvolte Kreslit > Blok > Vytvorit

- Na panelu nastroju Kresli zvolte nastroj Vytvorit blok.
- Napiste block a stisknéte Enter.

2. Zvolte nazev bloku, kterému chcete zménit definici.
3. Zvolte entity pro blok a stisknéte OK.

4. Specifikujte bod vlozZeni bloku.

5. Zatrhnéte volbu "ANO".



6. Napiste regen a stisknéte Enter.

Zména bloku probéhne okamzité a vdechny instance z bloku ve vykrese budou
aktualizovany.

Muzete aktualizovat vSechny instance bloku ze samostatného vykresu opétovnym
vloZenim vykresu.

3.4 Vkladani blokai

Muzete vlozZit bloky a jiné vykresy do aktualniho vykresu. Kdyz viozite blok, program
s nim zachazi jako s jedinou entitou. Kdyz vlozite vykres, je pfidan do aktualniho
vykresu jako blok. Mizete vlozit nasobné instance blokd bez opétovného nahravani
originalniho souboru s vykresem. Pokud zménite originalni soubor s vykresem, tyto
zmény neovlivni aktualni vykres, pokud nezménite definici bloku opétovnym
vloZenim zménéného vykresu.

Muzete taky vlozit bloky z jinych vykrest do aktualniho vykresu s vyuzitim 4MCAD
Exploreru. Oba vykresy musi byt otevieny sou€asné, aby bylo mozné vykonat tuto
operaci.

Kdyz vlozite blok nebo vykres, musite upfesnit bod vloZeni, méfitko a rotacni uhel.
Bod vlozeni bloku je odkazovym bodem, ktery zadate v prabéhu tvorby bloku. Kdyz
vlozite vykres jako blok, program vezme uréeny bod vlozZeni a pouzije jej jako bod
vloZeni bloku. Muzete zménit bod vlozeni tak, Ze pfi prvnim otevieni originalniho
vykresu zménite definici bodu.

Pro viozeni bodu

1. provedte jedno z nasledujiciho:

- Zvolte Vlozit > Blok

- Na panelu nastroju Vlozit kliknéte na nastroj Vlozit blok.

- Napiste ddinsert a stisknéte Enter.

2.V dialogovém okné Vlozit blok pod Vlozit kliknéte na Nazev bloku.

3. V okénku Nazev bloku zvolte jméno bloku, ktery chcete vlozit.

4. Kliknéte na Vlozit.

5. Upfesnéte bod viozeni bloku.

6. Zadejte udaje x, y a z pro méfitko a rotacni uhel, nebo stisknéte Enter pro
odsouhlaseni pfednastavenych hodnot.

Pro vlozeni celého vykresu do aktualniho vykresu
1. provedte jedno z nasledujiciho:
- Zvolte Vlozit > Blok

- Na panelu nastroju Vlozit kliknéte na nastroj Vlozit blok.
- Napiste ddinsert a stisknéte Enter.



2.V dialogovém okné Vlozit blok pod Vlozit kliknéte na Ze souboru.

3. Zadejte umisténi a nazev souboru s vykresem, nebo kliknéte na Prochazet pro
upfesnéni souboru z dialogového okna VloZzit vykres a kliknéte na Otevrit.

4. Kliknéte na Vlozit.
5. Upfesnéte bod vlozeni bloku.

6. Zadejte udaje x, y a z pro méfitko a rotacni uhel, nebo stisknéte Enter pro
odsouhlaseni pfednastavenych hodnot.

Poznamka:

Muzete zadat bod vioZeni, udaje méritka a rotacni uhel v dialogovém okné VioZzit
blok predtim, nez vioZite blok. Mizete nastavit, jestli se blok rozdéli na plavodni
komponenty entit po vioZeni. Pod umisténim, vycistéte zatrhavaci okénko Umisténi
bloku pri vkladani a zadejte poZzadované souradnice. Pokud chcete rozdélit blok
okamzité, zakliknéte okénko Rozdélit po viozZeni.

VloZit blok X
WIoZit
A '::]ZE soubory: Prochazet...
(@ MNézevbloky | _OBLIGUE w B
BodwloZeni hAEFitko Ctaceni
UrCit na obrazowvece Urit na obrazowce Urcit na chrazovee
0.0o00 > 1.0000 = 0 >
0.0000 = 1.0000 =
hd he Jednotka blaku
0.0000 = 1.0000 = Jednotka: iNedefianémD |
s Jednotne méfitko Koeficient: [1 J
C O Rozlogit
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A. Kliknéte a pak zadejte umisténi a jméno souboru s vykresem pro vloZeni souboru
S vykresem jako bloku.

B. Zadejte bod vloZeni, udaje méfitka a rotacni uhel predtim, nez vioZite blok
(dostupné pouze kdyz je Umisténi bloku pfi vkladani prazdné).

C. Kliknéte pro rozlozZeni bloku pri vioZzeni.
D. Kliknéte pro vloZeni bloku.

3.5 Rozlozeni bloku

Muzete rozlozit vioZeny blok na jeho originalni komponenty entit. Kdyz rozlozite blok,
ovlivni to pouze jednotlivou instanci tohoto bloku. Originalni blok zUstava ve vykrese



a Vy mlzete porad vkladat dodate¢né kopie tohoto bloku. Pokud rozlozite blok, ktery
obsahuje atributy, tyto atributy se ztrati, ale originalni definice atributt zUstava.

RozloZeni rozdéli komponenty entit na jejich nejbliZ8i jednodudsi uroven
komplexnosti, bloky nebo kfivky se opét stavaji bloky nebo kfivkami.

Pro rozdéleni bloku
1. provedte jedno z nasledujiciho:

- Zvolte Modifikace> Rozlozit
- Na panelu nastroju Modifikace kliknéte na nastroj Rozlozit.
- Napiste explode a stisknéte Enter.

2. Zvolte blok.

3. Stisknéte Enter.

3.6 Prace s atributy

Atribut je samostatnou entitou, kterou muzete ulozit jako ¢ast definice bloku.

Atributy se skladaji z textovych dat. Mlzete vyuzit atributy pro zaznam dat jako jsou

Cisla soucastek nebo cena. Atributy maji fixni i variabilni hodnoty. Kdyz vlozite blok,

ktery obsahuje atributy, program pfida fixni hodnoty do vykresu spole¢né s blokem a
VYy jste vyzvani abyste doplnili variabilni hodnoty.

Po vlozeni blokU, které obsahuiji atributy mizete vyexportovat informace o atributech
do samostatného souboru a nasledné prevést data do tabulkového souboru nebo
databaze, abyste vytvofili seznam soucastek nebo ucet za material. Informace z
atributd mizete vyuzit i na zjisténi poctu vliozeni konkrétniho bloku do vykresu.

Atributy mizou byt viditeIné nebo skryté. Skryté atributy nejsou ani zobrazovany ani

tistény, ale informace jsou porad ulozené ve vykrese a je mozné je vyexportovat do
souboru.

3.7 Definovani atributt

Atributy mizete do vykresu pfidavat tak, Ze je nejprve definujete a pak ulozite jako
Cast definice bloku. Pro definovani atributl zadejte vlastnosti atributu véetné jeho
jména, vyzvy a vychozi hodnoty, umisténi a formatu textu a volitelnych modu
(neviditelny, konstantni, verifikovat, pfednastaveny)

Pro definovani atributu

1. provedte jedno z nasledujiciho:

- Zvolte Kreslit > Blok > Definovat atributy
- Napiste ddattdef a stisknéte Enter.

2. Do dialogového okna Definice atributu napiste nazev, vyzvu a vychozi hodnotu.



3. Pod Bod vloZeni zadejte umisténi atributu ve vykrese, nebo kliknéte na Urcit na
obrazovce pro ur€eni poZzadovaného bodu pfimo ve vykrese.

4. Vyberte z nabidky poZzadovany maod atributu.
5. Pod Nastaveni textu zadejte parametry textu.

6. Pro pfidani atributu do vykresu kliknéte na OK.

E Definice atributu X
ReZim Atribut
E [Oeviditelny Etitek: A
F Cxonstantni
(3 [ verifikovat Wjeta: B
H L Frednastaveny vjchozi:  C
| [ uzamknout Polohu
[ vice Fadki Mastaveni textu
e zarowdni: M [ Vievo ¥
D Uréit na obrazovce i N e -
D Anotativni
0.0000

Vyska textu: K | 0.2000 igf%
Otofeni: L | 0 ‘EE;‘E,‘

0.0000 G‘%

0.0000

0.0000

Zarovnat pod pfedchozi definici atribub

J | oK |
a Storno

A. Zadejte nazev atributu

B. Zadejte identifikacni vyzvu, ktera se bude zobrazovat, kdyzZ budete vkladat blok
obsahujici atribut.

C. Zadejte vychozi nebo konstantni hodnotu. Pro variabilni atributy vychozi hodnota
Je nahrazena aktualni hodnotou, kdyZz pozdéji vkladate blok, ktery dany atribut
obsahuje.

D. Specifikujte x, y, a z souradnice vkladaciho bodu atributu.
E. Zvolte pro vytvoreni neviditelného atributu.
F. Zvolte pro vytvoreni atributu s konstantni hodnotou.

G. Zvolte pro vytvoreni atributu, kterého hodnota musi byt ovérena, kdyz pozdéji
vkladate blok, ktery atribut obsahuje.



H. Zvolte pro vytvoreni atributu, kterého hodnota je definovana a neni vyZadovana,
kdyZ pozdéji vkladate blok, ktery tento atribut obsahuje, ale kterou je mozné po
vioZeni bloku zménit.

I. Zvolte pro uzamceni polohy atributu.

J. Kliknéte pro ukonceni pfikazu a vioZeni atributu.

K. Zadejte thel rotace textu, nebo kliknéte pro specifikaci rotacniho thlu zvolenim
dvou bodi ve vykrese.

L. Zadejte vySku textu nebo kliknéte pro specifikaci vysky pomoci dvou bodu ve
vykrese.

M. Zvolte zarovnani textu.
N. Zvolte styl textu z text( jiz definovanych ve vykrese.
O. Kliknéte pro specifikaci bodu vioZeni atributu zvolenim bodu ve vykrese.

3.8 Uprava definici atributu

Definice atributu mizete zménit pfedtim, nez jej spojite s blokem, nebo pfedtim, nez
jej ulozite jako ¢ast definice bloku.

Pro editaci definice atributu

1. provedte jedno z nasledujiciho:

- Zvolte Modifikace > Objekt > Text

- Na panelu nastroju Modifikace Il zvolte nastroj Upravit text.
- Napiste ddedit a stisknéte Enter.

2. Zvolte definici atributu, kterého text chcete upravit.

3. V nabidce pfikazl upravte definici vlastnosti atributu.

4. Kliknéte na OK.
3.9 Pridavani atributt do bloku

Muzete pfidat atributy do bloku po tom, co jste je definovali a zvolili jako jednu z entit
bloku. Pridejte atributy potom, co Vas program vyzve, abyste vybrali entity, které
chcete vlozit do bloku. Potom, co je atribut vlozeny do bloku, program Vas pokazdé,
kdyz budete blok vkladat do nového vykresu, vyzve abyste zadali potfebné hodnoty
pro atributy.

3.10 Uprava atributti pridanych do blokii

Je mozné upravovat hodnoty atributu viozeného do bloku potom, co jste jej vlozili do
vykresu.

Pro upravu atributu pridaného do bloku



1. provedte jedno z nasleduijiciho:

- Zvolte Modifikovat > Objekt > Atribut > Jediny

- Na panelu nastroju Modifikace Il zvolte nastroj Upravit atributy.
- Napiste ddatte a stisknéte Enter.

2. Zvolte blok, ktery chcete upravit.

Dialogové okno Upravit atributy zobrazi vSechny atributy pfipojené k Vami
vybranému bloku.

3. Upravte hodnoty atributl, pokud je to potfeba.

4. Kliknéte na OK.

Upravit atributy bloku
A Blok:  Svitidia
B Mazev G Vyzva F Hodnota Vice fadka
LA Feontroluj £
| LAY Shantralyj Y
LA Jeontroluj =
SNAZEV Mazev svitidla Bodowé
GNAZEV Bodové
INTENZITA Intenzita svétla 1
BARVA Barva svétla (REE) 1.7
Hodnota:
@ E Stome

A. Zvolte néazev bloku.

B. Zobrazi jména atributt pfipojenych k bloku.

C. Kliknéte pro zvoleni atributu.

D. Napiste nové hodnoty zvoleného atributu.

E. Kliknéte pro aktualizaci hodnoty atributu a ukoncéeni pfikazu.
F. Zobrazi hodnoty kazdého atributu pfipojeného k bloku.

G. Zobrazi vyzvu pro kazdy atribut pfipojeny k bloku.



3.11 Export hodnot atribut

Hodnoty atributll je mozné exportovat z vykresu a ulozit je do samostatného
textového souboru pro vyuziti v databazovém programu. Mizete ulozit do soubort
jakékoliv z nasledujicich formatu:

- Comma Delimited Format (CDF) - obsahuje jeden fadek pro kazdou instanci bloku
se samostatnymi poli atributu oddélené ¢arkami. Pole s fetézci znak( jsou uzavieny
uvozovkami. Musite zvolit $ablonovy soubor, abyste mohli vyexportovat CDF soubor.

- Space Delimited Format (SDF) - obsahuje jeden fadek pro kazdou instanci bloku.
Kazdé pole s atributem ma pevnou délku. V textu nejsou zadné oddélovaci znaky.
Musite zvolit $ablonovy soubor pro export do SDF souboru.

- Drawing Exchange Format (DXF) - vytvafi podmnozinu standardniho DXF
souboru (.dxx soubor), ktery obsahuje vSechny informace o kazdém bloku véetné
bodu viozeni, rotanich uhld a hodnot atributt. Nevyzaduje Sablonovy soubor.

Pfed zahajenim exportu atributd do CDF a SDF souboru musite vytvofit Sablonovy
soubor. Sablonovy soubor je ASCII textovy soubor, ktery upfestiuje pole pro data
atribut(l, které budou vepsany do souboru s exportem. Kazdy fadek Sablonového
souboru zadava jedno pole atributu.

4MCAD rozeznava 15 rozli€nych poli, které obsahuji elementy jako jméno bloku,
souradnice x, y, z bodu yloiem’, vrstvu, na kterou jsou vlozeny atd. Mizete zahrnout
kterékoliv z téchto poli. Sablonovy soubor musi zahrnovat alespon jeden nazev
atributu.

Kazdy fadek v Sablonovém souboru musi za€inat nazvem pole. Nazev bloku a
hodnota viozZeni bloku musi za¢ina s BL:. DalSi znak musi byt C (pro fetézec znaku)
nebo N (pro numerické pole). Za timto znakem pak nasleduji 3 Cislice uréujici Sifku
pole (v znacich). Koncové 3 €islice urcuji po€et desetinnych mist (pro numericka
pole). V pfipadé, Zze se jedna o pole se znaky, posledni 3 Cisla museji byt nuly (000).
Typicky Sablonovy soubor mize vypadat nasledovné:

T

B— EL:DESE codood
[BL:X NO07001
“pr.v NOO7001
[TYPE 050000
o | MENUFACTURER C050000
MODELMUMEER 025000
[COST N00s002

A. Nazev pole

B. Nazev bloku. Nazev bloku musi za¢ina pismeny BL:



C. Bod viozeni. Hodnota bodu viozeni musi zaCinat pismeny BL:

D. Stitky atributu.

E. Pocet desetinnych mist pro numericka pole nebo 000 pro pismena.
F. Sitka pole pro pismena nebo numerické hodnoty.

G. C pro pole s pismeny, N pro numericka pole.

Pro vytvoreni Sablonového souboru

1. Vytvorte Sablonovy soubor s vyuzitim jakéhokoliv ASCII textového editoru (napf.
Microsoft Notepad nebo Microsoft WordPad) nebo programu na zpracovani textu,
jako je Microsoft Word.

2. Uvedte v souboru pozadované pole.

3. UloZte Sablonovy soubor do ASCII textového formatu.

Pro export hodnot atributt

1. Napiste ddattext a stisknéte Enter.

2. Kliknéte na Vyberte a zvolte entity, ze kterych chcete exportovat data.

3. Zadejte format extrahovaného textového souboru.

4. Pro CDF a SDF formaty zvolte soubor Sablony.

5. Zvolte vystupni soubor.

6. Kliknéte na Exrahovat.

Extrahovat atributy bt

4 H Bloky zvalené pro extrakci atributa: 10

B Format extrahovaneho textoveho soubor

Extrahovat do DXF {drawing exchange format
Extrahovat do COF (comma delimited farmat)
Extrahovat do SOF (space delimited format)
=
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A. Kliknéte pro zvoleni bloku ve vykrese, které obsahuji atributy, které chcete
vyexportovat.

B. Kiliknéte pro volbu formatu extrahovaného souboru.

C. Vyberte soubor Sablony pro CDF a SDF soubory.

D. Vyberte format vystupniho souboru.

E. Kliknéte pro extrakci atribut.

F. Kliknéte pro zadani vystupniho souboru v dialogovém okné.

G. Kliknéte pro zadani Sablonového souboru v dialogovém okné.

3.12 Prace s externimi referencemi

Jako externi reference je mozné k aktualnimu souboru pfipojovat i jiné vykresy. Na
rozdil od pfipojeni vykresu k aktualnimu vykresu jako bloku, kdy viozite entity ze
samostatného vykresu do aktualniho vykresu, externi reference pfipoji ukazatel k
externimu souboru. Entity externi reference se objevi v aktualnim souboru, ale entity
jako také nejsou do souboru pfidany. Proto pfidani externi reference neovlivni v
podstatné mife velikost aktualniho souboru.

Externi reference poskytuji dodate¢né moznosti, které nejsou dostupné pf¥i viozeni
vykresu jako bloku. Kdyz vlozite vykres jako blok, entity jsou ulozeny ve vykrese.
Zadna zména, kterou udélate v ptivodnim vykrese, se nepromitne ve vykrese, kam
jste blok vloZzili. Kdyz pfipojite externi referenci, kazda zména, kterou udélate v
plvodnim vykrese se objevi ve vykrese, ke kterému je pfipojena. Tyto zmény se
objevuji automaticky pokazdé, kdyz oteviete vykres, ktery obsahuje externi referenci.
Pokud vite, Ze originalni vykres byl zménén, muzete znovu nahrat externi referenci
pokazdé, kdyz pracujete na vykrese.

Externi reference jsou uziteCné pro sestavovani zdrojovych vykresl z vykresu
komponentl. Vyuzijte externi reference pro koordinaci prace s jinymi osobami ve
skupiné. Externi reference pomahaji redukovat velikost soubort s vykresy a davaji
jistotu, Ze pofad pracujete s aktualni verzi vykresu. V kazdém pfipadé, pokud
pracujete s vykresy, které maji pfipojeny externi reference, je dllezité, abyste k
zdrojovému vykresu pfipojili vSechny externi reference, které obsahuje. Kdyz
oteviete soubor, ktery obsahuje externi reference, zdrojové soubory s externimi
referencemi musi byt dostupné pro zobrazeni externich referenci ve vykrese.

Spravce externich referenci pomaha prikladat externi reference k vykresim a
pracovat s nimi.
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A. Viyberte externi referenci pro modifikaci jeji pfilohy.
B. Napiste nebo kliknéte na Prochazet pro uprfesnéni umisténi externi reference.
C. Kliknéte, pokud se ma externi reference stat trvalou soucasti vykresu.

D. Kliknéte pro odstranéni externi reference, ale zachovani jeji prvk( a informace o
umisténi pro snadnéjsi opétovné nahrani.

E. Kliknéte pro aktualizaci vSech zmén z externich referenci.
F. Kliknéte pro upiné odstranéni externi reference.
G. Kliknéte pro pripojeni vykresu.

3.13 Pripajeni externich referenci

Externi reference vznikne tim, Ze k aktualnimu vykresu pfipojite jiny samostatny
vykres. Externi reference se objevi ve vykrese jako definice bloku, ale na entity z
vykresu je pouze odkaz a nejsou do vykresu pfimo vliozeny. Pokud upravujete
pfipojeny vykres, aktualni vykres, ktery obsahuje externi reference, je automaticky
aktualizovany, kdyz jej oteviete, nebo muzete znovu nahrat externi reference
manualné, takze obsahuiji posledni verzi externi reference.

Kdyz pfipojite externi referenci, jeji hladiny, typy Car, styly textu a jiné soucéasti nejsou
vloZzeny do aktualniho vykresu. Ziskate k nim v8ak pfistup z referenéniho souboru.

Externi referenci mlzete pfipojit dvéma zpusoby:

- Priloha je vloZzenym vykresem, ktery obsahuje odkaz na originalni soubor.



PFilohy samy o sobé mlzou obsahovat dal$i referenéni soubory (tzv. nesting -
zahnizdéni). Kdyz pfipojite externi referenci, vSechny vnofené reference pfipojené k
originalnimu vykresu se objevi rovnéz v aktualnim vykrese.

- Prekryti je vloZeny vykres, ktery obsahuje odkaz k originalnimu souboru. Pfekryti
Vam umoznuje ulozit vykres navrch na jiny vykres podobné jako manualné pracujete
s prusvitkami. Kdyz vykres, ktery obsahuje prekryti externi referenci, je sam pfipojen
nebo prekryty jako externi reference pro jiny vykres, pfekryti se neobjevi jako externi
reference. Vyuzijte prekryti, kdyz chcete vidét referenéni geometrii ve vykrese, ale
nepotiebujete ji zahrnout do vykresu, které budou vyuZzity s jinymi (vnofené externi
reference).

Muzete pfipojit tolik kopii souboru s externimi referencemi, kolik chcete. Kazda kopie
muze mit odliSné umisténi, méfitko a rotacni uhel.

Pro pripojeni externi reference

1. provedte jedno z nasledujiciho:

- Zvolte Vlozit > Externi referenci

- Na panelu nastroju Xref kliknéte na nastroj XREF.
- Napiste xref a stisknéte Enter.

2. Kliknéte na Pfipojit.

3. Vyberte soubor s vykresem, ktery chcete vloZit jako externi referenci a kliknéte na
Otevrit.

4. Kliknéte na OK.
3.14 Odstranovani externich referenci

Odstranéni externich referenci z aktualniho vykresu je mozné jednodu$e s vyuzitim
Spravce externich referenci. MUzete uvolnit externi referenci, coz zpUsobi, Zze se
uchova informace o externi referenci v aktualnim vykrese a jednodus$e ji mizete
pozdéji znovu nahrat, nebo ji mizete odpojit Uplné.

Kdyz uvolnite externi referenci, odstranite ji z aktualniho vykresu. Jeji elementy, jako
jsou hladiny a typy C€ar zUstavaji ve vykrese a porad jsou vypsany ve Spravci
externich referenci. Odpojenim externi reference odstranite vSechny jeji elementy z
aktualniho vykresu a tyto se jiz v Spravci externich referenci nezobrazuiji.

Pro uvolnéni externi reference

1. provedte jedno z nasledujiciho:

- Zvolte Vlozit > Externi referenci

- Na panelu nastroju Xref kliknéte na nastroj XREF.

- Napiste xref a stisknéte Enter.

2. Vyberte externi referenci, kterou chcete uvolnit.

3. Kliknéte na Uvolnit.



Pro odpojeni externi reference
1. provedte jedno z nasledujiciho:

- Zvolte Vlozit > Externi referenci
- Na panelu nastroju Xref kliknéte na nastroj XREF.
- Napiste xref a stisknéte Enter.

2. Vyberte externi referenci, kterou chcete odpojit.
3. Kliknéte na Odpojit.

Poznamka:
Jenom externi reference, které jsou pfipojeny pfimo k aktualnimu vykresu je mozné
odpajit. Vnorené externi reference odpojeny byt nemohou.

3.15 Zmeéna lokalizace externich referenci

Pokud je soubor, ktery je propojeny s externi referenci pfesunuty do jiného adresare,
nebo jej pfejmenujete, program zobrazi zpravu, ze externi referenci neni mozné
nahrat. MUzete obnovit nastaveni odkazu k souboru tak, Zze zménite cestu k externi
referenci.

Pro zménu cesty k jednotlivé externi referenci

1. provedte jedno z nasledujiciho:

- Zvolte Vlozit > Externi referenci

- Na panelu nastroju Xref kliknéte na nastroj XREF.

- Napiste xref a stisknéte Enter.

2. Vyberte externi referenci, které chcete aktualizovat umisténi.

3. V Cesta k externi referenci udélejte nasledovné:

- zadejte nové jméno souboru nebo umisténi.
- kliknéte na Prochazet a vyberte umisténi referenéniho souboru.

4MCAD obnovi specifickou externi referenci automaticky.

Poznamka:
NemduZete rekurzivné odkazovat na vykres ze stejného originalniho vykresu.

3.16 Svazani externi reference s vykresem

Externi reference nejsou soucasti vykresu. V podstaté jsou jenom linkami pro
referenCni soubor. Pro vytvofeni kopie vykresu, ktery obsahuje externi reference pro
nékoho jiného, musite dotyénému dodat i kopie vykresu s externimi referencemi.
Navic, dana osoba musi pouzit stejné umisténi referenénich soubor nebo zménit
cesty k externich referencim.

Pro opatieni kopie vykresu, ktery obsahuje externi reference, je ¢asto jednodussi
nejprve svazat externi referenci s vykresem. Svazani externich referenci znamena,



Ze se stanou trvalou soucasti vykresu podobné, jako je to pfi vkladani samostatného
vykresu jako bloku.

S aktualnim vykresem mulzete svazat externi reference, které jsou pfipojeny pfimo k
nému, ale ne vnorené externi reference.

Pro svazani existujici externi reference s vykresem
1. provedte jedno z nasledujiciho:

- Zvolte Vlozit > Externi referenci
- Na panelu nastroju Xref kliknéte na nastroj XREF.
- Napiste xref a stisknéte Enter.

2. Zvolte externi referenci, kterou chcete pfipojit.
3. Kliknéte na Vazat.
4. Zvolte jedno z nasledujiciho:

- Vazat - svaze externi referenci s vykresem a vytvofi unikatni nazev pro kazdou
pojmenovanou entitu, jako jsou vrstvy nebo bloky, které jsou umistény v externich
referencich. Napfiklad, vrstva s nazvem Elektrické rozvody v externich referencich
bude pojmenovana Xref$0 $Electric v aktualnim vykrese. Pokud ma aktualni vykres
vrstvu nebo blok se stejnym nazvem, jméno se postupné zméni napfiklad Xref$1
$Electric.

- Vlozit - svaze externi referenci s vykresem, ale nezméni nazev zadné
pojmenované entity v externi referenci. Napfiklad vrstva s nazvem Elektrické rozvody
z externich referenci bude mit stejny nazev i v aktualnim vykrese. Pokud ma vykres
vrstvu nebo blok se stejnym nazvem, pojmenovana entita v externich referencich
piebira nazvy polozek z aktualniho vykresu.

5. Kliknéte na OK.
3.17 Orez externich referenci

Kdyz pfipojite vykres jako externi referenci, v aktualnim vykrese se zobrazi cely
referencni vykres. Pokud ale pfipojite externi referenci, muzete zadat ofez, ktery urci,
jaka &ast referenéniho vykresu je viditelna nebo skryta.

Orezané externi reference mlzete upravovat, kopirovat nebo ofezavat stejnym
zpusobem jako upravujete neofezané externi reference. Ramecek se pohybuje
spolecné s referenci. Pokud externi reference obsahuje vnofené ofezané externi
reference, tyto se rovnéz objevi ve vykrese ofezané.

TIP
Kromé orezani externich referenci mizZete taky ¢astecné ukryt bloky s vyuZzitim
orezu.

3.18 Vytvoreni orezu externi reference

VytvoFeni ofezu ovlivni pouze jakd €ast vykresu se zobrazi v referenénim vykrese.
Neovliviiuje originalni referenéni vykres ani referenéni geometrii. Ta ¢ast vykresu,



ktera se nachazi uvnitf ofezového ramecku, je viditelna a zbytek vykresu zlstava
skryty.

Pro nastaveni pravouhlého oiezu

1. provedte jedno z nasleduijiciho:

- Zvolte Modifikace > Objekt > Externi reference > Orez Xref
- Na panelu nastroju Xref zvolte nastroj Orez Xref.

- Napiste xclip a stisknéte Enter.

2. Vyberte externi referenci, kterou chcete ofezat. Pokud chcete, muzete zvolit i
bloky.

3. Stisknéte Enter.
4. Stisknéte Enter pro vytvofeni nového ofezu.

5. Pokud Vas program vyzve, stisknéte Enter pro smazani viech ohraniéeni, které jiz
existuji.

6. Zvolte Pravounhly.
7. Zadejte prvni roh ofezového ramecku.

8. Zadejte druhy roh ofezového ramecku. Zvolené externi reference budou ofezany
na pravouhlou vysec.

TIP

Muzete nejprve zvolit vSechny externi reference, kliknout na volbu pravym tlacitkem
a pak zvolit Ofez Xref z nabidky pfikazd.

Pro definovani ofezu pomoci krivky

1. Nakreslete kfivku ve tvaru, v jakém chcete ofezat externi referenci.

2. provedte jedno z nasledujiciho:

- Zvolte Modifikace > Objekt > Externi reference > Orez Xref

- Na panelu nastroju Xref zvolte nastroj Orez Xref.

- Napiste xclip a stisknéte Enter.

3. Zvolte externi reference, které chcete ofezat. Pokud chcete, muzete taky zvolit
blok.

4. Stisknéte Enter.
5. Stisknéte Enter, abyste vytvofili novy ofez.

6. Pokud Vas program vyzve, stisknéte Enter pro smazani vSech ohraniceni, které jiz
existuji.

7. Zvolte Vybrat kfivku.



8. Vyberte kfivku pro vytvoreni ofezového ramecku.

3.19 Vypinani a zapinani ofezu

Orez externi reference je mozné zapinat a vypinat. Kdyz je ofez vypnuty, ohraniCeni
se nezobrazuje a cela externi reference je viditelna, za podminky, Ze geometrie se
nachazi na vrstvé, ktera je zapnuta a rozmrazena. Ofez nepfestane existovat, kdyz
jej vypnete a mize byt opétovné zapnuty. Na druhé strané smazani ramecku je
trvalé.

Pro zapnuti a vypnuti ofezu

1. provedte jedno z nasledujiciho:

- Zvolte Modifikace > Objekt > Externi reference > Ramecek

- Na panelu nastroju Xref zvolte nastroj Ofezovy ramecek Xref.

- Napiste xcpfrliame a stisknéte Enter.

2. Pro vypnuti ofezového ramecku zvolte OFF. Pro zapnuti existujiciho ramec¢ku
zvolte ON.

3. Stisknéte Enter.

4. Pokud jste vypnuli ofezovy ramecek, kliknéte na ofezanou ¢ast externi reference
pro zobrazeni ¢asti vykresu, ktera byla predtim skryta.

TIP

Pokud je systémova proménna XCLIPFRAME zapnuta (hodnota 1), mizZete vybrat a
vytisknout ofezovy ramecek.

3.20 Smazani orfezu

Pokud ofez externi reference jiz vice nepotfebujete, muzete ji smazat.
Pro smazani ofezu externi reference

1. provedte jedno z nasledujiciho:

- Zvolte Modifikace > Objekt > Externi reference > Orez Xref

- Na panelu nastroju Xref zvolte nastroj Orez Xref.

- Napiste xclip a stisknéte Enter.

2. Zvolte externi referenci, kterou chcete uprauvit.

3. Stisknéte Enter.

4. Zvolte Smazat a stisknéte Enter.

5. Kliknéte na odsttihnutou &ast externi reference. Casti, které byly predtim skryté se
zobrazi ve vykrese.



3.21 Uprava externich referenci a bloki

Muzete upravovat externi reference a meénit definici bloku zevnitf aktualniho vykresu
s vyuzitim editace reference na misté. Bloky i reference jsou povazovany za
reference. Editaci referenci na misté muzete upravovat reference v ramci vizualniho
kontextu aktualniho vykresu.

Vykres €asto obsahuje jednu nebo vice referenci a taky vicero blokd. Kdyz pracujete
s blokovymi referencemi, mlzete zvolit blok, upravit ho, prohlizet si a upravovat jeho
polozky a aktualizovat jeho definici. Kdyz pracujete s referencemi, mazete zvolit
referenci, se kterou chcete pracovat, zménit entity, které obsahuje a ulozit zmény do
referenéniho vykresu. MUzete taky délat zrcadlové zmény bez nutnosti pfepinani
mezi aktualnim a referenénim vykresem.

Poznamka

Pokud planujete udélat podstatné zmény v referenci, otevrete referenéni vykres a
upravte ho pfimo v souboru. Editace na misté z aktualniho vykresu by mohla
podstatnym zplsobem zvétsit velikost souboru s aktualnim vykresem.

Entity, které jste vybrali ze zvolené externi reference nebo bloku jsou do¢asné
exportovany a tak je mozné je upravovat v aktualnim vykrese. Mnozina
exportovanych entit se nazyva pracovni mnozina. Tyto entity mohou byt upraveny a
pak ulozeny zpatky do referenéniho souboru nebo definice bloku.

Entity, ze kterych se sklada pracovni mnozina jsou vizualné oddéleny od ostatnich
entit vykresu. VSechny entity aktualniho vykresu kromé entit pracovni mnoziny jsou
vybledlé.

Pro editaci odkazovaného vykresu uvnitf aktualniho vykresu pouZijete pracovni
mnozinu pro identifikaci objektd, které nalezi definici xref nebo bloku a ne aktualnimu
vykresu.

V prabéhu editace reference na misté mizete pfidat nebo odstranit entity z pracovni
mnoziny. Pokud vytvofite nové entity v pribéhu editace reference na misté, jsou
automaticky vloZeny do pracovni mnoziny.

Pokud je nova entita vytvorena kvuli zmé&nam entit, které do pracovni mnoziny nejsou
zahrnuty, nova entita neni pfidana do pracovni mnoziny a je zobrazena vybledle.
Napfiklad pokud Vas vykres obsahuje dvé Cary, které nepatii do pracovni mnoziny.
Pokud upravujete €ary s vyuzitim pfikazu Fillet, novy oblouk se vytvofi mezi dvéma
¢arami. Oblouk nebude vlozen do pracovni mnoziny.

Pokud referenéni entity jsou soucasti pracovni mnoziny, muzete zvolit entitu pro
upravu dokonce i pokud je nakreslena na uzaméené hladiné referenéniho souboru.
Muzete odemknout hladinu, na které se entita nachazi a udélat potfebné zmény.
Zmeény, které jste udélali mizete ulozit, ale stav hladiny v referenénim souboru se
nezméni bez ohledu na to, jestli je nebo neni uzamdcena.

Entita, ktera je odstranéna z pracovni mnoziny je pfidana do aktualniho vykresu a
odstranéna z reference po uloZeni zmén. Entita, ktera je pfidana do pracovni
mnoziny je odstranéna z aktualniho souboru a po ulozeni zmén je pfidana k
referenci. Pokud vytvarite nebo mazete entity, tyto jsou automaticky pfidavany do
pracovni mnoZiny nebo jsou z ni odstranovany. Napfiklad pokud pouZijete pfikaz



Erase v pribéhu Upravy reference na misté, vymazané entity jsou odstranény z
pracovni mnoZziny. To, jestli entita je nebo neni v pracovni mnoziné zjistite podle
toho, jestli je zobrazovana vybledle.

Pro upravu externi reference nebo bloku

1. provedte jedno z nasledujiciho:

- Zvolte Nastroje > Uprava bloku a externi reference na misté > Upravit referenci
- Napiste refedit a stisknéte Enter.

2. Zvolte externi referenci nebo blok, ktery chcete upravit.
3. Stisknéte Enter.

4. Upravte externi referenci nebo blok.

5. Pro ukonceni pfikazu provedte jedno z nasledujiciho:

- Zvolte Nastroje > Uprava bloku a externi reference na misté > Zavit referenci
- Napiste refclose a stisknéte Enter.

Editovat reference >

|dentfikace reference  Nastaveni

MNazev reference:

| @=-¥% VODOVOD-TISK

Mahled

B Cesta: C:h_projektyhlubockydsp stexref wodovodisk .dwg
C (@) Automaticky vybrat viechny vnofené objekty
D () Dotdzat se na wybér vnofenych objektu

Zrust

A. Zobrazuje reference zvolené pro editaci na misté a vSechny reference vnorené ve
zvolené referenci.

B. Zobrazuje umisténi souboru zvolené reference. Pokud je zvolena reference
blokem, umisténi se nezobrazi.



C. Nastavi jestli jsou vnofené entity automaticky zahrnuty do procesu tpravy.
D. Nastavi jestli se vnofené entity pro proces tpravy musi vybirat individualné.

E. Zobrazi nahled obrazku aktualné zvolené reference.

Editovat reference it

Identifikace reference  Mastaveni

] A Wytvorit unikatni nazvy hladin, styli a blaka
B Zobrazit definice atrbutl pro editaci
C lJzamknout objekty mimo pracovni mnoginu

Zusit

A. Nastavi, jestli jsou nazvy hladin a dalSich objekt( pfi exportu z referencnich
soubort zménény tak, aby byl jejich nazev unikatni.

B. Nastavi, jestli se maji v prabéhu tpravy referenci vdechny definice atributi v
blokovych referencich exportovat a zobrazovat.

C. Uzamkne vSechny objekty, které nejsou v pracovni mnoZziné. To zabrani nahodné
volbé a upravé objektll v hostitelském vykrese v pribéhu procesu Upravy reference.

4. Vykresy

4.1 Vyhody CAD vykresu

CAD vykresy pomahaiji organizovat informace s vyssi efektivitou, nez starsi zplsoby
technického kresleni. Ve 4MCAD muzete kreslit entity reprezentujici rizné informace
v hladinach a vyuzivat tyto hladiny pro ureni barvy, typu €ar a vidtelnosti entit.
4MCAD také obsahuje pomucky, které umoznuji pfesné kresleni.

Tato sekce popisuje zaloZeni vykrest a vyuZiti kreslicich pomucek pro

- Vytvareni novych vykres(, otevirani vykresu a ukladani zmén ve vykresech.



- Vyuziti pomucek jako je mfizka, Uchopy a ortogonalni nastaveni pro presné kresleni
atd.

4.2 Vytvoreni nového vykresu

PFi spusténi 4MCADu vytvofi program automaticky novy vykres zalozeny na vykresu
Sablony ICAD2k_cz.dwg. Sablona obsahuje pfeddefinovana nastaveni jako jsou
jednotky vykresu, velikost textu a kreslici oblasti. Tato nastaveni mizete pouzit nebo
je podle svych potifeb zménit. Na Sablonovém vykresu neni nic vyjimecného. Pro
nové vykresy muzete jako Sablonu pouzit jakykoli vas vykres. Zalozenim nového
vykresu na existujici Sabloné (.dwt souboru) si muzete usetfit mnoho krokd. Novy
vykres tak bude obsahovat v8echna nastaveni a entity, které potfebujete. Pfi otevieni
nového vykresu z Vasi vlastni Sablony mlzete upravovat existujici nastaveni nebo
promazat entity, které nepotfebujete. Pokud uloZite vykres vytvofeny za pomoci
Sablony, zUstava Sablona nezménéna.

Pro vytvofeni nového vykresu zalozeného na Sabloné
1A. Provedte jedno z nasledujiciho:

- Zvolte Soubor > Novy
- Zvolte nastroj Novy v panelu nastroju Standard.

2A. Ve volbach zadejte znak ~ pro prochazeni souboru.
1B. Napiste newwiz a stisknéte Enter

2B. Kliknéte na Pouzit Sablonovy vykres a pak kliknéte na DalSi a v dialogu pro
Otevreni Sablony, kliknéte na Prochazet.

i R’
Privodce novym wykresem &J
B Uved Privodece novym wilresem umoznuje
. nastavit novy vykres véetné konfigurace
Sablony vykrest podle vasich potreb.
Mastavit nowvy vykres Jako sablonu mizete pouiit stavajici

vylres nebo vytvorit zcela novy vilres.

Lineami jednotly

Uhlové jednotiy :
@ Poufit Zablonovy vitkres

Syl tisku
" 1 Vtvorit zcela novy wylkres

Vytvofeni entity

< Zpét [ Dalgi = ] [ Stomio | INE’npovéda |

3. Vyberte soubor Sablony (.dwt), ktery pozadujete a kliknéte na Otevfit. Jako
Sablonu mlzete také zvolit jakykoli jiny vykres s pfiponou .dwg.

Pro vytvoieni nového vykresu bez Sablony zadejte v kroku 2A volbu . (te¢ka) nebo v
kroku 2B volbu Vytvofit zcela novy vykres.



4.3 Otevreni vykresu

Je mozné otevirat vykresy typu DWG (drawing), DXF (Drawing Exchange Format),
DWF (Design Web Format) a Sablony vykresu ve formatu DWT.

Pro otevieni existujiciho vykresu

1. Pouzijte jednu z nasledujicich metod

- Zvolte Soubor > Otevrit

- V panelu nastrojil Standard, kliknéte na nastroj Otevrit.

- Napiste prikaz open a stisknéte Enter.

2.V poli pro typ souboru zvolte typ souboru, ktery chcete otevrfit.
3. Zvolte adresar obsahujici poZzadovany soubor.

4. Zvolte vykres, ktery chcete otevrit.

5. Kliknéte na tladitko Otevrit.

Pokud vykres vyZzaduje heslo, zadejte jej, kliknéte na OK pro ovéfeni hesla a pak
znova na tlagitko Otevfit.

TIP:
Pro rychlé otevfeni vykresu z dialogu otevieni vykresu postaci dvojklik na nazev
souboru.

% Crteviit vykres [é]
Oblast hledani: | Dokumenty - @7 &
g - Popis
L Mazev poloiky Daturn zmény Typ
by : Velikost:
+ 4MCADL6.1Professional 7.4.2016 14:59 Sladka sou e,
Naposledy 4MCADL61Professionald6 1912.201517:50 Slaskason, | PeoieD; A
navitivene . Zménéno:
AMCADLG15tandard 261.201619:22 Slozka sou
!  4MCADL6.1x86 1012.201515:23 Slotkasoy  Otevieno:
Autodesk Application Manager 4122015 21:10 Slozkasou
lochs coreldraw X8 18.3.2016 18:04 Slozkaso, | Oteviitien pro gten’ e B

hEnit heslem  — C

seo projects backup 1732016 11:44 Slozka sou
- SQL Server Management Studio 23.3.2016 20:17 Slotkasor  [Y|Poufitnahled om—
= Visual Studio 2010 23.3.2016 19:59 Slozka sou o
Knihovny Nahled
_fk —
Pocitad i m 3
Nazev souboru: | hd [ OtewFit l
m Soubory typu: |Standardni soubor vykresu (".dwa) - | | Stomo |

A. Zobrazuje popis velikosti vykresu, datum vytvoreni a dal$i informace o vykresu.
B. Otevre vykres pouze pro Cteni pro zamezeni zmén v souboru.

C. Zapne nebo vypne nahled vykresu.



D. Dostupné pouze pfi ukladani vykresu.
E. Zobrazuje nahled vykresu pfed jeho otevienim.
Otevieni poskozeného vykresu

Soubory mohou byt poSkozené z mnoha diivod(. Napf. pokud pracujete pfi vypadku
proudu, selhani systému, nebo poskozeni hardwaru, vase soubory se mohou stat
poSkozenymi. 4AMCAD umoznuje otevieni a kontrolu poSkozenych soubor( pro jejich
obnoveni. VSechny podrobnosti jsou popsany v rozSifeném navodu.

4.4 Ulozeni vykresu

Pro ulozeni vykresu zvolte jeden z nasledujicich zpusobu:

- Zvolte Soubor > Ulozit

- V panelu nastrojii Standard zvolte Ulozit.
- Napiste save a stisknéte Enter

- Napiste gsave a stisknéte Enter

B Ulosit vjkres jako ==
Ulodt do: | 7| Dokumenty - @ F e m-
* Popis
I MNazev polozky Datum zmény Typ
g ’ Velikost:
o 4MCADL61Professional 7.4.2016 14:59 Slozka sou e
Naposledy 4MCAD161Professionab@t 1912.201517:50 Slotkasor, | NEOEE; A
navitiveng j Zménéno:
4MCAD16 15tandard 261.201619:22 Slozka sou
! AMCADLS 1:B6 1012.201515:23 Slozkasor  Otevieno:
Autodesk Application Manager 4122015 21:10 Slozka sou ) _
Flochs coreldraw X8 18.3.2016 1904 Slofkasor | OtevFitien pro &teni mmm—m—mp
seo projects backup 17.3.2016 11:44 Slozka sor || Chranit heslem  n—
SQL Server Management Studic 23.3.2016 2017 Slozkasor  [V]Poufitndhled  —
= ) Visual Studio 2010 2332016 19:59 Slozka sou -
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A. Zobrazuje velikost souboru, datum vytvoreni a dalsi informce o vykrese.
B. K dispozici pouze pri otevirani vykresu, ne pfi ukladani.

C. Zapne nebo vypne nahled vykresu.

D. Ulozi vykres pod heslem.

E. Zobrazi nahled vykresu pfed uloZenim.

4.4.1 Ulozeni vykresu pod jinym jménem nebo jinym
typem souboru

Vykres je mozné ulozit pod novym jménem a v jakémkoli z nasledujicich formatu:



Standardni vykresové soubory s koncovkou .dwg

Mulzete zvolit format .dwg, ktery je kompatibilni s rGznymi verzemi programu
AutoCAD.

Soubory formatu drawing exchange s koncovkou .dxf

Format .dxf je také kompatibilni s riznymi verzemi programu AutoCAD a dalSimi
programy.

$ab|ony vykrest s koncovkou .dwt

Sablony vykrest umoznuji jednoduse vytvofit novy vykres s pouzitim uloZzenych
nastaveni a entit.

Pro ulozeni vykresu s novym jménem nebo formatem souboru.

1. Provedte jedno z nasleduijiciho:

- Zvolte Soubor > Ulozit jako...
- Napiste saveas a stisknéte Enter

2.V dialogu pro ulozeni vykresu zvolte typ souboru.
3. Zadejte nazev nového souboru, ktery chcete vytvorit.

4. Kliknéte na Ulozit.

4.5 Audit vykresu

Vykres ohsahuje neplatna data.

5 témito neplatnymi daty byl uloZen,

Zobrazte log subor pro vice informaci;
ChdmitestingtauditP418-02test.dwg_SaveErrors.log

se jedna o hlaSeni o nepodporovanych entitach, vyuzijte ke kontrole a opravé
vykresu pfikaz Audit:



Zvolte Soubor > Nastroje vykresu > Audit a v pfikazovém fadku zadejte "Y" pro
opravu vSech nalezenych chyb ve vykrese.

Po provedeni auditu by pak mélo vSe fungovat v pofadku.

5. Navigace

5.1 Prohlizeni vykresu

4MCAD nabizi mnoho moznosti pro zobrazeni a prohlizeni vykresu. Rizna
nastaveni pro zobrazeni je mozné zménit pro urychleni zobrazeni nebo tisku
vykresu.

Tato sekce popisuje:

- Navigaci ve vykrese pomoci skrolovani, posunovani a ota€eni pohledu.

- Zménu zvétSeni vykresu zoomovanim.

- Praci s vice okny nebo pohledy vykresu.

- Nastaveni pro zobrazovani prvkl pro optimalizaci vykonu pfi praci s velkymi
vykresy.

5.2 Prekresleni a regenerace

PFi praci ve vykrese se mlze stat, Ze vizualni prvky zGstanou po vykonani pfikazu
stale zobrazeny stejné. To je mozné odstranit regeneraci nebo piekreslenim
zobrazeni.

Pro prekresleni aktualné zobrazeného okna provedte jedno z nasledujiciho:

- Zvolte Zobrazit > Prekreslit
- Na panelu nastroju Zobrazit zvolte nastroj Prekreslit (menu Standard).
- Napiste redraw a stisknéte Enter.

Informace o entitach ve vykrese jsou ulozeny v databazi jako desetinna €isla, coz
zajistuje vysokou presnost. Nékdy je nutné vykres pfepocitat nebo regenerovat z
databaze desetinnych Cisel pro pfevod téchto hodnot do pfislusnych soufadnic
obrazovky. To se dé&je automaticky, ale regeneraci je ale mozné spustit i manualné.
Pokud je vykres regenerovan, je také prekreslen.

Pro regeneraci aktualniho okna, zadejte v pfikazovém fadku regen.

Pokud je zobrazeno vice nez jedno okno, napiste regenall pro regeneraci vSech
oken.

5.3 Posun pohledu

Pohled vykresu je mozné posunout v kterémkoli sméru. Posunovani méni pohled v
horizontalnim, vertikalnim nebo diagonalnim sméru. Zvétdeni ani orientace entit v
prostoru se neméni. Jedinou zménou je zobrazena Cast vykresu.



Pro posun pohledu mUizete pouzit jakoukoli z nasledujicich metod:

- Pro pfesny posun zdejte dva body definujici velikost a smér posunu. Prvni
(zakladni) bod oznacCuje pocatecni bod posunu. Druhy bod oznacCuje délku posunu ve
vztahu k prvnimu bodu.

- Pro posun v realném Case je mozné pouzit pravé tlacitko mysi.

- Pokud mate mys s koleCkem nebo prostfednim tlagitkem, pouZijte je pro posun v
realném Case.

- Pro posun o malé vzdalenosti pouzijte klavesy Sipek.

Pro posun uréenim dvou bodti

1. Provedte jedno z nasleduijiciho:

- Zvolte Zobrazit > Posun > Bodem
- Na panelu nastroju Zobrazit zvolte nastroj Posun (menu Standard).

2. UrCete zakladni bod vypsanim soufadnic nebo uréenim bodu ve vykrese.
3. UrCete velikost posunuti vypsanim soufadnic nebo uréenim bodu v kreslicim okné.
Pro posun v realném case

1. Zaroven drzte klavesy Ctrl+Shift a pravé tlacitko mysi.

2. Pohybujte kurzorem ve sméru posunu.

3. Pro ukonceni posunu pohledu uvolnéte tlacitko mysi.

Jedna se o vhodnou metodu, pokud nemate k dispozici mys se tfemi tlaCitky.
Pro posun pohledu s pouzitim kolecka mysi

- Stisknéte kolecko a pohybuijte kurzorem.

Pro posun s pouzitim Sipek

- Stisknéte Sipku v pozadovaném sméru posunu.

5.4 Otaceni pohledu

4MCAD umozriuje otacet pohled vykresu v realném ¢ase. To umoznuje prohlizeni
modelu v jakémkoli uhlu.

Pro otaceni pohledu v redlném case
1. Provedte jedno z nasledujiciho:

- Na panelu nastroju Standard zvolte nastroj 3D orbit
- Napiste rtrot a stisknéte Enter.

2. Kliknéte a posurite mysi ve vykrese.



Pohled se otaci dle pohybu mysi.
3. Pro ukoncCeni otaceni uvolnéte tlacitko mysi.
4. Pokud navolite, pokra&uje rotace pohledu.

5. Pro ukonceni stiknéte Enter nebo pravé tlacitko mySi ve vykrese.

5.5 7Zo00m

Velikost (zvétSeni) pohledu je mozné kdykoli zménit pomoci zoomu. Pokud je zoom
aktivni, zméni se kurzor v lupu. ZmenSeni (zoom ven) umoznuje zobrazit vétsi cast
vykresu, zvétSeni (zoom dovnitf) umoziiuje zobrazit ¢ast vykresu ve vétSim detailu.
Zmeéna zvétSeni vykresu ovliviiuje pouze zpUsob zobrazeni vykresu; nema zadny vliv
na velikosti entit ve vykrese.

Zvétsovani a zmensovani

Jednim z nejjednodusSich zplsobu zménu velikosti vykresu je zména o
pfednastavenou hodnotu. Na panelu nastroju Zobrazit (menu Standard) zdvojnasobi
nastroj Zvétsit velikost zobrazeni vykresu. Nastroj Zmensit zméni zobrazeni na
polovinu. Stfed vykresu zobrazeny ve stfedu aktualniho vyfezu zistane pfi zoomu ve
stfedu obrazovky.

Zpusoby zoomu
Pro zménu velikosti zobrazeni je mozné pouzit jakoukoli z nasledujicich metod:

- Definice Casti vykresu pro zoom zadanim okna.

- Zoom v realném Case s pouzitim mysi.

- Pokud mate mys s koleCkem, pouzijte jej pro zoom ven a dovnitf.
Pro zvétseni pohledu na oblast s pouzitim okna

1. Provedte jedno z nasledujiciho:

- Zvolte Zobrazit > Zoom > Okno

- Na panelu nastroju Zoom kliknéte na nastroj Okno.

- Napiste zoom, stisknéte Enter a zvolte Okno (W dle angl. Window).

2. Vyberte prvni roh okna kolem oblasti, kterou si prejete zvétsit.

3. UrCete protéjsi roh okna kolem oblasti, kterou chcete zvétsit.



Pro ur€eni pravouhlého okna kolem oblasti vykresu pro zvétSeni vyberte prvni roh
(A) a protéjsi roh (B).

Pro zoom v realném ¢ase

1. Zaroven drzte Ctrl+Shift a leveé tlagitko mysi.

2. Pro zvétSeni potahnéte kurzorem smérem vzhuru.
3. Pro ukonceni zoomu uvolnéte tlacitko mysi.

Pro zoom s pouzitim kolecka mysi

- Otacejte koleCkem mysi smérem od sebe pro zvétSeni a smérem k sobé pro
zmenseni.

Kazdy pohyb koleCka smérem ven zmensuje s koeficientem 0.8; kazdy pohyb
smérem dovnitf zvétSuje s koeficientem 1.25.

Zobrazeni predchoziho pohledu vykresu

Po zvétSeni urcité casti vykresu se muzete chtit vratit zpét a zobrazit tak cely vykres.
V menu Zoom zvolte pfikaz Pfedchozi a obnovite pfedchozi pohled. Opakovanim
tohoto pfikazu je mozné zobrazit 25 poslednich zoomovanych nebo posunovanych
pohledd.

5.6 Zobrazeni v méritku

ZvétSeni nebo zmenSeni vykresu je mozné nastavit pfesnym koeficientem celkové
velikosti vykresu ve vztahu k aktualnimu zobrazeni. Pokud zménite koeficient
velikosti zobrazeni, stfed vykresu zobrazeny ve stfedu aktualniho vyfezu zlstane pfi
zoomu ve stfedu obrazovky. Pro nastaveni velikosti zobrazeni ve vztahu k celkové
velikosti vykresu, zadejte Cislo reprezentujici koeficient méfitka zobrazeni. Napfiklad
pokud zadate koeficient méfitka 2, zobrazi se vykres ve dvojnasobku plvodni
velikosti. Pokud zadate koeficient zvétSeni .5, je vykres zobrazen v polovi¢ni
velikosti. Velikost zobrazeni mizete také ménit relativné k aktualnimu zvétSeni
pfidanim pismene x za koeficient méfitka. Napfiklad pokud zadate koeficient méfitka



2x, je vykres zménén na dvojnasobek stavajiciho rozméru. Pokud zadate koeficient
zvétdeni .5x, je vykres zobrazen v polovicni velikosti.

Pro zoom v urcitém méritku relativnim k aktualnimu zobrazeni
1. Provedte jedno z nasleduijicich:

- Zvolte Zobrazit > Zoom > Méritko

- Na panelu nastroju Zoom kliknéte na nastroj Méfitko.

- Napiste zoom a stisknéte Enter.

2. Zadejte koeficient méfitka nasledovany znakem x (napfiklad 2x).

3. Stiskéte Enter.
5.7 Kombinace posunu a zoom pohledu

Je mozné urcit bod, ktery bude stfedem pohledu po provedeni zmény zvétseni
vykresu. Je také mozné urcit bod, ktery bude v levém dolnim rohu pohledu po zméné
velikosti zobrazeni vykresu pfikazem Zoom > Vlevo. S vyjimkou zoomu pomoci okna
zachovavaiji ostatni pfikazy pfi zoomu stfed ve stfedu aktualniho pohledu.

Pro zménu stredu aktualniho pohledu

1. Provedte jedno z nasledujiciho:

- Zvolte Zobrazit > Zoom > Stred

- Na panelu nastroji Zoom kliknéte na nastroj Stred (menu Standard).

- Napiste zoom, stisknéte Enter a zvote Stred (C - Center).

2. Zvolte bod, ktery chcete umistit v centru nového pohledu.

3. UrCete koeficient zmény méfitka zobrazeni nebo vySku vykresu v jednotkach
vykresu.

5.8 Zobrazit vSe

Muzete pouzit nastroj VSe pro zobrazeni celého vykresu. Pokud jste nakreslili néjaké
entity mimo definované meze vykresu, jsou meze vykresu zobrazeny. Pokud jsou
vSechny entity uvnitf mezi vykresu, je vykres zobrazen jen po meze.

Nastroj pro zoom Meze vykresu zobrazuje vykres po jeho meze s nejvétSim moznym
zvétSenim.

6. Nastaveni

6.1 Moznosti vlastniho nastaveni

Mnoho vlastnosti 4MCAD muzZete nastavovat, aby |épe vyhovovaly vasim potfebam.



Muzete napfiklad jednoduse vytvaret a ménit panely nastrojli pouhym pretazenim
ikon.

Pokud budete chtit znova nastavit ptivodni uzivatelské rozhrani, kliknéte na volbu
Reset.

4MCAD uklada vase vlastni nastaveni spiSe v systémovych registrech Windows, nez
v oddélenych souborech.

vvvvvv

Srafovani, fontd pisma, konverze jednotek, menu, paneld nastroji a klavesovych
zkratek.

4MCAD navic sjednocuje mnoho funkci vlastniho nastaveni do jediného pfikazu:
aliasy pfikazu, klavesové zkratky, vlastni menu a panely nastroju.

Muzete také pridavat viastni vytvorené programy v jednom z nasledujicich jazyku:
- LISP (jazyk kompatibilni s AutoLISP jazykem Autodesku)

- SDS (jazyk kompatibilni s ADS jazykem Autodesku)

- Misrosoft Visual Basic for Applications (VBA)

6.2 Tipy pro nastaveni 4M CAD

Po instalaci 4M CAD je vhodné provést jeho nastaveni tak, aby se Vam s programem
Co nejlépe pracovalo.

Panely nastroju

Pretahnéte nejpouzivanéjsi panely nastroju jako jsou "Kresli" a "Modifikace" do
vertikalni pozice po strané kresliciho okna. Panel nastroji ukotveny na horni strané
okna muzete uchopit najetim kurzoru na tfi Sedé tecky na levé strané panelu. Kurzor
se zméni na Sipky a pak stiskem a tazenim levého tladitka mySi mlzete panel
pfesunout. Po stranach kresliciho okna je mozné panely ukotvit na nové pozice.
Zruste zobrazeni panell nastrojl, které nepouzivate: Pretahnéte je na plochu
kresliciho okna a uzavrete kfizkem.

Naopak pomoci menu Zobrazit > Panely nastroja zvolte skupiny ikon, které jsou
pro Vasi praci uzite¢né (Kéty, Modifikace Il, Dotaz a dalsi).

Prikazovy radek

Posurite hranici pfikazového fadku nahoru tak, aby byly zobrazeny minimalné dva
nebo tfi Fadky historie. Kurzor se nad horni hranou okna pfikazového fadku zméni na
Sipky. Stiskem a taZenim levého tlaCitka okno zvétSite.

Vypnuti krokovani a mrizky

EZruéte nastaveni krokovani, které by Vam mohlo zplsobovat potize pfi uchopech,
a zobrazeni mfizky, pokud nejste zvykli krokovani (omezeni pohybu kurzoru po
preddefinovanych usecich) a mfizku (zobrazeni pomocného rastru) pfi praci
pouzivat:

KIiknéte pravym tlaitkem mysi na ikonu Krokovani  a zvolte "Vypnout
nastavené uchopy".

Kliknéte pravym tlaCitkem mySi na ikonu MFizky ve stavovém fadku a zvolte
"Skryt mFizku".



+Nastaveni uchopt

Kliknéte pravym tlagitkem mysi na ikonu Uchopti ve stavovém Fadku, zvolte
Nastaveni... a zaSkrtnéte nékteré z nabizenych uchopl (Koncovy, Stfed, Polovina,
Kolmo, Prusecik nebo dalsi moznosti). Neni vhodné navolit moznosti vSechny.

Dynamické zadani souradnic

Zkontrolujte, Ze je aktivni tlaCitko DYN uplIné vpravo dole ve stavovém fadku. Po
kliknuti pravym tlaCitkem mysi by mélo byt nastavené na "Ano". Zajisti, ze pfi
zadavani soufadnic jsou relativni soufadnice jako vychozi a nemusite tedy pfed
hodnoty zadavat zavinac.

Nastaveni pravého tlacitka mysi

Pro nastaveni chovani pravého tlacitka mysi zvolte Nastroje > Moznosti > zalozka
Zobrazeni a volbu Nastaveni pravého tla¢itka mysi v dolni ¢asti dialogu. Zvolte,
zda ma kliknuti praveho tlagitka mySi odpovidat stisku klavesy Enter nebo vyvolavat
kontextové menu. Na obrazku je chovani pravého tlagitka my3i nastaveno jako
analogie Enter pro opakovani posledniho pfikazu, kdy nejsou vybrany zadné entity a
pfi potvrzovani vybéru entit, pokud je aktivni pfikaz. Naopak je zvoleno zobrazeni
kontextového menu, pokud jsou vybrany entity a neni aktivni zadny pfikaz.

MNastaveni pravého tlagitka mysi &J

[ Zapnout chovani pravého kiku die délky stisku
Kratky ik pro ENTER
Dlouhy kik pro zobrazeni kontextového menu

Trvani dlouhého kliku: 100 milisekund

Wychozi rezim
Pokud nejsou vybrany objekty, prave tadtko znamena:
@ Refim pfikazu
Kontextove menu

ReZim Gprav

Pokud je vybran jeden nebo vice objektd, pravé tadtko znamena:
Rezim pfikazu

@) Kontextove menu

Rezim pfikazu
Pokud je aktivni pfikaz, pravé tladitko znamena:
@ ENTER
" Kontextové menu: zapnuto vZdy
Kontextové menu: zapnuto, pokud existuii moZnosti piikazu

UloZit & Zavrit | | Storno | [ Mapovéda

+Tlou§t’ky car

Pomoci ikony zvolte zda zobrazovat €i nezobrazovat tloustky ¢ar. Jedna se o
nastaveni ukladané s konkrétnim vykresem.

Pomoci Nastroje > Nastaveni kresleni... > Zobrazeni > Zménit nastaveni pro:
Tloust’ky €ar a nastavte vychozi tloustku Cary, ktera se projevi pfedevsim pfi tisku
(napfiklad hodnota 0.15).



Nabidky prikazt

Méné zkusSeni uzivatelé mohou vyuzit Okno s nabidkami pfikazu, které je ve
vychozim nastaveni verze 19 zapnuto a zobrazuje moZnosti voleb pfi provadéni
pfikazu. Volby pak neni nutné zadavat pismeny v pfikazovém fadku. Okno je
zobrazeno pouze pfi aktivnim pfikazu.

Okno mUzete zrusit pomoci Nastroje > Moznosti... > Zobrazeni > Zobrazovat
nabidky pfikazu.

Automatické ukladani

Pokud jste zvykli manualné si vykresy ukladat nékolikrat do hodiny a Vas systém je
stabilni, mUze Vas zdrzovat automatické ukladani vykrest. Miazete prodlouzit interval
pro automatické ukladani nebo je uplné zrusit. Zvolte Nastroje > Moznosti... >
zalozka Obecné. Zmérite interval pro automatické zalohovani (maximum je 240
minut).

Styly tisku z predchozi verze

Pokud jiz mate preddefinovany styly tisku v pfedchozi verzi nebo v jiném programu,
zkopirujte soubory se styly tisku do slozky Print Styles v adresafi instalace
(napfiklad C:/4MCAD19PRO/Print Styles).

Velikost vybérového terciku
V pfipadé potifeby mizete zvétsit velikost vybérového ter¢iku pomoci Nastroje >
Moznosti > zalozka Vybér v casti Velikost vybérového terciku.

6.3 Nastaveni aliasti (rychlych klaves)

Pro zménu aliasu (rychlé klavesy) zvolte v menu Nastroje > Vlastni nastaveni
menu.

Na vychozi zalozce dialogového okna Vlastni zvolte ve stromovém menu ICAD >
Aliasy a zvolte alias, ktery chcete zménit.

V pravé &asti dialogového okna po té zménte bud Nazev aliasu nebo Nazev
prikazu.
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Pro vytvoreni nového aliasu zvolte v menu Nastroje > Vlastni nastaveni menu a
prepnéte se na zalozku Pfesun. Zde v obou ¢astech dialogového okna oteviete ve
stromovém menu ICAD > Aliasy:

1. Pfesunte libovolny alias z levé ¢asti dialogového okna do pravé pod Aliasy
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2. Kliknéte pravym tlacitkem mysSi na nové pfesunuty alias v pravé ¢asti dialogového

okna a zvolte Viozit alias.
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3. Novy alias presurite do levé ¢asti dialogového okna. MizZete jich takto vytvorit i

vice za sebou.
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4. Prepnéte se na zalozku Vlastni, rozkliknéte ve stromové nabidce ICAD > Aliasy a
oznacte nové vytvoreny alias. V pravé ¢asti dialogového okna mu pak pfiradte
pozadovany pfikaz 4MCAD.

B | Upravit ufivatelske rozhrani > ‘
Viastnd  Presun

Pfizpasobeni

T ~
uc Obecné
UcP Mazev aliasu us

UN
“uN Mazev piikazu LINE
UNL Ferbreriid
URL D prvk tc-menumacro TH3FLI
us
v
v
VBAIDE b

oopoDODOOOOBS

Seznam pfikazi

[]1 wyrez ~
[1] 2 wyiezy

(2D drétovy model
[H 3 vitezy

@ 3D dritové zobrazeni
AL 3D Kivka

A1 3D plocha

152130 pole

B 20 nfmend

e ot | s

6.4 Optimalizace vykonu 4M CAD




Nové jadro a nové funkce 4MCAD 16 €i novéjsi znamenaji také vySSi pozadavky na

starSich pocitacl ¢i notebookUl s integrovanou grafickou kartou se to mize projevit
zpomalenim odezvy pfi praci v kreslicim okné. ZlepSeni vykonu je mozné pfi vypnuti
nékterych novych funkci kresliciho prostfedi nebo vyuziti pfislusné verze na 64-
bitovych systémech.

Nékolik tipu:

1. Ujistéte se, ze je ovladac Vasi grafické karty aktualni a pfipadné jej aktualizuijte.
2. Na systémech s 64-bitovou architekturou vyuZijte 64-bitovou instalaci.

3. VyzkouSejte praci s vypnutou hardwarovou akceleraci:

Nastroje > Moznosti > zalozka Zobrazeni > Hardwarova akcelerace

MoZnosti x>

Obecné Cesty/soubory Zobrazeni Profily Tisk  Uchopeni Schranka Vybér
Panel pfikazi

Pogetadek v okné 256 Velikost |16 |
[] Pouzivat klavesy Sipek nahoru/dolt k navigaci v okné historie piikazd

¥ sIp g P
[«] Zapnout automatické dokonZovani Volby automatickéhe dokongovani

Kreslici okno

Rameiek papiru ve vykresovém prostoru [+] Vychozi hodnoty nitkového kiize

D Obratit smér zoomu kolefkem my§| Vallenet lenrzory (% sbrozmudar. |5 :
[v] Zobrazit zalozky [v|Hardwarovs akcelerace
[ ]Zobrazit posuvniky e aneea
Nabidky
[ Zobrazovat nabidky pikazi Poéet poslednich vykresi: 9 T

Prihlednost oblastivybém (%) (15 -7

UZivatelské prostiedi

Jazyk | cestina Nastavit jazyk...

[ ] Ukézat celou cestu vykresu v zahlavi Téma | Office 2007 Silver ~

Standardni chovani Windows
Kontextova menu v kreslicim okné

Mastaveni pravého tladitka my3i...

Po této zméné nastaveni restartujte CAD program.

4. Vypnéte nékteré funkce dynamického zadavani:



Zvolte Nastroje > Nastaveni kresleni > zalozka Dynamické zadavani

Mastaveni vykresu *
Jednothky vitnesu: £adani soufadnic Fobrazeni
Vytvareni entity Modifilkace entity Mastaveni 20 Dynamicke zadani
Povolt zadani kurzorem [ Povolit zadani rozmérem

Zadani kurzorem Zadavani rozmén

-1.8924 | |B.5511

Mastaveni... Mastaveni...

Cynamicke dotazy

[] Zobrazovat dotazy a zaddvané
hodnoty prikazi u nitkového kifiize

Specify first point:

Wzhled napoveédy u kresleni...

? Zrut

VyzkouSejte praci s vypnutymi volbami Povolit zadani rozmérem a Zobrazovat
dotazy a zadavené hodnoty prikazi u nitkového krize.

C

ﬁ/5. Vypnéte vpravo dole ve stavovém fadku polarni trasovani ( , klavesa F10)
a objektové trasovani ( , kldvesa F11), pokud tyto funkce pfi kresleni pravé
nepotfebujete.

6. Zménte chovani kurzoru pomoci nastaveni hodnoty systémové proménné
Asyncselect na 0:

i/ Zadejte ASYNCSELECT do pfikazového radku.
iif Zadejte hodnotu 0 (nula) a potvrdte klavesou Enter.

7. Zkontrolujte nastaveni grafické karty na jejim ovladacim panelu. Pfiklad je z
ovladaciho panelu grafické karty Nvidia.

Nastavte vysokovykonny procesor a stisknéte tlaCitko Obnovit.



B oviadaci panel NVIDIA

@ Fpeé

Vyberte dlohu...

Ot

[+ Nastaveni 3D
Upravit nastaveni obrazu pr|

voval nastaveni

i..Mastavit konfiguraci Physx

Soubor Upravy Plocha Nastaveni 3D Napovéda

- O

uzefe zmenit globalni 30 nastaveni a ofit poflaceni pro zvolene programy. Pollaceni

kaZdém spusténi zvolenych programu

Chci pouZit nasledujici 3D nastaveni:
Globalni nastaveni Nastaveni programu

Preferovany graficky procesor:

Vysokovykonny procesor NVIDIA ~ %ﬁvnuat aktualizace...

Nastaveni:
Funkce Nastaveni ~
Akcelerace vice GPU / monitord ReZim vykonu vice monitord
Anizotropni filtrovani Rizeno aplikaci
CUDA - GPU Viechny
Filtrovani textur — Anizotropni optimalizac...  Vypnuto
Filtrovéni textur — Kvalita Kvalita
Filtrovdni textur — Negativni odklon drovn...  Povolit
Filtrovéni textur — Trilinedrni optimalizace Zapnuto
Maximalni pocet pfedem renderovanych s... PouZit nastaveni pro 3D aplikace
Mezipamét’ shaderu Zapnuto
Okolni prostfedi Vypnuto
Optimalizace podproces( Auto
Fiedrenderované snimky virtudini reality 1 v

Popis:
< >
Systémové informace Pouzit Zrusit
V nastaveni programu vyberte nebo pfidejte program 4MCAD, vyberte
vysokovykonny procesor a stisknéte tlacitko Pouzit.
B oviadaci panel NVIDIA — O

Wyberte dlohu...

Q|6

Soubor Upravy Plocha Mastaveni 3D Napovéda

Nastavit konfiguraci Physx

< >

Systémové informace

Mazele zménit globalni 30 nasfaveni a vylvohl poflaceni pro zvolene programy. Pollaceni budou por e

kazdém spusténi zvolenych programi.

Chdi pouZit nasledujici 3D nastaveni:

Globalni nastaveni Nastaveni programu

1. Vyberte program, ktery si pFejete pFizpfsobit:

E c:\#mcadlelpro\icad.exe e

Pridat | Odstranit <3 Obnovit

Zobrazit pouze programy, které se nachdzi

na tomto pocitaci

2. Vyberte preferovany graficky procesor pro tento program:

Vysokovykonny procesor NVIDIA

3. Zadat nastaven( pro tento program:

Funkce

Filtrovani textur — Kvalita

Filtrovani textur — Megativni edklon drovn...
Filtrovani textur — Trilinedrni optimalizace
Maximalni pocet pfedem renderovanych s...
Mezipamét’ shaderu

Okolni prostfedi

Optimalizace podprocesti

Predrenderované snimky virtualni reality PouZit globdIni nastaveni (1) | v

Nastaveni ~
PouZit globdini nastaveni (Kvalita)

PouZit globdlni nastaveni (Povolit)

PouZit globdIni nastaveni (Zapnuto)

PouZit globdlni nastaveni (PouZit nastaven...
Pouzit globalni nastaveni (Zapnuto)
Mepodporovdno pro tuto aplikac

PouZit globaIni nastaveni (Auto)

Fopis:

Zrusit

udou por




8. Nezatézujte operacni pamét pocitaCe otevienim vice aplikaci, nez je nezbytné
nutné.

9. Pokud je to mozné, pracujte spiSe s mendimi DWG vykresy.

Pokud vlastnite licenci 4MCAD 16 a nepodafilo by se vyreSit potize pfi rychlosti
kresleni, mdzete na stejném pocitaci vyuzit licenci verze 4MCAD 14, kterou ziskate
zdarma na vyzadani.

6.5 Barva entit

Nastaveni barvy entity uruje, jak se zobrazuje a pokud pouzijete barevnou tiskarnu,
i jak se tiskne. Entity jsou vytvareny v aktualni barvé. Existuje 255 standardnich
barev a dvé dalsi barevné vlastnosti, kterym se také ¢asto fika barvy. Sedm z 255
standardnich barev je mozné definovat pomoci jejich nazvu: €ervena, zluta, zelena,
azurova, modra, purpurova a bila. Cisla barev osm a devét nejsou pojmenovana.
Kazda barva ma unikatni Cislo od 1 do 255. DalSi dvé vlastnosti barev jsou DLE
HLADINY (BYLAYER) a DLE BLOKU (BYBLOCK). Tyto vlastnosti ur€uji, ze entita
pfevezme barvu své hladiny nebo bloku, ve kterém je umisténa. DLE HLADINY
(BYLAYER) je €islo barvy 256, DLE BLOKU (BYBLOCK) je ¢islo 0. Ve vSech
pfikazech, kde zadavate barvu, mlzete zadat BYLAYER a BYBLOCK nebo gisla 256
a 0. Barvy muzete také zadavat jejich vybérem z Dialogu barev. Pfi otevieni nového
vykresu jsou entity vytvareny s nastavenim BYLAYER (DLE HLADINY), coz
znamena, ze pfebiraji barvu aktualni hladiny. Zpocatku je jedina hladina 0 také
hladinou aktualni. Jeji vychozi barva je bila, takze nové entity jsou take bilé.

Pro nastaveni aktualni barvy entit

1. Provedte jedno z nasledujicich:

- Zvolte Nastroje > Nastaveni kresleni...

- V panelu nastroji Standard zvolte Nastaveni kresleni

- Napiste settings a stisknéte enter

2. Kliknéte na zalozku Tvorba entit



B | Nastaveni vikresu O x

Modifikace entit Nastaveni 3D Dynamické zadani
Jednotky wykresu: Zadani soufadnic Zobrazeni Tvorba entit

Hladina: 0 = Bawa:l:l Vybrat barvy...
Typ ary: | Bylayer v | Méiftko typu &ary: | 200:0000 12

Tloustka ¢ary| ————— BYLAYER | Globaini méfitko typu | 1.0000 &
Eary:
Styl tisku: | BYCOLOR

Atributy Prstence Elipsa Skici od ruky Srafy  VioZeni Body  KFivky/stopy Tw| % |*

Vychozi nastaveni vlioZzeni Metody vkladani atributd
() Pouzitvichozi hodnoty (@ Zadat hodnoty v pfikazovém fadku
(@ Vyzvat uzivatele () Zadat hodnoty v dialogovém okné
Wychozi rezimy atributu ReZimy zobrazeni atributu
[ ] Skryté [ |Uzaméené () Zapnuto - Vdy zobrazit atributy
[JPevné [ ]Vice fadku () Vypnuto - Nikdy nezobrazit atributy
L] oveiit {® Normaini - Jak je definovano v bloku
[ ]Definovane

@

3. Zvolte Vybrat barvy...

4.V dialogu barev zvolte BYLAYER, BYBLOCK, barvu dle vybéru nebo zadejte
Ciselny index barvy.

5. Potvrdte tladitkem OK.

6. Kliknéte znova na OK.



»
Barva

Indexové barvy |  True Color ] Enhysarev
Standardni barvy

Bl T NN -
Odstiny Sedi Logicke barvy

Bl | BvLAveR | [ eveLock |
25 22

Uplina paleta barev

A. Kliknéte pro nastaveni jedné ze standardnich barev

B. Kliknéte pro vybér jednoho z odstint Sedi.

C. Kliknéte pro nastaveni jakékoli dostupné barvy.

D. Zobrazuje aktualni barvu.

E. Zobrazuje ¢islo barvy.

F. Kliknéte pro nastaveni aktuélni barvy BYLAYER (DLE HLADINY).
G. Kliknéte pro nastaveni aktualni barvy BYBLOCK (DLE BLOKU).

6.6 Typy Car

Typy €ar pomahaiji pfedavat informace. Jsou pouzivany pro rozliSeni ucelu jedné
¢ary od druhé. Typ Cary se sklada z opakujiciho se vzoru te€ek, Carek nebo znaku a
prazdnych mezer. Typy €ar uréuji vzhled entit pfi zobrazeni i tisku. Ve vychozim
nastaveni ma kazdy vykres nejméné tfi typy €ar: Continuous (PIna), BYLAYER (DLE
HLADINY) A BYBLOCK (DLE BLOKU). Vykres muze obsahovat nekone¢ny pocet
dalSich typu €ar. Kdyz vytvofite novou entitu, je vytvofena pomoci aktualniho typu
Car. Ve vychozim nastaveni je typ ¢ary nastaven DLEHLADINY. Nova entita pfejima
typ ¢ary dle aktualni hladiny, ve které je vytvofena. Pokud zménite typ ¢ary hladiny,
zmeéni se typ Car vSech entit, které do hladiny nalezi, pokud byly vytvoreny s pouzitim
typu ¢ary BYLAYER. Jako aktualni mlzete také zvolit jiny typ ¢ary, ktery bude mit
prednost pred typem &ary aktualni hladiny. Zména typy €ary u hladiny pak nema na
tyto entity vliv. Jako tfeti moznost mazete pouzit typ ¢ary BYBLOCK (DLE BLOKU),
kdy nové entity maji typ Continuous (plna ¢ara), dokud nejsou seskupeny do bloku.
Entity pak pfejimaji nastaveny typ ¢ary bloku, kdyz vkladate blok do vykresu.

Pro nastaveni aktualniho typu éar

1. Provedte jedno z nasledujiciho:



- Zvolte Nastroje > Nastaveni kresleni...

- V panelu nastrojil Standard zvolte Nastaveni kresleni
- Napiste settings a stisknéte enter

2. Kliknéte na zaloZku Tvorba entit

3. V seznamu Typ €ary zvolte ten, ktery chcete nastavit jako aktualni.

4. Potvrdte tlacitkem OK.

B | Nastaveni vikresu O e
Modifikace entit Nastaveni 3D Dynamické zadani
Jednotky wykresu: Zadani soufadnic Zobrazeni Tvorba entit

Hladina: 0 = Barva:l:l Vybrat barvy...
Typ ary: | BylLayer ~ M&Fitko typu Eary: 500.0000
Tlougtka &y ———— BYLAYER | Globdlni méfitko typu | 1.0000
gary:

Styl tisku: [BYCOLOR

-
-
-
-

Atributy Prstence Elipsa Skici od ruky Srafy VloZeni Body  KFivky/stopy Tw * |

Wychozi nastaveni vlozeni Metody vkladani atributu
() Pouzit vychozi hodnoty (@) Zadat hodnoty v pfikazovém fadku
(@ Vyzvat uzivatele (C)Zadat hodnoty v dialogovém okné
Wychozi reZimy atributu Rezimy zobrazeni atributu
[ skryte [Juzaméene () Zapnuto - Vidy zobrazit atributy
CPevne  []Vice fadku () Wypnuto - Nikdy nezobrazit atributy
[]oveiit (@ Normaini - Jak je definovano v bloku
[l Definovang

@

Pokud v seznamu typa €ar pozadovany typ chybi, je nutné jej do vykresu nejprve
nadist napfiklad pomoci Priizkumnika 4MCAD:

V menu zvolte Format > Prozkoumat vykres..., dale sekci Typy ¢€ar, ikonu Nova
polozka a tlacitko Vybrat ze souboru. V dialogu pak zvolite novy typ ¢ary, ktery v
uz v Prizkumniku je mozné nastavit jako aktualni.



B | Nastaveni vykresu O *

Modifikace entit Nastaveni 3D Dynamické zadani
Jednotky vykresu: Zadani soufadnic Zobrazeni Tvorba entit

Hladina: |0 ™ Bar\ta:l:l Viybrat barvy...
Typ cary:  Bylayer ¥ | Méfitko typu &ry: | 500.0000 -2

Tlougtka &&ry| ————— BYLAYER |~ iEI'Oba'Inl' méfitko typu | 1.0000 =
cary:
Styl tisku: adiandtln
0.00 mm
Atributy  Prg 0.05 mm Srafy VloZeni Body  KFivky/stopy Tw 4 !
Vychozig ————0.09mm | Metody vkladani atributu
() Pouzit vychozi hodnoty {®) Zadat hodnoty v pfikazovém Fadku
(@ Vyzvat uzivatele () Zadat hodnoty v dialogovém okné
Vychozi reZimy atributu ReZimy zobrazeni atributl
[]skryte [ JUzaméené () Zapnuto - Vzdy zobrazit atributy
[ |Pevné [ ]Vice fadki () Vypnuto - Nikdy nezobrazit atribu
_/ VYP ¥ ty
] ovsiit {® Normalni - Jak je definovano v bloku
[ | Definované

@
6.7 Méritko typu cary

MiZete nastavit viastni méfitko typu &ary. Cim mensi méfitko, tim vice opakovani
vzoru Cary je na kreslici jednotku generovano. Typ ¢ary muze byt pro pfiklad
definovan jako sekvence Carek a mezer, kazda o délce 0,25 jednotky. Méfitko typu
Cary pouziva koficient méfitka pro uréeni délky. Méfitko 0.5 by zmenSilo délku kazdé
¢arky a mezery na 0.125 jednotky; méfitko 2 by zvétSilo délku kazdé na 0.5 jednotky.
Muzete urCovat invidualni méfitko typu €ary novych entit i globalni méfitko pro
vSechny entity ve vykrese.

v vs

Pro nastaveni individualniho méritka typu ¢ar
1. Provedte jedno z nasledujiciho:

- Zvolte Nastroje > Nastaveni kresleni...
- V panelu nastroji Standard, kliknéte na nastroj Nastaveni kresleni.
- Napiste settings a stisknéte Enter

2. Kliknéte na zalozku Tvorba entit

v v

3. V poli Méritko typu €ary napiste nebo zvolte méfitko, které chcete nastavit jako
aktualni.

4. Potvrdte tlacgitkem OK.



Pro nastaveni globalniho méfitka typu €ar v poli Globalni méritko typu ¢ary napiste
nebo zvolte méfitko, které chcete nastavit jako aktualni.

B | Nastaveni vykresu | X

Modifikace entit Nastaveni 3D Dynamické zadani
Jednotky vykresu: Zadani soufadnic Zobrazeni Tvorba entit
Hladina: 0 B Bar\ta:l:l Vybrat barvy...

Typ cary: | ByLayer ¥ m&titko typu gary: | 500.0000 -2
Tloustka &ary BYLAYER |~ | Globalni méfitko typu | 10000 2
cary:
Styl tisku: LDy ER
0.00 mm
Atributy  Pre 0.05 mm Srafy  VloZeni Body  Kiivky/stopy Tw 4}
Vychozi 0.09 mm v | Metody vkladani atributi

(O) Pouzit vichozi hadnoty
(@ Vyzvat uzivatele

Vychozi rezimy atributa

(@) Zadat hodnoty v pitkazovém fadku

(7)) Zadat hodnoty v dialogovém okné

RezZimy zobrazeni atributi

] skryta [JUzaméené () Zapnuto - Vzdy zobrazit atributy
[IPevne [ ]Vice fadku () Vypnuto - Nikdy nezobrazit atributy
[]oveiit (@ Normalni - Jak je definovano v bloku
[ ] Definované

&
6.8 Tloustky €ar

Zrusit

Tloustky ¢ar pomahaiji v CAD vykresech rozliSit ucel jedné Cary od druhé. Tloustky
Car urcuji jak silné nebo slabé se jevi entity pfi zobrazeni a tisku. Kazdy vykres
obsahuije tyto tloustky éar: DEAFAULT (VYCHOZI), BYLAYER (DLE HLADINY), BY
BLOCK (DLE BLOKU) a mnoho dalSich tlousték v milimetrech (nebo Ize pouZit i
palce). Kdyz vytvofite novou entitu, je vytvofena pomoci aktualniho tloustky ¢ary. Ve
vychozim nastaveni je tloustka ¢ary nastavena BYLAYER (DLE HLADINY). To
znamena, ze tloustka entity je urCovana aktualni hladinou. Pokud pfifadite
BYLAYER, zména tloustky ¢ary hladiny, zméni se tloustku ¢ar vSech entit, které do
hladiny nalezi, pokud byly vytvofeny s pouzitim tloustky BYLAYER. Jako aktualni
muzete také zvolit jinou tloustku ¢ary (nebo DEFAULT - vychozi), ktera bude mit
prednost pred tloudtkou hladiny. Entity vytvofené s touto tloustkou (nebo s vychozi
tlouStkou DEFAULT) pak nebudou ovlivnény tloustkou ¢ary hladiny. Jako treti
moznost muzete pouzit typ ¢ary BYBLOCK (DLE BLOKU), kdy nové entity maji
tloustku DEFAULT (vychozi), dokud nejsou seskupeny do bloku. Entity pak pfejimaji
nastavenou tloustku cary bloku, kdyz vkladate blok do vykresu. Pfi volbé tloustky
mensi nez .25 milimetrl se entity na obrazovce zobrazuji v tloustce jednoho pixelu.
Pokud vykres tisknete, tiskne se jako nejtensi dostupna tloustka tiskarny. Tloustky
¢ar nelze pfiradit rovinam, bodim, True Type fontim a rastrovym obrazk{m.

Pro nastaveni aktualni tloustky ¢ar
1. Provedte jedno z nasledujiciho:

- Zvolte Nastroje > Nastaveni kresleni...



- V panelu nastroji Standard, kliknéte na nastroj Nastaveni kresleni.

- Napiste settings a stisknéte Enter

2. Kliknéte na zalozku Tvorba entit

3. V seznamu Tloust’ka ¢ary zvolte ten, ktery chcete nastavi jako aktualni.

4. Potvrdte tlacitkem OK.

B | Mastaveni wykresu

Modifikace entit

O

Nastaveni 3D Dynamické zadani

Atributy  Prstence Elipsa

Vychozi nastaveni vioZeni
() Pouzit vychozi hodnoty

(@ Vyzvat uzivatele

Vychozi rezimy atributi

(2]

Skici od ruky Srafy  VieZeni Body

Jednotky wykresu: Zadéni soufadnic Zobrazeni Tvorba entit
Hladina: 0 ™~ Bar\ta:l:l Vybrat barwy...
Typ €ary: | BylLayer R Méfitko typu Zary: 500.0000 =
Tlougtka Eary BYLAYER v | Globdini méfitko typu | 1.0000 =
Gary:
Styl tisku: | BYCOLOR

Kfivky/stopy Tw !

Metody vkladani atributl
(@) Zadat hodnoty v piikazovém Fadku

() Zadathodnoty v dialogovém okné

ReZimy zobrazeni atributl

] skryte [[Juzaméene () Zapnuto - VZdy zobrazit atributy
[JPevne  []Vice radku (O Wypnuto - Nikdy nezobrazit atributy
[]ovaiit (@) Normalni - Jak je definavano v bloku
[ Definované

Zrusit

.4

6.9 Zobrazeni tloust’ky ¢ar

Ve vychozim nastaveni 4MCAD je zobrazovani tlousték ¢ar v kreslicim okné
vypnuto.

Nastaveni Ize zménit pomoci volby Nastroje > Nastaveni kresleni... > Zobrazeni >
Tloust’ky €ar



B | Nastaveni vykresu O *

Maodifikace entit Mastaveni 3D Dynamické zadani
Jednotky vykresu: Zadani soufadnic Zobrazeni Tvorba entit

Zobrazeni soufadnic

() Aktualizovat soufadnice pouze pifi vyb&ru bodu
() Soufadnice vidy zobrazuji umisténi kurzoru

(@) Soufadnice v poldrnim tvaru pro wjbér vzddlenosti a thlu
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Aktualni tloust'ka: BYLAYER

@

ZaSkrtnéne volbu a povrdte tladitkem "OK".
6.10 Vychozi tloust’ka car
Vychozi tloustka vSech €ar je 0.25 mm.

To je mozné zménit pomoci Nastroje > Nastaveni kresleni... > Zobrazeni >
Zalozka Tloust'ky €ar > Akualni tloustka ¢ary
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Maodifikace entit Mastaveni 3D Dynamické zadani
Jednotky vykresu: Zadani soufadnic Zobrazeni Tvorba entit

Zobrazeni soufadnic

() Aktualizovat soufadnice pouze pifi vyb&ru bodu
() Soufadnice vidy zobrazuji umisténi kurzoru

(@) Soufadnice v poldrnim tvaru pro wjbér vzddlenosti a thlu

Zobrazeni Meze Tloustky €ar Uzly  Rozhrani programu  Zobrazeni
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Mnoho uzivatelt bude upfednostiiovat napfiklad vychozi tlioustku ¢ar 0.00 mm.

6.11 Linearni jednotky vykresu

Ve 4MCAD se vétsSinou kresli v aktualnich rozmérech (1:1) a méfitko vykresu se
nastavuje az pfi tisku. Dfive nez zaCnete kreslit, musite ale urdit vztah mezi
jednotkami vykresu a témi realnymi. Mizete se napfiklad rozhodnout, zda jedna
jednotka vykresu bude reprezentovat palec, stopu, metr nebo kilometr. Navic muzete
urcit zpUsob, jakym bude program méfit uhly. Pro linearni i uhlové jednotky muzete
také nastavit stupen zobrazeni pfesnosti jako je po€et desetinnych mist nebo
nejmensi jmenovatel pfi zobrazeni zlomkul. Nastaveni pfesnosti ovliviiuje pouze
zobrazeni vzdalenosti, uhli a soufadnic. 4MCAD vzdy uklada vzdalenosti, uhly a
soufadnice s pfesnosti realnych Cisel.

Pro nastaveni desetinnych jednotek vykresu, které jsou u nas u linearnich
vzdalenosti nejpouzivanéjsi zvolte v menu volbu Nastroje > Nastaveni kresleni....
Pak pokracuijte na zalozce Jednotky vykresu: volbou Délkové.
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Maodifikace entit Mastaveni 3D Dynamické zadani
Jednotky vykresu: Zadéni soufadnic Zobrazeni Tvorba entit

[ ] odebrat mezery pii pfevodu vzdalenosti & Ghlf na text

Uhlovd Délkové [ uss

Typy jednotek

() Exponencidini

(@) Desetinné

() Palcové desetinné
() Architektonické
() Zlomkové

32.3320

Pfesnost 4 =

@

Zvolte nastaveni Desetinné a mlizete také zvolit poCet zobrazovanych desetinnych
mist (vychozi nastaveni je 6).

6.12 Uhlové jednotky

Pro nastaveni uhlovych jednotek vykresu:

1. Provedte jedno z nasledujiciho:

- Zvolte Nastroje > Nastaveni kresleni...

- V panelu nastroji Standard, kliknéte na nastroj Nastaveni kresleni.
- Napiste settings a stisknéte Enter

2. Kliknéte na zalozku Jednotky vykresu

3. Zvolte zalozku Uhlova.

4. Pod Typy jednotek zvolte pozadovany typ.

5. U Presnost zadejte pfesnost zobrazeni dle poctu desetinnych mist, ktera
pozadujete nebo pro nastaveni pouzijte Sipky.

Pole nad timto nastavenim zobrazuje nahled zvolenych uhlovych jednotek s aktalni
presnosti.

6. U Smér uhlu zvolte smér, ve kterém budou uhly vzristat, pokud zadate pozitivni
velikost uhlu.



7. U Zaklad uhlu uréete pozici kompasu pro nulovy uhel.

Napriklad ve vychozim nastaveni je uhel 0 na "tfech hodinach" nebo "vychodni"
pozici.

Sousedici ikona zobrazuje aktualni nastaveni zakladny uhlu.

8. Potvrdte tlacitkem OK.

B | Nastaveni vykresu O pd
Modifikace entit Mastaveni 3D Dynamické zadani
Jednotky vykresu: Zadéni soufadnic Zobrazeni Tvorba entit

[ ] odebrat mezery pfi pfevodu vzdélenosti & Ghld na text

A

Uhlovd pélkové [, USS

B Typy jednotek Smér uhlu
(@) Stupné desitkové (C)ve sméru hodinovych rucice
() stupn&/minuty/sekundy (@) Proti sméru hodinowvjich rugice
() Grady
() Radidny

() Zemépisné jednotky ZaKld Gh:

a2 E . bt
C Ffesnost 0 =
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(7] oK Zrugit

A. Urcuje typ jednotek, které nastavujete

B. Vyberte typ thlovych jednotek.

C. Zvolte presnost zobrazeni uhlovych jednotek.
D. Zvolte smér, ve kterém uthel narusta.

E. Zvolte zakladnu thlu, smér nulového uhlu.

6.13 Vyska textu

Nastaveni ovliviiuje vysku textu méfeno v jednotkach vykresu. Nastavte jeho velikost
tak, aby byla vétSina textu ve vykrese vytisténa v urcité vyhovuijici velikosti. Napfiklad



2,5 mm. Pokud budete tisknout vykres v méfitku 1:50 a budete chtit nejmensi
velikost pisma 2,5 mm, nastavte jeho vySku na 125 kreslicich jednotek.

Pro nastaveni vysky textu

1. Provedte jedno z nasleduijiciho:

- Zvolte Nastroje > Nastaveni kresleni...

- V panelu nastroji Standard, kliknéte na nastroj Nastaveni kresleni.
- Napiste settings a stisknéte Enter

2. Kliknéte na zalozku Tvorba entit

3. Vyberte zalozku Text.

4. V poli Vychozi vysSka textu zvolte vlastni vySku nebo zadejte poZzadovanou
hodnotu.

5. Potvrdte tlacitkem OK.
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Modifikace entit Nastaveni 3D Dynamické zadani
Jednotky vykresu: Zadani soufadnic Zobrazeni Tvorba entit
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A. Zvolte Text
B. Urcete vysku textu v jednotkach vykresu.

6.14 Meze vykresu



Muzete urcit meze vykresu, které reprezentuji neviditelnou hranici kolem vaseho
vykresu. Muzete vyuzit meze vykresu, abyste si byli jisti, Ze nevytvorite vétsi vykres,
nez jaky by bylo mozné vytisknout na papir v daném méfitku.

Pro nastaveni mezi vykresu

1. Provedte jedno z nasledujiciho:

- Zvolte Nastroje > Nastaveni kresleni...

- V panelu nastroji Standard, kliknéte na nastroj Nastaveni kresleni.

- Napiste settings a stisknéte Enter

2. Kliknéte na zaloZku Zadani souradnic nebo Zobrazeni.

3. Kliknéte na zaloZku Meze.

4. UrCete soufadnice x a y pravého horniho rohu a levého dolniho rohu mezi.

Muzete také kliknout na tlaCitko Zadat pro uréeni mezi vybérem bodu ve vykrese.

5. Pro omezeni kresleni mimo meze vykresu zaskrtnéte volbu Nepovolit vstup za
meze.

6. Potvrdte tlacitkem OK.

B | Mastaveni vykresu O >
Modifikace entit Mastaveni 3D Dynamické zadani
Jednotky vykresu: Zadani soufadnic Zobrazeni Tvorba entit

Zobrazeni soufadnic

() Aktualizovat soufadnice pouze pfi vibéru bodu

{_) Soufadnice vZdy zobrazuji umisténi kurzoru
(@) Soufadnice v poldrnim tvaru pro vibér vzdélenosti a Ghlu

A

Zobrazeni Meze  Tloudtky car Uzly Rozhrani programu  Zobrazeni

Meze vykresu

B Prava homi X: 406.7130 y: 2710576
Zadat> E
C Levadoni  x 1097023 . 61.0419
D Mepovolit vstup za meze
@ Zrusi

A. Zvolte Meze

B. Urcete soufadnice x a y pravého horniho rohu mezi.

C. Urcete souradnice x a y levého dolniho rohu mezi.

D. Pri zaSkrtnuti zabrani program kresleni mimo meze vykresu.



E. Uréete meze vykresu zadanim bodu ve vykrese.
6.15 Mrizka

Referenéni mfizka zobrazuje body v pravidelnych rozestupech. Zobrazeni mizete
vypnout a zapnout i ur€it vzdalenosti mezi body a uhel nato¢eni mfizky. Referenéni
mfizka se zobrazuje pouze v mezich vykresu a pomaha tak vizualizovat jeho hranice
a vzdalenosti mezi entitami ve vykrese.

Pro zapnuti zobrazeni mfizky a nastaveni vzdalenosti

1. Provedte jedno z nasleduijiciho:

- Zvolte Nastroje > Nastaveni kresleni...

- V panelu nastroji Standard, kliknéte na nastroj Nastaveni kresleni.
- Napiste settings a stisknéte Enter

2. Kliknéte na zalozku Zadani souradnic.

3. Vyberte zalozku Krokovani a mfizka.

4, Zvolte moznost Zapnout mrizku.

5. U Rozte¢ mrizky zvolte vodorovnou vzdalenost v poli X.

6. Zvolte vertikalni vzdalenost v poli Y.

7. Potvrdte tladitkem OK.

B | Nastaveni vykresu O >
Modifikace entit Nastawveni 3D Dynamické zadani
Jednotky wjkresu: Zadani soufadnic Zobrazeni Tvorba entit
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A. Zaskrtnéte volbu pro ortogonalni rezim.

B. ZaSkrtnéte volbu pro zobrazeni referenéni mrizKy.

C. Urcete vudalenosti ve sméru x a y mezi body mfizKy.

D. Zaskrtnéte volbu pro aktivaci krokovani.

E. Uréete vzdéalenosti ve sméru x a y.

F. Za$krtnéte volbu pro aktivaci isometrického krokovani a mriZky.
G. Zadejte aktualni isometrickou rovinu.

H. Urcete uhel natoCeni mrizky.

I. Zobrazuje aktualni uhel natoCeni mfizky.

J. Urc€ete x a y soufadnici poCatku krokovani.

K. Za$krtnéte volbu pro shodné nastaveni krokovani a mrizky.

6.16 Krokovani

Jednou moznosti pro zajisténi pfesnosti kresleni je aktivace a nastaveni krokovani.
Pokud je krokovani zapnuto, omezuje program vybér bodu na pfeddefinovane
intervaly kroku. Casto je uziteéné, kdyz intervaly krokd odpovidaji velikosti mfizky
nebo jinému nastaveni, ale jde o nezavisla nastaveni.

Pro zapnuti krokovani a nastaveni vzdalenosti

1. Provedte jedno z nasledujiciho:

- Zvolte Nastroje > Nastaveni kresleni...

- V panelu nastroji Standard, kliknéte na nastroj Nastaveni kresleni.

- Napiste settings a stisknéte Enter

2. Kliknéte na zaloZku Zadani souradnic.

3. Vyberte zalozku Krokovani a mfizka

4. Zaskrtnéte volbu Zapnout krokovani pro aktivaci funkce.

5. U Roztece krokovani zvolte vodorovnou vzdalenost v poli X.

6. U Roztece krokovani zvolte vertikalni vzdalenost v poli Y.

7. Potvrdte tladitkem OK.
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Kromé velikosti vzdalenosti mizete také upravit orientaci krokovani i mrizky.

Muzete také pootocit nastavenou mfizku pro vytvareni izometrickych vykresu.

6.17 Pocatek a nato€eni krokovani a mrizky

Pocatek krokovani a referenéni mfizky se ve vychozim nastaveni shoduje s
pocatkem vykresového prostoru v soufadnicich 0,0 globalniho soufdného systému.

Pocatek krokovani a mfizky vSak mazete zménit, aby se kreslené entity mohly Iépe
vztahovat k jiné pozici. Mfizku muzete také natocit v rznych uhlech. Zaroven je
natoCen také nitkovy kFiz. Pokud je mfizka zapnuta a rozte€e nastaveny na 0,0, je
jejim vychozi nastaveni stejné jako vzdalenosti krokovani.

Pro zménu uhlu a poc€atku krokovani

1. Provedte jedno z nasledujiciho:

- Zvolte Nastroje > Nastaveni kresleni...

- V panelu nastrojil Standard zvolte Nastaveni kresleni

- Napiste settings a stisknéte enter

2. Kliknéte na zélozku Zadani souradnic.

3. Vyberte zalozku Krokovani a mfizka.

4. ZaSkrtnéte volbu Zapnout krokovani pro aktivaci funkce.

5. Zaskrtnéte volbu Zapnout mfizku.



6. Pod Chovani krokovani zadejte v poli X soufadnici x nového poc¢atku krokovani.
7.V poli Y zadejte soufadnici Y nového pocatku krokovani.
8. V poli Nato€eni zadejte novy uhel natoCeni mrizky.

9. Potvrdte tladitkem OK.

X
Pootoéena mfizka a krokovani.

6.18 Izometrické krokovani a mrizka

Pro dvourozmérné vykresy mulizete vyuzit izometrického krokovani a mfizky. Pfi
volbé izometrie kreslite simulovany trojrozmérny pohled na dvourozmérné roviné
velmi podobné jako pfi kresleni na papir. Nezaménujte ale izometrické vykresy s
trojrozmérnymi. Trojrozmérné vykresy muzete vytvaret v trojrozmérném prostoru.
Volba izometrie vyZzdy vyuZiva tfi pfednastavené roviny oznaCované jako leva, prava
a horni. Nastaveni téchto rovin neni mozné zménit. Pokud je uhel krokovani 0, jsou
osy izometrie 30, 90 a 150 stuprill. Pokud se podivate na nastaveni Izometrického
krokovani a mfizky, intervaly krokovani, mfizky a nitkovy kfiZz odpovidaji akrualni
roviné. Mfizka je vZdy zobrazena jako izometricka a vyuZziva soufadnici y pro vypocet
vzdalenosti bodl. Pokud zaskrtnete volbu Kreslit ortogonalné, omezi program
kresleni entit na aktualni izometrickou rovinu.

Pro zapnuti volby Izometrického krokovani a mfizky

1. Provedte jedno z nasledujiciho:

- Zvolte Nastroje > Nastaveni kresleni...

- V panelu nastroju Standard, kliknéte na nastroj Nastaveni kresleni.
- Napiste settings a stisknéte Enter

2. Kliknéte na zalozku Zadani souradnic.

3. Zvolte zaloZzku Krokovani a mfizka.



4. Zvolte Zapnout krokovani.

5. V Chovani krokovani vyberte typ krokovani lzometrické a zvolte izometrickou

rovinu Horni, Levou ¢i Pravou.

6. Potvrdte tladitkem OK.
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Izometrické roviny leva (A), prava (B), horni (C).

6.19 Ortogonalni kresleni

Pohyb kurzoru je mozné omezit na vertikalni a horizontalni ose, takze

muzete kreslit

v pravych uhlech (ortogonalné). Napfiklad ve vychozi orientaci sméru 0 stupnil

(nulovy uhel na "tfech hodinach" nebo na "vychod"), je v ortogonalnim
omezeno na 0, 90, 180 a 270 stupnd.

rezimu

Pro zapnuti a vypnuti ortogonalniho kresleni vyuzivejte rychlou volbu pomoci klavesy

F8.

Nastaveni je ale mozné i pfes dialog Nastaveni:
1. Provedte jedno z nasledujiciho:

- Zvolte Nastroje > Nastaveni kresleni...

- V panelu nastroji Standard, kliknéte na nastroj Nastaveni kresleni.
- Napiste settings a stisknéte Enter



2. Kliknéte na zalozku Zadani souradnic.
3. Zaskrtnéte volbu Kreslit ortogonalné

4. Potvrdte tlacitkem OK.

6.20 Vzhled nitkového krize

Vzhled nitkového kfize v kreslicim okné je mozné nastavovat pomoci voleb v menu

vrw

Nastroje > Moznosti > Nitkové kfize

' -
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Barvy okna wykresu
Kontext: Polozky Barva:
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Panel prikazl ViFiEka hlawni i
B Mizka vedlejsi [
[ vyhledavad cesta i: |
B rrokovani (1
Docfasne znacky E
B nitkowy ki & USS ikona X E
B Mitkowy iz a USS kona
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B vybrané uzly i
| Obnavit vychoz
e | Atdniprvek |
P SN om | Akwdniobsah |
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|
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Pro nastaveni barev provedte zmény hodnot Osa X, Osa Y, Osa Z v oblasti Barva

osy.

Pro velikost nitkového kfiZze nastavte hodnotu v procentech velikosti obrazovky.

vrv

vy

Hodnota 100 znamena nitkovy kFiz az do okraji obrazovky. Maly nitkovy kFiz maze

mit hodnotu 5 nebo 10.

7. Pokrocila nastaveni

7.1 Vlastni nastaveni menu

4MCAD umozriuje vlastni nastaveni menu - pfidavani pfikazt, zménu jejich poradi a

dal$i moznosti.

Dialog pro upravy naleznete v menu pod volbou Nastroje > Vlastni nastaveni

menu...
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V levé
Casti dialogu je zobrazena stromova struktura aktualniho menu. Pomoci listovani ve
strukture a tlagitky "Vlozit", "Odstranit" a "Pfejmenovat" Ize polozky menu editovat.

Pro novou poloZku menu je mozné bud pfifadit pfikaz ze seznamu vpravo pomoci
tlacitka "PFidat pfikaz". Je také mozné volat makro napsané dfive v jazyku VBA jako
na obrazku.

Tlacitka "Importovat..." a "Exportovat..." umoziuji ulozeni nastaveni a jeho nacteni z
externiho souboru.

Tlagitko "Obnovit" nastavi vychozi tovarni nastaveni menu.

Po ukonceni editace €i importu zvolte tlaitko Export. Zvolte typ souboru .icm a
nahradte exportem soubor Icad2k_A.icm v instalaci programu (nap¥. cesta
C:/AMCAD161PRO/LANG/CSY/FINALICM/Icad2k_A.icm).

Po volbé vlastniho nastaveni menu, importu &i exportu pokracujte tlacitkem "Zavrit".

7.2 Nahrazovani fontu

Vykresy vytvofené v jinych programech mohou obsahovat texty ve fontech, které
4MCAD nema nebo se mohou objevit problémy s diakritikou. V takovém pfipadé je
vhodné nakonfigurovat automatické nahrazovani fontd pomoci souboru icad.fmp:

1. Prohledejte adresaif 4MCADu (napf. C:/4MCAD16PRO). Pokud v ném naleznete
soubor icad.fmp, otevrete jej v textovém editoru (napfiklad Poznamkovy blok -
Notepad). Pokud soubor neexistuje, vytvorte je;.



2. Vytvorte pravidla pro nahrazovani fontd. Dvojice "puvodni_font;novy font" musi
byt vzdy na novém fadku. Soubor miize vypadat napfiklad takto:

simplex;arial.ttf
isoct.shx;ic-isotl.shx
isoct2.shx;ic-isot2.shx
isoct3.shx;ic-isot3.shx

3. UloZte soubor pod nazvem icad.fmp do adresafre 4MCADu (napfiklad
C:/AMCAD16PRO).

4. Restartujte 4AMCAD

Poznamka
Ve starsi verzi 4MCAD 14 §Slo namisto souboru icad.fmp o soubor 4mcad.fmp.

8. Hladiny

8.1 Pruzkumnik (spravce) hladin

Hladiny jsou jako félie pouzivané pfi ruénim kresleni. Jsou pouzivany pro organizaci
raznych informaci vykresu. Kazdy vykres ma alespon jednu hladinu, vychozi, s
nazvem "0". Vykres mize obsahovat nekonecné mnozstvi dalSich hladin. Kdyz
vytvorite novou entitu, je vytvofena v aktualni hladiné.

Pro zobrazeni a editaci hladin ve vykrese

1. Provedte jedno z nasledujicich:

- Zvolte Format > Prozkoumat vykres > Hladiny

- V panelu nastrojl Vlastnosti zvolte nastroj Prozkoumat hladiny
- Napiste explayers a stisknéte enter

- Napiste la a stisknéte Enter.

V okné uvidite seznam hladin ve vykrese a ve sloupcich vpravo od nazva pak jejich
nastaveni, ktera je mozné ménit.
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8.2 Nova hladina

Ve vykrese muzete vytvofit nekonecné mnozstvi hladin pro lepsi prfehlednost a

spravu entit:

1. Zobrazte okno Spravce hladin.

2. Pro vytvofeni nové hladiny provedte jedno z nasledujiciho:

- kliknéte na prvni ikonu Nova polozka
- v menu zvolte Upravit > Novy > Hladina
- kliknéte pravym tladitkem do bilé plochy v pravé ¢asti okna a opét zvolte Novy >

Hladina

3. Je vytvofena nova hladina a pomoci klavesnice mizete okamzité zmeénit jeji
nazev. Nazev je mozné zmeénit i pozdéji pomoci kliknuti na nazev hladiny a pak
dalSim kliknutim po nepatrné prodlevé tak, aby neslo o dvojklik. Opét je aktivovana

moznost zadani nazvu.

4. Ve sloupcich nastavte vlastnosti hladiny jako je barva, tloustka a typ ¢ary. Mlzete

ji také nastavit jako aktualni hladinu.

5. Zaviete okno prizkumnika 4MCAD.

8.3 Aktualni hladina

Nové entity vzdy vznikaji v hlading€, ktera je nastavena jako aktualni.

Pro zménu aktualni hladiny:

1. Zobrazte okno Spravce hladin.

2. Oznacte dvojklikem nazev hladiny, kterou chcete zménit na aktualni, nebo hladinu

jen kliknutim vyberte a pouzijte ikonu Aktualni.




3. Zaviete okno prizkumnika 4MCAD.

8.4 Zapnuti a vypnuti hladiny

Jednotlivé hladiny i jejich skupiny je mozné vypinat a zapinat.

Vypnuti hladiny zpUsobi, Ze entity v této hladiné nejsou viditelné a nejsou vytistény.
Ackoli je hladina vypnuta, je ji stale mozné nastavit jako aktualni hladinu. V tomto
pfipadé nebudou nové nakreslené entity zobrazeny, dokud hladiny opét nezapnete.
Entity v neviditelnych hladinach mohou v nékterych pfipadech také ovlivnit zobrazeni
a tisk entit v ostatnich hladinach. Napftiklad pfi pouziti pfikazu Skryt mohou zpUsobit
skryti entit ve viditelnych hladinach.

V Prizkumniku 4MCAD je stav zapnuti nebo vypnuti hladiny indikovan ve sloupci
Zap/vyp. Rozsvicena zaroviCka znamena, ze hladina je zapnuta a zobrazuje se.

Pro zapnuti nebo vypnuti jednotlivé hladiny kliknéte na oznaceni Ano nebo Ne v
pfislusném Fadku a sloupci. Oznaceni i zobrazeni po uzavieni okna by se mélo
zZménit.

Pro hromadné zapnuti nebo vypnuti skupiny hladin je nejprve vSechny oznacte. To
je mozné pomoci kliknuti na nazev prvni hladiny a kliknutim na posledni se
stisknutou klavesou Shift. Je také mozné vybrat vS§echny hladiny pomoci kombinace
klaves Ctrl+A.

Pro zménu nastaveni pak provedte jedno z nasledujiciho:

- Kliknéte na ikonu Zapnout/vypnout hladinu v okné Prizkumnika 4MCAD

- Zvolte v menu Upravit > Vlastnosti... a zaSkrtnéte nebo odskrtnéte volbu Stav
hladiny: Vypnout

- Kliknéte pravym tlacitkem mySi na oznacenou skupinu hladin a v kontextovém
menu zvolte opét Vlastnosti...
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8.5 Zmrazeni a rozmrazeni hladiny

Hladiny je mozné zmrazit nebo rozmrazit. Entity ve zmrazenych hladinach se
nezobrazuji, netisknou a neregeneruji se. Pokud hladinu zmrazite, entity v ni
umisténé neovlinuji zobrazeni ani tisk jinych entit. Entity ve zmrazenych vrstvach
napfiklad nezakryji ostatni entity pfi pfikazu Skryt, ktery odstrani skryté entity. Ve
zmrazené hladiné také nelze kreslit, dokud neni rozmrazena a nelze ji nastavit jako
aktualni.

Aktualni hladinu neni mozné zmrazit. Pokus se pokusite zmrazit aktualni hladinu,
objevi se vyzva k volbé jiné hladiny.

Pro zmrazeni nebo rozmrazeni jednotlivé hladiny kliknéte na oznaceni Zmrazeno
nebo Rozmrazeno v pfislusném fadku a sloupci.

Pro hromadné zmrazeni nebo rozmrazeni skupiny hladin je nejprve vSechny
oznacte. To je mozné pomoci kliknuti na nazev prvni hladiny a kliknutim na posledni
se stisknutou klavesou Shift. Je také mozné vybrat vSechny hladiny pomoci
kombinace klaves Ctrl+A.

Pro zménu nastaveni pak kliknéte na oznaceni Zmrazeno nebo Rozmrazeno v
pfislusném fadku a sloupci.

8.6 Zamknuti a odemknuti hladiny

Hladiny je mozné zamknout nebo odemknout. Entity v uzamknutych hladinach jsou
vidtelné a také se tisknou, ale nelze je editovat. Uzamknuti brani nechténym
nahodilym Upravam entit.

V Prazkumniku 4MCAD je stav zamknuti nebo odemknuti zobrazen ve sloupci
uzamknuto. Stav Ano znamena, Ze je hladina uzamknuta a jeji entity nelze editovat.



Pro zamknuti nebo odemknuti jednotlivé hladiny kliknéte na oznaceni zamku v
pfislusném Fadku a sloupci. Otevieny zamek znamena otevienou vrstu, uzavieny
zamknutou.

Pro hromadné zamknuti nebo odemknuti skupiny hladin je nejprve vSechny
oznacte. To je mozné pomoci kliknuti na nazev prvni hladiny a kliknutim na posledni
se stisknutou klavesou Shift. Je také mozné vybrat vSechny hladiny pomoci
kombinace klaves Ctrl+A.

Pro zménu nastaveni pak kliknéte na ikonku zamecku v pfisluSném sloupci.

9. Uchopy

9.1 Uchopy entit

Uchopy jsou vizualni pomticka, ktera vam pom(iZze pouzivat efektivnéjsi praci s
entitami. Pokud mate Uchopy zapnuté, 4MCAD vam bude zobrazovat barevné
znacky, pokud najedete na urcité casti entit.

Uchopy entit umozruiji rychly vybér pfesnych geometrickych bod(i na existujicich
entitach bez nutnosti znat pfesné souradnice téchto bodu. S dchopy entit je mozné
vybrat koncovy bod usecky nebo oblouku, stfedovy bod kruznice, prasecik jakychkoli
dvou entit nebo jiny dllezity bod geometrie. Mlizete také vyuzit uchopy entit pro
kresleni entit teénych nebo kolmych k existujici entité. Uchopy entit miZete vyuzit
kdykoli program vyzaduje zadani bodu, napfiklad pfi kresleni useky nebo jiné entity.

S Uchopy entit je mozné pracovat dvéma zpUsoby:

- Zapnout stalé uchopy entit, které zlstavaji v platnosti, dokud je nevypnete jinou
volbou uchopl, kdyZ neni aktivni Zzadny pfikaz.

- Zapnout jednorazovy uchop pro vybér uchopu, kdyz je aktivni jiny pfikaz.

Jednorazovy uchop entity mizete také vyuzit pro vynuceni jiného uchopu, nez je
stalé nastaveni. Pro uchopy entit rozpoznava program pouze viditelné entity nebo
viditelné &asti entit. Nelze uchopit entity ve vypnutych hladinach nebo mezery
Carkovanych ¢ar.

Pokud urcite jeden nebo vice uchopt entit, pfida se k nitkovému kfizi tchopovy
terCik. Navic se k nitkovému kfizi pfida ikona indikujici aktivni uchop. Pfi vybéru
entity uchopi program uchop nejblize ke stfedu

terciku.

OXAOBRTDOBE X

1. Koncovy uchop (END)
2. Nejblizsi uchop (NEA)
3. Polovina (MID)

4. Stfed (CEN)



5. Kolmy uchyt (PER)

6. TANgenta

7. Kvadrant (QUA)

8. Vlozeni (INS)

9. Bod (POI)

10. Prisecik (INT)

11. Vlozeni (INS)

12. Zdanlivy (APP)

13. Rovnobézny (PARA)
14. Protazeni (EXT)

9.2 Nastaveni uchopt entit

Uchopy entit je mozné nastavit jakoukoli z nasledujicich metod:
- Zvolte Nastroje > Uchop entit > Nastaveni tichop entit

- Zvolte nastroje ichoptl na panelu Uchopy entit.

- V pfikazovém fadku zadejte pfikaz setesnap.

- Ve stavovém fadku kliknéte pravym tlaCitkem na tlacitko ESNAP a zvolte
Nastaveni.

- Stisknéte klavesu Shift a zaroven kliknéte pravym tlacitkem mysi kdekoli v
kreslicim okné pro zobrazeni kontextového menu uchopu entit a pak zvolte uchopy,
které chcete nastavit.

Uchopy entit miZete také nastavit v dialogu Nastaveni kresleni:

Zvolte Nastroje > Uchopy entit > Nastaveni tichop entit

Dialog Nastaveni kresleni je zobrazen s aktivni zélozkou Zadani souradnic. U
Nastaveni uchopt zaskrtnéte volbu u kazdého uchopu, ktery chcete nastavit.

Nastavené uchopy entit mizete rychle zapinat a vypinat pomoci klavesy F3.

9.3 Velikost uchopového terciku

PFi nastaveni jednoho nebo vice uchopu entit se pro aktivaci uchopu vyuziva citliva
oblast kolem stfedu nitkového kfize. Pfi ur€ovani bodt zvoli 4MCAD uchop nejblize k
centru uchopového terciku.

Pro zménu rozméru uchopového ter€iku zvolte v menu:
Nastroje > Moznosti > zalozka Uchopeni
V ¢asti Kurzor uchopu zaskrtnéte volbu Zobrazit teréik uchopu a zmérte hodnotu

v poli Velikost. Po té mizete opét zrusit volbu zobrazeni a po potvrzeni tlacitkem
OK, bude mit aktivni oblast nové zadany rozmér.
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Alternativné:

1. Provedte jedno z nasledujiciho:

- Zvolte Nastroje > Nastaveni kresleni...

- V panelu nastroji Standard, kliknéte na nastroj Nastaveni kresleni.
- Napiste settings a stisknéte Enter

2. Kliknéte na zalozku Zadani souradnic.

3. Zvolte zaloZku Vybér entit.

4. U Ter€ik uchopu entit zmérte hodnotu v poli Teréik.

5. Potvrdte tlacitkem OK.
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A. Zvolte Vybér entit
B. Napiste nebo vyberte velikost terCiku pro vybér entit.

9.4 Velikost a barva uchopovych znacek

Velikost a barvu znacek, které zobrazuji aktivni itchopovy bod mizete nastavovat
pomoci menu

Nastroje > Moznosti... > zalozka Uchopeni
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V oblasti Zna€ka uchopu jsou k dispozici tato nastaveni:

Zobrazit znacku uchopu | Vychozi nastaveni je Ano
Zobrazovat znacku uchopu ve vSech pohledech | Vychozi Ne
Barva... | Vychozi je ¢ervena (barva €. 255)

Velikost | Vychozi 8

TlouStka | Vychozi 2

9.5 Nastaveni velikosti a barvy uzl

Pro nastaveni vzhledu uchopovych uzl( zvolte v menu programu:

Nastroje > Nastaveni kresleni > zalozka Zobrazeni > Zalozka Uzly
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Nahled aktualniho nastaveni je zobrazen v ramecku.

Pro zménu aktualniho nastaveni upravte hodnotu v poli Velikost uzlu nebo zvolte
jinou barvu tlagitkem Vybrat barvy... v poli Barva uzlu.

Vychozi hodnoty jsou nastaveny na velikost 6 a modrou.

9.6 Nejblize

PouZzijte nejblizSi ichop pro uchopeni nejbliz8iho bodu jiné entity. Je mozné uchopit
nejbliz§i bod na oblouku, kruznici, elipse, eliptickém oblouku, useéce, pfimce, kfivce
nebo spline.

Pro nastaveni nejblizSiho uchopu provedte jedno z nasledujiciho:
- Zvolte Nastroje > Uchop entit > Nejblizsi

- Na panelu nastroji Uchopy entit zvolte nastroj Nejblizsi
- Napiste nearest nebo nea (u jednorazového uchopu) a stisknéte Enter

9.7 Koncovy



Nastroj pro koncovy Uchop uchopi koncovy bod jiné entity. MGzete uchopit koncovy
bod oblouku, usecky, kfivky, pfimky, roviny nebo trojrozmérné stény. Pokud ma
entita urcitou tloustku, muze byt koncovy uchop aplikovan také na hrany entity.

Pro nastaveni koncového uchopu provedte jedno z nasledujiciho:

- Zvolte Nastroje > Uchop entit > Koncovy

- Na panelu nastroji Uchopy entit zvolte nastroj Koncovy

- Napiste endpoint nebo end (u jednorazoveho uchopu) a stisknéte Enter

Pro uchopeni koncového bodu najedte kurozorem na entitu pobliZz koncového bodu.

9.8 Polovina

Nastroj uchopu poloviny umozriuje uchopit bod v poloviné jiné entity. Mizete uchopit
bod v poloviné oblouku, usecky, kfivky, pfimky nebo spline. V pfipadé nekoneénych
pfimek uchopuje polovina prvni definovany bod. Pokud ma entita urcitou tloustku,
muze byt uchop v poloviné aplikovan také na hrany entity.

Pro nastaveni uchopu v poloviné provedte jedno z nasledujicich:

- Zvolte Nastroje > Uchop entit > Polovina

- Na panelu nastroji Uchopy entit zvolte nastroj Polovina.
- Napisdte midpoint nebo mid (u jednorazoveho uchopu) a stisknéte Enter

Pro uchopeni bodu v poloviné najedte kurzorem na entitu pobliZ oblasti v poloviné
entity.

9.9 Stred

Nastroj pro uchop stfedu uchopi stfedovy bod jiné entity. MGzete uchopit stfedovy
bod oblouku, kruznice, polygonu, elipsy nebo elipsového oblouku.

Pro uchopeni stfedového budu je nutné zvolit viditelnou ¢ast entity.

Pro nastaveni uchopu stredu provedte jedno z nasledujiciho:

- Zvolte Nastroje > l’Jghop entit > Stred

- Na panelu nastroju Uchopy entit zvolte nastroj Stred

- Napiste center nebo cen (u jednorazového uchopu) a stisknéte Enter
Pro uchopeni stfedového bodu najedte kurzorem na viditelnou ¢ast entity.

9.10 Kolmo

Kolmy uchop uchopi bod v kolmé pozici na jiné entité. Tento uchop je mozné pouZit
na oblouk, elipsu, usecku, kfivku, pfimku, spline nebo hranu roviny.

Pro nastaveni kolmého uchopu provedte jedno z nasledujiciho:

- Zvolte Nastroje > Uchop entit > Kolmo



- Na panelu nastrojti Uchopy entit zvolte nastroj Kolmo
- Napiste perpendicular nebo per (u jednorazového uchopu) a stisknéte Enter

Pro vyuziti kolmého Uhlu k pozadované entité najedte kurzorem na entitu kdekoli.

9.11 Te€¢na

Nastroj pro uchop te¢ného bodu uchopi te¢ny bod jiné entity. Muzete takto uchopit
oblouk, elipsu, spline nebo kruznici pokud je zadan pfedchozi bod, ze kterého muze
byt vedena te¢na.

Kromé volby pfes rizna menu je mozné nastavit Gchop pomoci vypsani prikazu
tangent nebo tan (u jednorazového uchopu) na klavesnici a stisknutim Enter.

9.12 Kvadrant

Uchop kvadrantu uchopi koncové body &tvrtkruhu jiné entity. MdZete uchopit nejbliz&i
kvadrant oblouku, kruznice, elipsy nebo eliptického oblouku.

9.13 Bod vlozeni

Uchop bodu vioZeni uchopi bod vloZeni atributu, bloku nebo textové entity.
Pro nastaveni uchopu bodu vloZeni provedte jedno z nasledujiciho:

- Zvolte Nastroje > l'.lg:hop entit > Bod vlozeni

- Na panelu nastroju Uchopy entit zvolte nastroj Bod vlozeni

- Napiste insertion nebo ins (u jednorazového Uchopu) a stisknéte Enter

Pro vyuZiti uchopu bodu vloZeni k pozadované entité najedte kurzorem na entitu
kdekoli.

9.14 Bod

Nastroj uchopi bodovou entitu.

Pro nastaveni uchopu bodu provedte jedno z nasledujiciho:

- Zvolte Nastroje > Uchop entit > Bod

- Na panelu nastroju Uchopy entit zvolte nastroj Bod.

- Napiste node a stisknéte Enter.

Pro vyuZiti uchopu bodu najedte kurzorem na bodovou entitu.

9.15 Prusecnik

Uchop priiseéiku entit uchopi praseéik entit v trojrozmé&rném prostoru. Mdze byt
pouzit na kombinaci oblouku, kruznice, usec€ky, kfivky nebo pfimky.

Pokud je pfitomna pouze jedna entita, vyzve program k vybéru druhé a urci
uchopovy bod v misté, kde by doslo k praniku, pokud by byly entity nekone¢né délky.

Muzete uchopovat vrcholy trojrozmérnych entit a entity, které maji tloustku.



Pro nastaveni uchopu priseciku provedte jedno z nasleduijiciho:

- Zvolte Nastroje > L’lg:hop entit > Prisecik
- Na panelu nastroju Uchopy entit zvolte nastroj Prasecik
- Napiste intersection nebo int (u jednorazového uchopu) a stisknéte Enter

Pro uchop priniku najedte kurzorem na prunik entit.

9.16 Zdanlivy priseénik

Zdanlivy prasecnik umozruje uchop v pldorysném pohledu uzivatelského
soufadného systému (USS), kde by doslo k priniku entit pfi projekci na rovinu tohoto
pohledu. Zetové soufadnice vybranych entit jsou ignorovany: bod pruniku bude lezet
na aktualni elevaci soufadnice Z. Pokud je pfitomna pouze jedna entita, vyzve
program k vybéru druhé a uréi uchopovy bod v misté, kde by doslo k priniku, pokud
by byly entity nekoneéné délky.

Pro nastaveni zdanlivého pruniku provedte jedno z nasledujiciho:

- Zvolte Nastroje > Uchop entit > Zdanlivy pranik

- Na panelu nastroju Uchopy entit zvolte nastroj Zdanlivy prinik

- Napiste planviewint a stisknéte Enter

Najedte mysi na zdanlivy pranik dvou entit pro uchopeni tohoto praniku.
9.17 Vypnuti uchopu

Pro doasné vypinani a zapinani uchopt pouzijte funkéni klavesu F3.

PFikaz vypnuti uchopt umozriuje vypnuti vSech uchopu entit bez ohledu na to, jak
byly nastaveny.

Pro vypnuti vSech uchopu entit provedte jedno z nasledujiho:

- Zvolte Nastroje > Ughop entit > Vypnout vSechny tchopy entit

- Na panelu nastroju Uchopy entit zvolte nastroj Vypnout vSechny uchopy entit.

- Napiste none a stisknéte Enter

Po vypnuti dchopt timto pfikazem neni pfedchozi nastaveni uchopt ulozeno a bude

nutné je pro zapnuti nastavit znova! Z tohoto divodu je vyuzivano spise rychlé
doCasné vypnuti pomoci klavesy F3.

10. Souradnice

10.1 Souradné systémy

Pro pfesnost kresleni je mozné zadavat pozice bodu pfi kresleni nebo editaci entit
soufadnicemi. P¥i kresleni dvourozménych entit zadavejte dvourozmérné souradnice;



u trojrozmérnych entit trojrozmérné soufadnice. MliZete také zadat soufadnice ve
vztahu k jinym znamym pozicim nebo entitam ve vykrese. Zvlast pokud pracujete v
trojrozmérnych vykresech je ¢asto jednodussi zadavat soufadnice ve vztahu k
Uzivatelskému soufadnému systému (USS).

Tato sekce popisuje jak pracovat se soufadnicemi véetné:

- Pouzivani dvou a trojrozmérnych soufadnych systému.
- Zadavani absolutnich a relativnich soufadnic.

- Zadavani polarnich, sférickych a valcovych soufadnic.
- Definic a uprav uzivatelskych soufadnych systéma.

Pouziti pravouhlych souradnic

Mnoho pfikazt ve 4MCAD vyzaduje pfi kresleni nebo editaci entit zadavani bodu. Ty
je mozné zadavat myS3i nebo vypsanim hodnot soufadnic v pfikazovém fadku.
Program ur€uje body ve vykrese s pouzitim pravouhlych (kartezianskych) soufadnic.

Jak souradné systémy pracuiji

Karteziansky soufadny systém vyuziva tfi pravouhlé osy x, y a z pro uréeni bodl v
trojrozmérném prostoru. Kazda pozice ve vykrese mlze byt ozna¢ena jako bod
relativni k bodu se souradnicemi 0,0,0 (poc¢atku). PFi kresleni dvourozmérné entity
urCite horizontalni soufadnici podél osy x a vertikalni soufadnici podél osy y. Kazdy
bod v roviné tak mize byt uréen jako dvojice soufadnic x a y. Kladné souradnice lezi
ve sméru doprava a nahoru od poc¢atku, zaporné ve sméru doll a doleva od pocatku.

TFi pravouhlé osy kartezianského soufadného systému

PFi praci ve dvou rozmérech je nutné zadavat pouze soufadnice x a y. Program
pfedpoklada, ze hodnota osy z je vzdy v aktualni elevaci. P¥i praci ve tfech
rozmérech je nutné zadavat také hodnotu osy z. Pokud zobrazite vychozi padorysny
pohled vykresu (pohled ve sméru shora doll), osa Z mifi z obrazovky vzhuru v Ghlu
90 stupnd od roviny XY. Kladné souradnice jsou umistény nad rovinou XY, zaporné
pod ni. VSechny vykresy 4MCAD pouzivaji pevny soufadny systém nazvany Globalni
soufadny systém (GSS) a kazdy bod ve vykrese ma urcité soufadnice X,Y,Z v GSS.
Je také mozné definovat dal$i libovolné soufadné systémy umisténé kdekoli v
trojrozmérném prostoru. Ty se nazyvaji Uzivatelské soufadné systémy (USS) a
mohou byt umistény kdekoli v GSS s jakoukoli orientaci. Je mozné vytvofit jakékoli
mnozstvi uzivatelskych soufadnych systém, ukladat je nebo upravovat pro
jednodussi kresleni trojrozmérnych entit. Definovanim vlastnich USS uvnitf GSS je
mozné zjednodusit tvorbu vétSiny trojrozmérnych entit na kombinaci
dvourozmérnych. Pro orientaci v aktualnim soufadném systému zobrazuje program
ikonu soufadného systému. PFi zaCatku kresleni jste automaticky v globalnim
soufadném systému, coz indikuje pismeno W (World) v ikoné. Pokud zobrazite
pudorysny pohled, uvidite ikonu soufadného systému shora s osou Z sméfujici pfimo
k vam. Pokud zobrazite trojrozmérny vykres z jiného pohledu, zméni se ikona
soufadného systému, aby zobrazila tento novy bod pohledu. Zobrazené osy mifi v
kladnych smérech.

Jednotlivé osy jsou rozliSeny barevné pro snazsi orientaci v trojrozmérném prostoru:
- osa X: Cervena

-o0saY: zelena

- 0sa Z: modra

Barvy os je také mozné nastavit pomoci pfikazu Nastroje > Moznosti > Zobrazeni >
Barevné schéma
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10.2 Zobrazeni souradnic

Aktualni pozice kurzoru je zobrazena jako x,y,z soufadnice ve stavovém fadku a ve
vychozim nastaveni se pfi pohybu kurzoru automaticky aktualizuje. Zobrazeni
soufadnic je mozné pfepnout do statického rezimu pomoci klavesy F6, takzZe je
aktualizovano pouze pfi vybéru bodu.

Polarni zobrazeni
Zobrazeni soufadnic je také mozné pfepnout do jiného dynamického rezimu, takze je
misto soufadnic x,y,z zobrazena vzdalenost a uhel.

Zvolte Nastroje > Nastaveni kresleni a vyberte zalozku Zobrazeni.

U Zobrazeni soufradnic zvolte Soufadnice v polarnim tvaru pro vybér vzdalenosti
a uhlu.
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10.3 Zjisténi souradnic bodu

Pro zjisténi soufadnic bodu na entité jako je koncovy bod UseCky nastavte pfislusny
uchop (napfiklad Koncovy) pfed vybé&rem entity. Pokud nejsou nastaveny Zzadné
uchopy, jsou zobrazeny soufadnice X,y bodu se soufadnici z shodnou s aktualni
elevaci.

Pro zjisténi soufadnic bodu ve vykrese

1. Provedte jedno z nasledujiciho:

- Zvolte Nastroje > Dotaz > ID bodu.

- Na panelu nastroju Dotaz kliknéte na nastroj ID souradnic.
- Napiste idpoint a stisknéte Enter.

2. Vyberte bod, pro ktery chcete nalézt souradnice.

Pokud je zobrazeno okno pfikazového fadku, zobrazi se x,y,z soufadnice vybraného
bodu v pfikazovém radku.

Pokud pfikazovy fadek neni aktivovan, zobrazi se soufadnice v Okné historie vyzev
(klavesa F2).

10.4 Absolutni souradnice

Pro zadani absolutnich kartesianskych soufadnic napiste soufadnice pozice bodu do
pfikazového fadku.



Napfiklad pro nakresleni kfivky s pouzitim absolutnich kartesianskych souradnic z
pocatku (bodu 0,0) do bodu 3 jednotky doprava a 1 jednotku nad poCatkem zvolte
pfikaz Usecka (Line) a reagujte na vyzvy timto zptsobem:

I?oéétek usecky: 0,0
Uhel/Délka/: 3,1

PFi pouziti absolutnich kartezianskych soufadnic je nutné znat pfesné pozice véeho
kresleného.

Napfiklad pro nakresleni ¢tverce se stranou délky 8.5 jednotky s levym dolni bodem
na soufadnicich 4,5 s pouzitim absolutnich kartesianskych soufadnic je nutné urcit,
ze pravy horni roh bude lezet na soufadnicich 12.5,13.5.

10.5 Relativni souradnice

Jednodussi metodou nez absolutni soufadnice je zadavani relativnich
kartezidanskych soufadnic: uréujete pozici ve vykrese uréenim pozice relativné k
pfedchozim soufadnicim. Pro zadani relativnich kartezianskych soufradnic, zadejte v
pfikazovém fadku hodnoty soufadnic, ale zaCnéte je znakem zavinace (@).
Soufadnice za symbolem @ reprezentuji vzdalenosti podél osy X a 'Y k dal§imu
bodu.

Napfriklad pro nakresleni ¢tverce o strané 8.5 jednotky s pouzitim relativnich
kartezianskych soufadnic spustte pfikaz pro obdélnik (rectangle) a zvolte nasledujici
moznosti:

Vyberte prvni bod obdélniku: 4,5
Vyberte jiny bod obdélniku: @8.5,8.5

Relativni souradnice protéjSiho bodu ur€i jeho vzdalenost podél osy X a Y relativné k
prvnimu bodu.

Tip:
Pro napsani zavinaCe zvolte na anglické klavesnici klavesy Shift+2 na Ceské
klavesnici klavesy Ctrl+Alt+V

10.6 Polarni souradnice

Polarni soufadnice umozniuji jednoduché kresleni nato&enych entit. Polarni
soufadnice urCuji pozici bodu na zakladé vzdalenosti a Uhlu od poc¢atku (absolutni
soufadnice) nebo od pfedchoziho bodu (relativni soufadnice).

Pro zadani polarnich souradnic napiste vzdalenost a uhel oddélené Spi¢atou
zavorkou (<).

Napfiklad pro zadani relativnich soufadnic pro ureni bodu vzdaleného od
predchoziho o 1 jednotku a v Uhlu 45 stupniu, napiste @1<45.

11. Kresleni



11.1 Meéritko pri kresleni

Misto kresleni v uritém méfitku, kreslete v3e v realnych rozmérech. Je uziteCné brat
v potaz pozadované méfitko pfi nastavovani vykresu, ale budete je potfebovat az v
okamziku tisku. Napfiklad pokud budete kreslit machanickou souc¢astku o délce 400
mm, kreslete ji v rozméru 400 mm také v programu, misto pfepocitavani rozméru do
urcitého méfitka. PFislusné méfitko muzete nastavit pfi tisku. Méfitko ale ovliviiuje
zpusob, kterym se nékteré prvky jako text, Sipky nebo typy €ar tisknou. Tyto prvky
muzete pfizpusobit, uz kdyz poprvé nastavujete vykres, aby se tiskly ve spravné
velikosti. Napfiklad pfi vytvareni textu musite urcit jeho velikost, aby byla pozdéji pfi
tisku v ur€itém méfitku vytisténa spravné.

Velikost vykresu je uréena pomoci mezi. Pro vypoCet mezi tak, aby odpovidaly
velikosti papiru, vynasobte rozméry papiru méfitkem tisku. Napfiklad pokud budete
chtit tisknour na papir o velikosti A2 (ma rozméry 594 x 420 mm) v méfitku 1:100,
méla by byt velikost vykresu 59400 x 42 000 jednotek. Mlzete také tisknout na papir
jiného rozméru a vyuzit zalozky rozvrzeni (Layout) pro vytvoreni riznych pohledu a
méfitek vykresu. Koeficient méfitka tisku nema zadny vliv na vytvorené entity;
predstavuje pouze pomoc pro uréeni velikosti textu, méfitka typl ¢ar a mezi vykresu
pfi zaCatku kresleni. VySku textu i meze vykresu je mozné kdykoli zménit.

11.2 Srafy

Pokud do vykresu vlozite Srafovani, vyplni 4MCAD entity nebo uzaviené oblasti
ur€itym vzorem. Mlzete si zvolit jeden z pfeddefinovanych vzor( nebo vytvofit
vlastni. Nejprve urcite vzor Srafy a dalSi moznosti a pak zvolite entity nebo uzaviené
oblasti pro Srafovani.

Pro otevieni dialogu Srafovani provedte jedno z nasledujicho:

- Zvolte Kreslit > Srafy...
- Zvolte nastroj Srafa na panelu nastroju Kresli
- Napiste bhatch a stisknéte Enter

11.3 Jednoduché entity

Jednoduché entity zahrnuji ¢ary (UseCky a pfimky), kruznice, oblouky, elipsy,
elipsové oblouky, body a stopy. 4AMCAD navic umozriuje kresleni od ruky. Entity
kresleni od ruky jsou také povazovany za jednoduché.

Tato sekce popisuje nékolik metod pro tvorbu jednoduchych entit véetné:

- Pouzivani pfikazt menu.
- Nastroji v panelu Kreslit
- Zadavani pfikazu v pfikazovém radku.

V nékterych pfipadech existuji i jiné zpusoby tvorby entit. VétSinou budou uvedeny
alespori jeden nebo dva. DalSi zpUsoby tvorby entit naleznete v napovédé k
programu.

Pokud spustite nastroj nebo pfikaz pro kresleni, bude program oCekavat zadani
souradnic bodu jako jsou koncové body kreslenych entit nebo body vioZeni. Body a
vzdalenosti mizete zadavat mysi nebo napsat hodnoty soufadnic v pfikazovém



fadku. Béhem kresleni také program zobrazuje kontextovou napovédu s nabidkou
moznosti pro typ entity, ktery kreslite. Po vytvofeni entit je miZzete dale upravovat
pomoci nastroju modifikaci.

11.4 Usec€ka
Usecka sestava z poéateéniho a koncového bodu.

Je mozné spojit celou sérii UseCek, ale kazdy segment se bude chovat jako
samostatna entita.

Pro nakresleni usecky

1. Provedte jedno z nasledujiciho:

- Zvolte Kreslit > Usecka

- Zvolte nastroj Usecka na panelu nastroji Kresli
- Napiste line a stisknéte Enter

2. UrCete pocatecni bod.

3. UrcCete koncovy bod.

4.V dialogu vyzev zvolte Hotovo nebo stisknéte Enter pro ukon€eni pfikazu.

A

Pocatecni bod (A) a koncovy bod (B).
Dialog vyzev nebo pfikazovy fadek nabizi béhem kresleni nékolik moznosti.
Pfi kresleni prvniho segmentu usecky je mozné urcit jeho délku nebo uhel orientace.

Po nakresleni alespon jednoho segmentu mizete zvolit Zpét (pismeno U podle
anglického Undo) pro odstranéni pfedchoziho segmentu Usecky.

Pro ukonc&eni pfikazu stisknéte Enter nebo zvolte Hotovo.
Po nakresleni dvou nebo vice segmentl je mozné zvolit volbu Uzavfit (Close) pro

ukonceni pfikazu nakreslenim segmentu, ktery spoji posledni nakresleny segment s
prvnim bodem.



Pokud byl posledni pfedchozi nakreslenou entitou oblouk, muzete kreslit te¢nu z
koncového bodu oblouku.

11.5 Usecka jako tecna koncovéeho oblouku
Pro kresleni Usecky jako te¢ny z koncového bodu oblouku

1. Provedte jedno z nasleduijiciho:

- Zvolte Kreslit > Usecka

- Zvolte nastroj Usecka na panelu nastroji Kresli

- Napiste line a stisknéte Enter

2. Zadejte volbu podle (F) (pismeno F z angl. Follow)

3. Zadejte délku usecky.

Koncovy bod predchoziho oblouku (A) a délka usecky (B).
11.6 Kruznice

Vychozi metodou pro nakresleni kruznice je urCeni stfedového bodu a poloméru.
Kruznice je mozné kreslit jakoukoli z nasledujicich metod:

- Stred - Primér

- Stred - Polomér

- Dva body

- T¥i body

- Polomér - Te¢na - Te¢na

- TeCna - Te€na - TeCna

- Pfevod oblouku na kruznici

Pro vytvoFeni kruznice uréenim stfedového bodu a poloméru
1. Provedte jedno z nasledujiciho:
- Zvolte Kreslit > Kruznice

- Zvolte nastroj Kruznice na panelu nastroju Kresli
- Napiste circle a stisknéte Enter



2. UrcCete stfedovy bod.

3. Zadejte polomér kruznice.

Stredovy bod (A) a polomér (B).

11.7 Komplexni entity

Komplexni entity zahrnuiji kfivky (v€etné obdélnik( a polygon, spline, prstence a
roviny. Program navic obsahuje nastroje pro Srafovani objektu.

Tato sekce popisuje nékolik metod pro tvorbu komplexnich entit véetné:

- Pouzivani pfikazt menu.
- Nastroju v panelu Kreslit
- Zadavani ptikazu v pfikazovém fadku.

Pokud spustite nastroj nebo pfikaz pro kresleni, bude program oCekavat zadani
soufadnic bodu jako jsou koncové body kreslenych entit nebo body vioZzeni. BEéhem
kresleni program zobrazuje kontextovou napovédu s nabidkou moznosti pro typ
entity, ktery kreslite. Po vytvofeni entit je mlzete dale upravovat pomoci nastrojl
modifikaci. Nékteré z téchto typu entit vyzaduji specialni editacni pfikazy.

11.8 Obdélnik

Obdélniky jsou uzaviené kfivky se ¢tyfmi stranami. Obdélnik muzete vytvofit uréenim
protilehlych rohu. Obdélnik je pfizpusoben aktualnimu natoCeni krokovani a mrizky,
ale muzete zvolit volbu "OtoCeny" pro nato€eni obdélniku v jakémkoli jiném uhlu.

Pro nakresleni obdélniku
1. Provedte jedno z nasledujiciho:
- Zvolte Kreslit > Obdélnik

- Zvolte nastroj Obdélnik na panelu nastroju Kresli
- Napiste rectangle a stisknéte Enter



2. Zadejte roh obdélniku.

3. Zadejte protéjsi roh obdélniku.

Tt

Protéjsi rohy (A a B).

Kazdou stranu obdélniku je mozné editovat zvlast s pouZzitim nastroje Editace kfivky
na panelu nastroji Modifikace Il. Strany je mozné rozlozit na jednotlivé usecky
pomoci nastroje Rozlozit na panelu Modifikace.

S pomoci obdélniku muzete také nakreslit étverec. Misto volby protéjSich roh
zadejte volbu S (z angl. Square).

11.9 Krivky

KFivku je mozné nakreslit s jakymkoli typem &ary a s pouzitim SiFky, ktera zUstava
konstantni nebo se podél délky segmentl méni. Pfi editaci je mozné upravovat celou
kfivku nebo individualni segmenty. Po tom, co zadate prvni bod kfivky, je vam
nabidnuto nékolik moznosti jako Vzdalenost, Polovi¢éni Sitka a Sitka. MGzete urdit
ruzné pocatecni a koncové Sirky a vytvorit tak zuzujici se segment.

Po nakresleni alespor jednoho segmentu mlzete pouzit pfikaz "zpét" (U) (z angl.
Undo) pro vraceni pfedchoziho kroku.

Po nakresleni dvou nebo vice segmentu kfivky je mozné pouzit pfikaz "uzavfit" (CL)
(z angl. Close) pro ukon¢eni pfikazu segmentem, ktery spoji prvni a posledni
nakresleny segment.

Zvolte Hotovo nebo stisknéte Enter pro ukonceni pfikazu bez uzavfeni kfivky.

11.10 Krivka s rovhymi segmenty

1. Pro kresleni kfivky s rovnymi segmenty provedte jedno z nasledujiciho:

- Zvolte Kreslit > Krivka
- Zvolte nastroj Kfivka na panelu nastroju Kresli



- Napiste polyline a stisknéte Enter
2. UrCete pocatelni bod.
3. UrCete koncovy bod kazdého segmentu.

4. Zvolte Uzavfit nebo Hotovo pro ukonceni prikazu.

Pocatecni bod kfivky (A) a koncové body segmentu (B).

S moznosti "oblouk" (A) (z angl. Arc) je mozné kreslit obloukové segmenty, dokud
opét nezadate volbu pro rovné segmenty. U obloukovych segmentu je prvnim bodem
oblouku posledni bod pfedchoziho segmentu. Ve vychozim nastaveni kreslite
obloukovy segment nejprve ur¢enim koncového bodu kazdého segmentu. Kazdy
obloukovy segment je te¢ny k pfedchozimu obloukovému nebo rovnému segmentu.

Pokud zadate volbu "uzavfit" (CL) (z angl. Close) pfi kresleni obloukovych segment
je uzavirajici segment nakreslen jako oblouk.

Oblouk muzete také urcit jakoukoli z nasledujicich metod:
- Pocatecni bod, opsany uhel, stfedovy bod

- Pocatec¢ni bod, opsany uhel, polomér

- Pocatecni bod, stfed, koncovy bod

- Pocatecni bod, opsany uhel, koncovy bod

- Pocatecni bod, stfed, opsany uhel

- Pocatecni bod, stfed, délka tétivy

- Pocate¢ni bod, smér, koncovy bod

- Pocatec¢ni bod, polomér, opsany uhel

- Pocatec¢ni bod, druhy bod, koncovy bod

11.11 Kresleni rovného segmentu
naslednym obloukovym

1. Provedte jedno z nasledujiciho:

- Zvolte Kreslit > Krivka
- Zvolte nastroj Krivka na panelu nastroju Kresli



- Napiste polyline a stisknéte Enter

2. UrCete pocatelni bod.

3. UrCete koncovy bod.

4.V menu nabidka pfikazu zvolte volbu "kreslit oblouky" (A) (z angl. Arc).
5. UrCete koncovy bod obloukového segmentu.

6. Stisknéte Enter pro ukonceni pfikazu.
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Pocate¢ni bod kfivky (A), koncovy bod usecky/pocatecni bod kfivky (B) a koncovy
bod oblouku (C).

Celé kfivky i individualni segmenty je mozné editovat nastrojem Editace kfivek na
panelu nastroju Modifikace II.

Kfivky je mozné prevést na oblouky a usecky pomoci pfikazu RozloZit na panelu
nastroju Upravit.

Je mozné nastavit, zda se kfivky s Siftkou budou zobrazovat jako vyplnéné nebo jako
obrysy pomoci nastroje Vyplni v panelu Nastaveni.

11.12 Spline

Spline je hladka kfivka definovana mnozinou bodu. Spline je mozné pouzit pro
kresleni sochafskych tvart nebo pro kresleni tvarQ jako je fez turbinou nebo kfidlem
letadla.

Pro nakresleni spline

1. Provedte jedno z nasledujiciho:

- Zvolte Kreslit > Spline



- Zvolte nastroj Spline na panelu nastroju Kresli
- Napiste spline a stisknéte Enter

2. Uréete pocatetni bod spline.
3. UrCete druhy bod spline.

4. UrCete dalSi body dle potfeby a ukoncete kfivku pomoci enter nebo volbou zavfit
na nabidce pfikazu.

5. UrCete bod tecny pocatecniho bodu.

6. Uréete bod te¢ny koncového bodu.

12. Text

12.1 Nahledy fontu pro textové prikazy

Nahledy nékterych fontl pro textové prikazy v programu 4MCAD:



C—TxT STANDARD, the defoult text sbylel
abcdafghiklmnopagrstuvweyz 1234567830

[C-COMP ABCDEFGHHELMNOPRESTUVHEYZ
abedefpghijklmnopgratuvrwxyz 1234567850

C-DrM ABCDEFCHIJKLMMOPORS TUWWEY Z
abcdebghi klrnopgratuwwxyz 1234567830

T—GREKS  ABYAERTHREMAMMNONGOPI TV = F
o ydegynediuromniorTuE wipd 1234567830

‘C—-GRERC  ABRARSCHMIEAMNOIIOPEITIVOZEZ
afybrpynodekprondoaruspiypd 123406720

T-GOTH  HEODHFSOARTIRODDOROGRGUOVEIEIS
ahroefghiiklonapgrafomweryy 123453087H90

C—GOTHG NEEDESEHIERYMRLPORETNGNEY]
abebefabiiflonsparftennryy 1234567VHEN

C—GOTHE  ABURENERITRLMNGEQEBTAEINLEZ
abrbebghitklamopqrsboewayz  122436TEO0

C_HANDT  ABCDEFGHLIKLMMOPQRS TUNW WY
obcdafghiklmnopgrstuwvwsyz 1234567850

IC-150F1  ABLDEFCHUKLMNOPORS TUW W XY Z
abrdefghijklmnopgrs bavw:oyz 1235067090

IC-130F2  ABCDEFOHIKLMHOPORSTU W K Y Z
abcdefghkimnopgrs fuyvweyz 123456 789G

IC-150P3  ABCDEFGHIKLMHORORSTUVW KYZ
ahrdefghijkimnopgrs buvwsyz 1235567890

IC-150T1 ABCOEFOHI JELMNOPARS TUVWEY Z
abrdefoghi jklmnopgrstuvweyr 1234567091

IC-150T2 ABLOEFGHI IKLMNOPORSTUVWEYZ
abrdefghi |klmnopgrasrfuvwxyz 1234567091

[C-150T3 ABCDEFGHI IKELMHODPORSTUYWEY 2
abrdefght klmnopgrstuvwzyz 123656789

Ir-ITdlL  ABCDEFCHITRLMNOPQRETUVIHXYE
abode fghigclmnopgrsiuvuweys 12345367830

fO—fTALL  ABCDEFCHITKEMNOPQRETUVRXYZ
abcdefghigkimnopgrstuvweyzs 71234587830

ICLTALT ABCDEFCGHISKIMNOPQRSTUVWXYE
abedefghiiimnopgrsbuvwarys 12345678910

12.2 Specialni znaky v DWG / DXF

Specialni znaky se v DWG/DXF vykresech definuji pomoci pfedpony %% a kédu.
Je také mozné vkladani pfes schranku, pokud znak mate v néjakém dokumentu k
dispozici nebo definici znaku dle Unicode.

NejCastéjsSi specialni znaky:

Kaéd Funkce
%%cC Vykresli znak pro prameér (J)
%%p Symbol plus-minus ()

%%d Oznaceni stupriti (°)



%%% Vykresli jeden znak pro procenta (%)

%%137 Promile (%o)

%%u Zacatek a konec podtrzeni
%%0 Zacatek a konec nadtrzeni
%%nnn Definice pomoci Cisla

Pro dal8i specialni znaky doporucujeme vyuzit vhodnou tabulku, kde Cisla
jednotllivych znaku najdete. Takovou tabulku naleznete napfiklad na strance
http://www.jakpsatweb.cz/html/entity-ciselne-vypis.html

12.3 Dalsi specialni znaky v DWF / DXF

Dalsi specialni znaky v DWG/DXF vykresech:

Kéd Funkce

%%064 Zavinac (@)

%%124 Svisla ¢ara (| )

%%126 Vinovka (~)

%%128 Euro (€)

%%149 Tecka uprostfed fadku (¢)
%%149 Vodorovna ¢ara (-)
%%153 TM obchodni znamka (™)
%%166 Svisla &ara prerusena ( |)
%%167 Paragraf (§)

%%169 Copyright (©)

%%174 Registrovana znamka (®)
%%181 Recké pismeno p
%%182 Recké pismeno 9 (Pi)
%%215 Krat x

%%223 Ostré S (R)

%%247 Déleno (+)

%%291 KFizek (#)

%%292 Dolar ($)

%%294 A, and (&)

12.4 Recka pismena v CAD vykresech

Pismena fecké abecedy je mozné vkladat pomoci schranky nebo definice Unicode.

Velka pismena

Pismeno Nazev Unicode
A alfa \U+0391
B béta \U+0392
r gamma \U+0393
A delta \U+0394
E epsilon\U+0395

Z (d)zéta \U+0396
H éta \U+0397
© théta \U+0398
I iota \U+0399
K kappa \U+039A


http://www.jakpsatweb.cz/html/entity-ciselne-vypis.html

N lambda \U+039B
M my \U+039C
N ny \U+039D
= ksi \U+039E
0] omikron \U+039F
r pi \U+03A0
P ré \U+03A1
b2 sigma \U+03A3
T tau \U+03A4
Y ypsilon \U+03A5
) fi \U+03A6
X chi \U+03A7
W psi \U+03A8
Q omega \U+03A9

Mala pismena

Pismeno Nazev Unicode
a alfa \U+03B1
B béta \U+03B2
Y gamma \U+03B3
0 delta \U+03B4
€ epsilon\U+03B5

4 (d)zéta \U+03B6
n éta \U+03B7
0 théta \U+03B8
[ iota \U+03B9
K kappa \U+03BA
A lambda \U+03BB
] my \U+03BC
v ny \U+03BD
¢ ksi \U+03BE
o} omikron \U+03BF
m pi \U+03CO0
p ré \U+03C1
o sigma \U+03C3
T tau \U+03C4
U ypsilon \U+03C5
(0} fi \U+03C6
X chi \U+03C7
0] psi \U+03C8
w omega \U+03C9

13. Koty

13.1 Porozumeéni kotach

Muzete vytvofit pét zakladnich typl két: pfimou, uhlovou, poloméru, priméru a
stani¢ni. MUzete vytvofit koty pro jiz existujici entitu, tim, Ze je vyberete. Nebo



muzete vytvofit kétu ozna¢enim bodl v ramci vykresu. Napfiklad muzete vytvofit
pfimou kotu bud vybranim entity a okétovanim ji, nebo ur€enim prvni a druhé
vynaseci cary
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A. Kéta poloméru.

B. Vertikalni pfima kota.

C. Uhlova kota.

D. Linearni fetézova kéta.
E. Sikma kota.

F. Kéta priméru.

G. Horizontalni pfima kéta.
H. Pfima kéta od zakladny.

Kdyz tvofite kotu, program ji tvofi na sou€asnou vrstvu ve zvoleném stylu. Kazda
kéta ma svij vybrany styl, ktery kontroluje jeji vzhled, jako je tfeba typ Sipek, styl
textu, nebo barva komponentl. Mlzete upravit jiz existujici kdtovaci styl zménénim
jedné kotovaci proménné a poté aktualizovat kotovaci styl, aby zrcadlil nové
nastaveni.

Kazda vytvofena entita se sklada z nékolika &asti. Cary koty oznaduiji, kde kéta kongi
a kde zacina. Kdyz vytvofite uhlovou kétu, ¢ara kéty je oblouk, ktery lezi pod
mé&fenym uhlem.

Vynaseci ¢ary, nebo také projekéni, jsou ty, které vedou od entity, pro kterou tvofite
kotu, takze mazete umistit Caru kéty mimo entitu. Hlavicky Sipek koty ur€uji oba
konce Cary kéty.

Text kéty obsahuje naméfenou kétu, ale muze také obsahovat predpony, pfipony,
tolerance a dalSi zvolitelné texty.



A. Vynaseci Cara.

B. Hlavicka Sipky koty.
C. Céara kéty.

D. Text koty.

Kota mize také obsahovat dalSi zvoliteIné komponenty. Odkaz je ¢ara vedena od
vlastnosti kresleni k popisku. Odkaz zacina hlavic¢kou Sipky a muzete jej vyuzit k
umisténi koéty mimo kotovaci €aru nebo k pfidani popisku. Pokud tvofite kotu
poloméru, mlzete pfidat stfedové znaceni, coz je maly kfizek znadici stfed kruznice
nebo oblouku. Nebo muzete pfidat stfedové ¢ary, coz jsou kfizici se ¢ary vedouci
ven ze stfedu kruhu nebo oblouku.

Duis autem

13.2 Vytvareni kot

Kotu muzete vytvofit:

- Vybranim entity a ur€enim umisténi cary koty.

- Ur€enim vynasSecich Car koéty a uréeni umisténi cary koty.

Kdyz vytvarite koty vybranim entity, program automaticky umisti zacatky vynasecich
¢ar ve vhodnych bodech zalozenych na typu vybrané entity. Napf. definujici body
jsou umistény na koncovych bodech oblouku, pfimky nebo Uusec¢ky. Kdyz tvofite kotu
uréenim pocatkl vynasecich €ar, body které urcite, budou zaroveri body defini¢nimi.
Pro pfesnéjsi urCeni téchto bodu vyuzijte entitu krokovani.

13.3 Vytvareni primé koty

PFimé koéty popisuji pfimé vzdalenosti nebo délky a mizou byt orientovany
horizontalné nebo vertikaln&, nebo zarovnany rovnobézné s existujici entitou nebo
vybranym pocate¢nim bodem vynaseci Cary koty. Po vytvofeni pfimé kéty mizete
pfidat kétu od zakladny nebo kétu fetézovou. Kéta od zakladny vklada dalsi kétu
zacCinajici stejnym pocCatkem vynaseci Cary predeslé pfimeé koty. Pfima fetézova kota
navazuje dalSi pfimou kotu od druhé vynaseci ¢ary predeslé pfimeé koty.



TIP:

Pro pfesnéjsi ur€eni bodd, pouzijte entitu krokovani.
Pro vytvoreni horizontalni nebo vertikalni koéty:
1. Provedte jeden z nasledujicich bodu:

- Zvolte Kéta > Pfima

- Na panelu nastroju két kliknéte na Linearni

- Napiste DIMLIN a poté stisknéte Enter.

2. Stisknéte Enter a poté vyberte entitu k okotovani.

Nebo muzete vlozit kétu uréenim prvniho a poté druhého pocateéniho bodu vynaseci
cary.

3. UrCete umisténi pfimé koty.
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Pro urceni pfimé koty vybranim entity, vyberte entitu (A) pro kétu a poté urcete
umisténi kotovaci ary.

Vysledek.

Pro vioZeni primé koéty zvolenim pocatecnich bodu vynasecich ¢ar, vyberte prvni bod
vynaseci ¢ary (A), vyberte druhy pocatecni bod druhé vynaseci ¢ary (B), a poté
urcete umisténi kotovaci ¢ary (C).

Vysledek.

Pro vytvoreni Sikmé koéty

1. Provedte jedno z nasledujicich:



- Zvolte Kéty > Sikma

- Na panelu nastrojd két kliknéte na Sikma

- Napiste DIMALI a stisknéte Enter.

2. Stisknéte Enter a vyberte entitu pro okétovani.

Nebo muzete vlozit kotu uréenim prvniho a poté druhého pocateéniho bodu vynaseci
Cary.

3. UrCete umisténi Sikmé koty.

Iﬁ_“ 2.9481

Pro viozeni sikmé koty vybranim entity, zvolte entitu (A) pro kétu, a poté vyberte
umisténi pro caru koty (B).

Vysledek.

c B
A XI_‘J 2,948

Pro vioZeni Sikmé kdty zvolenim pocatecnich bodd vynaSecich &ar, vyberte prvni bod
vynaseci ¢ary (A), vyberte druhy pocatecni bod druhé vynaseci ¢ary (B), a poté
urCete umisténi kétovaci cary (C).

Vysledek

Pro vytvoreni pfimé koéty od zakladny

POZNAMKA:

Pfed pouzitim této funkce musite mit nejprve vytvofenou kotu.

1. Provedte jedno z nasledujicich:

- Zvolte Kéty > Od zakladny

- Na panelu nastroju két zvolte Od zakladny

- Napiste DIMBASE a stisknéte Enter.

2. Pro zvoleni zacinajici kéty stisknéte Enter.



3. Zvolte dalSi po¢atek vynaseci €ary a stisknéte Enter.

Nebo stisknéte Enter a poté vyberte jiz existujici kotu pro navazujici. Vyberte
pocate¢ni bod pro nasledujici vynaseci ¢aru a stisknéte Enter.

Program automaticky umisti novou koétu od zakladny nad nebo pod pfedchozi ¢aru
kéty. Vzdalenost mezi dvéma ¢arami kot je dana hodnotou odsazenim kéty od
zakladny v dialogovém okné nastaveni kot.
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Pro pridani koty od zakladny k jiz existujici koté, vyberte jiz existujici kétu (A), Zvolte
dal$i poc¢atecni bod vynasSeci ¢ary (B) a zvolte si tolik dodatecnych bod, kolik
potfebujete (C).
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Vysledek.
Pro vytvoreni pfimé retézové kéty
POZNAMKA:

PFed pouzitim této funkce musite mit nejprve vytvofenou kétu.
1. Provedte jedno z nasledujicich:

- Zvolte Koty > Retézova

- Na panelu nastrojii két zvolte Retézova

- Napiste DIMCONT a stisknéte Enter.

2. Pro zvoleni zacinajici kéty stisknéte Enter.

3. Zvolte dalSi poCatek vynaseci €ary a stisknéte Enter.



Nebo stisknéte Enter a poté jiz existujici kétu pro pokracovani.
4. Pro pfidani fetézové koty pokracujte vybranim poc¢atecniho bodu vynaseci ¢ary.

5. Pro ukon¢eni pfikazu stisknéte dvakrat Enter.
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Pro pridani retézové koty k jiz existujici koteé, zvolte jiz existujici kotu (A), uréete
nasledujici po¢atecni bod vynasSeci ¢ary (B) a poté zvolte dalsi pocatecni body
vynas$ecich ¢ar (C).
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Vysledek.

13.4 Vytvareni uhlové kéty

Uhlova kéta popisuje naméfeny Uhel mezi dvéma Usedkami. MzZete také méit Ghel
vybérem jeho vrcholu a dvou koncovych bodud. Po vytvofeni uhlové koty, mizete
pfidat kétu od zakladu nebo fetézovou kotu. Kéta od zakladny vklada dalsi kétu
zacinajici stejnym pocCatkem vynaseci ¢ary predeslé pfimé koéty. Pfima fetézova kota
navazuje dalSi pfimou koétu od druhé vynadeci Cary predeslé pfimé koéty.

Pro kétovani uhlu zahrnutého do oblouku

1. Provedte jedno z nasleduijicich:

- Zvolte Kéty > Uhlova

- V panelu nastroju két kliknéte na Uhlova

- Napiste DIMANG a stisknéte Enter.



2. Vyberte oblouk.

3. UrCete umisténi koty oblouku.
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Pro okoétovani uhlu zahrnutého do oblouku vyberte oblouk (A) a urcete umisténi koty.

Vysledek.

Pro kétovani uhlu mezi dvéma useckami
1. Provedte jedno z nasledujicich:

- Zvolte Kéta > Uhlova

- V panelu nastrojd két kliknéte na Uhlova
- Napiste DIMANG a stisknéte Enter.

2. Zvolte jednu Usecku.

3. Zvolte druhou usecku.

4. UrCete umisténi kotovaci Cary.
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Vyberte jednu usecku (A), vyberte druhou usecku (B) a urCete umisténi kétovaci cary

(©).
Vysledek.
13.5 Vytvareni kéty primeéru a poloméru



Kota priméru a polomeéru popisuje polomér a primér obloukt a kruhl. Mizete

zahrnout také stfedové znacky.
Vytvoreni koty priméru

1. Provedte jedno z nasleduijicich:

- Zvolte Kéta > Priméru

- V panelu nastrojl kot zvolte Priméru
- Napiste DIMDIA a stisknéte Enter.

2. Vyberte oblouk nebo kruh.

3. UrCete polohu Cary koty.
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Zvolte kruh (A), uréete umisténi ¢ary koty (B).
Vysledek.

Vytvoreni koty poloméru

1. Provedte jedno z nasledujicich:

- Zvolte Kéta > Poloméru

- V panelu nastrojli vyberte Poloméru

- Napiste DIMRAD a stisknéte Enter.

2. Vyberte kruh nebo oblouk.

3. Uréete umisténi Cary koty.
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Zvolte kruh (A) a poté urcete umisténi Cary koty (B).



Vysledek.
13.6 Vytvareni stanic¢ni koty

Staniéni kéta popisuje kolmou vzdalenost od po&atecniho nebo zakladového bodu
(zaCatek pravé uzivané soustavy [UCS]). Stani¢ni koty se skladaji z x- nebo y-
soufadnic a odkazu. Kota x-soufadnice méfi vzdalenost podél osy x; kota y-
soufadnice méfi vzdalenost podél osy y.

Jakmile vyberete stani¢ni body, program automaticky urci, jestli se jedna o bod na
ose x nebo y a urci smér, kterym mate tahnout pro uréeni druhého bodu. Zda bude
bod na x- nebo y- ose mlzete urcit také vy. Text stanicni koty je vzdy zarovnan s
odkazovou stani¢ni ¢arou, bez ohledu na orientaci ur€enou sou¢asnym stylem koéty.
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Staniéni kéta méri vzdalenost podél osy x- a y- od poéatku do vybraného stani¢niho
bodu.

Vytvoreni stani¢ni koty

1. Provedte jedno z nasledujicich:

- Zvolte Kéty >Stanicni

- V panelu nastrojl kot kliknéte na Stanic¢ni
- Napiste DIMORD a stisknéte Enter.

2. Zvolte bod pro stanicni koétu.

3. UrCete konecny bod odkazové Cary.
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Urcete stanicni bod (A), urcete koncovy bod odkazové cCary (B)
TIP:
Pro pfesnéjsi urCeni bodl pouzijte entitu krokovani.

13.7 Vytvareni odkazu

Odkazy se skladaji z isecky, nebo vice Usetek spojujici vlastnost ve vykresu s jejim
popiskem. Vétsinou, umistite hlavicku Sipky na prvni bod. Popisek, vytvoreny jako
text koty, je umistén bezprostfedné vedle posledniho bodu. Ve vychozim stavu je
text umistén na konci odkazové ¢ary posledni koty. Mizete také napsat popisek jako
samostatny fadek textu.

Vytvorieni odkazu a popisku

1. Provedte jedno z nasledujicich:

- Zvolte Kéty > Odkaz

- V panelu nastroju kot zvolte Odkaz

- Napiste DIMLEADER a stisknéte Enter.

2. UrCete pocatecni bod odkazu.

3. Ur€ete koncovy bod odkazu.

4. UrCete dalsi koncové body odkazového fadku.

5. Po ur€eni posledniho koncového bodu stisknéte Enter.

6. Napiste text popisku nebo stisknéte Enter pro pfijmuti aktualni kéty jako popisek.
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Urcete pocéateéni bod odkazu (A) a koncovy bod odkazového radku (B).

Vysledek.
13.8 Kétovani modelu ve vykresovém

prostoru

Zobrazeni két, popiskd, kliGovych poznamek a dalSich anotaci zabere néjaky ¢as.
Pokud kreslite na zalozku Rozlozeni (layout), €as pro zobrazeni a vizualni neporadek
jsou zkraceny, kdyZ pracujete na své modelové zalozce (Model tab). 4AMCAD
umoznuje okétovani modelového prostoru jak v zaloZce Model, tak v zalozce
Rozvrzeni (Layout), zalezi jen na vasSich metodach, které vam lépe vyhovuji.
Koétovani modelu ve vykresovém prostoru

1. Kliknéte na zalozku Layout (Rozlozeni).

2. Vytvorte nejméné jeden vyfez. Pro upfesnéni kouknéte na ,Tvofeni vyfez(“.

3. Uzamknéte zadouci vyfez podle nasledujiciho navodu:

- Kliknéte na okraj vyfezu, ktery chcete pouzit pro kétovani.

- Na panelu vlastnosti zvolte ,,Ano“ pro Uzamknout vyfez a stisknéte Enter.

Uzamceni vyfezu neni nutné, ale je extrémné uzite¢né pfi pfiblizovani a posunu
pohledu ve vyfezu; funkce pfedchazi stupnici vyfezu a ménéni stfedu.

TIP:

Mozna budete chtit umistit vyfez na jeho vlastni vykresovy prostor a po jeho
uzamceni skryt prostor, ktery vyfez obsahuje. To vam umozni pracovat v ramci
vyfezu rozvrzeni, aniz by bylo pfehlédnuté vase zobrazeni nebo vybér.

4. Ujistéte se, ze pracujete na vykresovém prostoru ovéfenim si pfepinace
Modelového/Vykresového prostoru ve stavovém rfadku zacinajicim na ,P“. Pokud je
to nutné, pfepnéte na vykresovy model pomoci dvojitého kliknuti na pfepinac
Modelového/Vykresového prostoru ve stavovém fadku.



5. Vytvorte kotu. Mlzete vybrat entity modelového prostoru pfimo, uréenim
definiénich bodl, nebo pouzitim uchoptl entit, pro prfesnéjsi uréeni defini¢nich bodu.

Kota je vytvofena na Vykresovém prostoru.

Pro vice detaild o vyuzivani vykresového prostoru a modelového prostoru kouknéte
na ,Porozuméni vykresovému a modelovému prostoru®.

13.9 Uprava két

Muzete také pouzit vrcholy pro Upravu entit két. MUzete upravovat text koty. Mazete
otacet kotovou €arou i textem v jakémkoli uhlu a muzete premistovat text koty
kamkoli podél kétovaci Cary.

13.10 Vytvareni vynasecich €ar

Vynaseci ¢ary byvaji bézné kolmo ke kétovaci Cafe. Mlzete vSak uhel vynasecich
Car jakkoliv zménit nezavisle na kétovaci Cére.

Vytvoreni Sikmych vynasecich ¢ar

1. Provedte jedno z nasledujicich

- Zvolte Kéty > Sklopena

- V panelu nastroju két kliknéte na Kéta sklopena

- Napiste DIMEDIT, stisknéte Enter a v zobrazeném okné zvolte Kéta sklopena
2. Vyberte pfimou kétu, které chcete upravit vynaseci ¢ary a stisknéte Enter.

3. Napiste vami vybrany uhel a stisknéte Enter
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Viyberte entitu, kterou chcete zeSikmit (A), napiste tuhel zeSikmeni.
Vysledek.

TIP:




Pro srovnani Sikmeého Uhlu, pokud nevite pfesny uhel, pouzijte entitu krokovani pro
vybrani dvou boda.

13.11 Uprava textu kéty

Muzete otacet text existujici kéty, posouvat kétovaci text na jiné misto, nebo nahradit
text kdty novym textem. Mlzete také obnovit text kéty do jeho puvodni pozice
vyuzitim stavajiciho stylu koty.

Kdyz otacite nebo nahrazujete vybrany text, prvné ur€ite zménu, poté vyberete jednu
nebo vice két, pro které chcete zménu uskute€nit. VSechny vybrané kéty jsou
aktualizovany zaroven.

Pro otoceni textu kéty (Pokrocila uroven schopnosti)

1. Provedte jedno z nasleduijicich:

- Zvolte Kéty > Natocit text koty.

- Na panelu nastroju két zvolte Natocit text koty.

- Napiste DIMEDIT a stisknéte Enter, poté v historii vyzev zvolte Otocit text.

2. Napiste novy uhel textu kéty a stisknéte Enter.

3. Vyberte kotu, kterou chcete otocit a stisknéte Enter.
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Viyberte koétu k otaceni (A), poté napiste uhel pro otaceni.
Vysledek.
POZNAMKA:

Uhel textu kéty vztazeny k &are koty. Pokud je otadeni textu kéty uréeno jako nulové,
Uhel textu je uren typem a stylem koty.

Pro posunuti textu kéty (Pokrocila troven schopnosti)
1. Provedte jedno z nasleduijicich:

- Zvolte Kéty > Zménit polohu textu koty.



- Na panelu nastroju koét kliknéte na Znovu umistit text kéty.
- napiste DIMEDIT a stisknéte Enter.
2. Zvolte koétu pro pfemisténi textu.

3. UrCete novou pozici textu.
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Viyberte kétu pro pfemisténi (A), vyberte nové umisténi textu (B).

Pro obnoveni pozice textu kéty (Pokrog€ila uroven schopnosti)

1. Provedte jedno z nasleduijicich:

- Na panelu nastroju kot zvolte Obnovit pozici textu.

- napiste DIMEDIT a stisknéte Enter, poté v historii vyzev zvolte Domu (H)
2. Vyberte text kéty pro obnoveni a stisknéte Enter.

Pro nahrazeni existujiciho textu koty novym textem (Pokrocila uroven
schopnosti)

1. Provedte jedno z nasledujicich:

- Zvolte Kéty > Editovat text koty.

- Na panelu nastroju két zvolte Upravit text kéty.

- NapiSte DIMEDIT a v historii vyzev zvolte Novy (N).
2. Napiste novy text kéty a stisknéte Enter.

3. Vyberte kotu pro pfepsani a poté stisknéte Enter.

13.12 Porozumeéni kétovacimu stylu a
promeénnych kot

Koty, které vkladate, jsou tvofeny stavajicim stylem koty. Styly kot muzete vytvaret,
obnovovat, pfejmenovavat.

Pro zobrazeni informaci o stavajicim stylu koty a porovnani s ostatnimi jmény stylu
muzete pouzit pfikaz DIMSTYLE.



Styly kot vam poskytuji cestu, jak zménit nastaveni, které kontroluje vzhled kot.
Muzete tedy uchovat nékteré nastaveni pro znovupouziti. Pokud nedefinujete styl
kéty pred jejim vytvafenim, Program pouZije Standartni styl kéty, ktery uklada
vychozi nastaveni proménnych kéty. Kazda moznost v dialogovém okné Nastaveni
koty zavisi na proménné, kterou muzete vytvofit ruéné. Viz. Reference pfikaz(.
Vytvareni stylu koty

1. Provedte jedno z nasleduijicich:

- Zvolte Format > Kétovaci styl...

- Na panelu nastroju Kéty kliknéte na Stav kétovacich proménnych

- Napiste SETDIM a stisknéte Enter.

2.V dialogovém okné Spravce stylu kétovani zvolte Novy...

3. Napiste jméno noveho stylu koty.

4. Zvolte Pokracovat.

5. V dialogovém okné Spravce stylu koty zvolte jednu z dalSich zaloZek a poté
zménte nastaveni koty, pokud je nutné.

6. Pro ukonceni pfikazu stisknéte OK.

Pifejmenovani stylu kéty

1. Provedte jedno z nasledujicich:

- Zvolte Format > Kétovaci styl...

- Na panelu nastroju Koty kliknéte na Stav kétovacich proménnych
- Napiste SETDIM a stisknéte Enter.

2.V dialogovém okné Spravce stylu kétovani zvolte Pfejmenovat...
3. Na seznamu styl k pfejmenovani zvolte styl, ktery chcete pfejmenovat.
4.V okné Na napiste nové jméno stylu koty.

5. Zvolte Pfejmenovat.

6. Zvolte OK.

Smazani pojmenovaného stylu kéty

1. Provedte jedno z nasledujicich:

- Zvolte Format > Kétovaci styl...



- Na panelu nastroju Kéty kliknéte na Stav kétovacich proménnych
- Napiste SETDIM a stisknéte Enter.

2.V dialogovém okné Spravce styll kot zvolte Odstranit.

3. Zvolte styl kéty pro smazani.

4. Zvolte OK.

Zobrazeni informaci o stylu koty

1. Napiste DIMSTYLE a stisknéte Enter.

2. Vyberte moznost Upravit a prohlédnéte si informace o proménnych.

13.13 Nastaveni koétovacich sipek

Muzete si nastavit vzhled a velikost hlavicky Sipky nebo umistit poznamky na konec
Cary koty. Kazda zména, kterou provedete, ma dopad na stavajici styl koty. Hlavicky
Sipek, které jste zvolili, se zobrazuji v obrazku na pravé strané dialogového okna
Spravce stylu két.

Muzete si vybrat z Fady typu hlavicek Sipek. MUzete nastavit kazdy konec jiny pro
kétovou ¢aru a odkazovou kotu. Pocatedni Sipka odpovida prvni vynaseci Care;
koncova Sipka druhé vynaseci Care.

Hodnota velikosti znacky uréuje velikost hlavicky Sipky, méfené v jednotkach
vykresu. MUzete také pouzit kétovaci ¢arky misto hlavicek Sipek.

Vybrani hlaviéky Sipky

1. Provedte jedno z nasledujicich:

- Zvolte Format > Kétovaci styl...

- Na panelu nastroju Kéty kliknéte na Stav kétovacich proménnych
- Napiste SETDIM a stisknéte Enter.

2. Zvolte zalozku Upravit.

3. V seznamu Pocatecni Sipka nebo Koncova Sipka zvolte po¢ateCni a koncovou
hlavicku Sipku.

4. Na seznamu Sipka odkazové kéty zvolte Sipku hlaviéky pro odkazovou kétu.
5. Kliknéte na OK.
POZNAMKA:

Typ odkazové koty miZete nastavit také pouZitim DIMLDRBLK systémové
proménné.



[Cary | Symboly a Sipky | Text
| Sipky
|| Povolit samostatné Sipky pro zadatek donec
Pocatecni sipka

B | Sipka, vyplnéna

Koncova ipka
C Sipka, vypinéna
Sipka odkazové kéty
D i Sipka, vyplnéna

— BE0,7500—
A Kétovaci Siphy: 0.1800
Stavebni kotovaci Sy —-—
E 7 Poutit kétovact 0.0000 : 1741500 ———
Edroy

Stredowvé znadky

Znacka: | Znatka b4

Vo Kétovani obloutw Zalomena kdta poloménu - Linedmi zalomend kdta
Veliko ! -
0.0500 z Symbol pozice: Uhel zalomeni: Kioef . wyShy zalomeni:

|Pr'-ed vl 45

| Hodnoty vychozi | | VWchozi nastaveni | l

A. Napiste nebo vyberte velikost hlavicky Sipky.

B. Kliknéte pro vybrani hlavicky Sipky pro pocatecni Sipku, nebo kliknéte na obrazek
pro automaticky posouvaci nahled.

C. Kliknéte pro vybrani hlavi¢ky Sipky pro koncovou Sipku, nebo kliknéte na obrazek
pro automaticky posouvaci nahled.

D. Kliknéte pro vybrani hlavicky Sipky pro odkazovou Sipku, nebo kliknéte na obrazek
pro automaticky posouvaci nahled.

E. Zvolte Pouzit kétovaci ¢arky misto pouziti hlavicek Sipek.

F. NapiSte nebo zvolte typ kétovacich Carek.

13.14 Nastaveni kotovaciho formatu

Muzete si zvolit zpusob, jakym jsou umistény hlavicky Sipek kot a text kot vzhledem k
¢are koéty. Zména, kterou provedete, muze mit dopad na stavajici styl koty. Hlavicky
Sipek, které jste zvolili, se zobrazuji v obrazku na pravé strané dialogového okna
Spravce stylu két.

Program sam urci, zda se i text kéty i hlavicky Sipky kéty vejdou mezi vynaseci Cary,
porovnanim vzdalenosti mezi vynasecimi ¢arami a velikosti textu koty, velikosti
hlavi€ek Sipek a prostorem potfebnym okolo textu koty. Pokud je to mozné, text koty i
hlavicky Sipek koty, jsou umistény mezi vynaseci ¢ary. Pokud ale ani text ani hlavicky



Sipek nepasuji mezi vynaseci ¢ary, mlzete urcit kam text a hlavicky Sipek umistite
pomoci metody PfizpUsobit v dialogovém okné Spravce stylu kétovani.
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Text i hlavicky jsou umistény vné vynasecich Car.

Text je umistén uvnitf vynasSecich ¢ar a hlaviéky vné.

Text je umistén nad Carou kéty s odkazem spojujicim ho s ¢arou koty.
Formatovani kot

1. Provedte jedno z nasledujicich:

- Zvolte Format > Kétovaci styl...

- Na panelu nastroju Kéty kliknéte na Stav kotovacich proménnych
- Napiste SETDIM a stisknéte Enter.

2. Zvolte Upravit. Pak vyberte zalozku Pfizpusobit.

3. Zvolte moznost, ktera vam vyhovuije.

4. UrCete vzdalenost umisténi.

5. Kliknéte na OK.

POZNAMKA:

Pozici hlavi¢ek Sipek a textu kéty mizete také urcit pomoci DIMATFIT systémové

proménné. Premisténi textu koty mizete nastavit také pomoci DIMTMOVE
systémové proménné.



i | Prepsat aktualni styl

[ oy | Symboly @ Sipky | Tet | Phizpisabit | Hiavni jednotiey | Altemiativni jednotiy '-I'o-lelance:
Metoda umisténi
Pokud se text a Sipky nevejdou dovnitF
vynasecich Sar:

:A @ Bud'text nebo Sipky {podle vhodnosti)

Text dovnitf, Sipky vné oty
Text wné, Sipky uvnitf
Texd i Siphy vné
7| Umistit tesd vidy mezi vynaseci Gary
| Potla&tt Sipky, pokud se nevejdou mezi
vymaseci any
| Kreslit kétovaci S mezi vinadeci &any i
ledyi jsou Siply mimo méfené body
Umisténi textu
E @ Stejné s kitovaci Edrou
F ") Pfes kitovaci &an, s odkazem
G PFes kitovaci &anu, bez odkazu

Urmistit text rudné, ignorovat zarovnani WEFitko kit
| Anotativni
() ME&Fitko két dle rozwrieni

@ Pouiit celkové méFitko:

l Hodnoty vychozi | | Wychozi nastaveni | I QK

A. Zvolte, pokud chcete umistit vné vynasecich &ar bud’ hlaviéky Sipek, nebo text,
kdyZ se oboje nevejde.

B. Zvolte pro umisténi textu mezi vynaseci ¢ary a hlavicky Sipek vné.

C. Zvolte pro umisténi textu vné vynasecich Car a hlavicek Sipek mezi vynaseci Cary.
D. Zvolte, pro umisténi i textu i hlaviCek Sipek vné vynasecich car.

E. Zvolte pro umisténi textu stejné s kotovaci ¢arou.

F. Zvolte pro umisténi textu mimo kétovaci ¢aru s odkazem.

G. Zvolte pro umisténi textu mimo kotovaci ¢aru bez odkazu.

13.15 Nastaveni ¢ary kéty

Muzete si zménit nastaveni ovliviiujici aru koty, vynaseci €ary a stfedovych znacek.
Zména, kterou provedete, miize mit dopad na stavajici styl kéty. Vzhled stavajiciho
vybraného stylu koty se zobrazi v pravém okné dialogového okna Spravce stylu kot.
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A. Pfesah vynaseci ¢ary od kétovaci ary.

B. Posunuti od zakladni koty.

C. Posunuti od pocatku.

Nastaveni barvy ¢ary koty

1. Provedte jedno z nasleduijicich:

- Zvolte Format > Kétovaci styl...

- Na panelu nastroju Kéty kliknéte na Stav kotovacich proménnych
- Napiste SETDIM a stisknéte Enter.

2. Zvolte Upravit. Pak si zvolte zalozku Cary.

3. Zvolte svij vybér.

4. Zvolte OK.
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| Cay | Sﬁbolya Siphey Text Pﬁzpﬂsoﬁ'rt Hlévnijednutky_ N;[emativn-i.jgdnuﬂ_w -Tol.elance;
Kétovaci Gary

C Barva:

Typ Cary:

Tougtka Eany:

B Presah na konci:
Odsazeni zakladmy:

E Fotiacit | Kt &ra 1:

D‘\ﬁmééec? Eary

Barva: Bl cELOCcK
Typ vynas. Sary 1:
menm.cyy T Fr Presah vynasecich car od A
Todhaday: | B~ Poddtek: 00625 = Kétovaci &&y:  0.1800

F Potlasit [Vyrn. 281 [C]Vyn. &8 2 . i
| | Vynaseci cany s pevnou délkou

| Hodnoty wychozi | | Vchozi nastaveni | | QK || Stomo

A. Napiste nebo vyberte presah vynasecich Car od kbtovaci ¢ary a pocatku.

B. V Koty napiste nebo vyberte vzdalenost, kterou vynaseci Cary tvofi za ¢arami Kot.
C. Vyberte barvu a typ Cary koty.

D. Vyberte barvu a typ vyna$eci Cary.

E. Zvolte pro potlaceni prvni nebo druhé Cary koty.

F. Zvolte pro potlaeni prvni nebo druhé vynaseci ¢ary.

13.16 Nastaveni kotovaciho textu

Muzete si pfizpUsobit nastaveni ovliviiujici vzhled textu kéty. Zména, kterou
provedete, mize mit dopad na stavajici styl koty. Vzhled stavajiciho vybraného stylu
koty se zobrazi v pravém okné dialogového okna Spravce stylu kot.
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Text prichyceny ke kotovaci ¢afe horizontalné.



Text zarovnany s kotovaci ¢arou.

Zarovnat text ke koétovaci ¢are

1. Provedte jedno z nasledujicich:

- Zvolte Format > Kétovaci styl...

- Na panelu nastroju Kéty kliknéte na Stav kétovacich proménnych
- Napiste SETDIM a stisknéte Enter.

2. Zvolte Upravit a pak zvolte zalozku Text.

3. Zvolte svUj vybér.

Zvolte OK.

B T Prepeat skchialng Syl kot

[Cay | Symboly asipky | T | Pizpasobit | Hani jednatky | Atemativni jecnoty | Tolerance |
Vzhled texdu —~
A suitestu: [ Standard [ Trazkumnik.|

D savatetu: B ELOCK -
Vipiitequ:  (Bezpomadi  ~]
Barva pozadi: B CYELOCK

B viska textu: 0.1200

Umnist&ni testu

E Vertikalne: |\-‘ystFed'rt mezi vynadecimi Saram |

Swishy posun textu: 0.0000

E‘Iorizontélné: |\«‘)’Sh’ed'rt mezi vynadecimi Sarami * |
Smér pohledu: Feva doprava -

Orientace textu MoZnosti
Oriertace, kdy? je test mimo vymaseci &any: [\."odoro\rné = | [ Kreslit amecek kolem textu

Oriertace, kdy? je text uvnitF vynasecich ar: |Vodor0vné - zdélenost kolem testu:  0.0300

| Hodnoty vychozi | | Vychozi nastaveni | |

A. Zvolte pr vybér stylu textu pouzitého v textu koty.
B. Napiste nebo vyberte vysku text ve vykresovych jednotkach.

C. Zvolte pro zobrazeni Priizkumniku 4MCAD a elementu stylu textu.

D. Zvolte barvu textu.

E. Zvolte, zda chcete pouZit horizontalni nebo vertikalni spojeni s kotovaci ¢arou.

13.17 Nastaveni kétovacich jednotek

Muzete ovliviiovat vzhled a format hlavnich a alternativnich jednotek kot. Vzhled
stavajiciho vybraného stylu kéty se zobrazi v pravém okné dialogového okna
Spravce stylu két.



2190 2.230 =—2.000 —

Zaokrouhleni vzdalenosti na 0,0100 (ptivodni kéta pfed zaokrouhlenim)
Vzdalenost zaokrouhlena na 0,2500

Vzdalenost zaokrouhlena na 1,0000

Zaokrouhleni kéty

1. Provedte jedno z nasledujicich:

- Zvolte Format > Kétovaci styl...

- Na panelu nastroju Kéty kliknéte na Stav kétovacich proménnych

- Napiste SETDIM a stisknéte Enter.

2. Zvolte si Upravit a pak zalozku Hlavni jednotky

3. V poli Pfima kota napiste nebo vyberte nejblizsi moznou hodnotu, na kterou
chcete kétu zaokrouhlit.

4. Zvolte OK.
POZNAMKA:

Jednotky pro primou kétu muZete také urcit pomoci systémové proménné
DIMLUNIT.



B Zménit styl kotovani: 30 g

Cany Symbaly a Sipky  Text PAzpuscbit Hlavnijednotky  Atemativni jednotky  Tolerance

Prim& kota
AForrnét jednotek: | Desetinne ~
B Presnost: 1] ~
Forméat zlomibo: Vodorovne
C oddéiovaz desetin: " (Tedka) v
[D zackrouhieni: 00000 L=
Predpona: | ‘
Pfipona: | ‘
Meéritko jednotek
| Kosficient méitka: 10000 2
[ Pougit pouze pro kéty rozvrieni
Ee
Potlageni nul CSJ
E ] vodni F ] Kencové °
e - o Uhlova kéta —
o et Formt Potlageni nul
onm T el i . .
Dusice edotek: Stupné desitkove [ Uvodni
Pfesnost: 1] w [ ] Kencové
9 Hodnaty stranky na wychozi V&echny hodnoty na wychozi Frust

A. Zvolte format pfimé koty.

B. Napiste nebo vyberte ¢islo s poctem desetinnych mist, které chcete, aby se
zobrazilo u kétovaci ¢ary.

C. Zvolte pro znacky pro pouZivana desetinna Cisla.

D. Napiste nebo vyberte nejblizsi hodnotu, ke které chcete vzdalenost koty
zaokrouhlit.

E. Zvolte pro potlaceni nul uvodnich.

F. Zvolte pro potlaceni nul koncovych.

G. Zvolte format jednotek thlové koty.

H. Vyberte, zda chcete potlacit uvodni a koncové nuly.

I. Zvolte nebo napiste méfitko jednotek pouZity u vSech kot.

13.18 Pridavani geometrické tolerance

Geometricka tolerance oznacuje maximalni povolenou variantu v geometricky
definovaném vykresu. 4MCAD kresli geometrickou toleranci pomoci znacky
tolerance, coz je obdélnik rozdélen do oddild.



Kazda znacka tolerance je sklada z minimalné dvou &asti. Prvni obsahuje symbol
geometrické tolerance, ktery oznacuje geometrickou charakteristiku, pro kterou je
tolerance aplikovana, jako tfeba umisténi, orientace, nebo forma. Napf. tolerance
formy muze uréovat rovnost nebo zaobleni povrchu. Geometrické symboly tolerance
a jejich vlastnosti jsou zobrazeny v nasledujici tabulce.

Geometrické symboly tolerance

Symboly umisténi

Pozice

Soustfednost nebo souosost
Symetrie

Symboly orientace

Rovnobéznosti

Kolmosti

Uhlu

Symboly formy

Valcovitosti

Plochosti

Kruhovosti nebo oblosti

Primosti

Symboly profilu

Profil povrchu



Profil pfimky
Symboly vybihani

Kruhovy vybéh
Upliny vybéh

Druha znacka obsahuje toleran¢ni hodnotu. Pokud je to vhodné, hodnotu tolerance
predchazi symbol priméru nasledovan symbolem materialnich podminek. Materialni
podminky jsou vyuZivany k vlastnostem, které se mohou liSit ve velikosti. Symboly
materialnich podminek a jejich vyznam jsou ukazany v nasledujici tabulce.

Materialni podminky

Maximalni materialni kondice (MMC), vlastnost obsahujici maximalni mnozstvi
materialu, stanoveném v limitech.

L
Minimalni materialni kondice (LMC), vlastnost obsahujici minimalni mnozstvi
materialu, stanoveném v limitech.

Bez ohledu na materialni kondice (RFS) urCuje, Zze vlastnost muze mit jakoukoliv
velikost v ramci stanoveného limitu.

Hodnota tolerance mlze byt nasledovana primarnimi, sekundarnimi a terciarnimi
udaji odkazovych pismen, spolu s materialnimi kondicemi kazdého data. Pismena
dat odkazl jsou bézné pouzivany jako odkazy tolerance jedné ze tfi kolmych rovin, z
kterych je udélano méreni. Ackoli pismena odkazu dat mizou uréovat pfesny bod
nebo osu.

A. Symbol geometrické viastnosti.

B. Symbol poloméru.



C. Hodnota tolerance.

D. Symbol materiélni kondice.

E. Odkaz data.

Kdyz jsou pouzity dvé tolerance pro stejnou geometrii, mlizete také pfidat kompozitni
toleranci skladajici se z primarni toleran¢ni hodnoty nasledovanou sekundarni
toleranéni hodnotou. Pro jesté blizsi ur€eni, tolerance mlze obsahovat
projektovanou toleranci skladajici se z hodnoty vySky nasledovanou symbolem
projektované tolerance. Napf. projektovanou toleranci mizete vyuzit pro oznaceni,
zda je vlozena Cast kolma.

Pridani geometrické tolerance

1. Provedte jedno z nasledujicich:

- Zvolte Kéta > Tolerance

- V panelu nastrojl kot zvolte Tolerance

- Napiste tolerance a stisknéte Enter.

2. Pro zobrazeni symbolu geometrické tolerance na prvni linii, kliknéte na Sym.

3. Kliknéte pro zvoleni symbolu geometricke tolerance.

4. Pod toleranci 1 kliknéte na Dia okénko pro pfidani symbolu praméru.

5. Do poli¢ka napiSte hodnotu prvni tolerance.

6. Pro zobrazeni symbolt materialovych podminek, kliknéte na M.C.

7. Kliknéte pro zvoleni materialovych podminek.

8. Pod Tolerance 2, opakuijte kroky 4 az 7 pro pfidani druhé hodnoty, pokud je to
vhodné.

9. Pod Datum 1 napiSte primarni referen¢ni datum.
10. Pro zobrazeni symbol( materialovych podminek kliknéte na M. C.
11. Kliknéte a vyberte materialovou podminku.

12. Opakujte od kroku 9 po 11 pro pfidani druhotného nebo tercialniho data, pokud je
nutné.

13. V druhém fadku opakujte krok 2 az 12 pro pfidani slozené tolerance, pokud je
vhodné.

14. V okné VySka napiste symbol toleranéni zény a z6nu navrhované tolerance.



15. Pro oznaceni symbolu navrhované tolerance, kliknéte na Zéna navrhované
tolerance.

16. Kliknéte na OK.

17. Ve vykresu uréete umisténi funkce ramu.

Tolerance 1 Tolerance 2 Datum 1 Datum 2 Datum 3

Prim Prir

B @B B BHBE-F
BN N | ] B B

Wiska: B Ziona navrhovane tolerance: .
Identffikator
zakladry:

B

A. Pouzijte tento fadek pro zahrnuti sloZené tolerance.

B. Napiste hodnotu vysky projektované tolerance.

C. Napiste identifikator data.

D. Kliknéte pro zahrnuti symbolu projektované tolerance.

E. Kliknéte pro vybrani symbolu materialové podminky pro terciarni datum.
F. Napiste pismeno referenéniho data.

G. Kliknéte pro vybrani symbolu materialni podminky pro sekundarni datum.
H. Napiste sekundarni pismeno referenc¢niho data.

I. Kliknéte pro vybrani symbolu materialnich podminek primarniho data.

J. Napiste pismeno primarniho referenéniho data.

K. Kliknéte pro vybrani symbolu materialni podminky primarniho data.

L. Napiste hodnotu sekundarni tolerance.

M. Kliknéte pro zahrnuti symbolu praméru pro hodnotu sekundarni tolerance.
N. Kliknéte pro zvoleni symbolu materialni podminky pro hodnotu primarni tolerance.
O. Napiste hodnotu primérni tolerance.

P. Kliknéte pro zahrnuti symbolu praméru pro prvni toleranci.



Q. Kliknéte pro zvoleni symbolu geometrické tolerance.

13.19 Nastaveni tolerance koty

Muzete vytvaret kotu bud jako tolerance nebo limity két. Kdyz vytvafite toleranci koty,
muzete kontrolovat horni a spodni limity tolerance stejné tak jako desetinna mista
Cisla textu koty. Obrazek na pravé strané dialogového okna Nastaveni kéty, ukazuje
vzhled tolerance a limith zaloZzeném na aktualnim nastaveni stylu koty.

+0,015 3.389

3374 5008 3.366

Vytvorieni tolerance koéty

1. Provedte jedno z nasleduijicich:

- Zvolte Format > Kétovaci styl...

- Na panelu nastroju Kéty kliknéte na Stav kotovacich proménnych
- Napiste SETDIM a stisknéte Enter.

2. Vyberte Upravit a kliknéte na zaloZku Tolerance.

3. Napiste nebo vyberte dolni mez tolerance.

4. Napiste nebo vyberte horni mez tolerance.

5. Kliknéte na OK.

6. Vlozte koétu.



| Prepsat aktusini styl k

[ Cary | Symboly a &pky | Text [ Pizptsobt | Hawni ednatiy | Atemativni ednatiy | Toleranc |

Forméat tolerance

Metoda:

Presnost: C

Homi mez tolerance: ’f_\

Dalni mez tolerance: B
MEFitko wysloy:
Wertilcalni umisténi:

Zarovnani tolerance:

Potlageni nul

Stopy a palce

: | Hodnoty wychozi | | Wychozi nastaveni | | Ok || Stomo

A. Napiste nebo zvolte minimalni toleranci nebo horni mez tolerance.
B. Napiste nebo vyberte maximalni toleranci nebo spodni mez tolerance.

C. Napiste nebo vyberte desetinné Cislo zobrazujici se v limitech nebo tolerancich
kot.

D. Zvolte pro potlaéeni zahrnuti tvodni nuly nebo zahrnuti méfeni ve stopach.

E. Zvolte pro potlaceni zahrnuti koncové nuly nebo zahrnuti méfeni v palcich
v limitech koty, kdyzZ se ¢islo v palcich rovna nule.

13.20 Nastaveni jednotek alternativni koty

Kromé primarniho textu kéty, mizete zahrnout i alternativni kotu. Muzete také urcit
vzhled a format alternativni kéty, v€etné faktoru méfitka vyuzitém pro vytvareni
alternativnich két. Obrazek na pravé strané dialogového okna Spravce stylu kotovani
ukazuje vzhled koty na zakladé sou€asného nastaveni stylu koty.

=3 1/2* [B7.76mm]—




Vytvareni alternativni koty

1. Provedte jedno z nasledujicich:

- Zvolte Format > Kétovaci styl...

- Na panelu nastroju Kéty kliknéte na Stav kétovacich proménnych

- Napiste SETDIM a stisknéte Enter.

2. Vyberte Upravit a kliknéte na zalozku Alternativni jednotky.

3. Napiste nebo vyberte faktor pro méfitko.

4. Pro policko Pfipona, napiste pfiponu, kterou chcete pfichytit k alternativni kété.
5. Kliknéte na OK.

6. Vlozte kotu.

| CfE:!ry | Symboly a ‘s.'.ipl_q.- ::.Text Pﬁzptlsob.it Hlévﬁi_j_ednoﬂ;:y_ Altemativni jednoticy :-Tole.,mnc:e
V| Zobrazit attemativni jednothor A

MNastaveni altemativnich jednotek

Farmat jednoteGl Desetinné - |
Pfesnost: |00 ~|

L 3 : ! 2 T
Masobitel alter. jednotek F 25.4000 780000 [
Zaokrouhlt na: [= 0.0000
Predpona: H
PFipona:

1877000 C425

Umisténi: | Po hlawni hodnot& -

Potlaeni nul

B ] Uvodni C | Koncowe

Altemativni tolerance

Stopg:' a palce o B o |—I—D.DD = | Stn:u.:q.r a palce
stop palcu J i o el || O stop
| Potladit po&ate&ni nuly .
K [ Patiadi prebytedné nuly V1 0 paleh
E| | Hodnoty vychozi | | Vychozi nastaveni | | QK | | Stomio

A. Za$krtnéte pro zahrnuti alternativni koty.

B. Zvolte pro zabranéni zahrnuti tvodnich nul, nebo pro zahrnuti méreni ve stopach
u alternativnich kot, pokud je kota kratSi nez jednu stopu.

C. Zvolte pro zabranéni zahrnuti koncovych nul, nebo zahrnuti méfeni palct, pokud
Je Cislo palct nula.

D. Napiste nebo vyberte pocet desetinnych mist zobrazenych v alternativni koté.
E. Napiste nebo vyberte jakékoli zaokrouhleni alternativni koty.

v Vs

F. Napiste nebo vyberte faktor méritka pouZzity pro méfeni kot pro vytvoreni
alternativnich kot.



G. Zvolte format jednotek.
H. Napiste pfedponu nebo priponu, kterou chcete pripojit k alternativni koté.

1. Napiste nebo vyberte pocet desetinnych mist zobrazenych v limitech nebo
tolerancich zahrnutych jako soucast alternativnich kot.

J. Zvolte pro zabranéni zahrnuti tvodnich nul nebo zahrnuti méfeni stop v limitech
nebo tolerancich zahrnutych v alternativnich kétach.

K. Zvolte pro zabranéni zahrnuti koncovych nul nebo zahrnuti méreni v palcich v
limitech nebo tolerancich zahrnutych v alternativnich kotach.

14. Srafy

14.1 Srafy

Pokud do vykresu vlozite Srafovani, vyplni 4MCAD entity nebo uzaviené oblasti
ur€itym vzorem. MUzete si zvolit jeden z pfeddefinovanych vzorl nebo vytvofit
vlastni. Nejprve urcite vzor Srafy a dalSi moznosti a pak zvolite entity nebo uzaviené
oblasti pro Srafovani.

Pro otevieni dialogu Srafovani provedte jedno z nasledujicho:

- Zvolte Kreslit > Srafy...
- Zvolte nastroj Srafa na panelu nastroju Kresli
- Napiste bhatch a stisknéte Enter

14.2 Preddefinované vzory srafovani

Vzor Srafy se sklada z opakujiciho se vzoru &ar, mezer a te€ek. Je mozné vybirat ze
skupiny preddefinovanych vzor nebo definovat vzor vlastni. Posledni zvoleny vzor
je nastaven u pfistiho Srafovani jako vychozi. Pfeddefinované standardni vzory
Srafovani jsou uloZeny v souborech knihoven s nazvy icad.pat a icadiso.pat. Je
mozneé pouZzivat také externi knihovny jako jsou vlastni vzory nebo knihovny
dodavané vyrobci a standardizacnimi organizacemi.

Pro vybér preddefinovaného vzoru

1. Provedte jedno z nasledujiciho:

- Zvolte Kreslit > Srafa

- Zvolte nastroj Srafa na panelu nastroji Kresli
- Napiste bhatch a stisknéte Enter

2.V tabulce Srafy a pfechody zvolte zalozku "Srafy".

3. V seznamu typl vzorl zvolte Preddefinované. U pfeddefinovanych vzoru je
mozné nastavit méfitko pro zvétSeni nebo zmenseni vychoziho rozméru Srafy.



4. Pro zménu méfitka zadejte koeficient jako procento vychoziho méfitka.

5. Pro zménu uhlu zadejte uhel ve stupnich (1-360). Ve vychozim nastaveni je uhel
pocitan ve sméru hodinovych ruc€i¢ek; zadanim numerické hodnoty je mozné zmeénit
uhel jakéhokoli vzoru Srafovani.

6. Pro Sifku pera ISO zadejte jeji hodnotu. Pfi volbé pfeddefinovanych standardnich
vzorl ISO je mozné nastavit méfitko zaloZzené na ISO Sifce pera.

7. Pro zkopirovani vlastnosti z existujici Srafy zvolte Kopirovat vlastnosti na zalozce
Vlastnosti vzoru.

8. Pro asociaci Srafy s ohrani€ujicimi entitami zaskrtnéte volbu Asociativni.
Asociativni Srafa je automaticky aktualizovana, pokud zménite jeji hranice.

9. Srafujte jednim z nasledujicich zplisobu:

- Vyberte entity, které chcete Srafovat. Detaily naleznete v sekci Vybér entit pro
Srafovani.

- Vyberte oblast nebo hranici, kterou chcete Srafovat. Detaily naleznete v sekci Vybér
oblasti pro Srafovani.

14.3 Uzivatelské vzory sraf

Pro vytvoreni uzivatelského vzoru Srafy

1. Provedte jedno z nasledujiciho:

- Zvolte Kreslit > Srafa

- Zvolte nastroj Srafa na panelu nastroju Kresli

- Napiste bhatch a stisknéte Enter

2.V tabulce Srafy a prechody si zvolte zalozku "Srafy".
3. V seznamu vzoru kliknéte na Definované uzivatelem.

4.V poli Rozte€ zadejte rozte¢ Car Srafy.

5. Pro Srafovani kfizem zaSkrtnéte volbu Dvojita. Volba vlozi kopii uZivatelem
definovaného vzorku Srafy pooto€enou o 90 stuprfiti oproti prvnimu vzorku.

6. Pro kopirovani vlastnosti z existujiciho vzoru Srafy zvolte Zdédit vlastnosti a ve
vykrese zvolte Srafu pro kopirovani.

7. Pro asociaci Srafy s ohraniCujicimi entitami zaskrtnéte volbu Asociativni.
Asociativni Srafa je automaticky aktualizovana, pokud zménite jeji hranice.

8. Srafujte jednim z nasledujicich zpUsobd:

- Vyberte entity, které chcete Srafovat. Detaily naleznete v sekci Vybér entit pro
Srafovani.



- Vyberte oblast nebo hranici, kterou chcete Srafovat. Detaily naleznete v sekci Vybér

oblasti pro Srafovani.

Srafy a pfechody

}Rél’ﬁf}‘ Pfechod

Typ a vzor
B Typ: PFeddefinované v
(: Vzor: ANSIZ1 ~
D nahled:

at

Barva: “:IEYLAYEFE v||EZédné ~|Q

F UZivatelsky vzor:

Uhel a méfitko

Uhel: Mé&Fitko:
G o MRk ~[i
I-l D-,-'cjita'o Relativné k vykresovému prostoru
I Rozteé 1
J IS0 Sifka pera 1.00 mm
Pocatek srafy
K @ rousit aktudin pocatek
O PouZit zadany potdtek
L |
IVI Vychozi k mezim Srafy
= Vievo dole
N UloZit jako vychozi potatek
(7] dhled

Hranice

Pidat: Zadejte body

Pfidat: Vyberte entity

|
B

B

.| Zobrazit vybér

MoZnosti

[ Anotativni
Asocigtivni

[Jvytvoiit oddé&lené srafy

Pofadi kresleni:
Poslat za hranici
Hladina:

Pouzit aktudlni
Priihlednost:

PouZit aktualni
DN |

B | zdadit viastnosti

Storno

Ostrivky
Detekce ostrivki
Styl zobrazeni ostrévk:

R
e

(@) Normalni O vnéjéi () Ignorova

QO

72
=

Zachovani hranic
[Jzachovat hranice

Typ entity: Kfivka
Skupina hranic

Aktudlni wyiez =~ ot Novd

Tolerance mezery

Tolerance: IZ’ jednotek

Zdeédit vlastnosti
(@ Pouzit aktudlni poctek

(") Pouzit poatek zdrojové Srafy

A. Zvolte zalozku, abyste mohli vytvorit vzor pro Srafovani.

B. Zvolte typ vzoru pro Srafovani.

C. Zvolte preddefinovany vzor pro Srafovani ze seznamu nebo kliknéte na ... pro
vybér Srafovaciho vzoru z dialogového okna.

D. Kliknéte abyste zvolili Srafovaci vzor.

E. Zvolte barvu Srafovaci ¢ary.

F. Zvolte UZivatelsky vzor ze seznamu nebo kliknéte na ... pro vybér vzoru pro

Srafovani v dialogovém okné.

G. Pro zménu uhlu zadejte uhel ve stupnich (1-360). Ve vychozim nastaveni je thel
pocitan ve sméru hodinovych ruciCek; zadanim numerické hodnoty je mozné zmeénit

uhel jakéhokoli vzoru Srafovani.

H. Zvolte pro kfizové Srafovani uZivatelem definovaného vzoru.




1. Vlozte pro uréeni hustoty Srafovani pro uZivatelsky definované vzory.

J. Nastavuje Sitku pera pro standardni ISO vzory.

K. Zvolte jestli chcete vyuZit aktualni poCatek nebo zadany pocatek.

M. Zvolte pro nastaveni nové Srafy vlevo nahore, vpravo nahore, vlevo dole, vpravo
dole nebo ve stfedu nastavenych hranic.

N. Zvolte pro uloZeni hodnoty zadatku nové Srafy.

O. Zvolte pro méreni vzoru Srafy vzhledem k prostorovym jednotkam papiru. (Pouze
pro pojmenované layouty).

P. Pro zménu méfitka zadejte koeficient jako procento vychoziho méritka.
Q. Zvolte barvu pozadi Srafy.

14.4 Vybeér vzoru srafy z knihovny
Pro vybér vzoru Srafy z knihovny provedte jedno z nasledujiciho:

- Zvolte Kreslit > Srafa

- Zvolte nastroj Srafa na panelu nastroji Kresli

- Napiste bhatch a stisknéte Enter

2.V tabulce Srafy a pfechody zvolte zalozku "Srafy".

3. Zvolte knihovnu vzorl ze soubortd 4mcad.pat nebo 4mcadiso.pat.
4. Pro vybér pfeddefinavaného vzoru kliknéte na nahled vzoru.

5. Srafujte jednim z nasledujicich zptsoba:

- Vyberte entity, které chcete Srafovat. Detaily naleznete v sekci Vybér entit pro
Srafovani.

- Vyberte oblast nebo hranici, kterou chcete Srafovat. Detaily naleznete v sekci Vybér
oblasti pro Srafovani.



Hranice Ostriivky

Srafy  Prechod

Typ a vzor E Vzory srafovani

Typ: Preddefinovane 3 ANSI S0 Ostatni pfeddefinované Wlasini

Vzor: B |ansp1 BB A

Nahled: 22222222
G

ANSIZ

Barva: [ ] BYLAYER v|||§]2a’dne’ v|

UZivatelsky vzor:

|
(hel a mFitko ANSIIE ANSI36 ANSI37 ANSI3E
Uhel: Méfitko:

0 ~| 1 .

Dvojitd Relativné k vykresovému prostoru
Rozted
IS0 &itka pera 1.00 mm
Poé&dtek Srafy
(@) Pouzit aktudlni pocatek
() Pouzit zadany po&dtek

#

zi k mezim Srafy

UloZit jako vychozi pocatek

(2] Storno <
A. Knihovny vzort Sraf
B. Vypis vzort dle nazvu
C. Grafické nahledy vzort

14.5 Vybeér entit pro srafovani

Srafovat je mozné jakoukoli entitu, ktera vytvofi uzavienou hranici, napfiklad
obdélnik nebo kruznici. Srafovat je mozné samostatnou entitu nebo nékolik entit
najednou.

Pro vybér entit pro Srafovani

1. Provedte jedno z nasledujiciho:

- Zvolte Kreslit > Srafa

- Zvolte nastroj Srafa na panelu nastroju Kresli

- Napiste bhatch a stisknéte Enter

2.V tabulce Srafy a pfechody zvolte zalozku "Srafy".

3. Pod volbou Detekce ostriavku zvolte jednu z moznosti:

Normalni - vnéjsi entita i jeji ostrivky jsou detekovany pro Srafovani.

Vnéjsi - pouze vnéjSi entita a jeji vnéjsi ostravky jsou detekovany pro Srafovani.
Ignorovat - pouze vnéjsi entita je detekovana pro Srafovani.



Srafy a pfechody &
= Hranice Ostrivky
Srafy  PFechod
s, E [/| Detekee ostréivkd
Typ a vzor Pfidat: Zadejte body
Styl zobrazeni ostrivki:
Typ: Freddefinované et = 2
## | Pridat: Vyberte entity 7 R F Sl
Vzor: ANSI31 = ! 1 7 ?
& o D)) )
Nahled: = 7Nl - ez
£ (@) Norméini [@LYE () Iignorova
Zachovani hranic
Barva: “:‘ BYLAYER | | E‘ Zadne v | S| Zobrazit vybér []zachovat hranice
e . ty: KFivk
UZivatelsky vzor: MoZnosti Typ entity: il
Uhel a méfitko [] Anotativni Skupina hranic
Uhel: Méfitko: [~] asociativai Aktuginivifez || MNova
0 V| | 1 v [ vytvofit oddélené &rafy
e B Tolerance mezery
Dvojitd Relativné k vjkresovému prostoru Poradi kresleni: _
L 2 Tolerance: jednotek
Rozted 1
Hladina: e :
IS0 &itka pera 1.00 mm - e Zdé&dit vlastnosti
PouZit aktualni b ® i 7
i ) Pous ilni podat
Poatek &rafy N (@) Pouzit aktudini po&dte
(@ Pouzit aktudlni pogdtek S () Pouit poatek zdrojové Erafy
ouZit aktuglni ~
(O Pouzit zadany poatek
# : - N |
WWichozi k mezim Srafy
- F—H . c:
Vievo dole : @ Zdédit vlastnosti
L
UloZit jako vychozi pocatek
e Storno <

Normalni ostrivky (A), vnéjsi ostriivek (B) a ignorovani ostrivku (C).

4. Pro zachovani novych entit vytvofenych pro kresleni hranice zaskrtnéte volbu
Zachovat hranice. Stavajici entity jdou vzdy zachovany.

5. Kliknéte na Zadat entity.

6. Ve vykrese vyberte entity pro Srafovani individualné nebo zvolte metodu vybéru z
nabizenych moznosti. Pro ukonceni vybéru stisknéte Enter.

7.V tabulce Srafy a pfechody kliknéte na OK.
14.6 Vyber oblasti pro srafovani

Muzete vlozit Srafu do oblasti ohrani€ené zvolenymi entitami, které tvofi hranici Srafy.
Srafa je tvofeny uzavienou oblasti ne samotnymi entitami.

Po tom, co 4MCAD nakresli Srafu, pfistupuje k ni jako k samostatné entité, ktera je
jak asociativni tak nezavisla na entitach tvoficich jeji hranice.

Pro volbu oblasti pro Srafovani

1. Provedte jedno z nasledujiciho:



- Zvolte Kreslit > Srafa

- Zvolte nastroj Srafa na panelu nastrojil Kresli
- Napiste bhatch a stisknéte Enter

2.V tabulce Srafy a prechody zvolte zalozku "Srafy".

3. Pod volbou Detekce ostrivka zvolte jednu z moznosti:

Normalni - vnéjsi entita i jeji ostrivky jsou detekovany pro Srafovani.
Vnéjsi - pouze vnéjSi entita a jeji vnéjSi ostravky jsou detekovany pro Srafovani.
Ignorovat - pouze vnéjsi entita je detekovana pro Srafovani.

4. Pro zachovani novych entit vytvofenych pro kresleni hranice zaskrtnéte volbu

Zachovat hranice. Stavajici entity jdou vzdy zachovany.

5. Kliknéte na Vyberte entity.

6. Ve vykrese kliknéte na okruh co nejbliZze k hranici, ne na hranici samotnou. Pokud
je to potfeba, pokracujte v klikani na dodate¢né uzaviené okruhy.

7.V tabulce Srafy a pfechody kliknéte na OK.

Srafy a pfechody

Srafy  prechod

Typ a vzor

Typ: Preddefinované ~
Vzor: ANSIZ1 fd
Nahled:

[ || s 3
B =
anva: ([ ]BYLAYER v ||] Zadns

UZivatelsky vzor:

Uhel a méfitko

IS0 Sitka pera 1.00 mm

Pocatek srafy
(@ Pouzit aktudini pocdtek
(O Pouzit zadany pocatek
|
Vychozi k mezim Srafy
Vievo dole

UloZit jako vychozi potatek

Uhel: Mé&fitko:

; giE -
Dvojitd Relativné k vykresovému prostoru

Rozted 1

m O 0O @ >

Hranice

Pfidat: Zadejte body

i# |  Pridat: Vyberte entity

.| Zobrazit vybér

MoZnosti

[ Anotativni

[v] Asaciativni

[Tvytvofit oddélené Erafy
Poradi kresleni:

Poslat za hranici

Hladina:

PouZit aktualni
priihlednost:

PouzZit aktualni
D |

@’ Zdédit vlastnosti

Storno

Ostrivky
Detekce ostrivki

Styl zobrazeni ostrévk:

7.
[ ]
Y

= s
(®) Normalni

O vnéjéi

O Ignorova

Zachovani hranic
[Jzachovat hranice
Typ entity: Krivka

Skupina hranic

Aktudlni wfez =~ o Novd
Tolerance mezery

Tolerance: IZ’ jednotek

Zdédit vlastnosti
(@ Pouzit aktudlni poctek

C' PouZit pocatek zdrojove Srafy

A. Uréuje hranice z existujicich objektd, které formuji uzavienou oblast kolem

specifického bodu.




B. Urcuje ohranic¢eni ze zvolenych objektu, které formuji uzavienou oblast.

C. Odstrariuje z definované hranice vSechny dfive pridané objekty.

D. Vytvari kifivku nebo oblast kolem zvolené Srafy nebo vyplné a volitelné spojuje
Srafu s objektem, ktery se tam nachazi.

E. Dogasné uzavre dialogové okno Srafy a pfechody a zobrazi aktualné definované
hranice s aktualnim nastavenim Sraf nebo vypini. Tato moznost neni dostupna, kdyz
neni definované ohraniceni.

14.7 Vzory sraf
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Zde naleznete nahledy zakladnich vzoru Sraf v programu 4MCAD. Vzory jsou
definovany s souboru icad.pat a také jsou umistény v souboru Hatch_patterns.dwg.
Muzete si také zobrazit nahledy Vzoru Sraf 1ISO.
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Note: All pattems are shown at 100% scale unless
otherwise noted, All pattems are 0 degreo rotaton,
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14.8 Vzory sraf ISO

Na obrazku jsou nahledy ISO vzora Sraf dostupnych v programu 4MCAD v souboru
icadiso.pat. Nahledy stadradnich vzor( ¢ar naleznete na strance Vzory Sraf.

ANSIZ1@1200 IICAD_ISC-:?N1'IOJ1.?01" -"AQ_ISCIC’HTODGSI?:(N-

‘k_.‘_él,ém,i n_'}:m :I:I.I}_ISC-JS‘MO)M.?Q#{ ;':AJJSSHW'.OO\:!,?:tVn»
f‘isia‘i.‘il"ai':m j»:l.n_lsc-::m:'o-u.'zox; E-:An_lsslzavtooau?:mj
ez R o
usws-x |»bj:m "mu_lsoxwi-:o;z{.'zor: ?-:A:;_ns.‘m;v-,rooaru?:m:

ANSI2@120h  ICAD_ISOORWIN0@ 1200 1CAD_ISO15W100@ 120th

ANSISTRI20h  ICAD_ISOOSWI00@1/20m

S —— e

ANSIZE@IZ20n  ICADISCOUWI00@ 1200

Note: Al patterns are shown al 100%: scale unless
otharwise noted, All pattems are O dagree rotation,
Some pattems conlaning simple dots may appear
different when printed depending on your printers
resolution.

Copyright © 1599 InlelliCAD Technolegy Consortium
IntelsCAD Hatch Pattems, Release 1.0

So0 file: icadiso.pat

This software provided “as is” without express or
implied warranty.

14.9 Srafovani prechodem

Ve 4MCAD muzete Srafovat i pfechodem. Tento zplGsob Srafovani vytvofi barevny
pfechod mezi odstiny jedné barvy nebo dvou barev.

Pro Srafovani pfechodem

1. Provedte jedno z nasledujiciho:

- Zvolte Kreslit > Srafa

- Zvolte nastroj Srafa na panelu nastroju Kresli
- Napiste bhatch a stisknéte Enter

2.V tabulce Srafy a pfechody zvolte zalozku "Pfechod".

3. U moznosti Barva si zvolte jednu z nasledujicich moznosti:



- Jedna barva — specifikuje, Ze vypli bude tvofit pozvolny pfechod mezi tmavsimi a
svétlejSimi odstiny jedné barvy. KdyZ zvolite moZnost jedna barva, na tladitku ...
muzete vybrat tu, kterou chcete pouzit. Objevi se i posuvnik, na kterém muzete zvolit
intenzitu stinu a odstinu zvolené barvy.

- Dvé barvy — specifikuje, Ze pro vypli se vyuzije plynuly pfechod mezi dvéma
barvami. Kdyz zvolite moznost dvé barvy, pomoci tlaCitek ... zvolite barvy, které
chcete vyuzit.

4. Ze vzorek barev pak vyberte tu, kterou chcete vyuzit pro barevnou vypln.

5. Specifikujte orientaci pfechodu a jeho symetri¢nost.

Srafy a pfechody 2

A

Hranice Ostrivky
éraﬁ( Pfechod

Pridat: Zadejte body Detekce ostrivkd

Barva Styl zobrazeni ostrivk:
B () Jedna barva (@) Dvé barvy % | Pridat: Vyberte entity E '
S e Ddstranit nranice @
(@) Norméini [@LYE () Iignorova

. Zachovani hranic
|% | Zobrazit vyb&r []zachovat hranice
Typ entity: Kfivka

MoZnosti

H [] Anotativni Skupina hranic
E Asaciativni Aktudlnivifez v~ | gp  Nova
2 [ vytvofit oddélens Erafy

Tolerance mezery

? : Pofadi kresleni:
: Tolerance: IZ' jednotek
: Poslat za hranici v
Hladina:

2Zdédit viastnosti
PouzZit aktualni v
Orientace (@) Pouit aktudlni poctek
Prihlednost: o
e e PouZit pofatek zdrojové Srafy
F [“]vystiedsné  Uhel: G |Puu2|'t aktualni V‘

KN |

F3 | zdadit viastnosti

@  néhled oK Storno <

A. Vyberte zalozku Prechod pro tvorbu Srafy pfechodem.

B. Zvolte pro specifikaci pfechodu jedné nebo dvou barev.

C. Zvolte prvni barvu a kliknéte na ..... pro vybér barvy.

D. Pokud jste zvolili dvé barvy, vyberte druhou barvu kliknutim na ... tlaCitko.
E. Zvolte vzor pro Srafovani.

F. Zvolte pro vycentrovani Srafy, pokud moznost Vystfedéné nezvolite, vzor se
posune nahoru a vlevo.

G. Zvolte uhel Srafovani.



15. Vyber entit

15.1 Metody vybéru entit

Kdyz zvolite pfikaz, ktery vyzaduje abyste zvolili entity (napfiklad mazani nebo
zménu entit), mazete je vybrat z nabidky pfikazu nebo jejich zadanim v pfikazovém
fadku:

Vybér vSech entit (ALL) - vyberete vSechny entity z aktualniho vykresu.

Pridat do vybéru (+ nebo A) - pfidate jednu nebo vicero entit do aktualni mnoziny
entit.

Odebrat z vybéru (- nebo R) - odstranite jednu nebo vicero entit z aktualni mnoZziny
entit.

Predchozi vybér (P) - vybere entity obsazené v pfedchozi vybérové entité.

Posledni entita ve vykrese (L) - vyberete entitu, které byla do vykresu pfidana jako
posledni.

UvnitF okna (W) - vyberete entity obsazené uvnitf pravouhlého vybéroveého okna.

KFizujici okno (C) - vyberete entity obsazené nebo protinajici hranice pravouhlého
vybérového okna.

Vnéjsi okno (O) - vyberete entity nachazejici se kompletné mimo pravouhlého
vybérového okna.

Polygonové okno (WP) - vyberete entity, které jsou obsazené uvnitf
mnohouhelnikové vybérového okna.

KfFizujici polygon (CP) - vyberete entity, které se nachazeji uvnitf nebo jsou protnuté
mnohouhelnikovym vybérovym oknem.

Vné polygonového okna (OP) - vyberete entity, které jsou celé mimo vybérového
mnohouhelnikového okna.

Kruhové okno (WC) - vyberete entity obsazené uvniti kruhového vybérového okna.

KfFizujici kruznice (CC) - vyberete entity obsazené uvnitf nebo protinajici kruhové
vybérového okna.

Vnéjsi kruznice (OC) - vyberete entity, které jsou celé mimo kruhového vybé&rového
okna.

Bod (PO) - vyberete jakykoliv uzaviené entity, které obklopuji zvoleny bod.

Plot (F) - vyberete entity protinajici Caru nebo segmenty Cary.



Vybér podle vlastnosti (PRO) - vyberete entity, které maji odpovidajici viastnost -
napfiklad, vSechny entity, které se nachazeji na konkrétni vrstvé nebo jsou
nakreslené konkrétni barvou.

Muzete vyuzit i nékolika metod automatického vybéru bez jejich zobrazeni v nabidce
prikazu. Napfiklad, muzete jednoduse kliknout na vybrané entity nebo muzete vyuzit
vybér entit uvnitf nebo protinajici vybérové okno tak, Ze zadefinujete protilehlé rohy
Ctvercového vybérového okna. Smér, kterym natahnete vybérové okno (zprava
doleva nebo zleva doprava) ur€uje typ okna, které jste vytvofili.

Pro vytvoreni okna pro vybér Uvniti okna

1. Kliknéte na zvoleny bod vykresu.
2. Kliknéte nejprve na pravou stranu od zvoleného vybéru a pak zvolte druhy bod ve

vykrese.
= e
A : I |LI:' we |
L | i bt gt

Uvnitr okna - vybér probiha od bodu A po bod B (zleva doprava).
Vysledni vybér.

Tato metoda se vyuziva nejCastéji, protoze je jednoducha.

Pro vytvoreni okna pro vybér Protinajici okno

1. Kliknéte nejdfive na bod ve vykrese.

2. Kliknéte na levou stranu od entity, kterou chcete zvolit a pak vyberte druhy bod
vybérového okna.

Protinajici okno - vybér probiha od bodu A po bod B (zprava doleva).
Viysledni vybér.

Kromé Ctvercoveho vybérového okna mizete definovat i jiné tvary jako
mnohouhelnik, kruh nebo plot. (Cara, ktera umoziuje vybrat entity, které protina.)

Vybér entit pomoci Polygonového okna

1. Aktivujte pfikaz pro modifikaci entit:

- v panelu Modifikace Il zvolte polozku Upravit atributy
2. Ve vybérovém okné zvolte Inkluzivni polygon.

3. Nakreslete poZzadovany mnohouhelnik.

4. Pro potvrzeni vybéru stisknéte Enter.



N

Polygonové okno je specifikované vrcholy (A, B, C).
Viysledni vybér.

Pro vybér entit pomoci Plotu

1. Aktivujte pfikaz pro modifikaci entit:

- v panelu Modifikace Il zvolte poloZzku Upravit atributy
2. Ve vybérovém okné zvolte Plot.

3. Upfesnéte koncové body segmentu Plot.

4. Pro potvrzeni vybéru stisknéte Enter.

B
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Plot specifikovany koncovymi body (A, B, C).
Vysledni vybér.

Pro vybér entit za vyuziti jejich vlastnosti

1. Aktivujte pfikaz pro modifikaci entit:

- na panelu nastroju zvolte Modifikace > Vlastnosti.

2. Ve vybérovém okné zvolte Vybrat dle vlastnosti.

3. Zvolte moznost pro vybér: Barva, Blok, Hladina, MéFitko tloustky &ar, Typ Cary,
Tloustka ¢ary, Proxy, Typ, Hodnota (atributu, textu nebo vicefadkového textu), Sitka
(poly&ar).

4. Provedte vybér v zavislosti od zvolené moznosti.

5. Pro potvrzeni vybéru stisknéte Enter.

15.2 ZruSeni vybéru entit

Pokud entity v aktualnim vybéru jiz nepotfebujete, mizete vybér zrusit odstranénim
entit z vyb&rové mnoziny.

Pro odstranéni entit z vybérové mnoziny
1. Stisknéte Shift a pak provedte novy vybér entit.

Poznamka:
Pokud drzite Shift stlaceny v prab&hu vybéru entit s vyuzitim protinajiciho okna
odstranite vSechny entity ze specifické vybérové mnoziny.

Pro odstranéni vSech entit z vybérové mnoziny



1. Stisknéte Escape.

15.3 Rychly vybeér entit

V panelu vlastnosti ¢i pfe menu je k dispozici Rychly vybér entit (filtr), ktery umozni
vybrat najednou vSechny entity v aktualnim vykrese dle jejich vlastnosti.

Zvolte Nastroje > Rychly vybér

Rychly vjbér X
Aplikovat na: | Cely wykres it "{:ITE
Typ entity: |Bloky i
Bloky
Vlastnosti: [Oblouk
Definice atributu
VloZeni
KruZnice
Dimension
Elipsa
Srafa
Svétlo
Usecka
MText
Bod
KFivka
Operator:
Hodnota:
Jak pouZit:

(@) Ffipojit k nové vyb&rové mnoZing

() Wyjmout z nové vibérové mnoZiny

[ ] Ffipojit k aktudlni vwbérové mnoZing
[«] Vypsat existujici textové hodnoty

°

Dialogové okno Rychlého vybéru nabizi nékolik moZnosti nastaveni vybéru dle
vlastnosti

V prvnim menu Aplikovat na zvolte oblast aplikace vybéru mezi moznostmi:

Cely vykres | Volba je k dispozici vzdy

Aktualni vybér | Volba je k dipozici, pokud jiz ve vykrese néjaka vybérova mnozina
existuje.

V menu Typ entity zvolte na jaké entity dle jejich druhu bude rychly vybér aplikovan.
V dalSich polich Vlastnosti, Operator a Hodnota mazete definovat dalSi

podrobnéjsi kritéria vybéru.
Pokud si dali kritéria nepfejete nastavit, zvolte moznost Vybrat vSe v poli Operator.



V dolni &asti dialogového okna jsou dale k dispozici moznosti:

Jak pouzit

Pfipojit k nové vybérové mnoziné

Vylougit z vybérové mnoziny

nebo mate moznost zaskrtnout volby Pridat k aktualni vybérové mnoziné.

15.4 Zvyrazneni vybranych entit

Muzete nastavit, aby byly vybrané entity zvyraznény, coZz umoznuje vybérovou
mnozinu lépe vidét. Ve vychozim nastaveni je tato funkce zapnuta.

Pro zapnuti nebo vypnuti zvyraznéni vybranych entit

1. Provedte jedno z nasledujiciho:

- Zvolte Nastroje > Nastaveni kresleni...

- V panelu nastroja Standard, kliknéte na nastroj Nastaveni kresleni.
- Napiste settings a stisknéte Enter

2. Zvolte zaloZku Zobrazeni.

3. Tam zvolte zalozku Zobrazeni.

4. Zaskrtnéte nebo odSkrtnéte volbu Zvyraznit polozku pfi vybéru

5. Potvrdte tladitkem OK.



B | Nastaveni vykresu O *

Maodifikace entit Mastaveni 3D Dynamické zadani
Jednotky vykresu: Zadani soufadnic Zobrazeni Tvorba entit

Zobrazeni soufadnic

() Aktualizovat soufadnice pouze pifi vyb&ru bodu
() Soufadnice vidy zobrazuji umisténi kurzoru

(@) Soufadnice v poldrnim tvaru pro wjbér vzddlenosti a thlu

Zobrazeni Meze Tloudtky Ear Uzly Rozhrani programu  Zobrazeni

[#] Zobrazit plnou vyplii pro roviny, kiivky a stopy
[ ]Zapnout rychly text
[«] Zvyraznit polozku pfi vybéru

[ | Zobrazitbody znatky
Ptetahovani entit lkona USS
() Bez pietahovani () Vypnuta
() Zapnout pfetahovani na pozadani (@ Zapnuta
(@) Je-li mozné, zapnout pietahovani (W poéatku USS

@

Pro nastaveni kdy a jakym zplsobem zobrazovat vybrané entity zvolte v menu:

Nastroje > Moznosti > zalozka Vybér



MoZnosti

Obecné Cesty/soubory Zobrazeni Profily Tisk  Uchopeni Schranka Vybér

Velikost vybéroveého teréiku WVelikost uziu

BB I O

Mahled vybéru Uzly
| KdyzZ je aktivni pfik
yZ je aktivni pfikaz Birie
[«“] Kdy2 neni aktivni pikaz
‘-0,127,255 v
Mastaveni vizualniho efektu...
ReZimy vybéru [ zapnout uzly
[v]Vjbér pied pitkazem [ ] Zapnout uzly v ramei blok
PouZit klavesu Shift pro pfidani k
wybéru Povaolittipy pro uzly
[ ] stisknout a t3hnout

[v] Implicitni okna uzl

[] Skupiny objektu

[ |Hranice asoc. Srafovani

&

Limit vybéru objektu pro zobrazeni

Zrusit

Muzete nastavit nahled vybéru:

- Kdyz je aktivni pfikaz
- KdyzZ neni aktivni pfikaz

Obé volby jsou ve vychozim nastaveni zapnuty.
Vybrané entity mohou byt zobrazeny:

- Carkované

- Silné

- Kombinaci obou efektl

Jako vychozi je zvolena moznost "Oboji".

15.5 Velikosti vybérového terciku

Velikost terCiku, ktery slouzi pro vybér jednotlivych entit nastavte pomoci:

Nastroje > Moznosti > zalozka Vybér




Moznosti *

Obecné Cesty/soubory Zobrazeni Profily Tisk  Uchopeni Schranka Vybér

Velikost vybéroveého teréiku WVelikost uziu

BB I O

Mahled vybéru Uzly
| KdyzZ je aktivni pfik
yZ je aktivni pfikaz Birie
[«“] Kdy2 neni aktivni pikaz
‘-0,12?,255 v
Mastaveni vizualniho efektu...
ReZimy vybéru [ zapnout uzly
[v]Vjbér pied pitkazem [ ] Zapnout uzly v ramei blok
PouZit klavesu Shift pro pfidani k
wybéru Povaolittipy pro uzly
[ ] stisknout a t3hnout

Limit vybéru objektu pro zobrazeni
uzl

[«]Implicitni okna
[] Skupiny objektu

[ |Hranice asoc. Srafovani

@

V &asti Velikost vybérového teréiku zvolte velikost v pixelech a potvrdte tlacitkem
OK.

16. Modifikace

16.1 Modifikace entit

4MCAD nabizi mnoho nastroj pro Upravy entit ve vykrese. Muzete jednoduse
posunovat, otacet, protahovat entity ve vykrese nebo ménit jejich méfitko. Pokud
budete chtit entitu odstranit, je to mozné pouhymi nékolika kliky mysi. MGzete také
vytvaret nasobné kopie entit nebo kopirovat entity z jednoho vykresu do jiného.
VétSinu entit je mozné upravovat pomoci obecnych editacnich nastrojd, z nichz
vétSina je umisténa na panelu nastroji Modifikace a ve stejnojmenném menu.
Komplexni entity mohou vyZadovat specialni pfikazy.

Tato sekce popisuje jak:

- Ménit vlastnosti entit
- Upravovat entity jejich posunem, ota€enim nebo zménou pofadi vykreslovani



- Ménit velikost entit pomoci natazeni, zmény méfitka, prodlouzenim, ofezem nebo
upravou délky

- Rozdélovat a spojovat entity

- Seskupovat entity

- Editovat kfivky

- Rozkladat entity

- Vytvaret zaobleni a zkoseni

16.2 Tvorba skupin

Skupina je mnozinou entit, které jsme ulozili jako jednu jednotku. Po poCate¢nim
vybéru je mozné do skupiny entity pfidavat, odstrafiovat a pfeskupovat. Pokud je to
potfeba, je mozné skupinu zru$it a pracovat s entitami samostatné.

Dialogové okno Skupina Fidi nastaveni pro vdechny skupiny ve vykrese.

Skupina x

Nazev: Popis: Volitelne:

Vypsat skupiny dle entity > Zvyraznit vybranou skupinu > []Zobrazit nepojmenované skupiny

Wytvofit novou skupinu

Nazev: Popis:

| | | | [AVolieiné

DVWOFHjako nepojmencvanou skupinu brat entity a vvtvoiit skupinu =
Upravit vybranou skupinu

Nazev: Popis:

|| | OVvolitelné
Prejmenovat skupinu Zmeénit popis skupiny Uspofadat entity...
Pfidat entity ke skuping > Qdebrat entity ze skupiny > | Qdstranit skupinu entit

@

Kdyz tvofite skupinu, zadate jeji jméno, popis a pak zvolite entity, které do ni budou
patfit.

Pro vytvoreni skupiny

1. Vykonejte jedno z nasledujiciho:

- zvolte Nastroje > Skupina

- na panelu Nastroju Modifikace Il kliknéte na tlacitko Skupina
- napiste group a stisknéte Enter



2. Pod Vytvofit novou skupinu napiste jméno a popis skupiny.

3. Zatrhnéte Volitelné, pokud chcete, aby se automaticky vybraly vSechny entity,
pokud oznacite jednu entitu ze skupiny ve vykrese.

4. Kliknéte na Vytvofit entity a vytvofit skupinu.

5. Zvolte entity, které chcete vioZit do skupiny a stisknéte Enter.

6. V dialogovém okné skupina kliknéte na OK.

Tip: Mazete zadat jméno skupiny v pfikazovém fadku po vybéru entit.
16.3 Modifikace skupin

Pro modifikaci skupin a jejich entit

1. Vykonejte jedno z nasledujiciho:

- zvolte Nastroje > Skupina

- na panelu Nastroju Modifikace Il kliknéte na tlaCitko Skupina

- napiste group a stisknéte Enter

2. Vyberte skupinu, kterou chcete zménit.

3. Pod Upravit vybranou skupinu, vykonejte jedno z nasledujiciho:

- Zadejte noveé jméno a kliknéte na Pfejmenovat skupinu.

- Zadejte novy popis a kliknéte na Zménit popis skupiny.

- Vyberte, jestli chcete Uspofadat entity ve skupiné.

- Kliknéte na Pridat entity ke skupiné, vyberte entity, které chcete ke skupiné pfidat a
kliknéte Enter.

- Kliknéte na Odebrat entity ze skupiny, zvolte entity, které chcete ze skupiny odebrat
a stisknéte Enter.

4.V dialogovém okné Skupina kliknéte na OK.

Pro zménu poradi entit ve skupiné:

1. Vykonejte jedno z nasledujiciho:

- zvolte Nastroje > Skupina

- na panelu Nastroju Modifikace Il kliknéte na tlacitko Skupina

- napiste group a stisknéte Enter

2. Pod Upravit vybranou skupinu kliknéte na Usporadat entity.

3. V dialogovém okné Usporadat entity vyberte skupinu, kterou chcete usporadat.

4. Abyste vidéli pofadi entit ve skupiné, kliknéte na Zvyraznit. Pokracujte podle Sipek,
které se zobrazi, abyste si prohlidli entitu po entité.

5. Pro obraceni pofadi uspofradani entit ve skupiné kliknéte na Opacné poradi.

6. Pro zménu pofadi specifickych entit nebo rozsahu entit:



- Na Odebrat z pozice - zadejte aktualni pozici entity
- Na Umistit na pozici - zadejte novou pozici entity
- Na Pocet entit - zadejte pocet entit nebo rozsah entit, které chcete preusporadat.

Napfiklad pokud chcete zménit pofadi pouze jediné entity, zadejte 1.
- Kliknéte na Uspofadat.

Poznamka: Entity ve skupiné maji isla 0, 1, 2, 3 atd.

7. Kliknéte na OK a pak zase na OK.

16.4 ZruSeni skupiny entit

Kdyz rusite skupinu entit, entity zUstavaji na vykrese, ale z vykresu je smazana
skupina.

Pro zruseni entit

1. Vykonejte jedno z nasledujiciho:

- zvolte Nastroje > Skupina

- na panelu Nastroju Modifikace Il kliknéte na tlacitko Skupina
- napiste group a stisknéte Enter

2. Vyberte skupinu, kterou chcete smazat
3. Pod Upravit vybranou skupinu stisknéte tlacitko Odstranit skupinu entit.

4. Kliknéte na OK.
16.5 Modifikace viastnosti

Je mozné ménit hladinu, tloustku, typ ¢ary, barvu nebo méfitko typu €ary jedné nebo
vice entit. V zavislosti na typu vybrané entity nebo entit je mozné ménit také dalSi
vlastnosti jako pocateéni a koncové body €ar, stfed a polomér kruhu a vrcholy kfivek.
Je mozné upravovat vSechny viastnosti vSech entit zaroven. Napfiklad s pouZitim
pfikazu entprop vyberte entity v urcité hladiné a jednoduse je pfesunte do jiné
hladiny jejim vybérem v panelu vlastnosti. Zmény provedené v dialogu Vlastnosti
entit v polich Hladina, Barva, Tloustka, Typ ¢ary a Méfitko typu Cary ovlivauji
vSechny vybrané entity. Pokud je vybrano nékolik entit s rGznymi vlastnostmi je
vychozi hodnotou Varies (RGzné). Zmény provedené v zalozkach entit jako Kruznice,
Usecka nebo oblouk ovlivni véechny vybrané entity tohoto typu. Entity pro zmé&nu
vlastnosti je mozné vybrat jakoukoli metodou vybéru.

Pro zménu vilastnosti entit

1. Provedte jedno z nasledujiciho:

- Zvolte Modifikace > Vlastnosti

- V panelu nastroju Modifikace, kliknéte na nastroj Vlastnosti.
- Napiste entprop a stisknéte Enter.

2. Vyberte entity a stisknéte Enter.

3. Provedte zmény pozZzadovanych vlastnosti a stisknéte Enter.



Mnoho vlastnosti entit mizete také ménit na panelu nastroji Vlastnosti. Nastaveni
zobrazené na panelu nastroju Vlastnosti pokud neni vybrana zadna entita, urCuje
vlastnosti nové vytvofenych entit.

Dialog Vlastnosti entit na nasleduijici ilustraci ma nékolik sekci. Zalozka Obecné v
horni ¢asti dialogu entit zobrazuje vlastnosti spolecné vSem entitam jako Hladina,
Barva, Tloustka, Typ ¢ary, Méfitko typu ¢ary a Tloustka. Spodni sekce dialogu
Vlastnosti entit zobrazuje vlastnosti specifické pro vybrané entity.
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16.6 Mazani entit

Vybrané entity je mozné z vykresu odstranit. Je to mozné s pouzitim jakékoli metody
vybéru entit.

Pro smazani vybranych entit

1. Provedte jedno z nasleduijicich:

- Zvolte Modifikace > Vymazat

- V panelu nastroju Modifikace, kliknéte na nastroj Vymazat.

- Napiste delete a stisknéte Enter

2. Vyberte entity a stisknéte Enter.



Entity mGzete také vybrat dopfedu a pouze stisknout klavesu Delete.

16.7 Kopirovani

Muzete kopirovat jednu nebo vice entit vytvofenim jedné kopie nebo nasobnych kopii
v aktualnim vykresu. Entity mGzete kopirovat také mezi vykresy.

Poutzijte jakoukoli z nasledujicich metod pro kopirovani entit v aktualnim vykresu:
- Kopie v pozici vztazené od originalu.
- Kopie rovnobézna s originalem.

- Kopie jako zrcadlovy obraz originalu.
- VytvozZeni nékolika kopii v pravouhlém nebo kruhovém vzoru.

16.8 Kopirovani entit uvnitr vykresu

Muzete duplikovat entity uvniti aktualniho vykresu. Nejcastéjsi metodu je vytvoreni
vybérové mnoziny a urCeni pocatecniho nebo zakladniho bodu, koncového nebo
cilového bodu pro kopii. MUzete také vytvaret nasobné kopie nebo kopirovat vybér
na pozici uréenou smeérovym vektorem.

Pro kopirovani vybéru

1. Provedte jedno z nasledujiciho:

- Zvolte Modifikace > Kopie

- V panelu nastroji Modifikace, kliknéte na nastroj Kopie.

- Napiste copy a stisknéte Enter

2. Vyberte entity a stisknéte Enter.

3. Uréete zakladni bod.

4. UrCete cilovy bod.

X

Entity pro kopirovani (A), zakladni bod (B), cilovy bod a vysledek.

16.9 Posun

Vychozi metodu je vytvoreni vybérové mnoZziny a uréeni pocate¢niho nebo
zakladniho bodu a koncového nebo cilového bodu posunu entit. Entity je mozné
presunout také zadanim vektoru.

Pro posun vybérové mnoziny provedte jedno z nasledujiciho:
- Zvolte Modifikace > Posun

- V panelu nastroju Modifikace, kliknéte na nastroj Posun.
- NapisSte move a stisknéte Enter



2. Vyberte entity a stisknéte Enter.
3. Uréete zakladni bod.

4. UrCete cilovy bod.

Pro posun entity vyberte (A), zékladni bod (B) a cilovy bod (C).

Entity je také mozné posunout diky jejim vrcholim. Pro posun entity vyberte a
zobrazi se jeji jednotlivé body, kliknéte na vrchol a tazenim jej pfesunte. Vrchol, diky
kterém se posune cela entita zavisi na typu entity. Napfiklad u usecky jde o bod v jeji
poloviné. Pro posun zakfivené entity jako oblouk, kruznice nebo elipsa zvolte jeji
stfed. Ne vSechny entity je mozné pres jejich vrcholy posunout.

Pro presun entity s pomoci vrcholil

1. Vyberte entitu.

2. Kliknéte na vrchol pro jeho vybér.

3. Presunite entitu na novou pozici.

4. Kliknéte pro jeho uvolnéni.

16.10 Otoceni

Entity je mozné otacet kolem urCeného bodu o zadany uhel nebo o referenéni uhel
od zakladniho Uhlu. NejpouzivangjSim zplsobem otaceni entit je pouziti relativniho
uhlu od jejich aktualni orientace.

Pro otoCeni vybérové mnoziny.

1. Provedte jedno z nasledujiciho:

- Zvolte Modifikace > Oto¢it

- V panelu nastroji Modifikace, kliknéte na nastroj Otogit.

- Napiste rotate a stisknéte Enter

2. Vyberte entity a stisknéte Enter.

3. UrGete zakladni bod otaceni.

4. Zadejte uhel otoceni.



)]
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Pro otoceni entity vyberte poZadovonou entitu (A), uréete bod otaceni (B) a uhel
otaceni (C).

Pro otoCeni vybérové mnoziny vzhledem k zakladnimu uhlu.
1. Provedte jedno z nasledujiciho:

- Zvolte Modifikace > Oto¢it

- V panelu nastroja Modifikace, kliknéte na nastroj Otogit.

- Napiste rotate a stisknéte Enter

2. Vyberte entity a stisknéte Enter.

3. UrCete zakladni bod otaceni.

4. Zvolte vyzvu zakladni uhel (B).

5. Uréete zakladni uhel.

6. UrCete novy uhel.



Pro otoceni entity o referenéni uhel vzhledem k zakladnimu uhlu vyberte entitu (A),
urcete bod otoceni (B), vyberte zakladni thel tak, Ze nejprve znova kliknete bod
otaceni (B) a urcite druhy bod zakladniho thlu (C). Nakonec zvolite bod uréujici novy
uhel (D).

16.11 Natazeni

Velikost entit je mozné zménit natazenim jejich délky. Pro natazeni je nutné vybrat
entity bud pomoci protinajiciho obdélnikového nebo polygonového okna. Pak zadate
vzdalenost nebo zakladni a cilovy bod. U entity protinajici okno nebo polygonovou
hranici jsou natazeny; entity, které leZi celé uvnitf okna jsou posunuty.

Pro natazeni entity

1. Provedte jedno z nasledujiciho:

- Zvolte Modifikace > Natahnout

- V panelu nastroji Modifikace, kliknéte na nastroj Natahnout.

- Napiste stretch a stisknéte Enter

2. Vyberte entity pomoci protinajiciho okna nebo polygonu. Vrcholy entit, které
budete chtit pfesunout musi lezet uvnitf okna nebo polygonu.

3. Vyberte entity a stisknéte Enter.
4. UrCete zakladni bod.
5. Ur€ete druhy bod vzdalenosti.

Pro nataZeni entit je vyberte protinajicim oknem nebo polygonem (A), zadejte
zakladni bod (B) a cilovy bod (C) vzdalenosti.



Pro natazeni entit s pouzitim vrcholU vyberte entitu, aby byly zobrazeny vrcholy a
vyberte vrchol, aby byl aktivni. Stane se zakladnim bodem. Pak jej pfesunete na
novou pozici. Vrchol pro vybér zavisi na typu entity. Napfiklad pro natazeni vrcholu
obdélniku zvolite poZzadovany roh. Pro nataZzeni usecky je nutné zvolit koncovy bod.
Ne u v3ech entit je natazeni pfes jejich vrcholy mozné.

Pro natazeni s pomoci vrcholu
1. Vyberte entitu.

2. Kliknéte na vrchol pro jeho aktivaci.



3. Pfesunte vrchol.
4. Kliknéte pro jeho uvolnéni.

16.12 Meritko

Velikost entit je mozné zménit zménou jejich méfitka ve vztahu k zakladnimu bodu.
Je také mozné pouzit koeficient méritka referencni k zakladnimu koeficientu,
napfiklad ur€enim aktualni délky entity a zadanim délky nové.

Pro zménu méfitka vybéru koeficientem méfitka

1. Provedte jedno z nasledujicich:

- Zvolte Modifikace > MéfFitko.

- V panelu nastroja Modifikace, kliknéte na nastroj Méfitko.

- Napiste scale a stisknéte Enter

2. Vyberte entity a stisknéte Enter.

3. Uréete zakladni bod.

4. Zadejte koeficient méfitka klavesou a stisknéte Enter.

Pro zménu méfitka entity pomoci koeficientu vyberte entitu, urete zakladni bod (zde
levy dolni roh obdélniku) a koeficient méfitka.

Nékteré entity je také mozné Skalovat s pouZzitim jejich vrcholl. Pro Upravu entity ji
vyberte a kliknéte na vrchol. Velikost entity je pak mozné ménit pohybem vrcholu.
Vrchol pro vybér zavisi na typu entity. Napfiklad pro zménu méfitka kruznice je nutné
vybrat vrchol jejiho kvadrantu.

Pro zménu méfitka s pouzitim vrchold:

1. Vyberte entitu.



2. Kliknéte na vrchol pro jeho vybér.
3. Presurite vrchol.

4. Kliknéte pro jeho uvolnéni.
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Pro zménu méritka s pomoci vrcholl vyberte entitu (A), kliknéte na vrchol (B) a
zménte jeji méfitko taZenim vrcholu na novou pozici (C).

16.13 Prodlouzeni

Entity je mozné prodlouzit k urcité hranici definované jinymi entitami ve vykrese. Je
mozné provest také prodlouzeni do bodu, kde by protly uvazovanou hranici. Pfi
prodlouzeni entit vyberte nejprve hranice pro prodlouzeni a pak samotné entity pro
prodlouzeni. Ty je mozné vybirat jedno po druhé nebo vice najednou pomoci metody
plot. Je mozné prodluzovat oblouky, usecky, dvourozmérné kfivky a stopy. Oblouky,
kruznice, elipsy, stopy, nekonec¢né pfimky a vyfezy v rozvrzeni mohou fungovat jako
hranice.

Pro prodlouzeni entity



1. Provedte jedno z nasleduijiciho:

- Zvolte Modifikace > Prodlouzit

- V panelu nastroji Modifikace, kliknéte na nastroj Prodlouzit.

- Napiste extend a stisknéte Enter

2. Vyberte jednu nebo vice entit jako hrani¢ni entity a stisknéte Enter.

3. Vyberte entitu pro prodlouZeni.

4. Vyberte dalSi entitu pro prodlouzeni nebo stisknéte Enter pro ukonceni pfikazu.

e

Pro prodlouZeni entit vyberte hranici prodlouZeni (A) a entity pro prodlouzeni (B).
Pro prodlouzeni entity k uvazované hranici

1. Provedte jedno z nasledujiciho:

- Zvolte Modifikace > Prodlouzit

- V panelu nastroji Modifikace, kliknéte na nastroj Prodlouzit.

- Napiste extend a stisknéte Enter

2. Vyberte jednu nebo vice entit jako hrani¢ni entity a stisknéte Enter.

3. Ve volbach zvolte Rezim hran (pismeno E).

4. Ve volbach zvolte prodluzit (pismeno E).

5. Vyberte entitu pro prodlouZzeni.

6. Vyberte dalsi entitu pro prodlouzeni nebo stisknéte Enter pro ukonéeni pfikazu.



B /
Pro prodlouZeni entit vyberte hranici prodlouZeni (A) a entity pro prodlouZeni (B).
Pro prodlouzeni vice entit najednou pomoci metody plot (fence)
1. Provedte jedno z nasledujiciho
- Zvolte Modifikace > Prodlouzit
- V panelu nastroja Modifikace, kliknéte na nastroj Prodlouzit.
- Napiste extend a stisknéte Enter
2. Vyberte jednu nebo vice entit jako hrani¢ni entity a stisknéte Enter.
3. Ve volbach zadejte Plot (pismeno F).
4. Zadejte prvni bod plotu.
5. Zadejte druhy bod plotu.

6. Zadejte dalsi bod plotu nebo stisknéte Enter pro dokonc&eni pfikazu.
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Vyberte hranici (A) a pak urcete prvni (B) a druhy bod (C) plotu.

Pokud prodluzujete kfivku s tloustkou protne jeji osa definovanou hranici. Protoze
konec kfivky je vzdy pravouhly, jeji mala ¢ast maze hranici pfesahovat. Zuzujici se
kfivka se bude zuzovat, dokud neprotne hranici pro prodlouZeni. Pokud by to
znamenalo negativni Sifku, je koncova Sifka zménéna na O.



Zuzujici se kfivka (A) se bude zuzovat, dokud neprotne hranici pro prodlouzeni (B).

16.14 Orez

Entity je mozné ofezavat dle jedné nebo vice hranic definovanych ostatnimi entitami.
Je také mozné urcit ofez pomoci uvazované hranice. Pfi ofezu entit nejprve
definujete ofezové hrany a po té entity jednu po druhé nebé vice najednou pfi pouziti
metody plot. Je mozné ofezavat oblouky, kruznice, usec¢ky, dvou a trojrozmérné
kiivky a stopy. Oblouky, kruznice, kfivky, stopy, pfimky a vyfezy v rozvrzeni mohou
fungovat jako hranice ofezu. Entita mlze byt zaroven hranici i jednou z ofezavanych
entit.

Pro ofez entity

1. Provedte jedno z nasledujiciho:

- Zvolte Modifikace > Orezat

- V panelu nastroji Modifikace, kliknéte na nastroj Orez.

- Napiste trim a stisknéte Enter.

2. Vyberte jednu nebo vice entit jako hran ofezu a stisknéte Enter.

3. Vyberte entitu pro ofez.

4. Vyberte dalSi entitu pro ofez nebo stisknéte Enter pro ukonceni pfikazu.

A

Pro ofez entit vyberte hranici (A) a entity pro ofez (B).
Pro ofez entity dle uvazované hranice
1. Provedte jedno z nasledujiciho:
- Zvolte Modifikace > Orez
- V panelu nastroju Modifikace, kliknéte na nastroj Orez.
- Napiste trim a stisknéte Enter.
2. Vyberte jednu nebo vice entit jako hran ofezu a stisknéte Enter.

3. Ve volbach zvolte Rezim hran (pismeno E).

4. Ve volbach zvolte prodluZzit (pismeno E).



5. Vyberte entitu pro ofez.

Pro orez entit vyberte hranici prodlouzeni (A) a entity pro ofez (B).
Pro ofez vice entit najednou pomoci metody plot (fence)

1. Provedte jedno z nasledujiciho:

- Zvolte Modifikace > Orez

- V panelu nastroja Modifikace, kliknéte na nastroj Orez.

- Napiste trim a stisknéte Enter.

2. Vyberte jednu nebo vice entit jako hran ofezu a stisknéte Enter.
3. Ve volbach zadejte Plot (pismeno F).

4. Zadejte prvni bod plotu.

5. Zadejte druhy bod plotu.

6. Zadejte dalsi bod plotu nebo stisknéte Enter pro dokonc&eni pfikazu.

/\”/\

Viyberte hranici (A) a pak urcete prvni (B) a druhy bod (C) plotu.



16.15 Zmeéna délky

Muzete ménit délku entit nebo velikost opsaného Uhlu u oblouk.
Pro upravu délky vyuzijte jakoukoli z nasledujicich metod:

- Dynamicky potahnéte koncovy bod nebo uhel.

- Ur€ete velikost prodlouzeni nebo uhlu od koncového bodu.

- Zadejte novou délku jako procento celkové délky nebo uhlu.

- Zadejte novou celkovou délku nebo velikost opsaného uhlu.

Je mozné upravovat délky usecek, obloukl a otevienych kfivek.
Pro zménu délky entity tazenim

1. Provedte jedno z nasledujiciho:

- Zvolte Modifikace > Upravit délku

- V panelu nastroji Modifikace, kliknéte na nastroj Upravit délku
- Napiste editlen a stisknéte Enter

2. Zvolte moznost Dynamicky.

3. Vyberte entitu pro upravu.

4. UrCete novy koncovy bod nebo opsany uhel.
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Vyberte entitu (A) a novy koncovy bod (B).

16.16 Editace krivek

Je mozné upravovat jakykoli typ dvou nebo trojrozmérnych kfivek. Entity jako
obdélniky, polygony, prstence, stejné jako trojrozmérné entity jako jehlany, valce a
koule jsou vSechny variace kfivek, které je mozné editovat. Kfivku je mozné editovat
jejim otevienim nebo uzavienim, zménou celkoveé Sifky nebo Sifky jednotlivych
segmentu, spojenim jednotlivych segmentt do kfivky nebo aproximacni spline.
Nastroj pro editaci kfivek je také mozné pouzit pro editaci jednotlivych vrchold, jejich
pfidavani, odstrafiovani nebo posun. K existujici kfivce je také mozné pfipojit nové
segmenty, zménit typ ¢ary a obratit smér nebo pofadi vrcholl. Pro Upravu kFivky ji
nejprve vyberte a pak zvolte volbu pro jeji editaci. Nabizené moznosti se liSi dle toho,



zda je vybrana kfivka dvou nebo trojrozmérnou entitou. Pokud vybrana entita neni
kfivkou, nastroj ji na kfivku pfevede. Na kfivky je mozné pfevést pouze oblouky a
usecky. Pokud se vice Usecek a obloukl navzajem dotyka svymi koncovymi body, je
mozné je vSechny vybrat a pfevést na kfivku zaroven.

Pro pfevedeni entity na kfivku

1. Provedte jedno z nasledujiciho:

- Zvolte Modifikace > Objekt >KFivka .

- V panelu nastroji Modifikace I, kliknéte na nastroj Upravit krivku.

- Napiste editpline a stisknéte Enter.

2. Vyberte entitu.

3. Zvolte jednu z nabizenych moznosti nebo Konec pro ukonéeni pfikazu.

16.17 Otevreni a uzavreni krivky

Pokud uzavrete kfivku, program nakresli rovny segment kfivky mezi poslednim a
prvnim vrcholem. Pokud je prvni i posledni segment obloukovy, program uzavie
kfivku obloukem. Otevieni kfivky odstrani tento uzavirajici segment. Kdyz vyberete
kfivku pro editaci, je zobrazena moznost pro otevieni nebo uzavieni dle skute¢nosti,
zda je vybrana kfivka uzaviena nebo oteviena.

Pro uzavfeni oteviené kfivky

1. Provedte jedno z nasledujiciho:

- Zvolte Modifikace > Objekt >Kfivka .

- V panelu nastroji Modifikace I, kliknéte na nastroj Upravit krivku.

- Napiste editpline a stisknéte Enter.

2. Vyberte kfivku.

3. Zadejte volbu Uzavfit (pismeno C z angl. Close)

4. Zvolte dal§i moznost nebo Konec pro ukonéeni pfikazu.



Uzavreni oteviené krivky prida rovny nebo obloukovy segment mezi prvnim (A) a
poslednim (B) vrcholem.

16.18 Rozlozeni

Komplexni entity jako blok nebo kfivka je mozné rozloZzit na jejich soucasti.
RozloZenim kfivky, obdélniku, prstence, polygonu nebo kéty vzniknou jednoduché
entity, které je mozné individualné upravovat. Bloky jsou pfevedeny na jednotlivé
entity v€etné dalSich moznych blokd, které pavodni blok obsahoval.

Pro rozlozeni vyberte entity a pouZijte jednu z nasledujicih voleb:
- V. menu zadejte Modifikace > Rozlozit

- Na panelu nastroju Modifikace zvolte nastroj Rozlozit
- Napiste explode a stisknéte Enter

17. Rozvrzeni

17.1 Rozvrzeni (Layout)

Rozvrzeni jsou uzite€nym nastojem pro urychleni opakovaného tisku vyfezl z
vykresu.

PFfepinani mezi modelovym a vykresovym prostorem (rozvrzenimi) je mozné pomoci
zalozek pod kreslicim oknem. Pfes kliknuti pravym tlacitkem na zalozky je mozné
prejmenovani, pfidani, odebrani nebo zména poradi rozvrzeni.



Lapaut Layouts

V samotném rozvrzeni je tfeba nejprve vytvofit vlastni vyfez pomoci volby Zobrazit >
Plovouci vyrezy > 1 vyrez

Vyfez automaticky zobrazi cely vykres z modelového prostoru. Dvojklik dovnitF
vyfezu aktivuje moznost posunu a nastaveni méfitka. Aktivni vyfez je zobrazen jako
ohrani€eny silnou ¢arou. Dvojklik mimo vyfez aktivuje zpét moznost prace ve
vykresovém prostoru.

Pro tisk je vhodné v aktivnim vyfezu nastavit ur€ité méfitko pomoci volby Zobrazit >
Zoom > Méritko. Méfitko je pak mozné zadat do pfikazového fadku - napfiklad
"1/50x" pro méfitko 1:50.

Vyfez je také mozné zapnout nebo vypnout:

Ve vykresovém prostoru kliknéte na jeden nebo vice vyfezu levym tlacitkem pro
jejich vybér. Zapnuti nebo vypnuti vyfezu pak bude mozné pomoci volby Zobrazit >
Plovouci vyfezy > Zapnout vyrezy nebo Vypnout vyrezy.

17.2 Modelovy a vykresovy prostor

Kdyz zaCnete kreslit, vychozi pracovni oblast se nazyva modelovy prostor. Modelovy
prostor je oblast, kde vytvafite dvoj a trojrozmérné entity zalozené na Globalnim
soufadnim systému (GSS) nebo na UZivatelském soufadném systému (USS). Vasi
praci v modelovém prostoru zobrazite s pouzitim zalozky Model. Zobrazuje se zde
jediny pohled, ktery vyplfiuje obrazovku. Na zalozce Model muzete vytvofit dalsi
pohledy zvané vyrezy, které mohou zobrazovat stejné nebo rozdilné dvou nebo
trojrozmérné pohledy sefazené vedle sebe. V modelovém prostoru muizete pracovat
pouze v jednom z vyfez( najednou a mizete tisknout pouze z aktualniho vyfezu.

4MCAD nabizi dalSi pracovni oblast zvanou vykresovy prostor. Obsah vykresového
prostoru zobrazuje rozvrzeni vaseho vykresu na papiru. V této pracovni oblasti
muzete vytvaret a usporfadavat rizné pohledy na model podobnym zplisobem, jakym
sefazujete detaily nebo ortogonalni pohledy na papife. Muzete také pfidavat
poznamky anotace, hranice, nadpisy a dalsi entity dulezité pro tistény vykres, které
tak nezavazi v modelovém prostoru pfi kresleni. Ve vykresovém prostoru je mozné
pracovat a upravovat s pouZzitim zalozek Layout (Rozvrzeni). Kazdy pohled nebo
vyfez vytvofeny ve vykresovém prostoru pfedstavuje okno na vykres v modelovém
prostoru. Je mozné vytvofrit jeden nebo vice vyfezu a je mozné je umistit kdekoli na
obrazovce. Jejich hrany se mohou dotykat ale nemusi, je mozné vytisknout je
vSechny najednou.

Vykres neni nutné tisknout z vykresového prostoru, ale nabizi to nékolik vyhod:
- Tisk stejného vykresu s rozdilnymi nastavenimi tisku, ktera ulozite s kazdym
rozvrzenim - napfiklad Sifky per, soubory nataveni tiskarny, nastaveni tlousték ¢ar,

méfitko vykresu a dalsi.

- Vlozeni entit, které nejsou nutné v samotném modelu jako poznamky a komentare,
zjednodusuiji orientaci v modelovém prostoru.



- V jediném rozvrzeni je mozné vytvofit vice vyfezu, které zobrazuji model z riznych
pohledll a v rizném méfritku.

17.3 Zobrazeni vykresu

PFi praci ve vykresovém prostoru (rozvrzeni) mizete stale zobrazovat vykres z
modelového prostoru. Je proto nutné vytvofit v rozvrzeni vyfez. Uvnitf vyfezu je také

na zalozku Model.

Pro zobrazeni vykresu v modelovém prostoru na zalozce Model
- Kliknéte na zalozku Model

Pro zobrazeni vykresu ve vykresovém prostoru na zalozce Layout (rozvrzeni)
provedte jedno z nasledujiciho

- Kliknéte na zalozku Layout

- Napiste "layout" a stisknéte Enter.

- Zadejte volbu naStavit (pismeno S z angl. Set)

- Napiste nazev rozvrzeni, které chcete nastavit jako aktualni a stisknéte Enter.

Zalozky s nazvy rozvrzeni se zobrazuji v levém dolnim rohu vykresového okna:

(ML 4] ¥ | W], Model 473 100 A =4 100 A =3 50 /, a4 50 /

Pfi prvnim zobrazeni rozvrzeni se zda, Ze vykres zmizel. Nejde o chybu. Pro
zobrazeni vykresu je nutné vytvofit v rozvrzeni alesponi jeden vyfez.

Pro zobrazeni vykresu v rozvrzeni:
1. Zvolte pozadovanou zalozku rozvrzeni (Layout).

2. Vytvofte a zobrazte novy vyfez - viz. navod nize.

17.4 Nové rozvrzeni (layout)

Ve 4MCAD je pro jeden vykres mozné vytvofit vice rozvrzeni. Kazdé rozvrzeni
reprezentuje list papiru. V kazdém rozvrzeni mizete urcit jinou oblast tisku, méfitko,
méfFitko tloustky Car, nastaveni per a pfidavat jiné kéty, nadpisy a dalSi geometrii.
Entity vioZzené do rozvrzeni ve vykresovém prostoru se v modelovém prostoru
neobjevuji. Kazdé rozvrZzeni vyZzaduje nejméné jeden vytvoreny vyfez. Tento vyfez
zobrazuje entity vykresu z modelového prostoru.

Kdyz vytvorite novy vykres, automaticky obsahuje dvé vychozi rozvrzeni: Layout1 a
Layout2. V Ceské verzi 4AMCAD jiz mohou byt pfednastavena riizna dalSi rozvrzeni.
Muzete pouzit jedno z vychozich rozvrzeni, vytvofit viastni nebo vytvorit viastni ze
Sablony uloZené ve formatu DWT, DWG nebo DXF. Kazdy vykres mize obsahovat
az 255 rdznych rozvrzeni.



Pro vytvoreni nového rozvrzeni s pouzitim vychozich zalozek

1. Kliknéte na zalozku Layout 1 nebo Layout 2.

2. Nastavte nejméné jeden vyfez.

3. Pokud chcete, pfejmenujte rozvrzeni.

Pro vytvoireni nového rozvrzeni na nové zalozce

1. Provedte jedno z nasleduijiciho:

- Zvolte Vlozit > Rozvrzeni > Nové rozvrzeni

- V panelu nastrojil Rozvrzeni (menu Standard) kliknéte na nastroj Nové rozvrzeni.
- Napiste layout, stisknéte Enter a zvote Nové (pismeno N).

2. Zadejte unikatni nazev pro nové rozvrzeni a stisknéte Enter.

Nazev muze byt dlouhy az 255 znakl a muze obsahovat pismena, Cisla, znak dolaru
($), pomicky (-), podrzitka (_) nebo jejich kombinace.

3. Nastavte nejméné jeden vyfez (viz navod nize).
Pro vytvoreni nového rozvrzeni z existujiciho souboru
1. Provedte jedno z nasledujiciho:

- Zvolte Vlozit > Rozvrzeni > Rozvrzeni ze Sablony.
- Napiste layout, stisknéte Enter a zvote Sablona (pismeno T dle angl. Template).

2. Vyberte poZadovanou $ablonu, vykres nebo soubor ve formatu DXF, ktery
obsahuje pozadované rozvrzeni a zvolte Otevfit.

3. Vyberte rozvrzeni a kliknéte OK.

Muzete zvolit vice rozvrzeni najednou pomoci klavesy Ctrl a vybéru nazvl rozvrzeni.
Nové vyuziti rozvrzeni z jinych soubort

USetfete €as vyuzitim rozvrzeni, ktera jste vytvofili jiz dfive. Uvnitf aktualniho vykresu
je mozné vytvofit kopie rozvrzeni, které bude obsahovat vétSinu nastaveni, ktera
potfebujete, a provést zmény v této nové kopii. Pokud jste vytvofili rozvrzeni, ktera
budete chtit znova vyuzit v dalSich vykresech, mlzete tato rozvrzeni ulozit jako
Sablonu vykresu.

Pro vytvofeni kopie rozvrzeni

1. NapiSte layout a stisknéte Enter.

2. Zadejte volbu Kopie (pismeno C z angl. Copy)

3. Napiste nazev rozvrzeni, které chcete zkopirovat a stisknéte Enter.



4. Zadejte nazev pro nové rozvrzeni a stisknéte Enter.

Pro ulozeni rozvrzeni jako Sablony vykresu

1. Napiste layout a stisknéte Enter.

2. Zadejte volbu ulozit (pismeno S z angl. Save)

3. Napiste nazev rozvrzeni, které chcete ulozit a stisknéte Enter.
4. UrCete nazev a umisténi souboru Sablony a kliknéte Ulozit.

Po tom, co jste uloZzili rozvrzeni jako $ablonu je muzete vyuzit pfi vytvareni novych
vykresl. Muzete také importovat rozvrzeni ze Sablony do jiného vykresu.

17.5 Sprava rozvrzeni

RozvrZeni je mozné pfejmenovat, smazat, prohlizet a vypsat vSechna rozvrzeni
pfitomna ve vykrese.

Nastaveni mlzete provést pomoci kontextového menu, které vyvolate kliknutim
praveho tlacitka mysi na zalozku rozvrZzeni nebo postupy uvedenymi nize.

Pro prejmenovani rozvrzeni

1. Kliknéte na zalozku layout pravym tlaCitkem.

2. Napiste nazev rozvrzeni, které chcete pfejmenovat a stisknéte Enter.
3. Kliknéte na OK.

Nazev muze byt dlouhy az 255 znakl a mize obsahovat pismena, Cisla, znak dolaru
(%), pomicky (-), podrzitka (_) nebo jejich kombinace.

Pro smazani rozvrzeni

1. Kliknéte na zalozku layout pravym tlacitkem.
2. Kliknéte na OK pro potvrzeni zmazani.

Pro zobrazeni seznamu vSech rozvrzeni

1. Napiste layout a stisknéte Enter.

2. Zadejte volbu ? pro vypis v8ech rozvrzeni.

3. Napiste s nebo stisknéte Enter pro skrolovani rozvrzenimi.

17.6 Vyrezy v rozvrzeni



PFi zaCatku prace v modelovém prostoru, je na zalozce Model jediny pohled na
model. DalSi pohledy miZzete vytvaret rozdélenim kresliciho okna na vice oken.
Kazdé bude obsahovat jiny vyfez v zaloZzce Model.

Na zalozce rozvrzeni je nutné vytvofit alespon jeden vyfez. Je ale mozné vytvofit i
vice vyfezu, které budou zobrazovat rizné pohledy na modelovy prostor. Kazdy
vyfez ve vykresovém prostoru funguje jako okno do modelového prostoru vykresu.
Pohled, méfitko a obsah kazdého vyfezu Ize nastavovat oddélené. Kazdy vyfez je
samostatnou entitou, kterou je mozné posunovat, kopirovat nebo mazat. Dvojklikem
dovnitf vyfezu je mozné jej aktivovat a pracovat s entitami uvnitf modelového
prostoru. Zmény provedené v jednom vyfezu jsou okamzité viditelné v ostatnich
vyfezech, pokud zobrazuji zménénou ¢ast vykresu. Zoom nebo posun pohledu v
aktualnim vyfezu ovliviiuje pouze tento aktualni vyfez.

Vyfezy je mozné vytvofit kdekoli ve vykresovém prostoru. MizZete nastavovat pocet
vytvarenych vyfezu a jejich umisténi.

Pro vytvoreni vyrezi v rozvrzeni
1. Provedte jedno z nasledujiciho:

- Zvolte Zobrazit > Plovouci vyrezy
- Napiste mview a stisknéte Enter.

2.V moznostech zvolte PrizpUsobit (F - Fit) pro vyfez pfes celé kreslici okno, Cislice
2, 3 nebo 4 pro vytvoreni rizného poctu vyfezll nebo zadejte dva proté;jsi rohy
vyfezu na obrazovce.

3. V. moznostech zvolte uspofadani vyrezu.

4. Zvolte jedno z nasledujiciho:

- Pro sefazeni vyfezu tak, aby vyplnily aktualni kreslici oblast zadejte Pfizpusobit

(F z angl. Fit).

- Pro sefazeni uvnitf ohranicujiciho obdélniku zadejte rohy obdélniku.

A B C




Mdzete vytvorit jeden vyrez rozvrzeni nebo oblast rozdélit na dva vyfezy a sefadit je
vertikalné (A) nebo horizontalné (B); tfi vyrezy a zvolit vlevo (C), vpravo (D), nad (E),
pod (F), vertikaliné (G) nebo horizontalné (H); nebo ¢tyfi vyrezy (1).

17.7 Zapnuti / vypnuti vyrezu

PFi vétSim poctu vyfezi muze dojit ke zpomaleni systému. Pokud to bude nutné,
muzete vyfezy zapnout nebo vypnout. Vypnuti vyfezu nesmaze vyfez ani jeho
obsah. Jen vypne jeho zobrazovani.

Pro zapnuti nebo vypnuti vyfezu

1. Zvolte pozadovanou zalozku rozvrzeni (Layout).

2. Provedte jedno z nasledujicich:

- Zvolte Zobrazit > Plovouci vyrezy
- Napiste mview a stisknéte Enter.

3. Zvolte Ano (ON) nebo Ne (OFF).
4. Vyberte hranu vyfezu, ktery chcete zapnout nebo vypnout a stisknéte Enter.

17.8 Méritko vyrezu

Muzete také nastavit zobrazovani prvkd uvnitf vyfezu uréenim koeficientu méfitka,
které zméni jak velké nebo malé se budou entity modelu ve vyfezu zobrazovat.

Pro zménu méfitka entit modelového prostoru relativné k vykresovému prostoru
provedte jedno z nasledujiciho:

- Zvolte Modifikace > Vlastnosti...

- Na panelu nastroju Modifikace kliknéte na nastroj Vlastnosti
- Napisdte _ai_propchk a pak stisknéte Enter.

2. Zvolte okraj vykresoveho prostoru.

3. V okénku Mé&fitko zadejte méFitko ve kterém chcete zobrazit entity modelového
prostoru z vykresového prostoru.

4. Kliknéte na OK.

Pro zménu méritka entit modelového prostoru relativné k vykresovému
prostoru:

1. Kliknéte na zalozku Model
2. Kliknéte na vyfez, ktery chcete oznadit jako aktivni.

3. Zvolte Zobrazit > Zoom > Mé&fitko



4. Napiste relativni hodnotu méfitka ve vztahu k vykresovému prostoru pomoci
vyuziti pfipony xp k hodnoté méfitka a pak stisknéte Enter.

Napfiklad abyste zvétsili méfitko entit ve vyfezu na zalozce Modelového prostoru

dvojnasobné v poméru k velikosti vykresového prostoru, napiste 2xp. Pro zmenSeni
méfitka na polovinu velikosti jednotek ve vykresovém prostoru napiste .5xp.

17.9 Upravy vyrezii

Po té, co v rozvrzeni vytvorite vyfezy, mlzete je dale dle potifeby upravovat. PFi praci
ve vykresovém prostoru muzete vyuzit nastaveni uchopt, které budou uchopovat
hranice vyfezl. Vyfezy muzete kopirovat, odstrariovat, posunovat, natahovat nebo
ménit jejich méfitko podobné jako u jiné entity ve vykrese. Upravy vyfezu v rozvrzeni
neovliviuji entity v modelovém prostoru.

Pro upravu vlastnosti vyfezu

1. Zvolte pozadovanou zalozku rozvrzeni (Layout).

2. Provedte jedno z nasledujicich:

- Zvolte Modifikace > Vlastnosti

- V panelu nastroji Modifikace, kliknéte na nastroj Vlastnosti.

- Napisdte _ai_propchk a stisknéte Enter.

3. Vyberte hranu vyiezu pro Upravu.

4. Upravte stfedovy bod, Sifku nebo vysku vyiezu.

5. V Méfitku vliozte méfitko, ve kterém chcete zobrazovat entity modelového prostoru
ve vykresovém prostoru.

6. Oznacte Uzamknout vyfez abyste uzamkli méfitko vyfezu a nahled v modelovém
prostoru, pokud budete posunovat nebo pfiblizovat zobrazeni ve nahledu vyfezu.

7. Oznacte USS pro Vyfez, pokud chcete vyuzit unikatni USS pro kazdy vyfez z
rozlozeni.

8. Potvrdte tladitkem OK.
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A. Zadejte centralni bod vyfezu rozvrzeni.
B. Zadejte vysku vyfezu rozvrzeni.
C. Zadejte Sirku vyrezu rozvrzeni.

D. Zadejte méritko, které se ma pouZit pro zobrazeni entit modelového prostoru v
ramci vyfezu rozvrZeni.

E. Zvolte "Ano" nebo "Ne" abyste vyuZili unikatni USS pro kazdy vyrez rozvrZzeni.

F. Zvolte "Ano" nebo "Ne" abyste uzamkli méritko a vyrez v modelovém prostoru v
prubéhu posunu a pfiblizovani ve vyrezu rozvrzeni.

Vyfezy je také mozné upravovat klasickymi pfikazy jako jsou Posun, Kopie €i
Méritko.

Je mozné upravovat pouze vyfezy v rozvrzeni. Pokud kliknete na pohled na zéalozZce
Model, je nastaven jako aktivni ale neni mozné jej upravovat.

18. Tisk

18.1 Tisk vykresli

Je mozné vytisknout kopii vykresu presné tak, jak byla vytvofena nebo miizete pfidat
formatovani a urcit nastaveni tisku a upravit tak zpUsob, jak bude vytisknuty vykres
vypadat. Jindy mazete chtit vytisknout vykres vicekrat a pokazdé s jinym nastavenim
a formatovanim. Napfiklad muzete potfebovat jiny vykres pro prezentaci klientovi a
nékolik riiznych variant pro dodavatele. Pro kazdy typ tisknutého vykresu muzete
vytvofit rozvrZzeni, které bude definovat jeho charakteristiky véetné méfitka, tisknuté
oblasti, tloustky per a dalSich nastaveni.

Tato sekce vysvétluje jak:

- Nastavit vykres pro tisku z modelového prostoru na zaloZzce Model (zéloZky u
prikazového fadku).

- Nastavit vykres pro tisk riznych rozvrzeni z vykresového prostoru na zalozce
rozvrzeni (Layout).

- Definovat, jak bude vytisknuty vykres vypadat.

- Tisknout vykres

18.2 Tisk v modelovém prostoru

PFi vytvareni vykresu pracujete téméf vyhradné v modelovém prostoru. Vykres
muZete vytisknout pfesné tak, jak je vytvofen v modelovém prostoru, upravit jej pfed
tiskem nebo nastavit tisk v zalozce rozvrzeni (Layout). Zalozky rozvrzeni jsou
vétSinou pouzivany, pokud jsou potfeba rlizna nastaveni tisku. Rozvrzeni je ale
mozné pouzit, i kdyZz je potfeba tisknout vykres jen jednim zpusobem. Napfiklad
pokud chcete na tistény vykres umistit vétSi mnozZstvi textu, je mozné vlozit text do
vykresového prostoru, takze nepfekazi pfi orientaci a praci v modelovém prostoru.



Pokud se rozhodnete tisknout pfimo z modelového prostoru, je mozné do
vykresového prostoru umistit dalSi entity a nastaveni, ktera urcuji zpusob, jak se
vykres vytiskne.

Zakladni kroky pro tisk vykresu z modelového prostoru jsou:
1. Vytvorte vykres v zalozce Model.

2. V modelovém prostoru vytvofte i vSechny dalSi prvky, které se maji tisknout.
Napfiklad kéty, legendu nebo rozpisku.

3. UrCete dalSi nastaveni tisku jako je méfitko tiSténého vykresu, tiSténa oblast, Sifky
per a dal$i moznosti.

4. UloZte nastaveni tlacitkem Pouzit pro rozvrzeni.

5. Zkontrolujte vzhled vykresu pomoci tlacitka Nahled. V pfipadé potfeby upravte
nastaveni, znova ulozte tlaCitkem Pouzit pro rozvrzeni a vzhled opét zkontrolujte.

6. Vytisknéte vykres.
18.3 Tisk z vykresového prostoru

PFi vytvareni vykresu pracujete témér vyhradné v modelovém prostoru. Kazdy
vytvoreny vykres muze obsahovat mnoho rozvrzeni, ktera simuluji papir, na ktery
budete vykres tisknout. Kazdé rozvrzeni je vytvofeno na samostatné zalozce Layout.
Pro kazdy zpusob tisku vykresu je mozné vytvofit zvlastni rozvrzeni. Rozvrzeni
umoznuje organizovat rizné pohledy a kontrolovat, ktera ¢ast vykresu se vytiskne a
v jakém méfitku. Pfed tiskem je mozné vlozit dalsi entity a nastaveni rozvrzeni, ktera
urci, jak se vykres bude tisknout. Tyto prvky se objevuji jen na zalozce rozvrzeni, ne
v modelovém prostoru. Rozvrzeni mlze napfikad obsahovat nadpisy, legendy nebo
poznamky, které se budou tisknout, ale nebudou zavazet pfi praci v modelovém
prostoru.

Zakladni kroky pro tisk vykresu z vykresového prostoru jsou:
1. Vytvorte vykres v zaloZzce Model.

2. Vytvorte nové rozvrzeni. Muzete pouzit existujici zalozky Layout 1 nebo Layout 2
nebo muizete vytvofit novou zalozku rozvrzeni.

3. Vytvorte nejméné jeden vyfez v rozvrZeni. Nastavte kazdy pohled pro nastaveni,
jakym zplisobem se vykres vytiskne a v jakém méfitku.

4. VloZte jakékoli dalsi prvky, které jsou nutné pro rozvrzeni jako kéty, legenda nebo
nadpisy.

5. Nastavte dalSi moznosti rozvrzeni jako je méfitko, oblast tisku, Sifky per a dalSi.
6. Ulozte nastaveni tlacitkem Pouzit pro rozvrzeni.

7. Zkontrolujte vzhled vykresu pomoci tlaCitka Nahled. V pfipadé potfeby upravte
nastaveni, znova ulozte tlaCitkem Pouzit pro rozvrzeni a vzhled opét zkontrolujte.



8. Vytisknéte vykres tlaCitkem Tisk.
18.4 Nastaveni tisku

Pred tiskem mUzete nastavit mnoho vlastnosti tisku. Nasledujici nastaveni tisku jsou
globalni pro vSechny vykresy:

- Ur€eni velikosti a orientace papiru.
- Vybér a konfigurace tiskarny nebo plotru.
- Zahlavi a zapati tisknuta nahote nebo dole na papire.

Tato nastaveni jsou ukladana spole€né s vykresem na zalozkach Model nebo
Layout:

- Ur€eni pohledu a méfitka tisknutého vykresu v€etné &asti tisknutého vykresu,
meéfitka tisku a pocatecniho bodu tisknuté oblasti.
- Mapovani barev a tlousték per.

- Volba zda tisknout tloustky ¢ar a pfizplsobovat je méFitku.
- Otevirani soubor( konfigurace tiskarnu typu PCP.

18.5 Vybér tiskarny

Tiskarnu nebo plotr je mozné nastavit v jakémkoli vykrese. Je mozné tisknou na
jakoukoli tiskarnu nebo plotr kompatibilni s Windows vcetné rastrovych tiskaren.

Pro vybér tiskarny nebo plotru

1. Provedte jedno nasledujiciho:

- Zvolte Soubor > Nastaveni tisku...

- V panelu nastroji Standard, kliknéte na nastroj Tisk.

- Napiste psetup, print nebo plot, stisknéte Enter.

2. Ze seznamu tiskaren vyberte tiskarnu nebo plotr a kliknéte na OK.
18.6 Velikost a orientace papiru
Velikost a orientaci papiru Ize nastavit pro vSechny vykresy.
Pro vybér velikosti a orientace papiru

1. Provedte jedno nasledujiciho:

- Zvolte Soubor > Nastaveni tisku...

- V panelu nastroju Standard, kliknéte na nastroj Tisk.

- Napiste psetup, print, nebo plot stisknéte Enter.

2. Vyberte velikost papiru a jeho orientaci a kliknéte OK.

Pokud chcete vykres vytisknout vzhiru nohama:

1. Pokud je to nutné, kliknéte na poZadovanou zalozku Vykresového nebo
Modelového prostoru.



2. Pokracuijte jednim z nasledovnych zpUsobu:

- Zvolte Soubor > Tisk
- Na panelu nastroju Standard zvolte nastroj Tisk
- Napiste psetup, print nebo plot a stisknéte Enter.

Dejte zatrzitko k moznosti Vzhiru nohama.

Zvolte moznost UlozZit zmény v rozvrZeni a pak kliknéte na Pouzit pro rozvrzeni
abyste ulozili zmény.

18.7 Méritko a pohled pri tisku

Muzete vytisknout cely vykres nebo jen jeho vybranou ¢ast dle moznosti, které
zvolite na zalozce Méfitko/Pohled v dialogu pro tisk. Muzete vytisknout vSe viditelné
na obrazovce nebo uréit jen ¢ast vykresu. Umisténi vykresu na papife miizete
urCovat umisténim pocatecniho bodu tiSténé oblasti (levy dolni roh) ve vztahu k
levému dolnimu rohu vykresu. Normalné je poCatek nastaven na 0,0, coz umisti levy
dolni roh tisknuté oblasti tak blizko levému dolnimu rohu papiru, jak to tiskarna nebo
plotr umozni. Mizete ale urcit jinou pozici zadanim jinych hodnot. Pfi vytvareni
vykresu kreslite vétSinou entity v realnych velikostech. P¥i tisku mizete urcit méfitko
tisténého vykresu nebo nechat program, aby méfitko pfizpUsobil velikosti papiru. Pro
tisk vykresu v urc€itém méritku, zadejte méfitko jako pomér kreslicich a tisknutych
jednotek. Pokud tisknete z rozvrzeni (zaloZzky Layout), méfitka a nastaveni pohledu
se pro kazdé rozvrzeni mohou lisit.

Pro automatické nastaveni méritka pfi tisku
1. Pokud je potieba, zvolte poZadovanou zaloZzku Model nebo Layout.
2. Provedte jedno z nasledujiciho:

- Zvolte Soubor > Tisk...
- Napiste print a stisknéte Enter.

3. Pro pfizplsobeni méfitka tisku tiSténému papiru zvolte Prizpusobit méfitko.
4. Zaskrtnéte Ulozit zmény v rozvrZeni a tlaCitko Pouzit pro uloZzeni zmén.
Pro nastaveni vlastniho koeficientu méritka

1. Pokud je potieba, zvolte pozadovanou zalozku Model nebo Layout.

2. Provedte jedno z nasledujiciho:

- Zvolte Soubor > Tisk...
- Napiste print a stisknéte Enter.

3. Vyberte méfitko ze seznamu nebo zvolte moznost Vlastni a zadejte jeho velikost.

4. Zvolte jednotky vykresu mezi milimetry a palci (vétSinou milimetry).



5. ZaSkrtnéte Ulozit zmény v rozvrzeni a tlacitko Pouzit pro ulozeni zmén.
Pro zadani ¢asti vykresu pro tisk

1. Pokud je potieba, zvolte poZadovanou zaloZzku Model nebo Layout.

2. Provedte jedno z nasleduijiciho:

- Zvolte Soubor > Tisk...
- Napiste print a stisknéte Enter.

3. V ¢asti Oblast tisku zvolte jedno z nasledujiciho:

- Aktualni pohled - vytiskne pohled na obrazovce.

- Ulozeny pohled - vytiskne ureny dfive ulozeny pohled.

- Meze - vytiskne v8e po meze definované v rozvrzeni nebo vykrese.

- Okno - vytiskne ¢ast vykresu obsazenou uvnitf uréeného okna v&etné zachovani
pomeéru stran.

Pokud zvolite okno, je nutné jej zadat. Pod Oblast tisku s okny zadejte x a 'y
souradnice diagonaly okna nebo ur€ete oblast tisku na obrazovce.

Pro nastaveni tisku tak, aby se tiskla jen oblast v uréeném okné a ne mimo okno,
zaskrtnéte volbu Vytisknout pouze oblast uvnitf uréeného okna.

4. Zaskrtnéte Ulozit zmény v rozvrzeni a tlacitko Pouzit pro ulozeni zmén.
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A. Zobrazi Model nebo nazev rozvrZeni, ke kterému se nastaveni vztahuje.
B. Kiiknéte pro vybér oblasti vykresu, kterou chcete tisknout.
C. Zadejte x a y souradnice protéjSich roh( obdélnikového okna pro vybér oblasti,

kterou chcete tisknout;, nebo urcete souradnice pfimo ve vykrese kliknutim na tlacitko
Vybrat oblast tisku.

D. Specifikujte méritko plochy k vytisténi zvolenim poméru vykresovych jednotek a
jednotek papiru, na ktery budete tisknout. Nebo zvolte PfizpGsobit papir méfitku.

E. Zvolte pro uloZeni zmén v rozvrZeni.

F. Nastavte stinovani tisknutého vykresu.

Pro uréeni pocatku oblasti tisku

1. Pokud je potfeba, zvolte poZadovanou zaloZku Model nebo Layout.
2. Provedte jedno z nasledujiciho:

- Zvolte Soubor > Tisk...
- Napiste print a stisknéte Enter.



3. Pod poc¢atkem tiskové plochy zvolte jedno z nasledujiciho:

- Pro vystfedéni oblast tisku na tisknuty papir, vyberte Centrovat vykres.

- Pro ur€eni poc¢atku oblasti tisku zadejte soufadnice x a y nebo kliknéte na Zvolit
pocatek a zadejte bod ve vykresu.

4. Zaskrtnéte Ulozit zmény v rozvrzeni a tladitko Pouzit pro ulozeni zmén.

18.8 Mapovani barev pri tisku (styl
vykreslovani)

Barvy, které se zobrazuji na obrazovce je mozné namapovat k barvam a tloustkam,
které chcete vytisknout. Mzete, napfiklad, namapovat Zlutou barvu k vystupni barvé
fialové, takze vSechny entity, které se na obrazovce zobrazuji zluté se budou tisknout
fialové. Spide nez jednotliva pera urcité tiskarny podporuje CAD mapovani na
jakékoli vystupni zafizeni Windows vcetné rastrovych tiskaren. Barvy a volby Sifek
mohou byt pro kazdé nastaveni rizné.

Pro zménu vystupni barvy a tloust’ky ¢ary
1. Pokud je potieba, zvolte poZadovanou zalozku Model nebo Layout.
2. Provedte jedno z nasledujiciho:

- Zvolte Soubor > Spravce stylu tisku... > vyberte Icad.ctb nebo
Monochrome.ctb > Upravit...

3. Ve sloupci barev Styly, kliknéte na barvu, kterou chcete zménit. Na pravé strané
se zobrazi styl, jakym je dana barva mapovana.

4. U barvy zvolte novou vystupni barvu, tloustku ¢ary nebo zmérite oboji, zvolte
Ulozit jako, zadejte nazev nového styly a tla€itko OK.

5. Zvolte nazev noveé vytvofeného stylu tisku v dialogu pro tisk u Tabulka stylu tisku
(pfifazeni per).

6. Zaskrtnéte Ulozit zmény v rozvrzeni a tladitko Pouzit pro uloZzeni zmén.

Pro zménu vice barev obrazovky na jednu vystupni barvu nebo jedinou $ifku, zvolte
pfi nastavovani nejprve barvy s pomoci klavesy Shift a pak zadejte vystupni barvu.
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A. Vyberte styl tisku

B. Zadejte popis vybraného stylu tisku.

C. Kliknéte pro vytvofeni nového stylu tisku.(pouZijte pouze navrzena jména)
D. Kliknéte pro odstranéni nové vytvofeného stylu.

E. Kliknutim upravite seznam dostupnych tlousték ¢ar pro béznou tabulku styl(
tisknuti.

F. Kliknéte pro uloZeni zmén.

G. Vyberte tloustku Cary pro vybrany styl tisku.

H. Vyberte typ &ary pro vybrany styl tisku.

I. Zvolte tloustku virtualniho pera pro vybrany styl tisku (pro tiskarny, které nemaji
realné pero, jako laserova nebo inkoustova).

J. Zvolte tloustku realného pera pro vybrany styl tisku.

K. Viyberte barvu pro zvoleny styl tisku.

Pro mapovani v§ech barev na ¢ernou
1. Pokud je potfeba, zvolte poZadovanou zaloZzku Model nebo Layout.

2. Provedte jedno z nasledujiciho:



- Zvolte Soubor > Tisk...
- Napiste print a stisknéte Enter.

3. Kliknéte na zalozku Upfesnit, u Tabulka stylu tisku (pfifazeni per) zvolte jeden ze
stylu tisku a kliknéte na tlaCitko Upravit nebo tlacitko Nova...

4. Vyberte vSechny barvy. Pro vybér vSech barev kliknéte na prvni, skrolujte uplné
doll a na kliknéte na posledni barvu se stisknutou klavesou Shift.

5. Zvolte novou vystupni barvu, zvolte Ulozit jako, zadejte nazev nového styly a
tlaCitko OK.

6. Zvolte nazev nové vytvofeného stylu tisku v dialogu pro tisk u Tabulka stylu tisku
(pfifazeni per).

7. Zaskrtnéte Ulozit zmény v rozvrzeni a tlacitko Pouzit pro ulozeni zmén.

18.9 Tloustky €ar pri tisku

U kazdého rozvrzeni ve vykrese mulzete urdit, zda tisknout a ménit méfitko tlousték
¢ar dle tloustky pfifazené entitdm. Entity maji pfifazeny tloustky ¢ar a mizete
nastavit, zda se s pfifazenym tloudtkami budou tisknout. Pokud vypnete tisk s
tloustkami ¢ar, vytisknou se entity s vychozi Sitkou. Mizete také nastavit, zda se
tloustky budou tisknout proporéné k méritku nastavenému pro tisk.

Pro nastaveni tlousték ¢ar
1. Pokud je potieba, zvolte poZadovanou zalozku Model nebo Layout.
2. Provedte jedno z nasledujiciho:

- Soubor > Spravce stylu tisku... > vyberte Icad.ctb nebo Monochrome.ctb >
Upravit...

3. Zvolte, jak chcete tisknout tloustky Car:

- Pouzit tloust’ku ¢ar pro tisk entit s pfifazenym i tlouStkami ¢ar

- Méritko tloustky €ar vytiskne tloustky ¢ar proporéné k méfitku nastaveném na
zalozce MéFitko/Pohled. Bez této volby se tloustky €ar vytisknou v pfifazenych
tloustkach bez pfizplsobeni méfitku tisku. (Zalozka rozvrzeni musi byt aktivni pro
pouziti méfitka typu Car.)

4. Zaskrtnéte Ulozit zmény v rozvrzeni a tlacitko Pouzit pro ulozeni zmén.
Pro definici tlousték Car dle barev navstivte sekci Mapovani barev pfi tisku. Pro

nastaveni tlousték Car pfi vytvareni entit navstivte sekci Hladiny nebo Nastaveni
aktualni tloustky car

18.10 Konfiguracni soubor tiskarny (PCP)

Konfiguraéni soubory tiskarny ukladaji informace, které vytvofite pro konkrétni
vykresy, coz usnadfiuje nastaveni pfi opakovaném tisku. Program podporuje



konfiguraéni soubory typu PCP. Tato vlastnost umoznuje pouzit také PCP soubory
vytvofené v jiném programu stejné jako pouziti vlastnich ulozenych PCP souboru.
Konfigura€ni soubory mohou byt pro kazdé rozvrzeni rizné.

Pro otevieni nebo ulozeni PCP souboru

1. Pokud je potieba, zvolte poZadovanou zaloZzku Model nebo Layout.

2. Provedte jedno z nasledujiciho:

- Zvolte Soubor > Tisk...
- Napiste print a stisknéte Enter.

3. Kliknéte na zalozku Upfesnit.

4. Pod Konfiguraéni soubor tiskarny zvolte Otevfit nebo Ulozit pro uloZeni
aktualniho nastaveni tisku jako PCP souboru.

5. Zaskrtnéte Ulozit zmény v rozvrzeni a tlacgitko Pouzit pro ulozeni zmén.

Tisk - Model i
Mastaveni stranky Tabulka stylu tisku (pFfazeni per)
Nezev:  [<zadny> *) [ Pada. | [z E -1k
Tiskama Nastaveii stinovani vytezu
Nazev: [Canon MP 250 series Prirter v] [ Mastnosti... ] Stinovany Jako zobrazeni =
wykr.
Tiskdma: Systémovd tiskdma Kvalita Normaini
Umisténi: USB001 =
: DPI 0
Popis:
Velikost papini: 210 257 mm e R
Tisknuteing oblast:  203x 289 Hocmiss i mewan
[ Tisk do souboru MéFitko tloustloy Car
Zobrazit styly tis
Velikost papin Pocet kopii Zobrazt styly tisku
. Tisknout posledni wykresovy prostor
Ad -] 1 . :
Skryt objekty wykresoveho prostory
MEFitho tisku Oblast tisku Moznosti tisku
[T Pfizptisobit papiru M&fitke: | 1:50 - Co tisknout: Oknao - ) Tisk tloustley o objektu e
7 — @ Tisk se stylem tisku a tlougtkou car
] @ _ 50,0000 it Oblast tisk 5 okny _1 Tisk bez stylu t‘isku a tloudtky Ear
0d: [] Tisk na pozadi
o [] Tisk ozradeni vykresu
Odsazeni {pofdtek nastavi na tisknutelnou plochu) X 63405970 . 738479292 rT! i ka :
A e pas || UloZit zmény rozvrzeni
(9 Cortanvet, s o Orientace vitkrasu
¥ |69.8063 i X 150754030 Y. 1041419250 ® Navjiiu .
B [ Vyorat obest s> | .
- |-201.3267 rat oblast tisku > =
AR et Nybred oot sk [ Vzhiinu nohama
(2] [Pousitporoaviieni] [ MNahed.. | [ 0K ] [ Somo |

A. ZaSkrtnéte pro vystfedéni oblasti tisku na papiru.

B. Zadejte x a y souradnice pocatku oblasti tisku.

C. Kliknéte pro tisk s nebo bez stylu tisku a tloustky ¢ar
D. ZaS$krtnéte pro tisk entit s pfifazenym tloustkami Car.
E. Vyberte tabulku stylu tisku.



F. Kliknéte pro zménu tabulky stylu tisku.

G. Kliknéte pro méritko tloustky Car.

18.11 Zobrazeni nahledu

Nahled zobrazuje, jak bude vytisknuty vykres vypadat. To pomaha zobrazit zmény

prfed samotnym tiskem.

Pro zobrazeni nahledu vykresu pfed tiskem

1. Pokud je potfeba, zvolte pozadovanou zalozku Model nebo Layout.

2. Provedte jedno nasledujiciho:

- Zvolte Soubor > Nahled tisku...

- Na panelu nastroju Standard kliknéte na nastroj Nahled tisku.
- Napiste preview a stisknéte Enter.
- Pokud nastavuijete tisk v dialogu tisku, zvolte tlac¢itko Nahled tisku

3. Po kontrole nahledu provedte jedno z nasledujiciho

- Pro tisk vykresu kliknéte na tlacitko Tisk.
- Pro navrat do nastaveni kliknéte na Nastaveni tisku.

Tisk - Model

Nastaveni stranky

Velikost papiru: 210 x 297 mm
Tisknutelnd plocha: 202 x 289
[ ]Tisk do souboru

Velikost papiru

Ad

MéFitko tisku

[ ] Pfizplisobit papir. M&fitko: | 1:40

1 mm

plochu)

[v]vystFedit na strance

X: 12,7542 i
Yo [g5.2206 i

1@

Nazev: <Zadny>
Tiskarna

Nazev: Samsung M2020 Series (USB0D1)
Tiskarna: Systémova tiskdrna

Umisténi: UsBOO1

Popis:

w | =|40.0000 jedn

Odsazeni tisku (pocatek nastaven na tisknutelnou

~ Pfidat...

£

Vlastnosti...

Pocet kopii
[ =
Oblast tisku
Co tisknout: Okno v

Oblast tisku s okny

0d:

X: | 16?63.4394i ¥: | 56881.1394|

Do:

X: | 2?284.4394i Y: | ?1?60.8394|

Vybrat oblast tisku =

Tabulka stylu tisku (pfifazeni per)
Zadné »
Nastaveni stinovani vyfezu
k ; Jako zobrazeni v
Stinovany
tisk -
: Mormalni
Kvalita
DPI 0

MozZnosti zéloZek rozvrZeni
Skdlovat tloustky Ear

Zobrazit styly tisku

Tisknout vykresovy prostor nakonec
Skryt objekty vykresového prostoru

[ ]Tisk prihlednosti

MoZnosti tisku
OTisknout tloustky ar
(@) Tisk se stylem tisku a tloustkou &ar
() Tisk bez stylu tisku a tloustky car
[]Tisk na pozadi
[ Tisk razitka vjkresu
UloZit zmény rozvrZeni
Orientace vykresu
() Navysku

(@) Nasitku

[Jvzhiiru nohama

PouZit pro rozvrZeni Nahled...




A. Kliknéte pro zvétseni.

B. Kliknéte pro zmenseni. Pokud jste klikli nékolikrat na zvétseni, kliknéte opét
nékolikrat na zmenseni pro zobrazeni celého nahledu.

C. Kliknéte pro tisk.

D. Kliknéte pro zavreni.

18.12 Odeslani tisku

Nastaveny soubor je mozné odeslat na tiskarnu nebo plotr pomoci volby Tisk.
Pro tisk vykresu

1. Pokud je potieba, zvolte poZadovanou zalozku Model nebo Layout.

2. Provedte jedno z nasledujiciho:

- Zvolte Soubor > Tisk...

- Na panelu nastroji Standard kliknéte na nastroj Tisk. Pokud kliknete na nastroj
Tisk v panelu Nastrojli, nezobrazi se dialog nastaveni tisku. Vykres bude
automaticky poslan do nastavené tiskarny.

- Napiste print a stisknéte Enter.

3. V dialogu Tisku provedte jakékoli upravy nastaveni.

4. Kliknéte na Tisk.

19. Tipy atriky



19.1 Tisk do formatu PDF

Pro sdileni vykres( se spolupracovniky, kolegy nebo klienty mize byt velice uzite€na
moznost tisku do formatu PDF. Prohlize¢ téchto soubor(l je dnes nainstalovan témér
na kazdém pocitaci a uzivatelé s nim tak nebudou mit zadny problém. Také samotné
vytvofeni souboru ve formatu PDF neni sloZité. Na internetu mizete zdarma nalézt
rizné virtualni tiskarny, které to umozni. Po nainstalovani pak pfibude v opera¢nim
systému nova tiskarna a diky ni mlzete z jakékoli aplikace ve Windows vytvaret
dokumenty ve formatu PDF stejnym zpUsobem, jako byste je tiskli.

Z virtualnich tiskaren zdarma Ize doporucit PDFCreator, CutePDF nebo PrimoPDF. Z
placenych programi je ¢asto vyuzivana napfiklad PDF Factory.

P¥i potiZich s tiskem muaze byt nutné zménit konfiguraci virtualni tiskarny. | v téchto
pfipadech nas mizete kontaktovat s Zzadosti o pomoc.

19.2 Tisk do PDF/A v PDF Creator

S pozadavkem tisku CAD vykresu do formatu PDF/A se mlzete setkat pfi potfebé
dlouhodobé kompatibilni archivace vystupl &i pfi pozadavcich na odevzdani
dokumentace v elektronické podobé. Verze formatu PDF/A jsou definovany v ISO
normach.

Tisk do formatu PDF/A 2b zdarma umoznuje virtualni tiskarna PDF Creator.

V dialogu tisku zvolte tiskarnu PDF Creator a po dalSich nastavenich tlacitko Tisk:



[ isk - Model e |

MNastaveni strénky Tabulka stylu tisku (pffazeni per)
Nezev: <> »| [ phdat. | [Monochromecth ) (il
Tiskama Mastaveii stinovani vyrezu

MNazev: [F‘n’moPDF v] ’ Wlastrosti... ] Stinovany
.

Tiskama: Systémova tiskama Kvalita Nomain i
Umist&ni: PrimoPort: =
: DRI u
Popis:
Velikost papin: 210 257 mm R e
Tisknutelnd oblast: 204 291 MoZnosti zaloZlek rozvrZeni
[7] Tisk do souboru Meritko toustky car
Velikost papin Pocet kopii obiast sy Hdas
< Tisknout posledni wylresowy prostor
[M s B .
Skryt objekty vykresového proston
MEFitho tisku Oblast tisku MoZnosti tisku
B P , (7 Tisk tiouStky Ear objekti
Pfizpdsobit papinu Méfitko: | 1:50 b Co tisknout: Okn hd 3
[ Phzs b ! i (@ Tisk se stylem tisku a thoudtkou Ear
: Oblast tisku s okny () Tisk bez shu tisku a thoudthy Zar
1 mm | = 500000 jedn. %
od: [ Tisk na pozadi
[ Tisk nznadeni wikresu

Odsazeni {podatek nastavi na tisknutelnou plochu) X 10342742  y. 511.8418
[7] Centrovat vykres Da:
« [13731 o X. 18276121  Y: 3822457

[¥] Ulozit zmény rozvrzeni
Crientace vikresu
) Nawysku

Y
@ NaZifku
. [100.5290 rat oblast tishu = i
Y. |100.529 mm m [ Vzhtins nohama

(2] |Pouiitprorozwiieni| | MNabed.. | [ OK | [ Stome |

V okné virtualni tiskarny tlacitko Moznosti:

£ PDFCreator 1.7.2 = =

Titulek dokumentu:
|E:'~._|:|ru:uiekly\hlubocky\dsp‘-.pudor

Dratum wytvoleni:
[20150210115637 | Ted

Dratumn dprasy:
[20150210115637 | Ted

Autor:
|Malek |

Kligova slova:

Prafil

Predvoleng W

After zaving open output file
«'| Edit PDF files with PDFAchitect

Zrugit Cekat [ve fronté) Moznoszti... E -mail UloZit




V levém menu zvolte PDF a upravte nastaveni dle potfeby. Jsou zobrazena vychozi
nastaveni. Zpét se vratite tlacitkem "Ulozit".
&)

MoZnosti...
Profil
Piedvoleny w ﬂ J J E J

-fJ Program

‘EI Obeché nastaveni = .

Ghostseript Format Adobe PDF

Dakument

UlaZit

- g Automatick ukladani Obecne ] Knmprese] Font_l,l] Barv_l,l] Bezpeénost] F'odpis]

- [F] Akce

o Tisk

Pisma Predvaoleng nastaveni Automaticke otaceni stran:

ol I Jazpky Predvolens W Jednu stranu ¥
K.ompatibilita: Pretisk:
Adobe Acrobat 5.0 [FODF 1.4) W Menulowy pretizk W
Page layout
Dizplay one page at a time. w
Page mode
Meither document autling nor thumbnail images visible. W
Start page
] Rypchlé zobrazavéni z webu

ZiLgit Obnovit hastaveni Lot

v hlavnim dialogu tiskarny zvolte opét tlacitko "Ulozit":



£ PDFCreator 1.7.2 - B

Titulek, dokumentu;
|E:\_|:|ru:niekty‘\hlubocky‘\dsp\pudor

Dratum wobvoreni:
2015021015637 | Ted

Dratum Gprasy:
(2015021015637 | Ted

Autor:
|Marek |

Fredmeét:
Fligowa slova:

Prraofil

Fredvaleni W

After zaving open output file
o | Edit PDUF files with POFArchitect

2t Cekat [ve fronté) MoZnost... E-mail |Jlodit

A jako typ ukladaného souboru zvolte PDF/A:

= UloZit jako...
T co# dmor test b dmcadl42 b pdf-a w5 Prohledat: pdf-a ¥
Uspofadat « Mova slozka B - (7]
-
',ﬂ Marek ] Mazew Datum zmény Typ
18 Tento poitad Hleddni neodpovidaji Zadné polozky.

©| Dokumenty Souboi PDF_(”.i df) I
PDFE/A-2b Files (*.pd

?"

i Hudba PDF/X soubory (*.pdf)

=| Obrazky Soubory PNG (".png)

m Plocha Soubory JPEG (".jpg]

L. Soubory BMP (*.bmp)

4 Stazené soubg Soubory PCX (*.pcx

8 Videa Soubory TIFF (*.tif)

FH 5 Soubory Postscriptu (*.ps)

S Windows3 O3 Soubory v EPS (Encapsulated Postscript) (*.eps)
Textoveé soubory (%t}

G“F S P5D (Adobe Photoshop) soubory (*.psd)

PCL (HP PCL-XL) soubory (*.pcl)

, RAW (bindrni format) scubory (*.raw)

Mazev souboru: Soubory SVG (*.5vg)

Ulozit jake typ: | Soubory JPEG (*.jpg) W

#. Skryt slozky Storno

Validitu souboru si mlzete tako ovéfit napfiklad pomoci online aplikace na strance
pdf-tools.com.

19.3 Upravy PDF dokumentt

Pro upravy jiz hotovych PDF dokumentu Ize vyuzit aplikace tfetich stran. Jako
vhodnou pomucku, ktera je k dispozici zdarma, mizeme doporucit PDF Split and
Merge (PDF SAM). Je také v Ceském jazyce.




ALY PDF Split and Merge basic Ver. 2.2.2 = =
Soubor :
BH& /| @
| pdfsam 2.2.2 h
B | Zasuvné moduly Oteviit Vyprazdnit, (), Zvetsit
: ’D Alternativni michani soubord
[ ] otodit o Posunout...
~[] Rozdeiit
Bl P ...
[ Slouéit/Rozbalit B Posines
’D Vizualni reorganizator Qdstranit
D Vizualni twirce dokumentu
D Moznosti Obnovit
...... D O apltiact @ Otofit vpr...
1-[A2] 2-[A2] 3-[A2]
] otoéit vie...
K7 Obratit
v

| Umisténi vystupniho souboru

o=
r_f | Vizualni recrganizator

PDF Split and Merge umozni otaceni PDF dokumentd, jejich spojeni do jednoho &i

naopak rlizné moznosti, jak dokument rozdélit. Uzitecna je i pomucka "Vizualni

reorganizator", ktera zobrazi nahledy jednotlivych stranek upravovaného souboru.

19.4 Tisk do JPG

Pro tisk vykrest do JPG ¢€i jiného formatu obrazka je mozné pouzit virtualni tiskarnu

PDFCreator.

Tiskarna je po instalaci k dispozici v seznamu ostatnich tiskaren. Po odeslani tisku

jsou pod tlaCitkem Moznosti k dispozici nastaveni kvality vystupniho formatu.



'8 MoZnosti...
Prafil

I Predwoleng

ﬁ Program

"] Obecna nastaveni
Ghaostacnpt
Dakurment
Ulozit
- B Automaticke ukladani
Aloe
oy Tisk
----- Pizma
----- =1 Jazpky

Formaty

E@ Fomnat JPEG [IFIF]

MNastaseeni

Rozlieni dpi

Barwy I'IEi.'-"F"F"2'I E barev [24 bitd)

Kovalita: x

LI

Obnovit nastaveni

Muzete provést pozadované zmény a pouzit tlacitko Ulozit.




' PDFCreator 1.6.2 - o] x|

Titulek dokumentu:

[ikrest |

D atum wytyvoreni:

[20130320203617 | Ted |

Dy akurn tprass:

[20130320203617 | Ted |

Autar;
|h-'|arek |

Predmét:
| |

Kligowa zlaova:

‘- Prafil

[ After zaving open output file
Edit PIF files with FOFArchitect

LI Celat [ve fronté] koZnosti... | E -mnail | [ladit

Poté zvolte v hlavnim dialogu Profil JPEG (graphic file), stisknéte Ulozit a zadejte
cestu a nazev vystupniho souboru.

19.5 Prevod bitmap (obrazkui) do DXF
(raster na vektor)

Pokud jako podklad k projektu dostanete naskenované vykresy (rastrové obrazky),
muze byt uzite€¢né, pokusit se je pfevést na do formatu DWG nebo DXF (vektory) a
pracovat s nimi v prostfedi 4MCADu. Pifevod nikdy nemuze byt dokonaly, ale i
pfiblizna konverze linii z rastrového obrazku muize usnadnit praci nebo mlzete
prevedené entity pouzit jako podklad pro dalSi kresleni.

Pro konverzi obrazku na format DXF Ize doporucit nastroj WinTopo, ktery je k
dispozici zdarma i v placené verzi. S jeho pomoci je mozné prevést obrazek do
formatu DXF.

ZkuSebni verze placenych programu nabizi také Img2CAD a VectorNow.

Jinou mozZnosti, jak pracovat s rastrovymi obrazky je jejich vioZzeni pfimo do DWG
vykresu (v menu Vlozit > Rastrovy obrazek), pfizplisobeni spravnému méfitku a
kresleni na jejich podkladu. 4MCAD podporuje vkladani rastrovych obrazkl ve
verzich Standard a Professional.




19.6 Prevod PDF do DWG / DXF

Pokud jako podklad ziskate PDF soubor vytvofeny v CAD programu je mozné jej
prevést do formatu DXF a dale s nim pracovat. Novy vykres pravdépodobné nebude
stejné presny jako plvodni DWG ¢&i DXF soubor.

Nastroje pro pfevod PDF do DXF jsou €asto placené nebo jsou soucasti jinych
placenych grafickych aplikaci. Lze nalézt i bezplatné nastroje, které ale omezuji
pocet pfevadénych soubord.

My muzeme doporucit program PDF2CAD, ktery je soucasti nasi nabidky.

Levné se jevi napriklad PDF to DXF JPG TIFF Converter, ale mizete sami zkusit
Stésti, kdyz do mezinarodnich vyhledavacu zadate klicovy slova jako "pdf2cad", "pdf
to DXF" a podobné. U programd je vzdy k dispozici zkuSebni verze zdarma.

DalsSi programy pro prevod PDF do DWG nebo DXF

PDFIn od AutoDWG

DotSoft PDF2DWG
PDF to DWG Converter od Aide

19.7 Pfevod DGN do DWG / DXF

Pfevod DGN do DWG / DXF je ve 4MCAD mozny od verze 4MCAD 16.

Jednoduse zvolte Soubor > Otevfit a zméfte poZadovany typ pfipony na DGN:



A AMCAD 16.1 Professions _ |
i WAL 101 FIOTESSIO =} |-}
Soubor Mastroje  Kreslit Mapovéda

EHSE BT o FAst clu /8 FERXET 0

3

Tento poditad

¢
Sit
MNazev souboru:

Soubory typu:

B FnEy P 8B4 IT DR BT n o

Soubor MicroStation Designi (™.dan) ~
Standardni soubor vykresu (*.dwg)

Formét pro pFevod wykresu ©.ddf)

Bindmi wyménny format (" dxb)

% Otevfit wykres %
Oblast hledani: | | don V] @ 3 =@
Na ~ Dat . T Popis
v arev atum zmén
% — 4 1P Velileost:
| | test.dgn 04,01.2016 14:43 Soubor Dt =
Rychly pfistup Wytvofeno:
Zménéno:
- Otevreno:
Plocha
evrit jen pro cteni
. [ otevrit Eteni
4 Chranit heslem
Knihovny PouZit ndhled
Nahled

BN

Command: _CLOSE

= Command: _CLOSE
* lConmand : _open

Sablona vykresu (*d

Design Web Format (*.dwf)
wit

Collada soubor (" dae)

Command: _open

Pfipraveny

Poté mizete soubor jako format DWG nebo DXF ulozit.

DGN soubor mUizete také do DWG vykresu podlozit pomoci pfikazu v menu Viozit >

DGN podklad... a nastavit parametry podlozZeni:

TMFPEIGHEEE B SR

4
-,

s



8 AMCAD 16.1 Professional - [Vijkres2.dwg] = m} *
Soubor Upravit Zobrazit [ ViaZit | Format Mastroje Render Kreslit Koty Modifikace Okno MNapovéda Mmooy
O e S E % @ sk IR - TPl 15 X el -
Externi ref
IO BYLAYER || [ ————praver I B
s (55| PDF podkiad... P
B : {5 DGN podkiad... 2 D
"‘P Mic nevybrano ~ _)&; F.,S.]_FI DWF podklad... o O@
T o B { {3 | Piipojit mraéno bodd /.
@ Barva O ByLa [ | Rastrovy obrazek... WD &
Lemds = =
@ L Hle!d_!j'a o - B8] Mové rozvrzeni O &
Typ Eary | ) = '$’
ﬁ I .Mé.Fﬂkr;\.typu RozvrZeni ze sablony.. ‘-“ o
Drawing Exchanage Binary... T
E i . wing g ) @ 'H
[ Prihlednost | DieHiadin | ACIS soubor.. A
m— = OLE Objekt... »
'%‘ | Vizualizace 3D & I S
[t | Bylayer | Xref spravce 8
Zob isti...| Stimy wrhi .
&3] ! -_IT:IZEI'Il et el V [ spravee obrazkd... R
| Syl tisku . [
4 [l ) ikaz:
aifi| | Totmladi )| Audio poznamka B
| | Tabulka tisk A r—
= Typ tabulky v...| Barva zavisla... | III]]
= |__ = : R
e [ Stred X [ 10.4299 [| B—=~*
gy (570 145000 1 [l 4]p M\ Model 4 Layout1 \ Layou2 /
~ x (Command:_ "_ZOOM . . - . s ; < o
 Zoom: Bliz (I)/Dal (0)/vse (A)/stred (C)/Dynamicky/Rozméry (E)/Levy/Predchozi/Pravy
(R)/0kno (W) /ENtita/<Méritko (nX/nXP)=: _E v

Command :

Pfipoji DGN dokument

| -617886.0707,-1192164.3543,0.0000 | A4 11| Al 2% B B L Bl H 2 Hw

20. Casté otazky

20.1 Instalace

20.1.1 Instalace stazena z internetu nelze spustit

Velmi pravdépodobné doslo k problému pfi stahovani instalacniho souboru a ten
nebyl staZzen cely. Mlzete zkontrolovat velikost souboru na disku pocitace a
orientacni velikost souboru udanou na strankach.

VyzkouSejte staZzeni souboru opakované tfeba i nékolikrat za sebou nebo s €asovym
odstupem.

Pokud ani opakovany pokus o stazeni souboru nebude Uspésny, vyZadejte si zdarma
zaslani CD se zkuSebni verzi na strance Demo CD zdarma.

20.1.2 Avast blokuje néktery ze soubori CAD
programu

Ve snaze ochranit uzivatele muze Avast antivirus oznacit néktery ze souboru
programu jako potencionalni hrozbu. Jde o faleSny poplach. MizZe se jednat
napfiklad o problém pfi vydani novych verzi.



Pokud dojde k zablokovani nékterého souboru, umisti jej Avast do Virové truhly. Tu
zobrazite pomoci kliknuti pravého tladitka mysi na ikonu Avast vpravo dole ve
stavovém fadku Windows a volbou Virova truhla:

Oteviit okno programu Avast
Ovladani &titd programu Avast >
Tichy/herni rezim

Virova truhla
Aktualizace >

Aktivovat rezim Offline
Zobrazit posledni pop-up
Informace o predplatném

O programu Avast

6:32

Az OB g5

Ve virové truhle kliknéte na nazev zablokovaného souboru pravym tlagitkem my3i a
zvolte "Obnovit a pfidat do vyjimek":
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Obnovit zobrazeni vEech soubord

V pfipadé pochybnosti si mizete soubor nechat provéfit Sirokou Skalou antivirovych
programu na strance VirusTotal.com.

Pro analyzu nahravejte jen jednotlivé soubory. Instalacni soubor je pro tento ucel
pfilis velky.



20.2 ZkuSebni verze

20.2.1 Jaké jsou rozdily mezi plnou a zkuSebni verzi?

ZkuSebni a pIna (aktivovana) verze programu jsou shodné. Zkusebni verze je po
dobu 30 dni pIné funkéni. Pokud nedojde k aktivaci, po 30 dnech pfejde do tzv.
"demo reZimu". Program Ize spoustét, zkoudet jeho funkce, ale neni mozné ukladat
soubory ani tisknout.

Rozdilnou instalaci obdrzite pouze pfi zakoupeni verze s HK kli¢em. | ta se ale lisi
pouze zpusobem aktivace.

20.2.2 ZkusSebni verze byla ukon€ena dfrive nez za 30
dni

Pro zkusebni verzi s ukladanim i tiskem, volte v ivodnim dialogu vZdy prostfedni
tlaCitko Zkusebni verze. Pri prvnim spusténi se zobrazuje text Zacit zkusebni dobu.

Parametry instalace

Wlozte, prozim, YWaie sénove Sislo a

zvolte “Akbivovat” pro akbivaci YWas
leqalni licence nebo "Zkutebni verze!
c E D pro odzkougeni JMCADL.

Jméno |

Spoletnost: |

Sériove dislo; |

30 dni zbiva pro wyzkougen.

Al tivoneat | Zkuiebni verze Demo

PFi volbé Demo rezimu je program funkéni, ale nelze ukladat soubory ani tisknout.
Zkontrolujte, zda volite tlaCitko Zkusebni verze.

K ukon&eni zkusebniho obdobi mlze dojit také pfi odinstalaci €i preinstalaci
programu nebo manipulaci se systémovym Casem pocitade. ZkuSebni verze je vzdy
prfed€asné ukonéena pfi zméné systémového Casu.

Pokud zkuSebni obdobi jiz expirovalo, nelze s danou verzi obnovit. Mizete ale
vyzkouset jinou verzi (Classic/Standard/Professional), vyzkouSet program jesté na
jiném pocitaci nebo si u nas zdarma vyzadat do€asnou, asové omezenou licenci.



20.3 Aktivace

20.3.1 Program pri aktivaci hlasi, ze je nutné byt
prihlasen jako administrator

Pokud se pfi aktivaci programu setkate s timto hlasenim, ukoncete nejprve program.
Po té kliknéte pravym tlaCitkem mysi na ikonu programu na ploSe pocitaCe a zvolte
moznost "Spustit jako spravce". Po té provedte znova aktivaci s Vasimi licenénimi
udaiji.

Oteviit
Odstranit potize s kompatibilitou
Otevrit umisténi souboru

WF TortoisesyN

Enable/Disable Digital Sianature Icons

ﬁ_“ Spustit jako spra
Zapnoutfvypnout symboly pro digitalni podpis
7-Zip

B Fiidat do archivu. ..

& Fidat do “icad.rar”

B Fkomprimovat a odeslat e-mailem. .

B Zkomprimovat do “icad.rar” a odeslat e-mailem
Pripnout na hlavni panel
Pripnout k nabidce Start

a) Majit viry v icad.exe

i Spustit v sandboxu
[ed vidy spouitét v sandboxu

Cbnovit pfedchozi verze

Odeslat

Vyimout
Kopirovat

Vytvofit zastupce
Ddstranit
Prejmenovat

Vlastnost




20.3.2 Zobrazuje se hlaseni "Vlozené sériové Cislo
neni platné”

“oite Yase sérioveé gislo a zvalte
‘A\ "Aktivovat" pro aktivaci licence nebo
zvalte "Zadit zkusebni dobu" pro

‘ A wuzlennEani dhdran

Jmét | VloZené sériové dislo neni platné.

OK
Séri j
Zhywa 30 dni nawyezkaoufend.
Akfivovat Zatit zkugebni dobu Demo

Zobrazuje-li se toto chybové hlaseni, zkontrolujte:

1. Zda zadavate sériové Cislo, které jste obdrzeli pfi zakoupeni Vasi licence a nikoli
jiné Cislo (napf. aktivacni kod).

2. Zda nedoslo k preklepu v sériovém Cisle. Pokud kopirujete €islo pfes schranku ve
Windows, zkontrolujte, zda nezlstala mezera €i jiny znak na konci nebo na zacatku
Cisla. VyzkouSejte také opacny zpusob nez pfi neluspésné aktivaci (ruéni prepsani
nebo kopirovani sériového €isla). Rucni pfepsani Cisla vylou€i moznost problému s
kédovanim pfi vkladani pfes schranku Windows.

3. Zda aktivujete spravnou verzi programu. Verzi programu zjistite v levém hornim
rohu okna programu, pfipadné v menu Napovéda > O programu.... Je rozdil mezi
instalacemi pro verzi s USB kli¢em a bez néj i pro béZnou verzi 4MCAD Classic a
verzi Classic pro nekomercni pouZiti. Rozdil mezi USB verzi a verzi pro aktivaci bez
USB kli¢e, neni pfimo v programu patrny. Stazeny instalaéni soubor pro USB verzi
ma v nazvu USB nebo HK.

B 4MCAD 19x64 Standard

Soubor Upravit Zobrazit VioZit Format MNastroje Render Plus Kreslit Koty Modifika

T PO | (A B T 0 on | ot | s b B |7 | ]
FEles BRISINY [0 © 26 ET
Mgl O sl o < [ ]eviarer . |



20.3.3 Aktivace pro uzivatele bez administratorskych
prav

Pokud ma 4MCAD pouzivat uzivatel bez administratorskych opravnéni k systému
Windows, je nutno zopakovat aktivaci licence podruhé pod jeho uétem:

1. Provedte instalaci a aktivaci programu pod uétem administratora operaéniho
systému.

2. P¥i prvnim spusténi pod uctem uzivatele je nutné zopakovat postup pro aktivaci
licence v&etné nového zadani kontaktnich udaju.

3. Pfi dalSim spusténi pod uzivatelskym uctem by se jiz program mél spustit
stadardnim zpUsobem.

20.3.4 Probéhla deaktivace, ale licenci se na novém
poéita€i nedafri aktivovat (mél/a jsem i starsi verzi)

Pokud v poradku probéhla deaktivace licence, pfiSlo o ni oznameni emailem, ale
aktivace na novém pocitaci se nedafi (zobrazuje se chybové hlaseni "Nemate
licenci..."), velmi pravdépodobné zlstala na pavodnim poditaci aktivni jesté licence
starSi verze napf. 4MCAD 11. Ta méla jiné licenéni €islo. Jedna se vlastné o jednu
licenci CAD programu se dvéma Cisly, pro starsi a novéjsi verzi.

Deaktivaci je nutné provést pro obé licencni Cisla. Odinstalujte tedy i starSi verzi.
Pokud by jiz na pocitaci nebyla, mélo by byt mozné ji instalovat (je k dispozici na
strance www.4mcad.cz/ke-stazeni dole) a po té deaktivovat pfi odinstalaci.

Na novém pocitaci doporu¢ujeme instalovat uz jen aktualni verzi.

20.4 Licencovani

20.4.1 Jsou licence éasové omezeny?

Nejsou. Pfi ndkupu ziskate casové neomezenou licenci zakoupeného programu.
20.4.2 Je mozné pouzivat program na vice pocitacich?

Pro pouziti programu na vice pocitacich jsou ureny verze s hardwarovym kli¢em
(HK). Jde o varianty instalaci 4MCAD Standard a 4MCAD PRO. Vertikalni aplikace
jsou s hardwarovym kliCem vzdy.

PFi zakoupeni 5 a vice shodnych licenci jakékoli verze jsou také k dispozici zajimavé
mnoZstevni slevy.

20.4.3 Jakym zptlisobem pienést licenci na jiny
pocitac?
Program nejprve odinstalujte na pavodnim pocitaci. Pokud je pocitac pfipojen k

internetu, probéhne zaroven deativace na serveru vyrobce. Licenci by po té mélo byt
mozné aktivovat na novém pocitaci.


http://www.4mcad.cz/ke-stazeni

Pokud puvodni pocita¢ neni na internetu, zvolte volbu "Emailem" a postupujte podle
pokynu aplikace. Bude vygenerovan textovy soubor, ktery je nutné odeslat na
zobrazenou adresu a emailem také obdrzite potvrzeni o deaktivaci licence. Aktivace
a deaktivace emailem mlze byt omezena jen na vSedni dny a trvat az nékolik hodin.
Pokud je to mozné, vyuzivejte aktivaci a deaktivaci "Online".

r

20.4.4 Kde v programu zobrazit licenéni Cislo?

Pokud je instalace programu na pocitaci aktivovana, je mozné zobrazit licenci po
spusténi programu v menu Napovéda > O programu. Jedné se o polozku "Sériové
Cislo". U verzi s hardwarovym kli€¢em muzete vyuzit islo k aktivaci na jiném pocitaci.

O programu 4MCAD bt ‘

4»\ AMCADE pro Microsoft Windows ‘A\
A Copyright® 1399 - 2018 4M A

“WEechna prévawhrazena

Frodukt  4MCAD
Cislo produkiu; - RE8-4137-3049 b4-bit
Jméno uivatele:  Marek Ruzicka

Spoleénost.  ARCH LAB
Sériové Eislo: -

AMCAD powered by InteliCAD

Copyright® 1999 - 2018 The InteliCAD Technology Consortium. VEechna prava
wyhrazena. "IntelliCAD" & logo IntelliCAD jsou registrovanymi ochranmymi znambkami
InteliCAD Technology Consortium ve Spojenych statech a dalfich zemich

Tento software je 7 Sasti zaloien na dile téchio ffetich stran

Teighs® by Open Design Alliance
Independent JFEG Group

Waechny ochranne znamky, obchodni jmena nebo nazvy spolednosti zde uiite jsou poudity
pouze pro déely identifikace a jsou majetkam jgjich viastnikid

20.4.5 Jak postupovat pri ztraté licenéniho cisla?

Licenéni Cislo je registrovano u vyrobce na jméno, pfijmeni a email kontaktni osoby.
Neznate své licen¢ni Cislo, napfiklad protozZe jste program néjakou dobu nepouzivali,
napiste na emailovou adresu v sekci Kontakt. MGzete takto pozadat i o licence CAD
programi 4M zakoupené u jinych prodejcu.



20.5 Upgrade

20.5.1 Je mozny prechod na jinou verzi programu?

Zakaznici, ktefi v minulosti zakoupili licence 4M IntelliCAD 6.6 mohou vyuZivat se
stejnym licen¢nim Cislem i verzi 4AMCAD 11. Obdobné jsou licence verze 12 platné i
pro 4AMCAD 14.

Ceny upgrade ze starSich verzi na verzi aktualni nalzenete v eshopu. Pokud
pozadovanou kombinaci nenaleznete, kontaktujte nam, prosim, pro jeji kalkulaci.

Existuje také moznost rozSifeni na vysSi verzi programu. To plati i pro moznosti
pfechodu na HK (USB) verze u 4MCAD Standard a 4MCAD PRO.

Do 3 mésicl od zakoupeni je upgrade k dispozici za cenovy rozdil licenci dle
aktualniho ceniku. Po tomto obdobi je cena 0 20% vysSi.

Ceny upgrade ze 4MCAD na vertikalni aplikace (napf. IDEA Architektura nebo
FineELEC) jsou kalkulovany vzdy jako cenovy rozdil licenci.

20.5.2 Jak probiha prechod na jiny typ licence?

Tento postup se tyka pfechodu na jiny typ licence v rdmci stejného Cisla verze -
napfiklad pfi upgrade z verze Standard na verzi Professional. U starSich licenci je
zaroven nutny upgrade na aktualni verzi programu.

Pfed zadosti o vygenerovani noveho licen¢niho Cisla je nutné pavodni licen¢ni Cislo
deaktivovat. Zadost o nové licencni Cislo je po uhradé ceny upgrade vyfizena v
pracovnich dnech zpravidla v priibéhu nékolika hodin. Pro zménu typu Vasi licence:

1. Pokud je to mozné, instalujte poZadovanou aplikaci jako zkuSebni verzi. To nelze
pfi planovaném rozsifeni stejné licence o hardwarovy kli¢ (napf. upgrade ze 4MCAD
PRO na 4MCAD PRO HK). Instalace pro verze s hardwarovym klicem se liSi od
instalace pro softwarovou licenci, ale obé verze PRO i PRO HK se instaluji do
adresare se shodnym nazvem. Jinak je mozné mit instalovany riizné verze na
jednom pocitaci soubézné. Pro hladky pribéh je vhodné provést objednavku alespori
tyden pfed expiraci zkusebniho obdobi.

2. Zjistéte v eshopu cenu upgrade nebo nas kontaktujte pro jeji kalkulaci. Po té
provedte objednavku v internetovém obchodé nebo emailem.

3. Obdrzite podklad k platbé. Uhradte jej a vyCkejte na nase potvrzeni o pfijeti platby.

4. Pokud bude nutné vyménit USB kli¢ (napfiklad pfi upgrade ze 4AMCAD Standard
HK na PRO HK), zaSlete soubézné s platbou plvodni USB kli¢ na nasi adresu.
Zasilku je nutné pojistit na cenu pavodni licence! Doporu€ujeme vloZit USB kli¢ do
bublinkové obalky, ktera je k dostani v papirnictvi i na postach, a tu jesté do plastové
obalky pro cenné psani, kterou koupite na posté. Cena a pojisténi zasilky je takto
nizSi. VyCkejte na nase potvrzeni o pfijeti platby a zasilky.

5. Po naSem potvrzeni o pfijeti platby provedte deaktivaci licence. Pokud nemate k
dispozici zkuSebni obdobi u nové verze, zvolte pro deaktivaci licence termin, ktery



Vam pro zménu licence bude vyhovovat. O provedené deaktivaci nas informuijte
emailem.

6. Nové licenéni Cislo obdrzite emailem v pracovnich dnech zpravidla v pribéhu
nékolika hodin. Ani v pribéhu dovolenych by ¢ekaci doba neméla prekrocit 2
pracovni dny. Rychlost vyfizeni mohou ovlivnit také statni svatky u zahrani¢nich
partner(, které nemusi odpovidat svatkim v CR.

PFi vyméné USB kli¢e zasilame novy, obratem po pfijeti ptivodniho kli¢e a thradé
platby.

20.6 Systémové pozadavky

20.6.1 4M CAD ve Windows 10

CAD programy 4M jsou ve Windows 10 bez problém funkéni. Doporucujeme vzdy
vyuzit aktualni verzi instalace, ktera je k dispozici na strance Ke stazeni.

Pfed provedenim upgrade Vaseho operacniho systému ze starSi zalohujte styly tisku
Ci dalsi nastaveni programu a 4M CAD odinstalujte. Tim také prob&hne deaktivace
licence, pokud je pocita¢ pfipojen k internetu. Bez internetového pfipojeni zvolte
deaktivaci emailem a zaslete nam vygenerovany textovy soubor.

Po té program instalujte a aktivujte na novém opera¢nim systému.

20.6.2 4MCAD pfii Windows 10 Anniversary Upddate

Pfed provedenim Anniversary Update ve Windows 10 doporu€ujeme provést
deaktivaci licence. Po provedeni aktualizace operacniho systému, je pak mozné
licenci znova aktivovat se zachovani uzivatelskych nastaveni.

Pokud byl proveden Windows 10 Anniversary Update bez deaktivace licence a
4MCAD se nespousti, bude nutné provést pfeinstalaci programu v€etné upiné
odinstalace a promazani registra.

Pokud tedy budete chtit tento update instalovat, mize byt vyhodnéjsi pfipravit je;j
pomoci deaktivace licence 4MCAD a po té provést manualné. To je mozné ve
Windows 10 pomoci Nastaveni > Aktualizace a zabezpec€eni a aktualizace nechte
ruéné zkontrolovat. Mélo by se jednat o polozku Windows 10, verze 1607. Update Ize
také stahnout pfimo za stranek spolecnosti Microsoft.

Problém byl odstranén v aktualnich instalacich 4MCAD 16, které naleznete na
strance Ke stazeni.

20.6.3 Budou CAD programy 4M fungovat na Windows
7 64-bit?

Ano, budou fungovat ve Windows 7 i Windows 8 a 8.1. Jedna o jedny z
nejpouzivanéjsich operacnich systéma mezi zakazniky 4MCAD. Nemél by byt také
rozdil mezi verzemi Windows Home, Professional €i jazykovou verzi systému.

20.6.4 Instalace na Windows XP se nedari.



Litujeme ale operac¢ni systém Windows XP jiz neni podporovan. CAD programy 4M
vyuzivaji nékteré DLL knihovny, které ve Windows XP nejsou a neni je tam ani
mozné doinstalovat. Pokud Windows XP mate a chcete na mén dale pracovat,
informace k dalSimu postupu ziskate v sekci pozadavky.

20.6.5 Lze 4M CAD spustit na Mac OS ?

CAD programy 4M vyzaduiji spusténi ve Windows. Doporu€ujeme Windows na Mac
instalovat pomoci BootCamp. 4MCAD se pfi testovani jevil pIné funkéni.

Méné vhodnou cestou je Parallels Desktop, kdy maji programy k dispozici méné

operacni paméti. Diky zkusebni verzi mizete 4MCAD otestovat pfimo na Vasem
systému.

20.7 Nastaveni

20.7.1 Lze nastavit vychozi méritko typu €ar a Sraf?

CAD programy nabizi mnozstvi uzite€nych typQ &ar i vzoru Sraf, které vSak maji pfi
pouziti v riznych oborech nevhodné méfitko. Napfiklad stavebni vykresy jsou
kresleny v milimetrech a pro mnoho typa ¢ar a Sraf vyhovuje méfiko kolem hodnoty
500.

Pro nastaveni vychoziho méfitka pro typy Car:

Zvolte Nastroje > Nastaveni kresleni... > zalozka Tvorba entit

U polozky Méritko typu ¢ary zménte hodnotu na 500 a potvrdte tlacitkem OK.



B | Nastaveni kresleni O py

Modifikace entit Mastaveni 3D Dynamické zadani
Jednotky wykresu: Zadani soufadnic Zobrazeni Tvorba entit

Hladina: |0 ~ | Barva: Viybrat barwy...
Typ &ry: | BylLayer ~ | Méfitko typu Ery: 500.0000 =

- b — BYLAYER R IULEITIT TITETTLRLE LY LI 1 U o
Tloustka Cary Eéry: =

Styl tisku: | BYCOLOR

Atributy Prstence Elipsa Skici od ruky Srafy  VioZeni Body  Kfivky/stopy Tw 4|}

Wychozi nastaveni vioZeni Metody vkladani atributl
() Pouzit vychozi hodnoty (@) Zadat hodnoty v piikazovém fadku
(@ Vyzvat uzivatele () Zadat hodnoty v dialogovém okné
Vychozi reZimy atributi Rezimy zobrazeni atributi
[ Iskryté [ JUzaméené () Zapnuto - Vzdy zobrazit atributy
[ [Pevné  [_]Vice fadka () Wypnuto - Nikdy nezobrazit atributy
[]ovaiit (® Normalni - Jak je definovano v bloku
[ ]Definované

Pro nastaveni vychoziho méfitka vzoru Srafy:
Zvolte Nastroje > Nastaveni kresleni... > zaloZka Tvorba entit
NiZe zvolte zalozku Srafy

v wr

U polozky Méfitko vzoru zménte hodnotu na 500 a potvrdte tlaitkem OK.



B | Mastaveni kresleni

Modifikace entit
Jednotky vykresu:

Hladina: 0

Typ €ary: |ByLayer

(| >

Mastaveni 30 Dynamické zadani
Zadéni soufadnic Zobrazeni Tworba entit
e Bawa:l:l Vybrat barvy...
~ | Méfftko typu gary: | o00.0000 2

Tloustka &ary

A b

BYLAYER | Globdln’ méfitko typu | 1.0000

Styl tisku: | BYCOLOR

Atributy Prstence Elipsa

cary:

Skici od ruky 5rafy  VieZeni Body  Kiivky/stopy Tv 4| *

Q@

Styl vzoru
Mazev vzoru: |ANSIZ1 ~ .
(®) Standardni
MEFitko vzoru: | spp - O vnagi
: = (vse
Uhel vzoru: a =
Srafovani pomoci Zar
[ ] Povolit dvojité Srafovani Rozted: 1.0000 =

20.7.2 Jak prepnout program na angli¢tinu ¢i €estinu?

Pro pfepnuti 4MCAD CZ z €estiny na angli€itnu zvolte v menu Nastroje > Vybér
menu... a zvolte jazyk Anglicky.



Mastavit jazyk x

Nastaveni Windows

Mistni jazyk: Cestina (Ceskn)
Mistni a jazykové moZnosti...
Systémovy jazyk:  Cedtina (Ceskn) . kor
Nastaveni 4MCAD

Metoda vybéru jazyka

(@) Ruéni wbér

() Automaticky prizplsabit nastaveni regionu

() Automaticky prizpisobit lokalizaci systému
Jazyky

v Jazyk Mativni nazev Zemé Aktualni profil

2@ Anglicky English United States Default

@ Cesky costina Czechia Default

2 s

Pro pfepnuti z anglického prostfedi zpét na ¢estinu zvolte v menu Tools > Menu
select... a jazyk Czech.



Set Language X

Windows Settings
Regional language: | SEEiEREElER =l )]

o s Regional and Language Cptions. ..
System language: Cezting (Ceska republika) J < il

AMCAD Settings
Language Selection Method
(@) Manual selection
() Automatically match regional settings
() Automatically match system locale

Languages
*  language Mative Mame Country Cument Profile
@ English Enalish |United States Default
2 Czech cedtina Czech Republic Default

? Cancel

Alternativné muzete v obou pfipadech v pfikazovém fadku pouzit pfikaz
MENUPARAMS.

20.7.3 Jak vypnout zobrazeni souradnic pobliz
kurzoru?

Nejlépe by mélo vyhovovat nastaveni, kdy se soufadnice pobliZ kurzoru zobrazi jen,
pokud je pravé zadavate na klavesnici:

v menu Nastroje > Nastaveni kresleni > Dynamické zadani... > v poli pod Zadani
kurzorem tla€itko Nastaveni:

pod Zobrazit napovédu souradnic volba: Jakmile zadavam data souradnic.



Jednotky vykresu: Zadani soufadnic Zobrazeni Tvorba entit
Modifikace entit Mastaveni 3D Dynamické zadani
Povolit zadani kurzorem Povolit zadani rozmérem
MNastaveni zadani kurzorem X
Viditelnost Format

Pro druhy a dalsi bod, vychozi k:
Zobrazit ndpovédu soufadnic: LR g R

(@) Poldrni format {®) Relativni soufadnice
(@) Jakmile zadém data soufadnic
() Kartezidnsky format () Absolutni soufadnice

() KdyZ pfikaz vy#aduje bod
() wzdy - | mimo piikaz

0K Storno

Vzhled napovédy pfi kresleni...

(7] oK Zrugit

20.7.4 Co délat kdyz 4MCAD pracuje po aktualizaci
Windows pomalu?

Po nedavnych aktualizacich Windows s grafickymi kartami Intel (duben 2017)
muZze dochazet ke zpomaleni prace 4M CAD. Problém se tyka integrovanych
grafickych karet Intel HD 4000 ¢i starSich a muze se objevovat i u jinych 3D
programu. Jedna se pravdépodobné o chybu tykajici se ovladacu grafickych karet.
Pokud se setkate s popsanymi potizemi, jsou k dispozici tyto moznosti feSeni:

1. Vypnéte hardwarovou akceleraci ve 4M CAD pomoci menu:

Nastroje > MozZnosti > zalozka Zobrazeni > volba Hardwarova akcelerace (vypnéte)

...a restartujte program.



MoZnosti

Obecné Cesty/soubory Zobrazeni Profily Tisk  Uchopeni Schranka Wybér
Panel pfikazi

PoZetFadek v okn& 256 = Velikost |16 |+

PouZivat klavesy Sipek nahoru/dold k navigaci v okné historie pfikazd

[] Zapnout automatické dokonEovani Volby automatického dokonZovani.

Kreslici okno

Ramectek papiru ve vykresovém prostoru [«] Vichozi hodnoty nitkového kifze

[ ] Obratit smé&r zoomu koledkem mysi Malilkostloncan Coobazodad b =
[] Zobrazit zalozky [ |Hardwarova akcelerace
[]Zobrazit posuvniky Barevné schéma...
Nabidky

[v] Zobrazavat nabidky piikazi Potet poslednich vykresi: 3 =

]

Prihlednost oblasti vwybéru (32): |12 |2

UZivatelske prostfedi

Jazyk | cestina Mastavit jazyk ..

[ ] Uk&zat celou cestu vykresu v zahlavi Téma | Office 2007 Silver w

Standardni chovani Windows

Kontextova menu v kreslicim okné

Mastaveni praveho tlacitka mysi...

2. Nebo instalujte 32-bit verzi 4AMCAD. Zda se, Ze tyto verze problém neovliviiuje.

3. Nebo muzete odinstalovat nedavné aktualizace Windows (KB4013429 a nasledné

aktualizace KB4015438 nebo KB4016635). Operacni systém se ale brzy mize
aktualizovat znova...

4. Zkontrolujte nastaveni grafické karty nebo pokud mate v pocitaci i jinou grafickou
kartu, mizete nastavit ji. Pfiklad je z ovladaciho panelu grafické karty Nvidia:

Nastavte vysokovykonny procesor a stisknéte tlaCitko Obnovit.



B oviadaci panel NVIDIA — O Py
Soubor Upravy Plocha Nastaveni 3D Napovéda

Vyberte T Mizete zménit globalni 30 nastaveni a vylvoii pollaceni pro zvoleng programy. Pollaceni budou por "
kazdém spusténi zvolenych programi.

[=-Nastaveni 30
..Upravit nastaveni obrazu pr

Chci pouzit nasledujici 3D nastaveni:

Mastavit konfiguraci PhysX

Globalni nastaveni Nastaveni programu

Preferovany graficky procesor:

Vysokovyjkonny procesor NVIDIA « | Epravovat aktualizace...

Nastaveni:
Funkce Nastaveni ~
Akcelerace vice GPU / monitor( ReFim vykonu vice monitord
Anizotropni filtrovani Rizeno aplikaci
CUDA - GPU Vechny
Filtrovéni textur — Anizotropni optimalizac... ~ Vypnuto
Filtrovani textur — Kvalita Kvalita
Filtrovani textur — Negativni odklon drovn...  Povolit

Filtrovani textur — Trilinedrni optimalizace Zapnuto
Maximalni pocet pfedem renderovanych s...  PouZit nastaveni pro 3D aplikace

Mezipamét’ shaderu Zapnuto

Okolni prostfedi Vypnuto

Optimalizace podprocesi Auto

Pfedrenderované snimky virtudini reality 1 hd

|« Obnovit
Popis: W
< >
< 2
PouZit Zrusit

Systémové informace

V nastaveni programu vyberte nebo pfidejte program 4MCAD, vyberte
vysokovykonny procesor a stisknéte tlaCitko PouZit.



Ovladaci panel NVIDIA — O X
Soubor Upravy Plocha Nastaveni 3D Napovéda

€k 'O‘-

Vyberte tlohu. . Wizete zmenit globalni 30 nastaveni a vylvorit pollaceni pro zvolené programy. Poflafeni budou por
kazdém spusténi zvolenych programi.

[=- Mastaveni 3D
...Upravit nastaveni obrazu pr

Spravovat 3D nastaveni Chci pouZit nasledujici 3D nastaveni:

i..Nastavit konfiguraci Physx

GlobalIni nastaveni Mastaveni programu

1. Vyberte program, ktery si pfejete pfizpdsobit:

PA c:\amcad161prolicad.exe ~ Pridat Odstranit < Obnovit

[ zobrazit pouze programy, které se nachazi na tomto poéitadi

2. Vyberte preferovany graficky procesor pro tento program:

Vysokovykonny procesor NVIDIA ~

3. Zadat nastaveni pro tento program:

Funkce Nastaveni ~
Filtrovani textur — Kvalita PouZit globalni nastaveni (Kvalita)

Filtrovani textur — MNegativni odklon drovn...  PouZit globalni nastaveni (Povolit)

Filtrovani textur — Trilinedrni optimalizace PouZit globalni nastaveni (Zapnuto)

Maximalni poet pfedem renderovanych s...  PouZit globalni nastaveni (PouZit nastaven...

Mezipamét’ shaderu PouZit globalni nastaveni (Zapnuto)
Okolni prostfedi MNepodporovane pro tuto aplikaci
Optimalizace podprocesi PouZit globaini nastaveni (Auto)

Predrenderované snimky virtudlni reality PouZit globalni nastaveni (1) |

Popis: v

< >

Pouzit Zrusit

Systémové informace

Pokud potize pfetrvaji, kontaktujte nas, prosim.
20.7.5 Ve vykrese se nezobrazuje nastavena mrizka
(rastr)

MFizka (rastr) se zobrazi jen uvnitf nastavenych mezi v CAD vykresu. Ty je mozné
nastavit pomoci Nastroje > Nastaveni kresleni... > Zobrazeni > zalozka Meze

Zde zménte napfiklad hodnotu Prava horni X a Y tak, aby odpovidaly vasemu
méfitku vykresu. Mizete také vyuzit tlaitko Zadat pro zadani oblasti mysi ve
vykrese.

Viz také stranka Meze vykresu v Napovédé

MFiZka se také nezobrazi, pokud by byl rastr pfili§ husty nebo pokud jsou vSechny
body nastaveného rastru mimo obrazovku.




B | Nastavenf kresleni | *

Modifikace entit Nastaveni 3D Dynamické zadani
Jednotky vikresu: Zadéni soufadnic Zobrazeni Tvorba entit

Zobrazeni soufadnic

() Aktualizovat soufadnice pouze pfi vib&ru bodu
() Soufadnice vidy zobrazuji umfsténi kurzoru
(@) Soufadnice v poldrnim tvaru pro vib&r vzddlenosti a thlu

Zobrazeni Meze  Tloustky €ar Uzly  Rozhrani programu ProhliZeni

Meze vykresu
Pravahomi X |4ﬂs.713t+ \Y; |2?1.057s \

Fadat>

levadolni X |109-7023 ‘ Y- |51.D419 ‘

[ ]Nepovolit vstup za meze

20.7.6 Jak obnovit vychozi nastaveni panelli nastroj?

Vychozi nastaveni uzivatelkého prostfedi Ize mimo jiné provést pfepnutim programu
na anli¢tinu a po té zmét na &esitnu dle postupu pro Pfepnuti jazyka CAD programu.

Obnovu vychoziho nastaveni panell nastoju provede pomoci volby Nastroje >
Vlastni nastaveni menu.... V dialogovém okné je po té nutné zvolit zalozku Panely
nastroju a stisknout tlacitko Reset. Dialogové okno uzavrete kfizkem ¢&i tlaCitkem
Zavrit.
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Vlastni I 23 ,.

Nabidky | Panely nastrojd | Kidvesnice | Aliasy |
| <default> v

Buttons
” -
Data entity r @@L
Dotaz
Editace téles
Format
Hladina
kresli
kreslit 30 sité
kreslit 30 telesa
Koty
Mastaveni
Mastroje
Obrézek
Pohled
Poradr kreslenr
Pofadi kresleni - Anotace

Prizkumnik < [ vioit jako plovoud

B endrowEni

Odstranit

m

| Prejmenovat |

Moinost. ..

Popis nastroje:
Pfikaz: |

Popis:

E] [ Zavfit ] [ Importovat... l"] [ Exportovat.. i?l [H.E!SEH !v]

20.7.7 Jak nastavit ikony, abych je Iépe vidél(a) ?

Ikony pfikazu na panelech nastroju je mozné nastavit na vétsi velikost. Zvolte
Zobrazit > Panely nastroju a zaSkrtnéte volbu "Velka tlacitka".
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Vyberte panely nastrojd M

Panely nastraoji:

Dotaz = | PFejmenovat
Editace téles b -
Kresli Odstranit
Koty

Modifikace Viastni...
i

Plochy

Pohledy

Pofadi zobrazeni
Render

Rozlofit
Standard

Styly zobrazeni
Text

Télesa

ss

Vlastnosti
Viastnost entity
Vlozit .

[¥] velks tatitka
7 Darevns ﬁaclﬂ!a

[V Zobrazit popisy néstrojd

E] | ok || stomo

m
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Ziskate panely nastroja s vétSimi tlagitky.

Z AMCAD 16.1 Professional - [Vykres
T Soubor Upravit Zobrazit Viozit

Format Nastroje Render Plus

55% YESE] T N —

20.7.8 Jak ulozit zmény v roletovém menu?

1. Zalohujte soubor Icad2k_A.icm v instalaci programu zkopirovanim do jiného
adresare. Soubor naleznete ve verzi PRO pod umisténim
C:/4AMCAD11PRO/LANG/CZ/FINALICM/Icad2k_A.icm. Pro jiné verze je umisténi
analogickeé.

2. Pomoci volby Nastroje > Vlastni nastaveni menu... zobrazite dialogové okno, ve
kterém provedete Upravy pfFikazu i import celych souboru (formaty .mnu, .mns i
.icm). Popis dialogu naleznete v této napovédé.



[ Vlastni @1

Mabidky |Panely nastrojd | Klavesnice | Aliasy |
Strom nabidek: Dostupné prikazy:
5o 1wz -
- @ Upravit 112 wifezy [H
[~ @ Zobrazit ()20 détovy model
G- @ Viodit [ 2 ez
[#- @ Format @I 30 drétove zobrazeni
[+ @ MNastroje @ AL 30 kfvka
[¥- @ Render 1:2: 30 pole
[+ @ Plus 30 prevod
[#- @ Kreslit 30 skryté
[+ @ Koty EH 4 vifezy
- @ Modifikace Pfidat piikaz 4MCAD Konverter...
[#- @ Okno AMCAD na intemetu
[+ @ MNapovéda Moznost. .. ACIS Soubar...
[+ @ Kontext Alctualizovat
Anuloid
&) Audio pozridmka -
POP1
E] [ Zavrit ” Importovat... i"’] l Exportovat... 1"’] |F{esa‘t i"’]

—

3. Po ukonceni editace ¢i importu zvolte tlaCitko Export.

4. Zvolte typ souboru .icm a nahradte exportem soubor Icad2k_A.icm v instalaci
programu (cesta C:/4AMCAD19PRO/LANG/CZ/FINALICM/Icad2k_A.icm).

U vertikalnich aplikaci FINE je nutné nahradit ekvivalentni soubor. Napfiklad
C:./FINE14_ELEC/LANG/CZ/Finallcm/Fine_A HLEK.icm pro FINE ELEC 14.

5. Restartujte program a zkontrolujte, Ze zmény byly uloZeny.
20.7.9 Odstranéni prikazu z Panelu nastrojt

1. V. menu 4MCAD zvolte Nastroje > Vlastni nastaveni menu...
2. Ve stromové struktufe rozkliknéte ACAD > Panely nastroji > nazev panelu
3. Na pozadovany pfikaz kliknéte pravym tlacitkem mysi a zvolte Odstranit.

4. Restartujte 4AMCAD.
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20.8 Otevirani vykresu

20.8.1 Jak nastavit vychozi adresar pro otevirani
vykresu?

Pro nastaveni vychoziho adresare pfi otevirani vykresu zvolte v menu Nastroje >
Moznosti a zalozku Cesty/Soubory.

V prvnim fadku oznaeném Vykresy kliknéte na seznam cest, jako prvni pfidejte
cestu do pozadovaného adresare a oddélte na konci stfednikem. Na obrazku je
nastaveni pro vychozi adresar C:\AMCAD16PRO.
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Obecné | Cesty/soubory | Zobrazeni | Profity | Tisk | Uchopeni | Schrdnka | Vbér |

|1' Sablony 3
£-J6A Whresy

o CNAMCADTE1PROVMENU

- CNAMCADTEIPRONDWG
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Mapovani pisem  CHNAMCADTETPROYcad fmp
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Prochazet...

@ [ OK ][ Stomo ]

20.8.2 Jak upravit Sablonu (vychozi vykres)?

Sablona (&i vychozi vykres nebo "prototyp") je DWG vykres, ktery se otevira vzdy pfi
spusténi programu nebo pfi vytvofeni nového vykresu. Ve vychozi Sabloné jsou jiz
nékteré objekty pfeddefinovany. To ale nemusi vSem uzivatelim vyhovovat a
mnohym m{ize usnadnit praci pfidat si do Sablony objekty vlastni.

Sablona je umisténa v adresafi s lokalizaci. Naptiklad
C:\AMCAD14PRO\LANG\CZ\prototypes\dMCAD2K_CZ.dwg

Pro upravu zalohujte vychozi Sablonu, pfipravte vlastni DWG vykres a prepiste jim
DWG soubor v uvedené cesté.

Alternativné mizete umistit svou Sablonu i jinde na disku a upravit cestu ulozenou v
systémové proménné BASEFILE.

20.8.3 Jak prevedu formaty STP nebo IGS do DWG?

Import formatt .stp (.step) a .igs (.iges) ve 4MCAD bohuzel neni mozny. Pokuste se
ziskat vykres ¢i model pfimo ve formatu DWG nebo DXF.



Pokud soubory téchto typl potfebujete importovat ¢asto, mlzete pro prevod
vyzkou$et cenove dostupny ViaCAD. Po ulozeni do DWG pak mlzete s vykresy opét
pracovat ve 4AMCADu.

20.9 Ukladani vykresl

20.9.1 Dlouhé ukladani DWG vykresu zdrzuje pri praci

Délku ukladani DWG vykresu Ize optimalizovat riznymi zpusoby:

Velikost soubort
vykresu. U vétSich vykresu neni vhodné mit v jednom DWG souboru rizné varianty
téhoz vykresu. Lépe je rozdélit je jednotlivé do nékolika souboru.

Vycisténi objektu ]

Pfikaz v menu Soubor > Nastroje vykresu... > Cistit > VSe, vyvola Cisténi jiz
nepouzivanych objektd. Klavesou Enter potvrdte ¢isténi vSech typu objektd (volba
<*>),

ZruSeni zalozni kopie

Ve vychozim nastaveni uklada program soubor vlastné dvakrat. Jednou s koncovkou
DWG a jednou zalozni kopii s koncovkou BAK. Je mozné zrusit ukladani zalozni
kopie pomoci nastaveni systémové proménné MAKEBAK na hodnotu 0.

ZrusSeni automatického ukladani

Pokud Vas pocita€ i CAD program funguje stabilng, je mozné zru8it automatické
ukladani v dialogu Nastroje > Moznosti... zruSenim volby Automaticky zalohovat.
Jedna se o samoziejmé o dvojseCné nastaveni, protoze jim pfi padu programu Ci
zvyk €as od Casu ulozit praci klavesovou zkratkou Ctrl+S. Pak mate vSe pod
kontrolou.

Audit vykresu

V ojedinélych pfipadech se mohou v DWG vykresech vyskytovat objekty, se kterymi
bude mit CAD program néjaky problém. To mlize zapfiCinit delSi dobu ukladani
vykresu. Vykres Ize vyzkouSet a problém vyfeSit pomoci pfikazu menu Soubor >
Nastroje vykresu > Audit.

20.9.2 Poskozeny DWG vykres nelze otevrit

Pokud se stala tato nepfijemna véc, Ze nelze otevfit DWG soubor vykresu napfiklad
po padu systému ¢&i programu, mazete vyuzit zalozni vykres s koncovkou .BAK, ktery
se zpravidla uklada pod stejnym nazvem soubé&zné se souborem DWG: Pfejmenujte
soubor s koncovkou .bak na jiny nazev a koncovku .dwg. Po té jej budete moci
otevfit standardnim zplsobem.

Ukladani do .BAK souboru kontroluje systémova proménna MAKEBAK.

MuUzete také zkusit vyuzit zalozni vykres ulozeny pfi Automatickém ukladani.



20.9.3 Kde najdu soubory z automatického ukladani?

Perioda automatického ukladani a pfipona ulozenych souboru jsou nastavovany v
dialogovém okné pod volbou v menu Nastroje > Moznosti, zalozka Obecné.

MoZnosti L%J

Obecné ICestyfscubananmzeni | Profity | Tiskk | Uchepeni | Schranka | wibér |

Uroveri znalosti
Uzivatelska drover: [Pokroc':iljr vJ

Automatické zalohovani

A tomaticky zalohovat kaidjich: |13 = mirwt

T IO SOUDOT] aur 2at

adl
=0}

UloZeni souboru
Vychozi format : [MDCAD 2013 jdwa) -

Otevrit

[ Pou#it Recover, pokud CtevFit selfe

Skrit upozomeéni pA otevirani vykrest pomaoci Recover

Alctudini prafil

Default
Chybova hidseni

[Tvwpnout chybova hlageni [T VWtvoft celou zprévu
Fabezpeceni VBA

[] PFi startu potladit makra VBA Common Project

l Nastavit asociativitu soubon ]

@ [ OK ][ Stomo ]

Vychozi nastaveni je automatické ukladani kazdych 60 minut a koncovka docasného
souboru SV$.

Analogicky jsou tyto hodnoty ulozeny v systémovych proménnych SAVETIME a
SAVEFILE.

Pokud je Vas systém dostate¢né stabilni, mizete dle uvahy nastavit delsi interval pro
automatické ukladani nebo je uplné zrusit (hodnota 0), pokud jste zvykli na obCasné
ukladani manuaini.

Adresaf, kde jsou soubory pfi automatickém ukladani umistény, je ur€en ve stejném
dialogovém okné pod zalozkou Cesty/soubory, polozka Do¢asna slozka.
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Muze jit o adresar pod uzivatelskym uctem, ktery je nastaven jako skryty.

Vyberte cestu, zkopirujte ji do schranky (Ctrl+C) a vlozte do Fadku s adresou
napfiklad v Prizkumniku soubort ve Windows. Zobrazené soubory v adresafi
sefadte dle data a mezi naposledy zménénymi objevite své vykresy s pavodnim
nazvem a koncovkou SV$. Zkopirujte je do jiného adresare, prfejmenuijte pfiponu na
.DWG a otevrete ve VaSem kreslicim programu.

Prectéte si také o UloZeni vykresu pfi padu 4M CAD.
20.9.4 Kam se ukladaji soubory pfi padu programu?

Pokud dojde k padu programu, nemusi byt Vase prace ztracena. Program po novém
spusténi nabidne otevfeni vykresu automaticky ulozeného pfi padu. Zapamatujte si
cestu do slozky k tomuto souboru. | kdyz otevieni neprob&hne, vykres
pravdépodobné ulozen je: Ve 4M CAD zvolte Soubor > Otevrit a vyhledejte soubor
na disku. Ve vychozim nastaveni se jedna o tuto cestu:

C:/Users/...Uzivatel.../Dokumenty/4AMCAD19Professional

Nazev uzivatele a verze CAD programu budou odpovidat Vasemu nastaveni a typu
programu.



V adresafi sefadte soubory od nejnovéjsiho, oteviete je a ulozte pod novym nazvem
do jiného zvoleného adresare.

Prectéte si také o Umisténi doasného souboru.

20.10 Kresleni

20.10.1 Vytvoreni oblouku dané délky

Pro kresleni oblouku o pfedem dané délce vytvorte nejprve jakykoli oblouk v
pozadovaném polomeéru pfikazem Oblouk.

Po té upravte jeho délku na pozadovanou hodnotu pfikazem Upravit délku:

1. Zvolte v menu Modifikace > Zvétsit délku nebo ikonu Upravit délku v panelu
nastroju Modifikace.

2. Zvolte moznost Celkem zadanim "T" v pfikazovém fadku a Enter
3. Zadejte poZzadovanou délku a potvrdte klavesou Enter.
Délka oblouku bude upravena na pozadovanou hodnotu. Zkraceni &i prodlouzeni

probéhne od pocatecniho bodu plvodniho oblouku. Mize byt tedy jesté nutné otocit
oblouk do poZadovaného umisténi.

20.11 Uchopy

20.11.1 Jak v CAD nakreslit te¢nu ke dvéma
kruznicim?

Pro vytvofeni te€ny ke dvéma kruZicim je mozné vyuzit uchop tecny:

1. Spustte pfikaz Useéka (Line).

2. Pfi zadavani prvniho bodu vynutte aktivaci uchopu teény na klavesnici viozenim
pismen TAN + Enter a kliknéte na kruznici kdekoli v okoli pfedpokladaného umisténi

prvniho bodu tecny.

3. Pro druhy bod teCny opét vynutte uchop klavesami Tab + Ener a zvolte bod na
druhé kruznici v blizkosti mista, kde oCekavate pozici druhého bodu.

TecCna bude programem automaticky vytvofena v poZadovanych bodech.

Ukazka je k dispozici na videu Te¢na ke dvéma kruznicim.



20.11.2 Uchopit stied kruznice, kdyz se nabizi jen jiné
uchopy

Uchop stfedu kruznice nebo oblouku je aktivovan pfi najeti kurzorem na obvod

v v

bod na kruznici.
Pro uchop stfedu kruznice &i oblouku muzete:
A/ Pro nastaveni pro delSi dobu zménit nastaveni ichopt pomoci kliku pravého

tlacitka mysi na policko ESNAP - Nastaveni uchop entit (F3) ve stavovém fadku
vpravo dole - volba Nastaveni.

Mastaveni wkresu L-L?—J

Vytvéfenientity | Modfikaceentity | Nastaveni3D | Dynamicks zadani
Jednothoy vikresu: i Zadani soufadnic | Zobrazeni

[7] Kreslit ortogonding

7l Magneticke

- automatické pRchyceni

Zménit nastaveni pro; | Uchopy entit v]

[¥] Trasovani uchopeni objektu 3
_ I Zobrazit moZnosti... I

[Vpnout uchopeni entity

Mastaveni Gchopl

[7] Koncavy [ StFed [ Prisedik

[] Nejblize [ Polovina [] Zdanlivi prisesik
[ Kalmy [ Bed [ VioZeni

[ Kvadrart [ Teena [7] Protazeni

I___J Rovnobé&zné

= | Vibratvie | | Zudtvie |

¥y @ [ 0K ]I Stomo |

‘z9z5590199.7109,00000 | AN 1 A Q% ] t ' moDELP Tomier g T

B/ Jednorazovy uchop vynutit uchop stfedu vynutit pomoci Shift + pravé tlacitko mysi
a po té zvolit pozadovany typ uchopu.

C/ Alternativné muzete jednorazovy uchop stfedu vynutit klavesami CEN + Enter.
20.11.3 Jak jednorazoveé vynutit uchopy entit?

Pokud potfebujete jeden konkrétni ichop a znacky preskakuji mezi riGznymi tchopy
nebo je uchop potlacen jinym nastavenim, Ize uchop v pribéhu kresleni jednorazové
vynutit pomoci klavesy Shift a sou€asnym kliknutim pravého tlacitka mysi.
Pozadovany uchop po té vyberte ze zobrazené nabidky:



god

Alternativné muazete uchop vynutit zadanim klavesové zkratky (3 znaky) a potvrzenim
Enter ¢i pomoci ikony na panelu nastroju.

Zkratky pro jednotlivé uchopy:

END koncovy bod

NEA nejblizsi

MID polovina

CEN stfed oblouku nebo kruznice
PER kolmo

TAN tecna

Panel nastroju |ze zobrazit pomoci menu Zobrazit > Panely nastrojd... a zaSkrnutim
volby Uchopy.

Uchopy entit A

LFAX|Q@GO|LB | AF|N

20.12 Vybér entit

20.12.1 Volba pifedchoziho vybéru

PFi upravach entit mazete zopakovat vybér pfedchozi vybérové mnoziny pomoci
klavesy P (dle angl. "previous") + Enter v okamziku, kde jste dotdzani na vybér entit.
Funkce mlze urychlit a usnadnit praci.



20.12.2 Nelze vybrat vice entit

Prepnuti systémové proménné PICKADD méni zplsob vybéru entit - Ize vybirat bud
vice entit najednou (vychozi nastaveni) nebo jen jednu entitu.

Pfepnuti hodnot kontroluje tlagitko v horni ¢asti panelu vlastnosti:

' Vlastnost

Kruznice

| Barva L1 BYLAYER
Hladina ]

. Typ Eér-_.r '

| M&Fitko typu ...| 500.0000

| Styl tisku | ByLayer

| Tloustka &ary | —— DieHl..

- Hypertextowy... .

Pokud je na tlaCitku zobrazena hodnota 1, pfepnéte rezim vybéru kliknutim mysi.

Vice: Systémova proménna PICKADD.

20.13 Modifikace

20.13.1 Jak kopirovat entity mezi vykresy?
Kopirovani entit mezi vykresy je mozné nékolika zpusoby. Nejjednoduseji:

1. Vyberte entity pro kopirovani ve zdrojovém vykrese.

2. Ulozte je do schranky pomoci Ctrl+C.

3. Pfepnéte do cilového vykresu pomoci menu Okno > Nazev vykresu ¢&i klavesovou
zkratkou Ctrl+Tab.

4. Spuste vkladani vykresu ze schranky Ctrl+V.

5. Zadejte bod vlozeni (pokyn v pfikazovém fadku). Bude se jednat o levy dolni roh
ohranicujici oblasti (bounding box) vybranych entit.

Pokud po vlozeni v cilovém vykrese nové entity nevidite, jsou pravdépodoné pro
aktualni pohled pfili§ velké nebo pfilis malé. Zvolte Zobrazit > Zoom > V3e.

Pro kopirovani mezi vykresy mlzete také pouzit pfikazy menu Upravit > Kopirovat,
Kopirovat se zakladnim bodem a VloZit. Kopirovani se zakladnim bodem umozni
zvolit jiny referen¢ni bod, nez je levy dolni roh ohranicujici oblasti.

20.13.2 Entity se viozi do bodu mimo obrazovku



PFi kopirovani mezi vykresy muze nastat situace, kdy CAD program pozaduje zadani
bodu pro vloZeni, ale Vy pfi vkladani ani po ném viloZzené entity nevidite, protoze
vloZeni probéhlo do bodu v modelovém prostoru, ktery je mimo obrazovku.

Pokud takova situace nastane, je nutné pred vlozenim kopirovanych entit vypnout
ortogonalni rezim klavesou F8 nebo pomoci dvojkliku mysi na tlaCitko ORTHO
vpravo dole ve stavovém fadku. Po dokonc€eni kopirovani muzete ortogonalni
kresleni stejnym zplisobem opét aktivovat.

20.13.3 Chybi Poradi zobrazeni ve 4MCAD 14 Classic

Pfikaz "Pofadi zobrazeni" (_draworder) funguje ve verzi 4MCAD 14 Classic pouze
zadanim z pfikazového fadku. Nelze jej ani pfidat manualné do menu a chybi i v
panelech nastroju. Problém bude opraven ve verzi 4MCAD 16. Pokud ale potfebujete
rychlejsi volani pfikazu, ulozte si nasledujici skripty pomoci pravého tlacitka mysi a
volby "Ulozit odkaz jako..." do adresafe s instalaci 4AMCAD (C:\4MCAD14CLASSIC):

poradi-zobrazeni.lsp
4dmcad.lsp

Po restartu bude k dispozici klavesova zkratka "DR", ktery zavola zminény pfikaz.
Novy pfikaz _dr bude také mozné manualné pfidat do roletového menu programu.

Po modifikaci je nutné exportovat menu do souboru
C:\AMCAD14CLASSIC\LANG\CZ\FINALICM\4mcad2k_A.icm

20.14 Srafy

20.14.1 Ve vykrese se nezobrazuji vytvorené Srafy

Pravdépodobné jste jiz zkontrolovali, Ze neni vypnuta hladina se Srafami nebo, Ze se
nesnazite Srafy kreslit s vypnutou aktualni hladinou. Pokud ne, zkontrolujte.

NejspiSe ale mate vypnuto zobrazeni vyplni. Nastaveni zkontrolujete v dialogu:
Nastroje > Nastaveni kresleni > zalozka Zobrazeni

Je tfeba mit zaSkrtnutou volbu Zobrazit plnou vypln pro roviny, krivky...
Alternativné je mozné zménit pfimo hodnotu systémové proménné FILLMODE na 1.

Pro uc€innost nastaveni je tfeba po zavieni dialogu vynutit pfekresleni obrazovky
(napfiklad posunem pohledu).

Jedna se o nastaveni, které je uloZzeno v DWG vykresu a mUze byt opravdu matouci,

pokud DWG vykres s takovym nastavenim od nékoho dostanete. Je to tedy také
vhodny zpusob, jak se koleglm pfi pfedavani podkladi pomstit :-(

20.15 Texty



20.15.1 Ve vykrese se chybné zobrazuji znaky s
diakritikou

Muze se jednat bud o pouziti fontu, ktery diakritiku neobsahuje nebo o vykres s
chybné nastavenym kédovanim &estiny.

Zkontrolujte nejprve v jakém je text stylu. To zjistite pfi vybraném textu v Panelu
vlastnosti.

| Text 2o
Contents INVESTOR
Annotative No ]
Justify Left
Height 206 5455
Rotation 0
Width factor 07212
Obhguing 0
Text aignment X 0
Text alignment ¥ 0
Text alignment Z 96087581689.1615

Po té muzete zkontrolovat a pfipadné zménit Pismo (font) pfifazeny ke stylu pomoci
volby Format > Styl textu...

Spravce stylu textu M
Mazev aktualniho stylu
[Siﬁndard - ] [ Mowy... ] Ffejmenovat... Odstranit
Rozméry textu ismo textu
[ Anatativni dzev: IAriaI - I
Orientace dle rozvrZeni s
Styl: lobycejne - ]
Pevna vyska: 0
Jazyk: Stredoevropsky -
Koeficient Sifky: 1 I By I
Meaig il 0 BigFont: (Z3dny)
Generovani textu Mahled textu
[ Tigk textu pozpathu
[ Tisk textu vzhiru nohama A r| a I
Tisk textu vertikalné

(2] [ Pousit | [ ok ][ storno |

Ve vykresech s ¢eskymi texty je nutné pouzivat kddovani ANSI_1250. Kédovani
nastavuje pfikaz CODEPAGE a zobrazuje jej systémova proménna
DWGCODEPAGE. Hodnota je uloZena spolu s vykresem.

Pro zménu kédovani:



1. Napiste do pfikazového fadku "codepage" a potvrdte Enter.
2. Zadejte novou hodnotu "ansi_1250" a opét potvrdte.

3. Vynutte regeneraci vykresu (v menu Zobrazit > Regenerovat vSe nebo zkratka
RE).

4. UloZte vykres

Lze také nastavit Pravidla pro automatické nahrazovani fontu.
20.15.2 Jak nastavit automatické nahrazovani fontu

Pro nahrazovani nékterého z font(l v CAD vykrese za jiny Ize nastavit automaticka
pravidla. Jde o uZiteCné nastaveni, pokud €asto dostavate vykresy s texty v urcitém
fontu, ale Vas CAD program pfislusny font nema ¢i v tomto fontu neobsahuje znaky s
diakritikou.

4MCAD se pfi otevirani vykresu Fidi pravidly obsazenymi v souboru icad.fmp, ktery
musi byt uloZzen v adresafi programu, napfiklad v umisténi
C:\4MCAD16PRO\icad.fmp pro verzi 4AMCAD 16 Professional. Pokud tam tento
soubor neni, Ize jej jednoduse vytvofit napfiklad pomoci poznamkového bloku ve
Windows a stejnou aplikaci jej také mlzete upravovat.

Syntaxi pravidel oziejmi tento priklad:
simplex.shx;simplex8.shx
Font simplex.shx bude pfi otevieni vykresu vzdy nahrazen fontem simplex8.shx.

Kazdé pravidlo je nutné uvést na novy fadek (Vzorovy-vychozi soubor pro
4MCAD19).

Poznamka
Ve starsi verzi 4MCAD 14 Slo namisto souboru icad.fmp o soubor 4mcad.fmp.

20.15.3 Lze vyhledat a hromadné nahradit ¢asti textu?

Ve verzich Standard a PRO obsahuje menu Plus pfikaz Najit-Nahradit pro vyhledani
zadaného Fetézce v fadkovych textech a jeho automatického nahrazeni za novy text.

20.15.4 Vlozeni Excelové tabulky do 4MCAD

V menu zvolte Vlozit > OLE Objekt... ponechte volbu Novy a zvolte Microsoft
Excel Worksheet



Vlozit objekt bt

Typ objektu: | oK |
® Novy Kresba OpenOffice.org XML 1.0 4 |
Microsoft Excel §7-2003 Worksheet Zrusit
(7) Ze soubonu Microsoft Excel Binary Workshest

Microsoft Excel Chart
Microsoft Excel Macro-Enabled Wark
Microsoft Excel Waorkshest

Microsoft Graph Chart it ||:| Zobrazt jako konu

Wysledek
Wozi novy objekt Microsoft Excel Worksheet do

dokumentu.

Nasledné se spusti program Excel, kam mUzete zadavat data nebo je vlozit ze
schranky z jiného dokumentu pomoci CTRL + V. Po vloZeni dat mizete Excel
uzavfit. Data je mozZné také pozdéji editovat: pomoci dvojkliku na tabulku ve vykrese
spustite Excel a provedete zmény.

Pro zobrazeni zmény je nutné vykres regenerovat.

20.16 Obrazky

20.16.1 Obrazek po viozeni do vykresu nelze editovat

Vykres muze mit v nastavenich vypnuto zobrazovani rameckl kolem rostrovych
obrazkl. Takové obrazky pak neni mozné editovat (posouvat, kopirovat, zvétSovat),
jak je zvykem u ostatnich entit v CAD vykresech.

Pro zapnuti ramecku u obrazkd zvolte v menu Modifikace > Objekt > Obrazek >
Ramecek

V pfikazovém fadku pak zadejte volbu ON a potvrdte klavesou Enter.
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20.17 Zobrazeni

20.17.1 Pozadi odstavcového textu (Mtext) prekryva
ostatni prvky

Siroce nastaveni pozadi odstavcového textu (MTEXT) miZe prekryvat ostatni prvky
ve vykrese:
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Pro napravu zobrazeni je tfeba sniZit nastaveni Sifky odstavcového textu nebo zrusit
zobrazeni masky pozadi. To je mozné bud manualné pro kazdy text zvlast Ci pfi
vybéru vice textovych entit napfiklad pomoci filiru nebo hromadné napfiklad pomoci
LISP skriptu.

Pro manualni nastaveni vyberte text nebo vice textd napfiklad pomoci filtru. Po té v
Panelu vlastnosti zmérte Maska pozadi: Ne a/nebo Definovana §ifka: 0.

Pro hromadné nastaveni v celém vykrese mizete také vyuzit LISP aplikaci ZruSeni
Sifky Mtext.

20.17.2 Kéty ve starsich vykresech se zobrazuiji
neuplné

Z davodu zmén nastaveni v novéjSich verzich 4AMCAD se mohou nékteré koty ve
starSich vykresech zobrazovat jako neuplné (napfiklad s pferudenou kétovaci Carou):
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| pfes chybné zobrazeni by mél tisk byt v poradku.

Pro napravu zobrazeni je nutné aktualizovat kéty jakoukoli zménou: posunem &i
upravou vlastnosti. K dispozici je také LISP aplikace, ktera vytvofi nové kopie két
hromadné pro vSechny entity ve vykrese.

Pro manualni Upravu vlastnosti:

1. Vyberte kétu &i kéty. Je mozné pouZzit Rychly vybér dle vliastnosti.

2.V Panelu viastnosti rozkliknéte v fadku Editovat kotu dialogové okno pro
nastaveni.



Sikmd kdta

———

________________________

] BYLAYER
Hladina 0
Typ Cary — Bylayer
Merfitko typu Sary 500.0000
Styl tisku ByLayer
Tlougtka cany DleHladimy
Hypertextovy odkaz

DleHladirmye

- zavfenad wplnéna

Sipha 2

-=— |zaviena vwplnéna

Kiatovaci Siphy

0.1200

Tloustka kdt. Sany DleBloku
Tloudtka vwn. Eary DleBloku
kit Zara 1 Zapnuta

Kit. ara 2 Japnuto

Barva két. Cary W BYBLOCK
Typ két. Edry

Prodlouzeni kat. Eany 0

Typ 1. wnaieci Cany — Bylayer
Typ 2. vynageci cary

Vynaseci dara 1 Fapnuto
Wnaseci &ara 2 Japnuta

Pevna wnaseci éara Viypnuto

Pevna délka vynaseci... | 1.0000

Barva vynadeci &ary M EYELOCK
Presah vynaseci éary | 0.1800
Cdsazeni vyn. Sany 0.0625

Barva vypingé Fadné

Typ zlomkeu Vodaorovné
Barva textu M EYELOCK
WSk textu 0.1800
Odsazeni textu 0.0900




3. Zmérite nékterou z vlastnosti. Napfiklad zagkrtnéte na zalozce Cary volbu Potladit
vnéjsi kotovaci ¢ary a potvrdte tlaCitkem OK.

Pro hromadnou aktualizaci mGzete vyuzit LISP aplikaci Aktualizace kot ve vykrese.

20.17.3 Jak zmérit délku entit v CAD vykrese?

Ikona pfikazu Vzdalenost pro méfeni délky je soucasti standardniho panelu
nastroju:

a AMCAD 19x64 Professional

Soubor Upravit Zobrazit Viefit Forméat Nastroje Render Plus Kreslit Kéty Modifikace Okno

L L N e M R

Pokud potfebujete ¢asto i méreni ploch, mlzete si zobrazit panel nastroji Dotaz
pomoci Zobrazit > Panely nastrojt... > Dotaz

a2 B
Délky jednotlivych entit jsou zobrazeny pfi jejich vybéru také v Panelu vlastnosti:




E AMCAD 16.1x64 Professional - [Vykres2.dwg]

5_3_] Soubor Uprawit Zobraot WViedt Format Nastroje Render Pl
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] BYLAYER

Plus Kresht

1%

i M [ carkovana

Kfivka w R P
Obecné .

[JBYLAYER
carkovana

Barva
Hiadina
Typ Cary

Méfitko typu Edry
Styl tisku
Tlougtka Edry
Hyperextovy odkaz
Prahlednost
Tlousfka
Vizualizace 3D
Matenal
Geomelrie
Vrichol
Vrchol X
VicholY

Sifka pofdtedniho segmentu
Koncova Sifka sagmentu

Globalni Sitka
Elevace
Plocha
Délka

5000000
BylLayer
DleHladiny

DleHladiny
0

ByLayer

1
1239 6619
-334.4139
0

0
0
0
8300899125
417.780

(Command :
IStorno
WCommand :
iCommand:
|Storno
Command :

automatické ukladini otevrenych wykresd. ..

Prikaz:

.Emnd B

288341

Pripraveny

Pokud nemate Panel vlastnosti zobrazeny, kliknéte na vybranou entitu pravym
tlacitkem mysi a zvolte "Vlastnosti".

Pro soucet délek vice entit vyuzijte LISP aplikaci Délka skupiny entit.

Muzete také vyuzit LISP aplikaci pro S¢itani vlastnosti ve 2D.



20.17.4 Jak zobrazit plochu kfivky?

Plochu kfivky je mozné nalézt v Panelu vlastnosti v sekci Geometrie:

| Viastnost
ke e, 7
Obecné =
| Barva 'JBYLAYER
Hiadina carkovana
Typ Eary
Méfitko typu Edry 500.0000
Styl tisku ByLayer
TlouStka Edry DleHladiny
Hyperexovy odkaz
Prihlednost DleHladiny
TlouZtka 0
Vizualizace 3D -
I ne———— B:.rLa o
Gaomaelrfie A
Vichaol 1
Vrchol X 1235 6619
Vichel Y -334.4139
Sifka pofdtedniho segmenty | 0
Koncova Sifka segmenitu 0
Globalni Sitka 0
Elevace 0
Plocha 2300899125
Diélka 4777801
Rizné -

Pokud nemate Panel vlastnosti zobrazeny, kliknéte na kfivku pravym tlacitkem mysi
a zvolte "Vlastnosti".

Ve starsi verzi AMCAD 14 je nutné pro moznost zobrazeni plochy uzaviené kfivkou
jiz pfi jejim kresleni vynutit uzavieni volbou Zavfit (C) pfi vytvareni posledniho
segmentu.

Kfivku, ktera nebyla uzaviena touto volbou je mozné upravit pomoci pfikazu PEDIT:
1. Zvolte v menu Modifikace > Objekt > Krivka

Alternativné zvolte ikonu Upravit kfivku na panelu nastroju Modifikace |I.

2. Vyberte poZadovanou kfivku

3. Uzavrete ji volbou Zavfit (C).

4. Ukoncete piikaz klavesou Enter



20.18 Panely nastrojt

20.18.1 Pri zméné jazyka nejsou nacteny panely

nastroju

Vybér jazyka mezi ¢estinou a angli¢tinou (pfikaz MENUPARAMS) muze byt také

vyuzivan pro obnovu vychozich nastaveni.

-

Mastavit jazyk

[

Mastaveni Windows

Mistni jazyk:

Systémovy jazyk: ;ﬁeéﬁna {Ceska 'republika}l

Mastaveni HMCAD
Metoda vybéru jazyvka
@) Rufni wibér
(71 Automaticky pfizpsobit nastaveni regionu
(71 Automaticky pfizpisobit lokalizad systému

[ Miztni a jazykové moznosti...

Jazyky
T landkc Mativni nazev Femé Altusini profil
2 Anglicky English Inited States Default
@ Ceshy cestina Czech Republic Default

20.19 Tisk

20.19.1 Nedari se tisk na Sirku

1.V &asti dialogu tisku Orientace vykresu zvolte Na Sifku (pravdépodobné mate).



v v,

2. Zvolte dalSi nastaveni jako: oblast tisku vybérovym oknem, méfitko, tabulka stylu
tisku (pfifazeni per) a zaskrtnéte volbu Stred tisku v sekci Odsazeni tisku.

3. Ulozte nastaveni tisku tlacitkem Pouzit pro rozvrzeni.

Plot-Moded 21
Mastaven sedrk) - Tabuka syl ssku (pf facerd par)
Nize Frde.. 12830 [poucivd sa vichozl] %) ﬂ
= leecana/ oy = Mastawaii irn i whieas
Hazey: | ho deckiet 3c -l Wastaceti Tak dlinevant  [22 coplace ~]
Tiz<&ma o ceshe: o Kusia ot | >
= TN -
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4. Zkontrolujte nastaveni tladitkem Nahled.... V pfipadé potieby nastaveni upravte,
opét ulozte tlacitkem Pouzit pro rozvrzeni a opét zkontrolujte v nahledu.

5. Vytisknéte vykres tlaCitkem Tisk.
20.19.2 Nefunguje tisk z rozvrzeni na PDF tiskarnu

VyzkouSejte pfed odeslanim rozvrzeni na tiskarnu stisknout v dialogu tisku tlaitko
Pouzit pro rozvrzeni a po té teprve tlacitko tisk.
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Pokud mate verzi 4AMCAD 24, mate také moznost vyzkouSet tisk ve starSim typu
dialogu tisku. Typ dialogu tisku Ize nastavit pod Nastroje > Moznosti v zaloZce Tisk.
Zmérite
Typ dialogu tisku na "Standardni" a vyzkouSejte tisk znova.



MoZnosti x|

Obecné | Cesty/soubory | Zobrazeni | Nikovékfize | Profiy
Tisk | Vibér | Uchopeni
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Zapati: I j
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Virchozi tabulka shylu tiskou:
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Typ dialogu tisku
‘ {* Standardni " Pokrogily
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Dal3i moznosti je provést ve vychozim (Pokro€ilém) dialogu tisku jeden tisk z
modelového prostoru. V nékterych pfipadech tim dojde ke zméné problémového
nastaveni a po té opét funguje tisk z rozvrzeni.

20.19.3 Pri tisku ve Windows 7 se nezobrazi cely
obsah dialogu tisku.

Tento problém byl odstranén ve verzi 4MCAD 14 a novéjSich.
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Problém se objevuje ve Windows 7 a souvisi se systémovym nastavenim velikosti
textd, nez je vychozich 100%.

MozZnosti FeSenim je tisk pomoci starSiho dialogu tisku, ktery je |ze nastavit pomoci
menu Nastroje > Moznosti > zalozka Tisk a v dolni ¢asti dialogu Typ dialogu tisku
volba Standardni.
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Obecné | Cesty/soubory | Zobrazeni | Nitkovékfize | Profiy
Tisk | Vijbir | Uchopeni
—Zahlavi a zapati
Zahlavi: I j
Zapati: I j
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Wchozi styltisku pro entity: [5YC0L0R 7
— Typ dialogu tisku
% Standandni " Pokrodily

Pridat nebo upravit tabulloy stylu tisku. .. |

ﬂ 0K I Stomo

Dal3i mozZnosti je nastaveni systémové velikosti textu ve Windows na vychozi
hodnotu 100%.

20.19.4 Pri tisku se zobrazuje nezadouci pozadi
odstavcového textu

Pokud mél odstavcovy text zapnutou masku pozadi, muze se pfi tisku jevit jako
nezadouci:
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Pro vypnuti masky pozadi textu vyberte jednu €i vice entit odstavcového textu a v
panelu vlastnosti dole na fadku Maska pozadi rozkliknéte dialogové okno s volbami:

Obsah ahoj datel'FP

| | Sandend | Mastaveni pozadi lﬁ
Anotativni | Ne

| Zarovnat Mevo nahofe [¥] Poui it masku pozadi
Smér | Wodorowné
Vidka textu [ozoo0 | Faktor odsazeni rdmedku: 15
Ctodeni |0
Faktor Fadkovani [ 7.0000 Barva vipiné pozadi
Velikost rozestupu &ar | 0.3333 . [¥] Pouiit barvu pozadi wikresu Bl Cervend

e = ra—
MNe | I

- S 2] [ ok ][ some

Definovana vyska |0 i
' Geometrie =

V dialogovém okné zruste volbu PouZit masku pozadi.

Pro hromadné vypnuti mizete také pouzit LISP aplikaci Vypnuti masky pozadi Mtext.

20.20 LISP



20.20.1 Jak nacist LISP aplikaci / skript pro
jednorazové pouziti?

LISP aplikace Ize jednorazové nacist v dialogu pod menu Nastroje > Nacist
aplikaci...

E Maéist soubory aplikace >
Seznam souborl aplikaci:
D-\_data\lisp\2disf\2dist Isp

CHMMCADT9PRO\symboly16 Isp
Ddmilisplab\obloukova-kota Isp

Pfidat nazev souboru... QOdebrat nazev socubomn... Madist

7] [] Uloit aktualizace

Tlac¢itkem Pridat nazev souboru vyhledejte soubor s koncovkou LSP na disku
pocitaCe. Po té je nutné nové pfidany soubor oznadit, stisknout tladitko Nacist a
zavfit dialog pomoci tla€itka OK. Po té budou v programu k dispozici nové funkce Ci
pfikazy.

Pokud si prejete nacitat LISP aplikaci automaticky pfi kazdém spusténi 4MCAD,
vyuzijte postup na strance o automatickém nacitani LISP.

20.20.2 Jak automaticky nacitat LISP?

PFi spusténi programu je automaticky nacten soubor icad.lsp umistény v adresafi
instalace. Napfriklad u verze Professional pujde o soubor C:/4AMCAD16PRO/icad.Isp.

Do néj mlzete pfimo umistit své definice nebo odkazy na vlastni soubory pomoci
pfikazu load, pfipadné xload:

Muzete napfiklad nakopirovat soubor mujlisp.lsp do adresare instalace (napf.
C:/AMCAD19PRO/mujlisp.Isp) a do souboru icad.Isp pfidat Fadek s pfikazem

(load "mujlisp.Isp")

Pro automatické nacitani icad.Isp s kazdym otevienym vykresem, nastavte hodnotu
systémové proménné ACADLSPASDOC na 1 (ON).

Pfikazy a funkce pak budou nacteny pfi kazdém spusténi 4MCAD.
U starSi verze 4MCAD 14 se misto icad.Isp jednalo o soubor 4mcad.Isp.

V souboru icad.lsp €i 4mcad.lsp ponechte Fadky, které v ném jiz jsou. Napfiklad pro
verzi 4AMCAD 19 Professional se jedna o tento fadek:



(xload "VLispCmd.dII")
20.20.3 Textové editory pro LISP

LISP (Ci AutoLISP) je mozné psat v jakémkoli textovém editoru, ktery do zdroje
nevklada vlastni formatovaci znaky jako je napfiklad Poznamkovy blok ve Windows.
Vyhodou lepSich editori byva barevné zvarazriovani kédu pro lepSi orientaci,
moznost definice klavesovych zkratek a v neposledni fadé barevna signalizace
parovani zavorek. Nékteré editory umozriuji také uzivatelsky upravovat soubory
programovaciho jazyka ¢i definovat jazyk novy.

Pro psani LISP muzete vyzkouS$et editory, které jsou zdarma:

Notepad++
PSPad

Ci placené:
UltraEdit

Vyvojafum Casto postaci i editory v prvni skupiné zdarma.

[ C3\_data\tutorials\lisp\osluneni\primka-plocha.lsp - Motepad++ = =
| Soubor l:lpra\r_',r Majit Zobrazit Fermat Syntaxe Mastaveni Makro Spustit  Pluging Okno 7 x|
|| o = s e & | | 2 | 80 Bg | = §|_--'_.:'.'_|—=—,-.'E??._JB|OIEIIEI”
;Elprimka-plocha.lsp E]Eoslunenii.isp ]zac-kreuhleni.!e:; ] B demart1sp & il E nahodne-cislo Jsp ]
[ == ldz (- 1lp2z 1lplz) ~
5 )
5 L
7 substitute line egquation teo vector equation and calculate t value
8 ;s if pnumerator is 0 then 1pl lies in the plane
(setg numerator (+ (* a 1plx) (* b 1ply) (* o 1pl=z) d))
0 ; denominator is dot product of 2 vectors:; if 0 then line is parallel with tI
1 (setqg denominator (+ (* a ldx) (* b 1ldy)} (* c 1ldz}))
2 = (if (egqmal denominator E 1)
63 = (progn
64 (if (egqmal numerator 0 0.0001)
68 )
69 = (progn
T (setg t (* -1 (/ numerator denominator)))
71 ; calculate intersection point
T2 (setg intx (+ 1lplx (* 1dx t)))
g (setg inty (+ 1ply {(* 1dy t)})
74 (setg intz (+ 1lplz (* 1d= t)))
Tt (setg intersection (list intx inty intz))
i ) v
< >
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